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1 Safety and Certifications
Before using the CIRRUS 6000, herein referred to as CIRRUS 6000,
you must fully understand potential safety hazards. Read the
following safety warnings and cautions in their entirety before
using the instrument. Additional warnings and cautions are found
throughout the instructions for use.

Under normal conditions, the risk/benefits profile of the CIRRUS
6000:

• Provides a high level of health and safety protection.

• Complies with MDD ER1.

1.1 Symbols and Labels

Warning Manufacturer

Caution Authorized European Community Represen-
tative

Note Conforms to applicable European
Directive(s)

Must follow Instructions for Use

Electronic Manuals CE Mark with identification number of DQS
-- accredited Notified Body for compliance
assessment to the European Union direc-
tives, including Medical Device Directive
93/42/EEC.

Stand-by

Fuse Certification mark of CSA – Nationally
recognized test laboratory for US and
CanadaDirect Current

Type B Applied Parts Disposal of the Product within the E.U. Do
not dispose via domestic waste disposal
system or communal waste disposal facility.

Serial Number

Catalog Number/Part Number CAUTION! Federal law (or United States)
restricts this device to sale by or on the
order of a licensed healthcare practi-
tioner.Model Number
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1.2 Definitions
Warnings and Cautions are defined as follows:

 WARNING! Indicates hazards that, if not avoided, could cause the
following:
> Severe injury or even death

The warning message names the possible consequences.

u These are actions that can be taken to prevent the hazard.

 CAUTION! Indicates hazards that, if not avoided, could result in the
following:
> Minor or moderate injury
> Moderate damage to or impaired performance of
equipment

The caution message names the possible consequences.

u These are actions that can be taken to prevent the hazard.

1.3 Safety

NOTE Report Serious Accidents

u If a serious incident has occurred in relation to this medical
device, to the user, or to another person, then the user (or
responsible person) must report the serious incident to the
medical device manufacturer or the distributor. In the European
Union, the user (or responsible person) must also report the
serious incident to the Competent Authority in the state where
the user is established.

1.3.1 Product Safety

 WARNING! Non-compliance with system requirements laid out in
standard IEC 60601–1

could result in compromised patient safety.

u The person or the responsible organization connecting
additional devices or reconfiguring the system must evaluate
the complete system to ensure compliance to the applicable
IEC 60601–1 requirements.

 WARNING! Device proximity to flammable gases or vapors

may cause ignition.

u Do NOT use in the presence of flammable anesthetics, or
oxidizing gases such as nitrous oxide and pure oxygen.
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 WARNING! Opening Instrument Covers

can lead to exposure to electrical and optical hazard.

u Do not open the instrument covers.

u Exceptions:

ð You may remove the rear cover to access labels and
connectors.

ð You may remove the instrument's top cover to inspect or
replace the fan filter.

 WARNING! Using the Device adjacent to, or stacked with, other
equipment

could impact device operation.

u If adjacent or stacked use is necessary, the equipment or
system should be observed to verify normal operation in the
configuration in which it will be used.

 WARNING! In case of an emergency

disconnect the appliance coupler.

u For the device, the most accessible power cord is the one that
plugs into the bottom of the table.

u Do not position device so it is difficult to unplug power cord.

 WARNING! Use of the acquisition device, a printer, or the power table
with an extension cord or a power strip (multiple portable
socket outlet)

could cause electrical shock to the patient or operator.

u Do not use extension cords with the instrument.

u If you plug something other than an instrument into the
Multiple Socket Outlet (MSO), the MSO may not have the
designed level of safety.

u Do not use power strips with the instrument.

u Do not plug in any other equipment into the same wall outlet
as the instrument.

u To avoid the risk of electric shock, this equipment must only be
connected to a supply mains with protective earth.

 CAUTION! Patients who hold on to the instrument before or during
tests

risk having their fingers pinched and possibly injured.

u Make sure that the patient is not holding on to the instrument
before or during tests.
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 CAUTION! Using the instrument on an uneven or sloped surface or
rolling the table in deep pile carpet or over objects on the
floor such as power cords

could cause the table and/or instrument to tip, resulting in injury to
operator or patient and damage to the instrument.

u Do not use the instrument on an uneven or sloped surface.

u Do not roll the table in deep pile carpet or over objects on the
floor such as power cords.

 CAUTION! Using aerosols near or placing containers of liquid on or near
the instrument

could damage the equipment. The instrument is not designed with
any specific measures to protect against harmful ingress of water
or other liquids (classified IPXO - ordinary equipment).

u Do not place containers of liquid, or use aerosols on or near
the equipment.

 CAUTION! Using a non-approved or incorrectly connected device

could invalidate the system safety approval.

u Follow all indications in this user document to ensure that all
connections are approved and correctly configured.

 CAUTION! Unauthorized modification or dismantling of the instrument
or system components

could result in damage to the instrument or components or harm
to the operator or other personnel.

u Only authorized ZEISS personnel are authorized to modify or
dismantle the instrument or its components.

 CAUTION! Reconfiguring system components on the table, or adding
non-system devices or components to the table, or replacing
original system components with substitutes not approved
by ZEISS

could result in failure of the table height adjustment mechanism,
instability of the table, tipping and damage to the instrument, and
injury to operator and patient.

u Do not reconfigure system components on the table, nor add
non–system devices or components to the table, nor replace
original system components with substitutes not approved by
ZEISS.
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 CAUTION! (United States) Federal law restricts this device for sale by, or
on the order of, a licensed healthcare practitioner.

u Purchasing from an unlicensed healthcare practitioner is against
(United States) Federal law.

u Purchasing from an unlicensed healthcare could result in a non-
standard, incorrectly installed, and faulty instrument that could
risk result accuracy and patient or operator safety.

NOTE The CIRRUS 6000 Power Table is safe to use within the
patient environment when the instrument is powered
through it, as instructed herein.

 WARNING! Installation or modification of devices and systems by
persons not authorized by ZEISS

can lead to the injury of patients and operators, as well as to
property damage. Installation and modification requires special
knowledge and skills.

u Have the installation performed only by persons authorized by
ZEISS.

u Do not modify or change the configuration of the instrument
or the system after being installed by ZEISS trained personnel.

 WARNING! Use of accessories, transducers, and cables other than those
specified or provided by the manufacturer of this equipment

could result in increased electromagnetic emissions or decreased
electromagnetic immunity of this equipment and result in improper
operation and potential safety hazards.

u Use only the accessories, transducers, and cables specified or
provided by ZEISS.

1.3.2 Optical Safety
• ANSI Z80.36-2019.

• Classification: Group 1 Instrument – Per ANSI Z80.36. Group 1
instruments are ophthalmic instruments for which no potential
light hazard exists.

 WARNING! Device produces visual stimuli, including flickering light and
flashing patterns, between 5 and 65 Hz

may adversely affect certain patients, although this effect is yet
unproven.

u Medical professionals need to determine whether this device
should be used for patients who may be photosensitive,
including those with epilepsy.
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 WARNING! Patient injection with photo–dynamic therapy (PDT)
treatment drugs, such as Visudyne®

could lead to unintended exposure and uncontrolled treatment of
neovascular vessels.

u Do not scan patients who have been injected with photo–
dynamic therapy (PDT) treatment drugs, such as Visudyne®, in
the previous 48 hours.

 CAUTION! Applicable Phototoxicity Statements (Ophthalmoscope
Guidance - (Direct and Indirect) - Guidance for Industry; July
1998; FDA CDRH):

Because prolonged intense light exposure can damage the retina,
the use of the device for ocular examination should not be unnec-
essarily prolonged.

u While no acute optical radiation hazards have been identified
for direct or indirect ophthalmoscopes, it is recommended that
the exposure time for the patient’s eye be limited to the
minimum time that is necessary for diagnosis.

u Infants, aphakes, and persons with diseased eyes will be at
greater risk. The risk may also be increased if the person being
examined has had any exposure with the same instrument or
any other ophthalmic instrument using a visible light source
during the previous 24 hours.

u This will apply particularly if the eye has been exposed to retinal
photography.

u Note:This medical device has no user adjustable intensity
settings for light incident on the retina, nor does it produce UV
radiation or short–wavelength blue light.

1.3.3 Electrical Safety
Class I Equipment - Protection against electrical shock.

 WARNING! An ungrounded Device

could lead to electric shock.

u Do not remove or disable the ground pin.

u Only an authorized ZEISS service representative may service the
instrument.

u Only an authorized ZEISS representative may install the
instrument.
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1.3.4 Printer and Peripherals Safety

 WARNING! Non-compliance with system requirements laid out in
standard IEC 60601–1 for instruments externally connected
to non-medical peripheral devices (i.e. printers, non-system
storage devices, etc.)

compromises patient safety.

u If a non-medical peripheral device is located within 1.5 m from
the patient, the usage of an isolation transformer is required.

u If the peripheral device is located outside the patient
environment (beyond 1.5 m) and is connected to the
instrument, a separation device must be used or there shall be
no electrical connection between the non-medical peripheral
device and the instrument.

 WARNING! Placing peripheral devices closer than 1.5 meters (4.9 feet)
from the patient

could result in electrical shock to the patient and/or operator.

u Use a wireless configuration, if possible.

u Use an isolation transformer in the USB configuration.

u Ensure that patients cannot touch a peripheral device with any
part of his or her body while being examined.

u Ensure the instrument operator does not attempt to touch the
patient and a peripheral device at the same time.

 WARNING! Simultaneously touching a patient and a peripheral device

could compromise patient safety.

u The instrument operator must not touch the patient and a
peripheral device simultaneously.

 CAUTION! Using peripheral devices not supplied or approved by Zeiss

could degrade the performance of the instrument and/or lead to
corrupted diagnostic or therapeutic information and may cause
safety hazards and void the instrument warranty.

u We strongly recommend you use peripheral devices supplied or
approved by Zeiss, because they will have been tested to work
safely with the instrument.

u Do not install any unapproved third party software on the
instrument.
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1.3.5 Networking Safety

 CAUTION! Internet connection of the Instrument

increases its vulnerability to serious security risks, including viruses
and worms that could disable your system or adversely affect its
performance and may void the instrument warranty.

u Only connect to the internet when it is absolutely necessary.

u Transfer data through internal networks.

u Ensure that all firewalls and internet security applications are
up-to-date and running.

1.3.5.1 Unsupported Network Activities

NOTE The user is responsible for system performance degradation
or any other change or defect resulting from unsupported
network activities.

ZEISS IS NOT RESPONSIBLE FOR SOFTWARE REPAIRS OR
UPGRADES NECESSITATED BY THE ATTEMPTED PERFOR-
MANCE OF THE FOLLOWING ACTIVITIES.

ZEISS does not support the following network activities, although
they may be possible:

• Printing with a printer not approved by ZEISS for use with this
instrument.

Refer to our website for the current list of approved hardware and
software. If you want to use a third party device, seek technical
support from the device manufacturer.

1.3.5.2 Networking Guidelines

CIRRUS 6000 provides IT–Network capabilities to allow data
archiving and information sharing in the clinical environment and
across medical facilities.

NOTE Users are responsible for network setup and maintenance.
Users are responsible for installing and configuring all
networking hardware and software.

ZEISS Technical Support is limited to testing instrument network
connectivity.

u ZEISS Technical Support cannot troubleshoot or repair
problems with network connectivity.

u Observe all guidelines in this document regarding instrument
networking.
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1.3.6 Record and Data Safety

1.3.6.1 Patient Record Deletion

 CAUTION! Deletion of a patient record

is permanent.

u Delete records with care!

 CAUTION! Merging incorrect patient records

can only be corrected using the Move Scan feature to separate the
merged file.

u Be certain that you select the correct patient records to merge.

1.3.6.2 Prohibited Activities

 CAUTION! Attempting to carry out activities not specifically endorsed
by ZEISS

may void your warranty and could result in damage to the
instrument.

u Read the user documentation.

u Follow directions carefully.

u Do not make upgrades, or carry out repairs or modifications,
without specific guidance and instruction from ZEISS or an
authorized ZEISS represenative.

The following activities are prohibited using the CIRRUS™ HD-OCT
instrument:

• Do not relocate the CIRRUS™ HD-OCT database to a network
file server.

• Do not share CIRRUS™ HD-OCT folders with other computer
systems via the network.

• Do not share the CIRRUS™ HD-OCT system printer on the
network if the printer is connected to the USB port.

1.4 Electromagnetic Compatibility (EMC)

 WARNING! Installing or putting the device into service without regard to
EMC information provided

may void your ZEISS instrument warranty, result in damage to the
instrument and/or compromise safety for patients and operators.

u This instrument has special EMC precaution requirements and
needs to be installed and put into service according to the EMC
information provided herein.
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 CAUTION! This instrument is intended for use in a professional
healthcare facility environment.

Using the instrument in any other environment may void the
warranty and compromises the safety of the patient and/or
operator.

NOTE The emissions characteristics of this equipment

make it suitable for use in industrial areas and hospitals (CISPR 11
Class A).

u If it is used in a residential environment, this equipment might
not offer adequate protection to radio-frequency communi-
cation services.

u The user might need to take mitigation measures, such as
relocating or re-orienting the equipment.

NOTE Excessive electromagnetic events may temporary disable the
instrument.

u If the instrument becomes disabled, reboot it.

Electromagnetic Emissions [} 20] and Electromagnetic Immunity
[} 20] are required per IEC 60601-1-2:2014.

1.4.1 Electromagnetic Emissions
This instrument complies with the following emission requirements:

Phenomenon Standard

Conducted and radiated RF
emissions

Group 1 
CISPR 11 Class A

Harmonic distortion IEC 61000-3-2 Class A

Voltage fluctuations and flicker IEC 61000-3-3: Complies

Table 1: Electromagnetic Emissions

1.4.2 Electromagnetic Immunity
This instrument complies with the following immunity require-
ments:

Phenomenon Basic EMC standard or test
method

Immunity test levels

Electrostatic Discharge IEC 61000-4-2 ± 8 kV contact 
± 2 kV, ± 4 kV, ± 8 kV, ± 15 kV air

Radiated RF EM fields IEC 61000-4-3 3 V/m 
80 MHz – 2,7 GHz
80 % AM at 1 kHz
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Phenomenon Basic EMC standard or test
method

Immunity test levels

Proximity fields from RF wireless
communications equipment

IEC 61000-4-3 See Wireless Communications
[} 22]

Rated power frequency magnetic
fields

IEC 61000-4-8 30 A/m
50 Hz or 60 Hz

Electrical fast transients / bursts IEC 61000-4-4 ± 2 kV 100 kHz repetition
frequency

Surges line-to-line IEC 61000-4-5 ± 0,5 kV, ± 1 kV

Surges line-to-ground IEC 61000-4-5 ± 0,5 kV,± 1 kV, ± 2 kV

Conducted disturbances induced
by RF fields

IEC 61000-4-6 3 V 
0,15 MHz – 80 MHz 
6 V in ISM bands 
between 0,15 MHz and 80 MHz 
80 % AM at 1 kHz

Voltage dips, short interruptions,
and voltage variations on power
supply input lines

IEC 61000-4-11 0 % UT1; 0,5 cycle 
At 0°, 45°, 90°, 135°, 180°, 225°,
270° and 315°

0 % UT1; 1 cycle
and 
70 % UT1; 25/30 cycles 
Single phase: at 0°

Voltage Interruptions IEC 61000-4-11 0 % UT1; 250/300 cycle

Table 2: Electomagnetic Immunity
1UT is the a.c. mains voltage prior to application of the test level.
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1.5 Wireless Communications
Test
Frequency 
(MHz)

Band (MHz) Service Modulation Maximum
Power (W)

Distance (m) Immunity
Test Level (V/
m)

385 380 - 390 TERTRA 400 Pulse 18 Hz 1.8 0.3 27

450 430 - 470 GMRS 460,
FRS 460

FM ± 5 kHz
deviation 
1 kHz sine

2 0.3 28

710
745
780

704 - 787 LTE Band 13,
17

Pulse 217 Hz 0.2 0.3 9

810
870
930

800 - 960 GSM
800/900,
TETRA 800,
iDEN 820,
CDMA 850,
LTE Band 5

Pulse 18 Hz 2 0.3 28

1720 
1845 
1970

1700 - 1990 GSM 1800;
CDMA 1900;
GSM 1900;
DECT; LTE
Band
1,3,4,25;
UMTS

Pulse 217 Hz 2 0.3 28

2450 2400 - 2570 Bluetooth,
WLAN,
802.11 b/g/n,
RFID 2450,
LTE Band 7

Pulse 217 Hz 2 0.3 28

5240 
5500
5785

5100 - 5800 WLAN
802.11 a/n

Pulse 217 Hz 0.2 0.3 9

Table 3: Test specifications for enclosure port immunity to RF wireless communications equipment.

1.6 Operator Training and Equipment Maintenance

NOTE Expected Service Life

The expected service life of CIRRUS 6000 is 7 years.
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1.6.1 Operator Training

 WARNING! Incorrect use of equipment

could result in damage to patients or equipment.

ü Only personnel who have undergone appropriate training and
instruction may use this device.

u Operating personnel must be appropriately trained and
instructed.

u Operating personnel must read and understand the User
Manual.

u The User Manual must be made available to operating
personnel at all times.

u To facilitate access for all operating personnel: Request
additional copies of user documentation as required from
ZEISS.

u Specify the competencies for handling the device and state
who is authorized for what tasks.

u Determine the reporting obligations for instrument error and/or
damage and make them known.

u Regularly review the applicable legal regulations regarding
accident prevention, health and safety in the country of use.

1.6.2 Equipment Maintenance

 CAUTION! Lack of regular safety inspections

could result in a decrease in device safety, increase in the possibility
of device damage, and/or inaccurate results.

ü Regular technical safety inspections must be carried out as
specified for this device by any and all applicable national
regulations.

ü Equipment inspections may only be performed by Zeiss or Zeiss-
qualified personnel.

u Comply with the specified maintenance intervals.

u Carry out all inspections fully.

u Minimally, local system inspections must include the following:

ð Availability of the Instructions for Use

ð Visual inspection of system and accessories for damage and
legibility of labels

ð Current leakage test

ð Test of protective ground conductor

ð Function and wear test of brakes, if applicable
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ð Function test of all switches, buttons, sockets and indicator
lamps of the system

 WARNING! Making changes to equipment without first consulting your
ZEISS Field Representative

could result in the equipment being Out of Compliance.

u Any additional equipment connected to medical electrical
devices must demonstrably comply with the applicable IEC or
ISO standards (e.g. IEC 60950 for data processing equipment).

u All configurations must meet the applicable requirements for
medical systems, as specified in IEC 60601-1 standard.

u Anyone connecting additional equipment or modifying the
configuration to a medical electrical device or system is a
system configurer, and that individual is responsible for
compliance of the complete system with the applicable
standards such as IEC 60601-1 and other applicable collateral
standards.

u Local legislation has priority over the above normative require-
ments.

1.6.3 Notification of Serious Incident
Any serious incident, affecting any person, that occurs in
connection with the use of this medical device, must immediately
be reported to the manufacturer or to the medical product
distributor. In the European Union, the operator must report this
serious incident to the responsible authorities in the applicable
country.

1.7 RoHS Compliance
The product is RoHS-compliant according to Directive 2011/65/EU.
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2 Introduction

2.1 Scope

2.1.1 Intended Use
The CIRRUS™ HD-OCT with Retinal Nerve Fiber Layer (RNFL),
Macular, Optic Nerve Head, Ganglion Cell and Asian Normative
Databases is indicated for in-vivo viewing, axial cross-sectional, and
three-dimensional imaging and measurement of anterior and
posterior ocular structures.

2.1.2 Indications for Use
The CIRRUS™ HD-OCT is a non-contact, high resolution
tomographic and biomicroscopic imaging device. It is indicated for
in-vivo viewing, axial cross-sectional, and three-dimensional
imaging and measurement of anterior and posterior ocular struc-
tures, including cornea, retina, retinal nerve fiber layer, ganglion
cell plus inner plexiform layer, macula, and optic nerve head.

The CIRRUS™ HD-OCT normative databases are quantitative tools
for the comparison of retinal nerve fiber layer thickness, macular
thickness, ganglion cell plus inner plexiform layer thickness, and
optic nerve head measurements to a database of normal subjects.

The CIRRUS™ HD-OCT Asian Normative Database is a quantitative
tool for the comparison of these measurements to a database of
normal subjects of Asian descent.

The CIRRUS™ HD-OCT is intended for use as a diagnostic device to
aid in the detection and management of ocular diseases including,
but not limited to, macular holes, cystoid macular edema, diabetic
retinopathy, age-related macular degeneration, and glaucoma.

2.1.3 Essential Performance
The CIRRUS 6000 is a retinal imaging device intended to be used as
a non-contact, diagnostic imaging instrument for in vivo viewing,
axial cross-sectional imaging, and three-dimensional imaging of
ocular structures. No cases have been identified in which the
product's failure to perform its intended clinical functions would
result in unacceptable risk.

The main clinical performance of this instrument is to capture,
display and store images to aid in the diagnosis and monitoring of
diseases and disorders. Since there are no surgical or treatment
decisions made solely on data obtained by the instrument, it was
determined that the instrument has no “essential performance” as
defined in IEC 60601-1 standard.
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2.1.4 Application
The CIRRUS™ HD-OCT instrument is designed for continuous use,
although it is expected that most sites operate the instrument for
10 hours or less per day, indoors, within a medical office or
hospital setting that has clean air free of soot, vapors from
adhesives, grease, or volatile organic chemicals.

CIRRUS™ HD-OCT is not a portable device. It is intended for
placement in one location. However, there is no permanently
installed infrastructure associated with the instrument, and it can
be moved between locations following the applicable guidelines
and warnings (see: Safety and Certifications [} 11]).

2.2 Subject/Patient Profile

NOTE Patients must be able to sit upright and place their face in
the chin and forehead rest of the instrument (with or
without supplemental human or mechanical support).

The device may be used on all adults in need of diagnostic evalu-
ation of the eye, including patients with the following disabilities or
challenges:

• Wheelchair user

• Very low or not measurable visual acuity

• Fixation problems

• Postural problems

• Deafness

• Large body, but not those above 99th percentile based on
anthropomorphic data

The patient must be able to sit upright and place their face in the
chin and forehead rest of the instrument (with or without supple-
mental human or mechanical support).

2.3 Operator Profile

2.3.1 Intended Demographic (Operators)
Operators are adults with professional training or experience in the
use of ophthalmic imaging equipment. Specific assumptions
regarding the qualifications of individuals operating the instrument
are given below:

• Ophthalmologist or other Medical Doctor

• Optometrist or equivalent

• Nurse

• Certified Medical Technician
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• Ophthalmic Photographer

• Non-certified Assistant

2.3.2 Required Occupational Skills (Operators)
Must possess all of the following skills:

• Computer literate

• Basic knowledge of the eye

• Able to work with elderly patients and those with disabilities

2.3.3 Job Requirements (Operators)
Must be able to perform all of the following operations:

• Power on the unit and log on

• Enter, find, and modify patient identifying data

• Clean surfaces that contact patient

• Position patient with the device, including moving the patient,
the device, the table height, and the patient's chair

• Select and acquire scan

• Review and save scan or try again

• Generate reports using available reporting protocols

• Review reports for completeness

• Output reports

• Archive data

• Turn off the unit

2.4 Data Analyst Profile

 CAUTION! Training and certification is required by governing bodies to
interpret the analysis in the treatment of ophthalmic
diseases or other eye–related medical issues.

The data created using this device is to be interpreted by clinicians
or technicians with professional training in diagnostic interpretation
of the images generated. Specific assumptions regarding the
profiles of individuals who carry out data interpretation are given
below. This guide contains information that will aid in the proper
interpretation of the resultant data.

2.4.1 Intended Demographic (Analysts)
The Data Analysts are:

• Ophthalmologist or other Medical Doctor

• Optometrist or equivalent
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2.4.2 Required Occupational Skills (Analysts)
Must possess all of the following skills:

• Computer literate

• Be professionally trained in the physiology of the eye and its
variations

• Able to work with elderly patients and those with disabilities

2.4.3 Job Requirements (Analysts)
• Accurately identify ocular anomalies

• Have a history of correct diagnoses of eye disease or work
solely within a research environment

• Be fully trained in the use of OCT equipment, and particularly,
in the analyses that comprise the Review portion of the
instrument software

2.5 User Documentation

2.5.1 Purpose
The user documentation that comes with your device is provided to
ensure that all users operate and maintain it safely and successfully.

• Read all user documentation before starting and using the
device

• Keep all user documentation where it is accessible at all times
for all users

• Pass the user documentation on to the next owner of the
device

2.5.2 Access
User documentation for your device is provided on the USB drive
that came with the device as part of the Instrument Accessory Kit.

2.5.3 Organization
This User Manual has been written to provide a comprehensive
overview of the Device and its software. It provides guidelines for
successful:

• Clinical setup and workflow

• Data acquisition and acceptance

• Review and Interpretation of CIRRUS 6000 data

In addition, instructions and information are provided to ensure
that data is safely managed and that the device is properly
maintained.
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2.5.4 Conventions Used in This Document
Certain types of information are specially marked in this document
for better recognition.

• This is a list.

– This is a second level list.

This is a cross-reference: Questions and comments [} 29].

This is software code or program text.

The name of software windows are capitalized. For example:
Patient Screen

Names of menus, and buttons or other selectable items, are shown
in Bold.

• View menu.

• File > Save as

• My documents > Documents

2.5.5 Questions and Comments
If you have questions or comments about this user documentation
or the device, contact your ZEISS representative.

2.6 CIRRUS HD-OCT Technology
The CIRRUS™ HD-OCT is a computerized instrument that acquires
and analyzes cross-sectional and three-dimensional tomograms of
the eye using spectral domain optical coherence tomography (SD-
OCT).

In low-coherence interferometry, light is sent along two optical
paths, one being the sample path (into the eye) and the other the
reference path of the interferometer. The light source is an 840 nm
superluminescent light emitting diode (SLD). Light returning from
the sample and reference paths is combined and introduced to the
detector, which is a spectrometer in SD-OCT. The spectrometer
resolves the interference signals throughout the depth of each A-
scan immediately by means of a Fourier transformation. This is
possible because the spectrometer resolves the relative amplitudes
and phases of the spectral components scattered back from all
depths of each A-scan tissue sample, without varying the length of
the reference path.

Different CIRRUS™ HD-OCT models use different technologies to
create the image:

• All models include a CCD video camera to monitor the exterior
eye and assist with scan alignment.

• Model 5000 and Model 6000  instruments include a Line
Scanning Ophthalmoscope (LSO).

• Model 500 instruments use the OCT beam to create the retinal
image.
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3 System Overview

3.1 Hardware Overview

NOTE CIRRUS™ HD-OCT includes user-replaceable alkaline
batteries in the mouse and keyboard.
CIRRUS™ HD-OCT also includes a lithium battery. Only a
certified ZEISS Technician can replace the lithium battery.

u Dispose of alkaline batteries in accordance with local laws (see:
Disposal [} 449]).

CIRRUS™ HD-OCT instrument includes the following integrated
components:

• scan acquisition optics

• interferometer 

• spectrometer

• system computer

In addition, the following external components are provided:

• monitor

• keyboard

• mouse

• (optional) printer

• (optional) wheelchair-accessible motorized table (adjusts to
each patient's height)

1

3
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Figure 1: CIRRUS™ HD-OCT System Hardware 

1 Monitor 2 Connectors (USB, network, etc.) and labels
under rear cover 
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3 USB Ports (2) 4 Mouse

5 Keyboard 6 Table Height Control

7 Power Table (Optional) 8 Patient Handle

9 Power Switch 10 Motorized Patient Alignment Unit

11 Dual Chinrest with Automatic Right/Left Sensors 12 Imaging Aperture

13 Head Rest 14 Port for External Fixation Arm

3.2 Software Overview
ZEISS pre-installs all software necessary to operate the CIRRUS
6000. Software updates with installation instructions may be
provided on USB flash disk.

CIRRUS 6000 software has the following screen types:

• Patient Screen

• Protocol and History Screen

• Acquire Screen

• Check Scan Quality Screen

• Analysis and Report Screen

3.2.1 Screen Layout

1

2

3

Pos
.

Name Explanation

1 Toolbar Menus common to all screens
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Pos
.

Name Explanation

2 Work Area Varies depending on mode and function

3 Navigation Bar Status indicator and mode selection common to all screens

NOTE Viewing a Patient in the Work Area

When using the application, if you are viewing a patient in the
Work Area, the following Current Patient field information appears
on the left side of the Toolbar:

u Name

u Medical Record Number

u Sex

u Date of Birth (DOB)

3.2.2 Toolbar
Each CIRRUS 6000 screen has context-specific menus and options.

3.2.2.1 Records Menu

The Records menu is different for instruments that use Native
Archive and DICOM Archive.
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3.2.2.1.1 Records Menu (Native Archive)

Menu Option Description

Retrieve Archived Exams... Retrieve selected exams from the archive.

Archive Now... Archives all unarchived exams.

Clear Archived Exams Clear exams to free additional disc space.

Archive Management: Create archive locations and set default para-
meters.

Preferences...

Archive/Synchronize During instrument startup or shutdown,
prompts you to archive exams and clear data.

DICOM Archive Disable Auto-Query or Auto-Archive.

Display Options Change display settings.

IPv4 / IPv6 Select Internet Protocol.

Search Worklist Patients .. Opens the Modality Worklist to set para-
meters for patient search through DICOM
Worklist server.

Import Exams... Opens Import Options.

Export Exams.. Opens Export Options.

Print Patient list.. Print the patient list currently displayed.

Print Today’s Patient list... Prints the patient list in the Today’s Patients.
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3.2.2.1.2 Records Menu (DICOM Archive)

Menu Option Purpose

Clear Archived Exams Clear exams to free additional disc space.

Preferences...

Archive/Synchronize During instrument startup or shutdown,
prompts you to archive exams and clear
data.

Normative Database Selects which normative database is the
default.

Display Options Allows change to default setting.

DICOM Archive Allows you to disable Auto–Query and/or
Auto–Archive.

IPv4 / IPv6 Allows you to select Internet Protocol
version.

DICOM Archive Allows patient record archive through the
DICOM server.

DICOM Retrieve Allows patient records retrieval through
the DICOM server.

Search Worklist Patients... Opens the Modality Worklist to set pa-
rameters for patient search through
DICOM Worklist server.

Import Exams... Opens Import Options.

Export Exams.. Opens Export Options.

Print Patient list.. Print the patient list currently displayed.

Print Today’s Patient list... Prints the patient list in the Today’s
Patients.

3.2.2.2 Edit Menu

Menu Option Description

Patient Record View or edit a patient's reccord.

Merge Two Patients... Combines duplicate patient records.

Delete Patient Delete selected patient record.

Move Scan.. Move a scan from one patient record to
another patient record.
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3.2.2.3 Tools Menu

Menu Option Description

Live Fundus Overlay Enables overlay display. If disabled, the
bounding box is visible, but not the vertical
and horizontal slice locations.

Colored OCT Enables color OCT images display.

Inverted Gray scale for
Raster

Changes black pixels to white and white to
black on gray scale raster scans.

Live OCT Center Lines Enables of a vertical center line display on
OCT images.

Auto Repeat Automatically adjusts the ocular lens and
chinrest to the previous settings for the same
patient, eye, and acquisition function.

Tracking Enables FastTrac™ for all scans.

Print Configuration... Sets the printout options for Macular
Thickness, ONH, and (HD 5 Line) Raster, and
Macula multi-slice parameters.

Scan Organizer Sets show or hide available scans, or change
scan order.

Export Audit Log File... Exports the log file.

Change My Password... Changes the current user's password.

Options

Categories... Creates, edits, or deletes categories for
patient records and search.

Institution Edit... Adds your organization's name and logo to
reports.

Equipment Edit... Creates a station name for the instrument,
create DICOM AE Title, and view other
equipment information.

Users... Creates, edits, or deletes staff / users.

Select Database..

(Review Station only)

Switches to a different instrument database.

3.2.2.4 Help Menu
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Menu Option Description

Keyboard Mouse Shortcuts Displays a categorized listing of keyboard
shortcut keys and mouse functions.

On-line Manual Opens the CIRRUS 6000 User Manual PDF.

License Registration Register a license.

View Licenses Displays a list of CIRRUS™ HD-OCT licenses.

Service Support Enables you to select the TeleService web link
for remote online servicing of the instrument,
and save a Log file for troubleshooting. 

About Displays the About dialog, which provides
software version information. 

3.2.3 Navigation
A navigation bar at the bottom that shows the current status of the
instrument and buttons to change modes.

3.2.3.1 Navigation Buttons

Figure 2: Navigation Buttons

Button Description

Opens ID Patient mode.

Opens Protocol page.

Opens scan acquisition (when patient is selected). 

Opens image analysis (when patient is selected). 

Exits the current mode and opens the prior mode (from acquire or analyze mode).

3.2.3.2 Navigation Status

NOTE Mouse over the status indicator and popup text will explain
the current status.

Status (bottom left) displays a single green–yellow–red indicator
along with a brief message about the instrument, hard drive, or
NAS. For example: 

OK or normal: The instrument is functioning normally.
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Warning: The instrument is operational but one or more problems
exist.

Critical: One or more serious problems exists that restricts use of
the instrument.

For more information about status, refer to: Status Messages
[} 425].

3.2.4 Basic Screens

4

1

3

2

5

Figure 3: Basic Screen Examples

Pos. Name Explanation

1 Patient ID Screen Select or add a patient.

2 Protocol Screen Displays the most popular scans for the selected protocol.

3 Acquire Screen (Instrument Only) Acquire scans for the selected patient.

4 Quality Check Screen (Instrument Only) Assess the scan's quality and decide whether
to save or retake the scan.

5 Analysis and Reports Screen (For saved scans) Review, adjust, annotate, and assess scan
results.
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4 Installation

4.1 Safety During Installation

 WARNING! Unauthorized Installation

Unauthorized installation could lead to the injury of patients and
operators, as well as to property damage.

u Only ZEISS authorized personnel may install Zeiss products.

 WARNING! Incorrectly configured or installed hardware

could damage the instrument or injure patients or operators.

u Allow only trained ZEISS Meditec personnel to install the
instrument and its components.

u Do not attempt to unpack the instrument or its components.

u Do not attempt to install the instrument or its components.

u Do not attempt to connect the instrument or its components.

u Do not attempt to setup or start the device.

 WARNING! An ungrounded Device

could lead to electric shock.

u Do not remove or disable the ground pin.

u Only an authorized ZEISS service representative may service the
instrument.

u Only an authorized ZEISS representative may install the
instrument.

 WARNING! Opening instrument covers

could result in exposure to electrical and optical hazards.

u Do not open the instrument covers.

u Exception: You may remove the rear cover to access labels,
change connectors, or clean fans.

4.2 About Changes to Hardware or Software
The CIRRUS™ HD-OCT is a medical device. The software and
hardware were designed in accordance with U.S., European and
other international medical device standards designed to protect
clinicians, users and patients from potential harm caused by
mechanical, diagnostic or therapeutic failures.

Read all safety information before installation and use. See: Safety
and Certifications [} 11].
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NOTE Zeiss does not provide technical support for third party
software.

For a list of approved Third Party Software and Hardware, refer to:
www.zeiss.com/cirrus-specifications.

4.3 About Data Storage

 CAUTION! We strongly recommend that a knowledgeable IT profes-
sional assists with network configuration when installing
review software.

NOTE You can export data from the Native archive in DICOM
format.

u You do not need an additional license to export data in
DICOM format.

u You do need an additional license to connect to  FORUM.

The CIRRUS™ HD-OCT instrument saves data locally; however we
recommended that you archive your data to a network file server
or a network attached storage device (external hard drive).

In addition to the Native archive, you can purchase a license for
FORUM that connects directly to a DICOM network which allows
you to: 

• Save your data to a DICOM-compatible system automatically.

• Archive your data on a DICOM-compatible system
automatically.

• Connect all ZEISS instruments to a DICOM-compatible network.

The following table explains the differences between using the
Native or DICOM data archiving.

Native Archiving DICOM Archiving

Export DICOM EPDF Reports YES YES

Access DICOM Modality Worklist
(MWL)

YES YES

Connect multiple ZEISS instru-
ments

NO YES

Access CIRRUS™ HD-OCT review
software.

YES

Instrument Review Software

YES

Local Database Review Software
through FORUM DICOM Archive
(with either FORUM-Floating
licensing or Node-locked licensing)

Table 4: Comparing Native and DICOM Archiving
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4.4 Installing the Instrument

NOTE Use extreme care when handling and transporting the
instrument shipping boxes.
The instrument contains fragile optics that require precise
alignment.

You are not responsible for initially installing CIRRUS 6000
hardware or software.

The CIRRUS 6000 arrives with its table and associated components
on a pallet in a number of separate shipping boxes. Do not allow
institution personnel to unpack or open any of these containers. 

On arrival, the ZEISS Field Representative will carefully unpack and
assemble all system components at the location you have selected
for its placement.

When the instrument installation is complete, configure the
software (see Configuring Software [} 57]).

4.4.1 Embedded Windows License
The CIRRUS™ HD-OCT instrument is issued with an embedded
Windows® license. The Windows license number is on a label
under the rear cover.

4.4.2 Preparing to Install
Install the CIRRUS 6000 instrument in an environment that meets
the following requirements:

• no direct sunlight

• properly grounded, dedicated 15 A power source that meets all
local electrical codes

• not connected to a power strip

• the device's ventilation openings are not blocked

• the device is not exposed to water or other liquids

Do not modify the instrument or use cables not provided by ZEISS.

The CIRRUS 6000 instrument arrives on a pallet with three boxes
that contain all parts and accessories needed to assemble the
instrument and table.
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4.5 Software and Document Media
CIRRUS 6000 comes with a USB case that contains two flash drives.

USB
Label

Content

Software to install on the CIRRUS 6000 instrument and review
stations.

User Documentation.

4.6 Installing Review Station Software

NOTE These instructions are provided only for installing CIRRUS
6000 Review software on a separate PC or laptop. Installing
Review software on a separate PC or laptop will give you
access to the Analysis/Review portion of the full CIRRUS
6000 application.

A Review Station is a laptop or PC that analysts can use to access,
edit, and create reports for scans.

4.6.1 Review Station Requirements

NOTE These instructions are provided for Review Station software
installation only.

If you plan to run CIRRUS 6000 software on a Review Station, the
laptop or PC must fulfill the following minimum system require-
ments.
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Minimum Recommended

Operating System • Windows Server 2008 R2

• Windows Server 2012 R2

• Windows 7 SP1, 64-bit

• Windows 8.1, 64-bit

• Windows 10

CPU Core i5 family Core i7 family

RAM 16 GB 32 GB

HDD 500 GB 1 TB

Graphics Capability 1920 x 1080 (only)

Table 5: System Requirements for stand-alone Review Stations

4.6.2 Review Station Performance

NOTE All times are calculated based on an estimated network
performance of 50% of theoretical.

u Actual performance for a typical clinical setting may differ and
will depend on the actual network configuration.

Ethernet Rating 100 Base-T 1 GbE 10 GbE

Speed (MB/sec) 12 120 1200

Network
Efficiency

0.5 0.5 0.5

Table 6: Review Station Performance

Scan Type Approx. Scan Size
(MB)

Time to Display (sec)

3x3 mm OCT Angiog-
raphy

140 5

6x6/8x8/12x12 mm
OCT Angiography

270 13

Table 7: Scan Display Performance

4.6.3 Install or Update Review Station Software

NOTE If an error message appears

the software did not install successfully.

u Press the Print Screen button on your keyboard and save the
error message to inform ZEISS Customer Support: 800–341–
6968. Outside the U.S., contact your local Zeiss distributor.
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NOTE In the Remote Desktop Services environment, Review
Software does not support the following functions:

u Adding, Editing, and Deleting a patient record

u Deleting Scans

u Importing Scans

u Adding users or user accounts to the review software

u Adding, Editing, and Deleting the Equipment data

u Adding, Editing, and Deleting the Institution data

u 3D visualization analysis

þ The Review Station fulfills the minimum system requirements
for the Review Software (see: Review Station Requirements
[} 42]).

þ The installation media kit is available (see: Software and
Document Media).

1. Insert the CIRRUS 6000 USB flash drive ( ) into the
computer's USB port.

2. Navigate to the USB drive.

3. Double-click Setup.exe.

ð Installation takes a few moments to prepare before the
installation wizard opens.

ð When preparation completes, the welcome page opens.
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4. Click Next.

ð The license agreement page opens.

5. Read and accept the license agreement.

6. Click Next.

ð If you installing the review software for the first time, the
mode selection window opens.
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7. (Initial installation only.) If you archive exam data using the
FORUM database environment, choose Local Mode.

ð For more information about FORUM, see: About Data
Storage [} 40].

8. (Initial installation only.)If you do not, choose Instrument
Mode.

9. Click Next.

ð (Local Mode) The Remote Desktop Services selection
window opens.

10. (Local Mode) If you use Remote Desktop Services, check
Remote Desktop Services will be used.

11. Click Next.

ð (Local Mode) The installation location window opens.
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12. (Local Mode) To select a different location for the application
installation, click Browse and navigate to the location for
installation.

13. Click Next.

ð The review software installation takes a few minutes to
complete. Progress bars indicate the progress as installation
progresses.

ð When installation completes, the finish prompt opens.

14. Click Finish.

ð The CIRRUS 6000 shortcut appears on the computer's
desktop.

15. To open the CIRRUS software, double-click on the icon.

16. Remove the USB flash drive from the USB port and return it to
the media kit.

17. Configure the Review Station: Configuring an Additional
Instrument or Review Station.



4 Installation Instructions for Use
CIRRUS™ HD-OCT4.7 Update Instrument Software

48 / 542 2660021174149 Rev. D 2019-10

4.7 Update Instrument Software

NOTE If an error message appears

the software did not install successfully.

u Press the Print Screen button on your keyboard and save the
error message to inform ZEISS Customer Support: 800–341–
6968. Outside the U.S., contact your local Zeiss distributor.

Prerequisite þ The installation media kit is available (see: Software and
Document Media).

Action 1. Insert the CIRRUS 6000 USB flash drive ( ) into the
computer's USB port.

2. Navigate to the USB drive.

3. Double-click Setup.exe.

ð Installation takes a few moments to prepare before the
installation wizard opens.

ð When preparation completes, the welcome page opens.
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4. Click Next.

ð The license agreement page opens.

5. Read and accept the license agreement.

6. Click Next.

ð The mode selection window opens.
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7. If you archive exam data using the FORUM database
environment, choose DICOM.

ð For more information about FORUM, see: About Data
Storage [} 40].

8. If you do not, choose Native.

9. Click Next.

ð Software installation takes a few minutes to complete.
Progress bars indicate the progress as installation
progresses.

ð When installation completes, the anterior segment
calibration prompt opens.

10. To calibrate Anterior Segment, check  Launch Anterior
Segment Calibration Wizard now and refer to: Calibrate the
Anterior Segment Lenses [} 418].
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11. To skip Anterior Segment calibration, uncheck  Launch
Anterior Segment Calibration Wizard now.

12. Click Next.

13. Click Finish.

ð The CIRRUS 6000 shortcut appears on the computer's
desktop.

14. Remove the USB flash drive from the USB port and return it to
the media kit.

4.8 Installing User Documentation
The user document does not install automatically. You can install
user documents from documentation flash drive so the online
instructions open from the menu.

Documents are available in multiple languages.

To install the documentation:

Prerequisite þ The media kit is available (see: Software and Document Media).

Action 1. Insert the document USB flash drive ( ) into the instrument's
USB port.

2. Open Windows Explorer and navigate to USB flash drive flash
drive files.

3. Double-click Setup.exe.

ð The document installation wizard opens.

4. Follow the instructions in the installation wizard.

5. Remove the USB flash drive from the USB port and return it to
the media kit.
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5 Startup and Shutdown

5.1 Safety During Startup and Shutdown

 WARNING! In case of an emergency

disconnect the appliance coupler.

u For the device, the most accessible power cord is the one that
plugs into the bottom of the table.

u Do not position device so it is difficult to unplug power cord.

 CAUTION! Protect Patient Health Information (PHI)

to maintain patient confidentiality.

u Health care providers are responsible for protection of patient
health information (PHI), both hardcopy and electronic.

u Use encryption when you export electronic data.

 CAUTION! Do Not Transport the Instrument Outside the Office

to retain the instrument warranty.

u Contact a ZEISS service technician to transport the instrument.

u If you attempt to transport the instrument without consulting a
ZEISS service technician, the instrument warranties are void.

 CAUTION! Unauthorized modification or dismantling of the instrument
or system components

could result in damage to the instrument or components, or harm
to the operator or other personnel.

u Only authorized ZEISS personnel may make modifications to, or
dismantle, the instrument or its components.

 CAUTION! Using aerosols near or placing containers of liquid on or near
the instrument

could damage the equipment. The instrument is not designed with
any specific measures to protect against harmful ingress of water
or other liquids (classified IPXO - ordinary equipment).

u Do not place containers of liquid, or use aerosols on or near
the equipment.

NOTE Health care providers are responsibility for protecting patient
health information (PHI), both hardcopy and electronic.

u We recommend using encryption when you export data.
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5.2 System Startup
Users are not authorized to dismantle or modify the CIRRUS™ HD-
OCT hardware except to remove the rear cover.

• Keep the instrument and lenses clean. Refer to: Cleaning and
Disinfection [} 407].

• Turn off when not in use for an extended period.

• The only user-replaceable part in the instrument is the top fan
filter.

During system startup, CIRRUS™ HD-OCT checks the following:

• Database accessibility and integrity

• Instrument storage space

• Network storage space

• CIRRUS™ HD-OCT application installation

• Instrument connections

If any system checks fail or reports errors, refer to: System Startup
Troubleshooting.

5.2.1 Turning on Power

NOTE The first time you log in, change the password for the
instrument.

There is a password that you can use for initial login.

u Change the password provided immediately after logging in for
the first time.

1

To turn on the instrument:

Action 1. Turn the power switch (1) on.
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2. Login to Windows. When logging in for the first time, use the
following username and password and immediately change the
password to a unique, secure password for your organization.

ð Initial Username: Zeiss

ð Initial Password:  November171846

3.

ð The system starts up and runs a series of checks, then the
CIRRUS™ HD-OCT application opens automatically.

Result ü After a series of instrument checks, the CIRRUS software
opens automatically.

5.2.2 Logging In
When system startup completes, the User Login dialog appears.
The administrator can add and delete users and set passwords (see
User Accounts).

For instructions on logging in as the administrator, see: Log in as
Admin [} 58].

To log in:

Action 1. Select your User Name.

2. Type your password.

3. Click OK.

5.3 System Shutdown
The safest way to power down the system is:

1. Logout (ZEISS application)

2. Shut Down (Windows)

To shut down the system:

Action 1. Click Logout.

ð If the system is set to archive data when you shut down the
system, an archive dialog opens.

2. If the archive dialog opens, select the appropriate archive
action.

3. Click Yes.

ð A confirmation opens.

4. Click Yes.
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ð The CIRRUS software application closes.

5. Select Windows Start > Shut Down.

ð A confirmation opens.

6. Click OK.

Result ü The instrument computer turns off.
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6 Configuring Software

6.1 About User Roles
These are the general roles of users (as opposed to specific types of
users) in CIRRUS 6000. For user types and permissions in the
software, see User Types [} 70].

Operator Doctor Adminis-
trator

Settings and Maintenance

Access ZEISS service link X

Configure equipment and institution settings X

Configure reports X X

Export log files X X

Manage licenses X

View instruction manual X X X

View licenses X

View software version information X X X

Patient Records

Configure patient categories X X

Add or delete patients X X

Edit patient records X X

User Management

Add or delete users X

Acquire scans X X

Review scans X X

Select, edit and annotate scans X X

Use review software installed on a separate computer X X

Reset other user's passwords X

Reset your own password X X X

Delete a local patient record X

Save and print reports X X

Import and export data X X

Configure import and export settings X
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Operator Doctor Adminis-
trator

Configure network settings X

Configure data backup X X X

Restore data from a backup X X

Perform system maintenance X

Table 8: User Roles

6.2 System Administration
Logging in as the System Administrator at the application level
allows access to additional configuration, including:

• Managing User Accounts [} 70]

• Editing the Instrument Identifier [} 60]

• Editing Your Institution Information [} 59]

Refer to: User Names and Passwords [} 77] for Login information.

6.2.1 Log in as Admin
The admin is not listed as a username. You must type "admin" for
username. The admin can add users and access advanced settings;
cannot acquire or analyze scans (see About User Roles [} 57]).

To log in as the administrator:

Prerequisite þ Startup Sequence completed successfully (system login
displayed).

Action 1. For User Name, type admin.

2. If this is the initial administrator login, type the password:
0000. Immediately change this password.

3. Type the admin password.

4. Click OK.

6.2.2 Configuring the Instrument or Review Station

NOTE Not available in DICOM Archive mode

This section describes how to configure settings on the CIRRUS
6000 instrument and review stations with your institution's infor-
mation, users, and instrument identification.

6.2.2.1 About Assigning the Issuer of Patient ID

The Issuer of Patient ID field allows you to configure how your
practice assigns patient IDs to new patients. Recommendations for
configuring the Issuer of Patient ID:
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• Set to the same Issuer of Patient ID value on every instrument
in your practice.

• If you use an Electronic Medical Record (EMR) system, configure
the  Issuer of Patient ID to match the EMR system's patient ID
value.

If you change the  Issuer of Patient ID, the change will apply to
future patient records; patient information already in the database
does not change.

6.2.2.2 Editing Your Institution Information

NOTE You must restart the software for the Institution Edit
changes to appear in report headers.

We recommended that the administrator uniquely identify your
institution, office clinic or hospital.

You can add your institution's logo. The institution name and logo
appear on scan analysis reports.

To fit on the page, reports only print the first 24 characters of the
institution name (including spaces).

To specify your institution name and add a logo:

Prerequisite þ On the CIRRUS™ HD-OCT instrument, Log in as Admin [} 58].

Action 1. Select Tools > Options > Institution Edit.

2. (Required)  For Name, type the name of your institution
(between 1 and 64 characters including spaces).

ð Reports only display the first 24 characters of the institution
name.

3. (Required)  For  Issuer of Patient ID, type your institution's
patient identification settings (see: About Assigning the Issuer
of Patient ID [} 58]).

4. To add your institution's logo, click Browse and navigate to
the logo image file (must be BMP format; for best results, use a
square image).

ð Your logo appears in the preview box. If your image is not
square, it will stretch to fit. The proportion shown in the
preview box shows how your logo will appear in reports.

5. Click Save.

6. Click Close.

ð The new settings implement the next time you open the
application.

7. To apply the new settings now, restart (close and reopen) the
application.
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6.2.2.3 Editing the Instrument Identifier

You must create a unique name for each CIRRUS 6000 instrument
and review station.

Tip: Use station names meaningful
to your organization (for example:
"Imaging Room 215").

When configuring these settings, important instrument information
displays, including:

• Model Number

• Sequence Number

• Serial Number

• Software Version

• DICOM AE Title (see: Connect to a DICOM Gateway [} 396]).

 Indicates optional features; license may be required.

To edit instrument information:

Prerequisite þ On the CIRRUS™ HD-OCT instrument, Log in as Admin [} 58].

Action 1. Select Tools > Options > Equipment Edit.

2. For Station Name, type an instrument identifier that is
meaningful to your institution.

3. If you have a license to connect to a DICOM Gateway, type the
DICOM AE Title (see: Connect to a DICOM Gateway [} 396]).

4. Click Save.

5. Click Close.
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6.2.3 Registering Licenses

NOTE You will need your software Certificate Serial Number
(shipped with your instrument) and optional feature licenses.

u If you cannot locate your software  Certificate Serial
Number, contact your ZEISS Representative to obtain this
information.

NOTE Register license(s) on instruments first, then on computers
running review station software.

Some features of this instrument require licenses that you can
purchase separately (see: About Licenses [} 61]). 

All licenses you purchase with the instrument are already registered
for you. If you purchase a license for optional features separately,
you must register the license on each instrument and each
computer running the review station software to enable the new
features.

Before you register a license, ensure that you have the following
information available:

• Certificate Serial Number (see the Software Product
Certificate provided with your instrument)

• Instrument Serial Number

6.2.3.1 About Licenses

NOTE Features described in this section are licensed separately and
may not be available in all markets.

u For information about feature availability in your market and
obtaining a license:

ð in the U.S.A, call 1-877-486-7473.

ð outside the U.S.A , contact your local ZEISS distributer.

Core License

The core license includes the features available without an
additional license. When you view your installed licenses, both
included and additionally purchased licenses are listed.

The core license includes software updates and features that were
formerly licensed separately (now included).
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License Name Enables

4.0 Software Upgrade Core Upgrades

6.0 Software Upgrade • Macular Cube 512 x 128

• Macular Cube 200 x 200

• Optic Disc Cube 200 x 200

• 1 or 5 Line

• HD 1 Line 100x

• HD 5 Line

• HD Radial

• HD 21 Line

• HD Cross

6.0 Software Upgrade Plus Light

CIRRUS 11.1 Core License

CIRRUS 11.2 Core License

Software Upgrade Plus

Instrument Review Software Install software for analysis on separate (Review
Station) computers

Advanced RPE Analysis Advanced RPE Analysis

Anterior Segment Imaging • Anterior Segment Cube

• Anterior Segment 5 Line Raster

• HD Angle

Epithelial Thickness Mapping Epithelial thickness measurement calculations for
Pachymetry

Ganglion Cell Analysis Ganglion Cell OU

Ganglion Cell Guided Progression Analysis Ganglion Cell Guided Progression

Guided Progression Analysis Guided Progression Analysis

Macular Normative Data Associates study data to compare macular thickness
to normal reference range for a patients' age

Macular Change Analysis Macular Change Analysis

Macular Reports Reports for analyses

ONH Normative Data Associates study data to compare optic disc and
RNFL measurements to normal reference range for a
patients' age.

ONH and RNFL Analysis ONH/RNFL OU Analysis

RNFL Thickness Analysis and 3D Volume Rendering 3D Visualization Analysis

Segmentation Layer Editor Macular cube segmentation editor for Macular
Thickness Analysis, Macular Thickness OU
Analysis, and Advanced RPE Analysis

Single Eye Summary Analysis Single Eye Summary

Tracking FastTrac feature

Table 9: Core Licenses
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Some CIRRUS™ HD-OCT scans and analyses or features require
separate licenses. Your instrument and review station list only the
scans and analyses with an active license.

License Name Enables

AngioPlex Metrix for 3x3 scan

(Requires AngioPlex OCT Angiography license)

Enables analysis calculations (Metrix) 3x3mm scans
for Angiography Analysis and Angiography
Change Analysis.

AngioPlex Metrix for 6x6 scan

(Requires AngioPlex OCT Angiography license)

Enables analysis calculations for 6x6mm scans for
Angiography Analysis and Angiography Change
Analysis.

AngioPlex Metrix for 3x3 and 6x6

(Requires AngioPlex OCT Angiography license)

Enables analysis calculations for 3x3mm and 6x6mm
scans for Angiography Analysis and Angiography
Change Analysis.

AngioPlex Metrix for 4.5x4.5 ONH Scan

(Requires AngioPlex OCT ONH Angiography license)

Enables analysis calculations for ONH angiography
scans for ONH Angiography Analysis and ONH
Angiography Change Analysis.

AngioPlex OCT Angiography • Angiography 3x3 mm

• Angiography 6x6 mm

• HD Angiography 6x6 mm

• Angiography 8x8 mm

• HD Angiography 8x8 mm

• Angiography 12x12 mm

• Montage Angiography 6x6 mm

• Montage Angiography 8x8 mm

AngioPlex OCT ONH Angiography • ONH Angiography 4.5x4.5 mm

Anterior Segment Imaging – Premier • Anterior Chamber

• Wide Angle to Angle

• HD Cornea

• Pachymetry

Asian Normative Database Associates study data to compare ganglion cell, optic
disc, and RNFL measurements to normal reference
range (Asian subjects only) for a patients' age.

Display Extrapolate Progression in GPA and GCP Enables an algorithm that extends progression
analyses to estimate future change for Guided
Progression and Ganglion Cell Guided
Progression

Table 10: Optional Instrument Licenses

Once you purchase and install a license, all related scans, analyses,
and features activate for that instrument or review software.

To see what licenses are installed, see: Registering Licenses [} 61].
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6.2.3.2 Register a License on an Instrument

To register a license on the instrument:

Prerequisite þ Your instrument(s) are connected to the internet.

þ On the CIRRUS™ HD-OCT instrument, Log in as Admin [} 58].

Action 1. Select Help > License Registration.

2. Select the name of the license you are installing.

ð The CZM License Registration Utility opens displaying
the prefix for your Certificate Serial Number, Feature to be
Registered, and Node ID for the license you selected.

3. Confirm that the prefix for your Certificate Serial Number
matches and type the rest of the Certificate Serial Number.

NOTE Write down the Node ID.

You need the Node ID to obtain the License Key and Security
Code.

4. Make a note of the Node ID.

ð You can leave the CZM License Registration Utility open.
After you obtain the license key and security code from the
ZEISS registration website, you need to return to the utility
to complete registration.

5. Open a browser and go to the ZEISS registration website:http://
www.zeiss.com/med/register.

ð The licensing portal opens.

http://www.zeiss.com/med/register
http://www.zeiss.com/med/register
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6. Click Register.

ð The registration details page opens.

7. Type the Certificate Serial Number and click Submit.

ð The CZM registration site displays the License Key and
Security Code for this license.

8. Make a note of the License Key and Security Code.

9. Close the web browser and return to (or re-open) the CZM
License Registration Utility.

10. For License Key, type the number you noted from the CZM
registration site.

11. For Security Code, type the number you noted from the CZM
registration site.

12. Click Save.

13. Log Out [} 124].

14. Install the license on each instrument for which you purchased
the optional features, then on computers running review
station software (if required).

15. To check the status of your licenses, see: View Licenses [} 69].

16. To install a licenses on a computer running review station
software, see: Register a License on a Review Station [} 66].

Result ü The new features are enabled on the instrument.
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6.2.3.3 Register a License on a Review Station

NOTE In instrument mode the review station inherits the licensed
features of the instrument it accesses.

You do not need to register a licenses on computers running
review station software.

u In an environment with multiple instruments, features available
to the review station may differ when accessing different
instruments (if optional features are licensed differently on
instruments).

Some features of this instrument require licenses that you can
purchase separately (see: About Licenses [} 61]). 

In instrument mode, a review station accesses the database of
scans stored on the instrument. The review station inherits the
licenses of the instrument it accesses.

To register a license on the review station:

Prerequisite þ All instruments in the environment have already registered this
license (Register a License on an Instrument [} 64]).

þ The instrument licensing information is available.

þ The Review Station environment is in Local or DICOM mode.

þ Login to the CIRRUS software.

Action 1. Log in as Admin [} 58].

2. Select Help > License Registration.

3. Select the name of the license you are installing.

ð The CZM License Registration Utility opens displaying
the prefix for your Certificate Serial Number, Feature to be
Registered, and Node ID for the license you selected.
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4. Confirm that the prefix for your Certificate Serial Number
matches and type the rest of the Certificate Serial Number.

NOTE Write down the Node ID.

You need the Node ID to obtain the License Key and Security
Code.

5. Make a note of the Node ID.

NOTE You can leave the CZM License Registration Utility open.

After you obtain the license key and security code from the ZEISS
registration website, you need to return to the utility to complete
registration.

6. Open a browser and go to the ZEISS registration website:http://
www.zeiss.com/med/register.

ð The licensing portal opens.

http://www.zeiss.com/med/register
http://www.zeiss.com/med/register
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7. Click Register.

ð The registration details page opens.

8. Type the Certificate Serial Number and click Submit.

ð The CZM registration site displays the License Key and
Security Code for this license.

NOTE Write down the License Key and Security Code.

You need this information to complete the registration.

9. Make a note of the License Key and Security Code.

10. Close the web browser and return to (or re-open) the CZM
License Registration Utility.
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11. For License Key, type the number you noted from the CZM
registration site.

12. For Security Code, type the number you noted from the CZM
registration site.

13. Click Save.

14. To check the status of your licenses, see: View Licenses [} 69].

Result ü The new features are enabled.

6.2.3.4 View Licenses

NOTE Features described in this section are licensed separately and
may not be available in all markets.

u For information about feature availability in your market and
obtaining a license:

ð in the U.S.A, call 1-877-486-7473.

ð outside the U.S.A , contact your local ZEISS distributer.

Many types of scans, analyses and features that originally required
a separate license are now included as standard features. The
licenses for these features still appear in the license view, even if
they are now included with the instrument.

Some features require licenses that you can purchase separately
(see: About Licenses [} 61]). You can check which optional features
are enabled on your instrument.

To view licenses:

Prerequisite þ On the CIRRUS™ HD-OCT instrument, login: Log In as Operator
or Data Analyst [} 123] or Log in as Admin [} 58].

Action 1. Select Help > View Licenses.

ð A dialog opens displaying the status of all optional licenses
for your instrument.
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2. To register a licenses on an instrument, see: Register a License
on an Instrument [} 64].

3. To register a licenses on a computer running review station
software, see: Register a License on a Review Station [} 66]

6.2.4 Managing User Accounts

NOTE Unsecured Logins

may result in unauthorized access or inaccurate record-keeping.

u Create individual user accounts for each staff member.

u Staff members should log out after every use.

CIRRUS 6000 saves the operator's user name for each scan
acquired. The currently logged in user name displays in the top
toolbar.

Analysis reports print the technician's name. To fit on the page,
reports can only display the first 32 characters (including spaces)

6.2.4.1 User Types

Operator Referring
Physician

Requesting
Physician

Reading
Physician

Ordering
scans

✔ ✔

Reviewing
scans

✔

Acquiring
scans

✔

Table 11: User Types and Permissions

6.2.4.2 Password Requirements

All passwords must follow these rules:

• Must be at least seven characters long.

• Must contain at least three of the following:

– European language uppercase characters (A through Z, with
diacritic marks, Greek, and Cyrillic characters).

– European language lowercase characters (A through Z, with
diacritic marks, Greek, and Cyrillic characters).

– Numbers (0 through 9).

– Non-alphabetic characters (for example: !, $, #, %)

• Any unicode character alphabetic character, including Asian
language unicode characters.
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6.2.4.3 Viewing User Accounts

NOTE Only Administrators can complete this task.

Prerequisite þ On the CIRRUS™ HD-OCT instrument, Log in as Admin [} 58].

Action 1. Select Tools >Options > Users.

ð  The Staff Registration dialog opens listing the users
already added to the system. If no users exist, the list is
empty.

6.2.4.4 Adding a New User

NOTE Only Administrators can complete this task.

NOTE First Name, Last Name and Password are case-sensitive.

Create a unique user account for each instrument operator who
acquires scans and each clinician who analyzes scans.

When you add a new user, you must provide last name and first
name. All other fields are optional. 

To add a new user:

Prerequisite þ On the CIRRUS™ HD-OCT instrument, Log in as Admin [} 58].

Action 1. Select Tools >Options > Users.

ð The Staff Registration dialog opens listing the users
already added to the system. If no users exist, the list is
empty.

2. Click New.

ð The New Staff dialog opens.

3. For Last Name, type the user's last name

4. For First Name, type the user's first name.

5. If available, complete Middle Name, Suffix, Prefix, and ID.

6. For Password, type a temporary password for the user.

7. For Verify Password, retype the temporary password.

8. Check the user type (see User Types [} 70]). Make sure to check
Operator for anyone using the instrument or review software.

9. Click Save.

10. Provide the user with the password and ask them to log in and
reset their password.
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6.2.4.5 Editing User Information and Password

NOTE Only Administrators can complete this task.

NOTE First Name, Last Name and Password are case-sensitive.

When you edit user information, you must provide at least one
name (last name or first name). All other fields are optional.

To edit a user:

Prerequisite þ On the CIRRUS™ HD-OCT instrument, Log in as Admin [} 58].

Action 1. Select Tools >Options > Users.

ð The Staff Registration dialog opens.

2. Select the user you want to edit.

3. Click Edit.

ð The Edit Staff dialog opens.

4. Update the user's Last Name, First Name, Middle Name,
Suffix, Prefix, and ID user type as required.

5. To reset their password, for Password, type a temporary
password for the user and for Verify Password, retype the
temporary password.

6. Click Save.

7. If you changed the user's password, provide the user with the
new password and ask them to log in and set a different
password.

6.2.4.6 Deleting a User

NOTE Only Administrators can complete this task.

NOTE You cannot delete a user that any exam data references.

To delete a user:

Prerequisite þ On the CIRRUS™ HD-OCT instrument, Log in as Admin [} 58].

Action 1. Select Tools >Options > Users.

ð The Staff Registration dialog opens.

2. Select the user you want to delete.

3. Click Delete.

ð A confirmation opens.
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4. Click OK.

6.2.5 Export Log Files

NOTE Save (export) audit log files regularly

to ensure events are tracked in case you encounter a data error.

CIRRUS 6000 records the following events and identifies them by
date, time, and User ID:

• Log on / log off

• Display analysis data

• Create, modify, or delete data

• Import/export data from removable media

• Receive and transmit data from/to an external connection
(network, for example)

• Remote service activity

The events are automatically recorded in (up to) 5 audit files of 5
Mb each. When the maximum limit for files and file size is reached,
the device overwrites the existing files.

The default folder for the audit log files is:
C:\ProgramData\Carl Zeiss Meditec\...\Logs.

6.2.5.1 Export a Log File

NOTE Only Administrators can complete this task.

To export a log file:

Prerequisite þ On the CIRRUS™ HD-OCT instrument, Log in as Admin [} 58].

Action 1. Select Tools > Export Audit Log File.

ð A browse dialog opens.

2. Navigate to the folder you want to store the audit log file.

3. Click Save.

Result ü The log is exported as a .zip file with the format:
AuditLog_dd_mm_yyyy_hh_mm.
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6.2.6 Data Archiving and Retrieval

NOTE We recommond you use a single archive location.

Archives are proprietary only readable from the device on which
they were created.

You cannot port archives to other instruments or to review
stations.

Archiving data stores a backup of CIRRUS 6000 data. Data is
archived to the Current location. For more information about
adding storage to the network for archiving, refer to: Adding a
Network Storage Device

Archives are automatically named following the format: [ID
Unique to the Instrument]-A-[YEAR][MONTH][DAY][HOUR]
[MINUTE][SEC]. For example: 123456789-
A-20190730154623

6.2.6.1 Setting Up an Archive

NOTE Although Administrators and Operators can set up an
archive, we recommend Administrators oversee this process.

To maintain consistency in your environment, have the Adminis-
trator set up a new archive.

The label for the new archive location has two parts:

• Automatically generated name (model number, serial number
and archive sequence number)

• (optional) Customizable suffix

To set up an archive:

Prerequisite þ Log In as Operator or Data Analyst [} 123].

þ You know the name and location of the new archive: Adding a
Network Storage Device

Action 1. Select Records > Archive Management.
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ð The Archive Locations dialog opens.

2. Click New.

ð The New Archive Location dialog opens.

3. To identify this archive location by description, for Description,
type your description (up to 85 characters).

4. Click Browse.

5. Navigate to the shared archive folder on the network file
server.
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6. Click OK.

7. Click Save.

8. Click Close.

6.2.6.2 Changing the Archive

To change the archive location:

Prerequisite þ Log In as Operator or Data Analyst [} 123].

þ You know the name of the new archive.

Action 1. Select Records > Archive Management.

ð The Archive Locations dialog opens listing all available
archives.

2. Select name of the archive you want to use.

3. Click Mark as Current.

4. Click Close.

Result ü The archive location changed.

6.2.7 Windows 10 System Administration

NOTE Only Administrators can complete this task.

This section contains detailed configuration information for system
administrators. Only system administrators should make changes to
these settings.

6.2.7.1 Windows Patches and Updates

Automatic Windows updates are disabled. Windows patches and
updates are distributed with CIRRUS 6000 after they are tested and
approved for use.
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6.2.7.2 Data Safety

6.2.7.2.1 Auto-Lock

After 15 minutes of inactivity, the CIRRUS 6000 screen locks and
the user must log in again.

6.2.7.2.2 Anti-Malware

When configuring anti-malware applications, ensure that updates
and full system scans do not occur when data acquisition could be
in progress. Windows Defender is configured and running on the
CIRRUS 6000. Definition files will be automatically downloaded and
installed if the system has Internet access.

Refer to the software release notes for a list of approved anti-
malware software.

6.2.7.2.3 User Names and Passwords

NOTE Passwords for Tech Support users are unique for each
system.

Zeiss instruments initially have three user names and passwords.
Initial passwords are shown in the table below. Change the
ZeissAdmin passwords before using the instrument.

User Name Type Password Purpose

Zeiss Administrator November171846

NOTE! Change this
password after initial
use.

Instrument User

ZeissAdmin Administrator November171846

NOTE! Change this
password after initial
use.

Instrument Adminis-
tration

Tech Support Administrator <unique> Zeiss Technical Support

Table 12: Initial User Names and Passwords

6.2.7.2.3.1 Password Requirements
All passwords must follow these rules:

• Must be at least seven characters long.

• Must contain at least three of the following:

– European language uppercase characters (A through Z, with
diacritic marks, Greek, and Cyrillic characters).

– European language lowercase characters (A through Z, with
diacritic marks, Greek, and Cyrillic characters).

– Numbers (0 through 9).

– Non-alphabetic characters (for example: !, $, #, %)
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• Any unicode character alphabetic character, including Asian
language unicode characters.

6.2.7.3 Networking

6.2.7.3.1 Network Controllers and IP Addressing

NOTE This instrument is not compatible with networks using IPv4
addressing in the range of 192.168.52.0 to 192.168.52.254

This instrument contains two network controllers; Internal Network
and External Network.

6.2.7.3.1.1 Internal Network

NOTE Do not rename the Internal Network

Internal Network is for instrument use only with the following
assignments:

• Static IPv4 address: 192.168.52.100

• Subnet mask: 255.255.255.0

6.2.7.3.1.2 External Network
The External Network is for instrument connectivity and
automatically picks up an IP address. Do not change the name of
the network controller.

6.2.7.3.2 Required Network Ports

The network ports listed in this section are required for proper
instrument operation.

6.2.7.3.2.1 Required Internal Network Ports

Service TCP UDP

Internal Communication Port 80

Table 13: Internal Network Ports (Required)

6.2.7.3.2.2 Required External Network Ports

Service TCP UDP

Database (for review software) 3051

Table 14: External Network Ports (Required)

6.2.7.3.2.2.1 Required External Network Ports for EMR and FORUM

Service TCP UDP

DICOM outbound 11119
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Service TCP UDP

FORUM outbound 8080

DICOM inbound 11112

FORUM inbound

The first available port in this range will be used.

8081 ~ 8101

DNS

(AutoConnect for instruments outbound)

5353

Table 15: External Network Ports (Required for EMR and FORUM)

6.2.7.3.3 Additional Network Ports

The following network ports are not required to operate the
instrument. These ports facilitate instrument configuration and
maintenance.

Service TCP UDP

Bonjour 1900, 
5350, 
5351, 
5353

Remote service (outbound) 80

DHCP 67 - 68

TCP/IP MS Networking 445

NTP 123

NETBIOS Name Service

(UDP open port visible externally)

137 137

NETBIOS Datagram Service 138 138

NETBIOS Session Service 139 139

Table 16: Additional Network Ports

6.2.7.4 Configuring Enhanced Security

Enhanced security settings are not required to operate the
instrument properly. You can change these settings individually to
match your network environment.

To remove Enhanced Security, log in as ZeissAdmin and run the
“Remove Enhanced Security.CMD” script as an Administrator. The
script is located on the desktop.

6.2.7.4.1 Disabling Enhanced Security Settings

When you received the CIRRUS 6000, enhanced security settings
are turned on. These settings are not required for the instrument to
operate properly.
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You can change individual settings per your institution's require-
ments or you can disable these settings using the Remove
Enhanced Security command on the desktop.

NOTE Only Administrators can complete this task.

To disable enhanced security settings:

Action 1. Log in to the ZeissAdmin user account.

2. Locate and run the Remove Enhanced Security.CMD
script as an Administrator by right-clicking on it and selecting
Run as Administrator.

3. When the process completes, you are presented with a list of
services and firewall rules that have been changed.

4. Reboot the device for the changed services and rules to take
effect.

6.2.7.4.2 Enabling Enhanced Security Settings

When you received the CIRRUS 6000, enhanced security settings
are turned on. These settings are not required for the instrument to
operate properly.

If there were changes to individual settings or if all enhanced
security settings were disabled, you can re-enable all of these
settings using the Install Enhanced Security command on the
desktop.

NOTE Only Administrators can complete this task.

To enable enhanced security settings:

Action 1. Log in to the ZeissAdmin user account.

2. Locate and run the Remove Enhanced Security.CMD
script as an Administrator by right-clicking on it and selecting
Run as Administrator.

3. When the process completes, you are presented with a list of
services and firewall rules that have been changed.

4. Reboot the device for the changed services and rules to take
effect.
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6.2.7.4.3 Enhanced Security Windows Firewall Rules

Enhanced security disables the following Windows firewall rules:

Disabled Firewall Rules

AllJoyn Router (TCP-In) 
AllJoyn Router (TCP-Out)
AllJoyn Router (UDP-In) 
AllJoyn Router (UDP-Out) 
Cast to Device functionality (qWave-TCP-In) 
Cast to Device functionality (qWave-TCP-Out) 
Cast to Device functionality (qWave-UDP-In) 
Cast to Device functionality (qWave-UDP-Out) 
Cast to Device SSDP Discovery (UDP-In) 
Cast to Device streaming server (HTTP-Streaming-In)
Cast to Device streaming server (RTCP-Streaming-In)
Cast to Device streaming server (RTP-Streaming-Out) 
Cast to Device streaming server (RTSP-Streaming-In)
Cast to Device UPnP Events (TCP-In)
Cortana 
Delivery Optimization (TCP-In) 
Delivery Optimization (UDP-In) 
DIAL protocol server (HTTP-In) 
Microsoft.AccountsControl 
Microsoft.LockApp 
Microsoft.Windows.ContentDeliveryManager
Microsoft.Windows.ParentalControls 
Microsoft.Windows.Apprep 
Network Discovery (WSD Events-In)
Proximity sharing over TCP (TCP sharing-In) 
Proximity sharing over TCP (TCP sharing-Out) 
Remote Assistance (DCOM-In) 
Remote Assistance (PNRP-In) 
Remote Assistance (RA Server TCP-In)
Remote Assistance (SSDP TCP-In) 
Remote Assistance (SSDP UDP-In) 
Remote Assistance (TCP-In)
SmartScreen 
Windows.ShellExperience 
Windows Spotlight 
Wireless Display (TCP-In) 
Wireless Display (TCP-Out) 
Wireless Display (UDP-Out) 
Wireless Display Infrastructure Back Channel (TCP-In)
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6.2.7.4.4 Enhanced Security Services

Enhanced security disables the following services:

Disabled Security Services

AllJoyn Router Service 
Application Layer Gateway Service 
Bluetooth Handsfree Service 
Bluetooth Support Service 
BranchCache 
Connected Devices Platform Service 
Connected User Experiences and Telenetry 
Downloaded Maps Manager 
Fax
Function Discovery Resource Publication 
Geolocation Service 
HomeGroup Listener 
HomeGroup Provider 
Infrared Monitor Service
Internet Connection Sharing (ICS) 
Microsoft iSCSI Initiator Service 
Microsoft Storage Spaces SMP 
Microsoft Windows SMS Router Service 
Network Connection Broker 
Phone Service 
Program Compatibility Assistant Service 
Quality Windows Audio Video Experience 
Retail Demo Service 
Shell Hardware Detection 
Telephony 
Touch Keyboard and Handwriting Panel Service 
Windows Camera Frame Server 
Windows Event Collector
Windows Image Acquisition (WIA) 
Windows Insider Service 
Windows Media Player Network Sharing Service 
Windows Mobile Hotspot Service 
Work Folders Xbox Live Auth Manager Xbox Live Game Save Xbox Live
Networking Service
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6.3 Setting Preferences

6.3.1 Setting Archive/Synchronize Alerts
CIRRUS 6000 allows you to set an archive reminder for either
system startup or system shutdown.

NOTE If no archive preference is selected

The hard drive will become full. Indicators are:

Yellow - hard drive is nearly full.

Red - hard drive is full; you cannot scan patients or review data
until the current data is archived.

u Select Records > Archive Now to immediately archive exams.

To set archive alerts:

Prerequisite þ Log In as Operator or Data Analyst [} 123].

Action 1. Select Records > Preferences.

2. Select the Archive/Synchronize tab.

3. To alert the operator of un-archived data each time the
instrument starts up, check Startup .

4. To alert the operator of un-archived data each time the
instrument shuts down, check Shutdown.

5. Select Shutdown to archive on shutdown.

6. Click OK.
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6.3.2 Changing the Default for Normative Data

NOTE Features described in this section are licensed separately and
may not be available in all markets.

u For information about feature availability in your market and
obtaining a license:

ð in the U.S.A, call 1-877-486-7473.

ð outside the U.S.A , contact your local ZEISS distributer.

If you have a license for the Asian normative database, an
additional Preferences panel exists to allow you to change
between Diversified and Asian normative data. For more infor-
mation about the normative databases, refer to: Diverse Population
Study [} 451].

You can set the default normative database. Changing the default
normative database does not impact patient records for patients
assigned to a specific normative database.

To change normative databases:

Prerequisite þ Log In as Operator or Data Analyst [} 123].

þ Your instrument or review software has a license for Asian
normative data: About Licenses [} 61]

Action 1. Select Records > Preferences.

2. Select the Normative Data Settings  tab.

3. Choose the normative data to set.

4. Click OK.

Result ü The system is now set to use the normative data selected
(for calculations).

6.3.3 Configure DICOM Archiving
If your system is not running DICOM Archive, only one option
appears on the DICOM Archive tab (to enable it).

To set DICOM options:

Prerequisite þ Log In as Operator or Data Analyst [} 123].

Action 1. Select Records > Preferences.

2. Select the DICOM Archive tab.

3. Check Enable Auto-Query/Retrieve.

ð Additional options display.



Instructions for Use 6 Configuring Software
CIRRUS™ HD-OCT 6.3 Setting Preferences

2660021174149 Rev. D 2019-10 85 / 542

4. To automatically delete data stored locally when you exit
Analysis, check Purge Archived Data for Current Patient
after Finishing Analysis.

5. To delete data stored locally when you shut down the
CIRRUS™ HD-OCT application, check  Purge Archived Data
for all Patients at Shutdown.

6. To enable exporting image files in a standard DICOM format,
check Send OP and OPT IODs During Archive (Except
After Saving) and select either:
Send Without Prompt  to disable prompt for export, or
Prompt Before Sending to enable prompt for export.

7. To enable automatic archiving of newly acquired exams or a
modified analysis, check Enable Auto-Archive.

8. Click OK.

6.3.4 Setting the Default Patient Screen

To set the default patient screen:

Prerequisite þ Log In as Operator or Data Analyst [} 123].

Action 1. Select Records > Preferences.

2. Select the Display Options tab.

3. To set the patient screen to start with Find Existing Patients,
choose Find Existing Patients.

4. To set the patient screen to start with Today's Patients, choose 
Today's Patients.
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5. Click OK.

6.3.5 Setting the Internet Protocol Version
CIRRUS 6000 instruments work on networks that support Internet
Protocol version 6, as well as version 4. CIRRUS 6000 Review
Software works only on version 4. The default setting is IPv4.

NOTE Choosing the Incorrect Network Protocol

will result in no network connectivity.

u Consult your IT professional before selecting.

To set the internet protocol version you use:

Prerequisite þ Log In as Operator or Data Analyst [} 123].

Action 1. Select Records > Preferences.

2. Select the IPv4 / IPv6 tab.

3. Select the internet protocol version your facility uses.

4. Click OK.

6.3.6 Setting the Preventive Maintenance Schedule
Two weeks prior to the scheduled date, the instrument begins to
displays a reminder (at startup) that maintenance is due.

CIRRUS 6000 instruments require regular maintenance. The
frequency of this maintenance depends on how much your insti-
tution uses the instrument.

To set the maintenance schedule reminder:

Prerequisite þ Log In as Operator or Data Analyst [} 123].

Action 1. Select Records > Preferences.

2. Select the Preventive Maintenance tab.
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3. Check Enable.

4. For Phone Number, type your local maintenance represen-
tative's phone number.

5. Click OK.

6.4 Manage Patient Data

6.4.1 Managing Patient Categories

NOTE Not available in DICOM Archive mode

You can create custom categories for patient records. Then you can
use categories to identify a group of patients that fit into your
category (or combination of categories) using Advanced Search
[} 132]. 

6.4.1.1 About Patient Categories

Some institutions create patient categories to apply to their
patients. Your institution can create custom categories that are
helpful to your clinicians. Your administrator can add new
categories, edit them or delete them.

For example, an institution could create categories to distinguish
the patient's age group like this:

• Child (under 12)

• Teen (12-19)

• Adult 20-45

• Adult 45-60

• Adult 60-80

• Adult 80+

Classification categories can help when a patient is diagnosed with
a specific problem.
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You can apply categories to a patient's record when you create it,
then change or delete categories that no longer apply.

6.4.1.2 Adding a Category

To add a category: 

Prerequisite þ Log In as Operator or Data Analyst [} 123].

Action 1. Select Tools > Options > Categories.

ð The Category Registration dialog opens listing existing
categories in alphabetical order.

2. Click New.

ð The Category Edit dialog opens.

3. For Name, type a name for the category (up to 64-characters).

4. Click Save.

5. (Optional) For Description, type a description (up to 64-
characters).

6.4.1.3 Editing a Category

NOTE You cannot edit categories created by another institution.

To edit a category:

Prerequisite þ Log In as Operator or Data Analyst [} 123].

Action 1. Select Tools > Options > Categories.

ð The Category Registration dialog opens listing existing
categories in alphabetical order.
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2. Select a category.

3. Click Edit.

ð The Category Edit dialog opens.

4. Update the category information.

5. Click Save.

6.4.1.4 Deleting a Category

NOTE You cannot edit categories created by another institution.

To delete a category:

Prerequisite þ Log In as Operator or Data Analyst [} 123]

Action 1. Select Tools > Options > Categories.

ð The Category Registration dialog opens listing existing
categories in alphabetical order.

2. Select a category.

3. Click Delete.

ð A confirmation opens.

4. Click OK.

6.4.2 Patient Privacy

NOTE Obscuring Patient Identities

leads to better security. The unique Patient ID is created when you
export with this option, referred to as the Obscured ID.

u In order to search on a patient with an Obscured ID, enter the
ID into the Obscured ID field of Advanced Search (see
Advanced Search [} 132]).

ð Users who wish to obtain additional medical information
about an anonymous patient must contact the originating
clinic.

The device gives you the choice to export exam data (Export Data
[} 93]) without information that could identify the patient. Upon
import, anonymous or “obscured” patient records appear in the
patient list with the originating institution name in the last name
field and a unique Patient ID generated during export. You have
the further option to export:

• the complete date of birth

• the month and year of birth

• the year of birth
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6.4.3 Merge Patient Records
If a single patient is identified twice with two different ID numbers,
you can merge the records.

To Merge Patient Records:

Prerequisite þ Log In as Operator or Data Analyst [} 123].

Action 1. Select Edit > Merge Patients.

ð The Merge Patient dialog opens.

2. Select the first record to merge.

3. Press <Ctrl> and select the second record to merge.

4. Click Merge Patients.

Result ü The patient records are now combined.

6.4.4 Move Scan
If a scan was acquired using an incorrect patient record, you can
move the scan data to the correct patient using Move Scan.

Prerequisite þ Log In as Operator or Data Analyst [} 123].

þ A scan is selected in analyze mode.

Action 1. Select Edit > Move Scan.
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ð The Move Scan window opens.

2. Click Search to find and select the patient scan.

3. Select Move to move the scan into the correct patient record.

6.4.5 Editing Patient Categories
To edit a patient record:

Prerequisite þ Log In as Operator or Data Analyst [} 123].

Action 1. Select the Patient [} 124].

2. Select Edit > Patient Record. 
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3. Select the Add/Remove Categories tab.

4. To add a category, select the category from the left panel and
click Add .

5. To remove a category, select the categories from the right
panel and click Remove.

6. Click Update.

7. Click Close.

6.4.6 Edit Patient Records
The Edit Patient option is reached from Edit > Patient Record.

You must have selected a patient to edit for this option to be
available. On selection, the Patient Edit screen appears. Follow the
instructions in Adding a New Patient [} 126] to fill in or change the 
Patient Edit fields.
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6.4.7 Print Patient Lists
Found in Records > Print Patient Lists, this option generates a
report that includes all patients listed on the Patient screen in
alphabetical order:

• Name

• Data of Birth

• Patient ID

The report can be viewed, saved or printed as described in 
Standard Print Options.

6.4.8 Export Data
You can export data several ways:

• Export in Native format

• Export in XML format

• Export in Native and XML format

• Export in IMG

You can export data to:

• A USB flash drive

• A folder on the instrument's hard drive

• Another CIRRUS™ HD-OCT instrument

6.4.8.1 About XML Data Export

XML Export  you choose where to save the data and CIRRUS™
HD-OCT saves in a single XML file using patient and scan infor-
mation to name the file as follows:

<Last Name>_<First Name>_<Middle Name>_<Patient ID>_<Date of Birth>_<Gender>_<Scan
Type>_<Scan Date and Time>_<Eye>_<Export Date and Time>.xml

For example:
Wilson_Gordon_Matthew_46673598_1981-02-07_Pachymetry_2019-06-10093523_OU_2
0190712115204.xml

XML Export  the following analysis types:

• Guided Progression Analysis

• Macular Change Analysis

• Anterior Chamber Analysis

• HD Angle Analysis

• Wide Angle to Angle Analysis

• Pachymetry Analysis

• HD Cornea Analysis

In addition to the analysis specific information, some XML data is
the same for all types, including:
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• Export Data

• Patient Data

• Visit Data

• General Scan Data

Field Name Description

EXPORT_DATE_TIME Date and time of export.

EXPORT_USER User (account name) for the person who exported the file.

EXPORT_HOST Host name of the system that created the export file.

EXPORT_INSTRUMENT_S
ERIAL_NUMBER

Serial number of the instrument.

EXPORT_VERSION XML Export version and XML Schema.

Table 17: Export Data

Field Name Description

FIRST_NAME Patient name information.

LAST_NAME

MIDDLE_NAMES

NAME_PREFIX

NAME_SUFFIX

PATIENT_ID_ISSUER Issuer of patient ID.

PATIENT_ID Patient ID.

BIRTH_DATE Patient’s Birth Date (yyyy-mm-dd or yyyy-mm).

GENDER Patient’s Sex (Male, Female, Other, Unknown).

CATEGORY Patient Category..

CATEGORY_NAME The name of the category

OBSCURITY LEVEL How much patient identification information is obscured (if applicable).

OBSCURITY ID Obscured ID (if applicable).

ID SPHERICAL EQUIV-
ALENT

Patient spherical equivalent.

NORMATIVE DATA Patient Normative type (if applicable).

OTHER PATIENT IDS Patient Other ID (if applicable).

ORIGINAL PATIENT ID Patient ID (blank if obscured) .

Table 18: Patient Data

Field Name Description

VISIT_DATE Scan date (yyyy-mm-dd)



Instructions for Use 6 Configuring Software
CIRRUS™ HD-OCT 6.4 Manage Patient Data

2660021174149 Rev. D 2019-10 95 / 542

Field Name Description

STUDY_ID User or equipment-generated ID.

REFERRING PHYSICIAN Patient’s primary referring physician.

REQUESTING PHYSICIAN Physician who requested the scan (attending physician).

PROTOCOL Scan protocol.

CREATION DATE Study information (if applicable)

ACCESSION NUMBER

STUDY INSTANCE UID

UID SERIES Series level
information.

Table 19: Visit Data

Field Name Description

SITE Site name.

DATE TIME The date and time of scan(yyyy-mm-ddThh:mm:ss).

PROTOCOL Scan protocol.

SCAN LENGTH Scan length (in mm).

SCAN DEPTH Scan depth.

SCAN TYPE Scan type.

Z MOTOR POSITION Z Motor position information.

FIXATION POSITION X Fixation target position information.

FIXATION POSITION Y

SCAN SCALING FACTOR
X

Zoom information.

SCAN SCALING FACTOR
Y

POLARIZATION SLIDER Polarization Slider.

CHINREST LOCATION X Chinrest adjustment information.

CHINREST LOCATION Y

CHINREST LOCATION Z

OCULAR LENS POSITION Ocular lens position.

NOISE Noise.

SATURATION Saturation.

SIGNAL STRENGTH Scan signal strength (0-10).

EYE TRACKING Eye tracking.
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Field Name Description

FIXATION TARGET Fixation target.

FIXATION BLINK RATE Fixation blink rate.

SCAN PATTERN OFFSET X Scan pattern adjustment information.

SCAN PATTERN OFFSET Y

COMMENT Scan comment.

OPERATORNAME Username of the operator who acquired the scan.

SERIES INSTANCE UID Series Instance unique id.

Table 20: General Scan Data

6.4.8.1.1 Macular Scans

6.4.8.1.1.1 Macular Thickness Analysis XML Export Values

1 2 3 4 5

6

7 8 9 10

11

12

13

18
21

20

25

23

14

15

16

24

22 23

19

17

Figure 4: XML Export: Macular Thickness Analysis

1 LAST_NAME 2 FIRST_NAME

3 PATIENT_ID 4 GENDER

5 BIRTH_DATE 6 VISIT_DATE

7 PROTOCOL 8 DATE_TIME

9 SITE 10 OPERATORNAME

11 SIGNALSTRENGTH 12 FOVEA_Y

13 FOVEA_X 14 ILMRPECENTRAL
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15 ILMRPEVOLUME 16 ILMRPEAVERAGE

17 Z_CENTER 18 Z_OUTERSUPERIOR

19 Z_INNERSUPERIOR 20 Z_INNERRIGHT

21 Z_OUTERRIGHT 22 Z_INNERINFERIOR

23 Z_OUTERINFERIOR 24 Z_INNERLEFT

25 Z_OUTERLEFT

6.4.8.1.1.2 Macular Change Analysis XML Export Values

8

11

1

2

4

5

9

6

7

10

3

Figure 5: XML Export: Macular Change 

1 DATE_TIME 2 REGISTRATION

3 Z_CENTER 4 Z_INNERSUPERIOR

5 Z_INNERRIGHT 6 Z_INNERINFERIOR

7 Z_INNERLEFT 8 Z_OUTERSUPERIOR

9 Z_OUTERRIGHT 10 Z_OUTERINFERIOR

11 Z_OUTERLEFT 12 FOVEA_X,Y
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6.4.8.1.1.3 Advanced RPE Anaylsis XML Export Values

1

7
6

5
4

3
2

Figure 6: Advanced Export 

1 DATE_TIME 5 VOLUME_OF_RPEELEVATIONSFIVEMMCIRCLE

2 AREA_OF_RPEELEVATIONSTHREEMMCIRCLE 6 AREA_OF_SUBRPE_ILLUMINATION

3 AREA_OF_RPEELEVATIONSFIVEMMCIRCLE 7 CLOSEST_DISTANCE_TO_FOVEA

4 VOLUME_OF_RPEELEVATIONSTHREEMMCIRCLE

6.4.8.1.1.4 Ganglion Cell OU Analysis XML Export Values

7 96

2

4

3

5

8

Figure 7: Ganglion Cell OU Advanced Export

1 SITE 2 GC_AVERAGE

3 GC_MINIMUM 4 GC_TEMPSUP
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5 GC_SUP 6 GC_NASSUP

7 GC_NASINF 8 GC_INF

9 GC_TEMPINF

6.4.8.1.1.5 Ganglion Cell Guided Progression XML Export Values

1

2

3
4

5

6

Figure 8: XML Export : Guided Progression Analysis

1 DATE_TIME 2 SERIAL_NUMBER

3 SIGNAL_STRENGTH 4 OVERALL_THICKNESS

5 SUPERIOR_THICKNESS 6 INFERIOR_THICKNESS
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6.4.8.1.2 ONH and RNFL Scans

6.4.8.1.2.1 ONH and RNFL OU Analysis XML Export Values

1

2
3

4

5

6
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Figure 9: XML Export: ONH / RNFL OU 

1 AVERAGETHICKNESS 2 SYMMETRY

3 RIMAREA 4 DISCAREA

5 AVERAGE_CD_RATIO 6 VERTICAL_CD_RATIO

7 CUPVOLUME 8 ONHCENTER_X,Y

9 QUADRANT_S 10 QUADRANT_N

11 QUADRANT_I 12 QUADRANT_T

13 CLOCKHOUR–1–12
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6.4.8.1.3 Angiography Scans

6.4.8.1.3.1 Angiography Analysis XML Export Values

2

8

10 12

Figure 10: XML Export : Angiography Analysis

1 FOVEA_LOCATION {X,Y} 2 CENTRALSUBFIELDTHICKNESS

• ILMRPE

• ILMRPEFIT

• RPERPEFIT

5 CUBEVOLUME

• ILMRPE

• ILMRPEFIT

• RPERPEFIT

6 CUBEAVGTHICKNESS

• ILMRPE

• ILMRPEFIT

• RPERPEFIT

7 FAZ_Center{X, Y} 8 FAZ_Area

FAZ_Perimeter

FAZ_CircularityIndex

9 FOVEA_LOCATION {X,Y} 10 VESSEL_ETDRS

• Z_CENTER

• Z_INNERRIGHT

• Z_INNERSUPERIOR

• Z_INNERLEFT

• Z_INNERINFERIOR

• Z_OUTERRIGHT

• Z_OUTERSUPERIOR

• Z_OUTERLEFT

• Z_OUTERINFERIOR
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11 VESSEL_CENTRAL_MEAN

VESSEL_INNER_MEAN

VESSEL_OUTER_MEAN

VESSEL_FULL_MEAN

12 PERFUSION_ETDRS

• Z_CENTER

• Z_INNERRIGHT

• Z_INNERSUPERIOR

• Z_INNERLEFT

• Z_INNERINFERIOR

• Z_OUTERRIGHT

• Z_OUTERSUPERIOR

• Z_OUTERLEFT

• Z_OUTERINFERIOR

13 PERFUSION_CENTRAL_MEAN

PERFUSION_OUTER_MEAN

PERFUSION_INNER_MEAN

PERFUSION_FULL_MEAN

6.4.8.1.3.2 ONH Angiography Analysis XML Export Values

Figure 11: XML Export: ONH Angiography Analysis 

1 ONH_CenterX

ONH_CenterY

2 PERFUSION_ETDRS

• Z_NASAL

• Z_SUPERIOR

• Z_TEMPORAL

• Z_INFERIOR



Instructions for Use 6 Configuring Software
CIRRUS™ HD-OCT 6.4 Manage Patient Data

2660021174149 Rev. D 2019-10 103 / 542

3 FLUX_ETDRS

• Z_NASAL

• Z_SUPERIOR

• Z_TEMPORAL

• Z_INFERIOR

4 PERFUSION_OUTER_MEAN

5 FLUX_OUTER_MEAN

6.4.8.1.4 Anterior Segment Scans

6.4.8.1.4.1 Anterior Chamber Analysis XML Export Values

8

10

11

9

1

3

4

141312

Figure 12: XML Export: Anterior Chamber Analysis 

1 HD_LASTEDITED 2 SIGNAL_STRENGTH

3 SCAN_LENGTH 4 SCAN_ANGLE

5 SCAN_SPACING 6 CALIPER_MEASUREMENT

7 ANNOTATION_MEASUREMENT 8 CCT

9 ATA 10 CLR

11 ACD 12 LEFTANGLE

13 RIGHTANGLE 14 CHAMBER_AREA
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6.4.8.1.4.2 HD Angle Analysis XML Export Values

4

8

9

3

Figure 13: XML Export : HD Angle Analysis 

1 HD_LASTEDITED 2 SIGNAL_STRENGTH

3 SCAN_LENGTH 4 SCAN_ANGLE

5 SCAN_SPACING 6 CALIPER_MEASUREMENT

• DECIMAL_PLACES

7 ANNOTATION_MEASUREMENT

• ANNOTATION_TEXT

8 IC_Angle

• A0D500

• Distance

• A0D750

• Distance

• TISA500

• Space Area

• TISA750

• Space Area

• SSA

• LOCATION

– Nasal = Left eye, left angle or right eye,
right angle

– Temporal = Left eye, right angle or
right eye, left angle

9 ANGLE
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6.4.8.1.4.3 HD Cornea Analysis XML Export Values

3
4

7

5

Figure 14: XML Export : HD Cornea Analysis

1 HD_LASTEDITED 2 SIGNAL_STRENGTH

3 SCAN_LENGTH 4 SCAN_ANGLE

5 CALIPER_MEASUREMENT 6 ANNOTATION_MEASUREMENT

7 STROMA_TOOL_DISTANCE

6.4.8.1.4.4 Wide Angle to Angle Analysis XML Export Values

8

3

4

9

6

10 11

Figure 15: XML Export: Wide Angle to Angle Analysis 

1 HD_LASTEDITED 2 SIGNAL_STRENGTH

3 SCAN_LENGTH 4 SCAN_ANGLE

5 SCAN_SPACING 6 CALIPER_MEASUREMENT

• DECIMAL_PLACES
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7 ANNOTATION_MEASUREMENT

• ANNOTATION_TEXT

8 IC_LEFT

• A0D500

• Distance

• A0D750

• Distance

• TISA500

• Space Area

• TISA750

• Space Area

• SSA

• LOCATION

– Nasal = Left eye, left angle or right eye,
right angle

– Temporal = Left eye, right angle or
right eye, left angle

9 IC_RIGHT

• A0D500

• Distance

• A0D750

• Distance

• TISA500

• Space Area

• TISA750

• Space Area

• SSA

• LOCATION

– Nasal = Left eye, left angle or right eye,
right angle

– Temporal = Left eye, right angle or
right eye, left angle

10 LEFTANGLE

11 RIGHTANGLE
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6.4.8.1.4.5 Pachymetry and Epithelial Thickness Analysis XML Export
Values

1 2

Figure 16: XML Export: Pachymetry Analysis

1 SUBFIELD_OD

• SUBMAXDATA

• SUBMEANDATA

• SUBMINDATA

• EPITHELIALSUBMAXDATA

• EPITHELIALSUBMEANDATA

2 SUBFIELD_OS

• SUBMAXDATA

• SUBMEANDATA

• SUBMINDATA

• EPITHELIALSUBMAXDATA

• EPITHELIALSUBMEANDATA

6.4.8.2 Data Export Options

Figure 17: Data Export

Export Type Description

Export and XML Exports patient data in both its Native format and XML format simultaneously.

• Maximum of 100 exams per export

• Export to Zip Format not recommended
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Export Type Description

XML Export Exports patient data formatted as an XML file with values of OCT Angiograpaphy
and the Cube reports, including: 

• Patient Identifiers (or tokens if patient identification is omitted)

• Study Identifiers

• Scan Information including:

– OD or OS

– Scan Type, Scan identifiers, and instrument identifiers

– Tracking details including fixation data over time (if available)

Export Exports patient data in its existing format.

6.4.8.3 Exporting Data

NOTE Creating a zip file takes extra time to compress.

Do not try to export a large numbers of patient exams into a single
zip file.

NOTE Always create a new folder when exporting zip files

If you export zip files to a folder that has existing files from
previous exports, the new zip file will combine the newly exported
records with the existing files (excluding existing zip files).

Tip: You can save time by using the
same folder to export patient data.

If you export to the same folder as a prior export, you can choose
to update the prior export or overwrite all data.

NOTE! If an export process is interrupted, you can restart the
export. If you use the same folder, the export will continue.

Prerequisite þ Removable media is inserted (If saving to removable media
such as a USB flash drive)

þ Target system login is successful (If the target system requires a
password for access).

þ Log In as Operator or Data Analyst [} 123].

Action 1. Select Records > Export Exams.

ð The Export Exams dialog opens showing the last export
path. (On first export, Path is empty.)
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2. To change the export destination, click Browse and navigate
to the desired location.

3. To create a new folder for the exported files, click Make New
Folder.

4. Click OK.

ð Path displays the new path.

5. To export the data compressed into one zip file, check Export
to Zip.

6. To hide patient identifying information (as for a clinical trials)
check Omit Patient Identifiers and select an option. For more
information, refer to: Patient Identifying Information Omission
Options [} 110].

7. To find the exams for a patient, type the patient's last name, ID
or select a category. You can also select a time interval to limit
the search results.

8. Click Search.

9. Click Search.

ð For additional search options, refer to Advanced Search
[} 132].

10. Under Results, click on the records to export. 
Click Select All in the Patient Export window to select all
patients in the list.
Press Ctrl while clicking on each record to select multiple
records.
In the Exam Export window, you may export individual scans
for the patient you selected in the Patient Export window.
Press Ctrl and click on each scan to select multiple scans.

11. Select an Export Option (see: Data Export Options [} 107]).

12. Click Export.
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ð If you are exporting to a folder used in a prior export, a
prompt opens.

13. If the prompt opens, select:
Increment to update the last export (retains existing exported
data and add any new or changed data.)
Overwrite to replace all data.

Result ü A progress dialog opens to inform you as the export
process progresses.

6.4.8.4 Patient Identifying Information Omission Options

NOTE You cannot edit or merge patient information in data
imported with identifying information omitted.

NOTE System-generated patient identifiers do not change.

There was a change in the way patient identifiers are generated
when you want to obscure the patient's name, day, and month of
birth.

u If a patient's records were not yet exported, a unique identifier
is assigned using the New Method.

u If a patient's records were already exported using the original
ID generation process Obsolete Method, future exports will
use the same identifier as before.

Option Description

Omit:

• Patient Name

• Replaces patient's Last Name with the institution name.

• Replaces patient's First Name and Patient ID with a unique 17-
character number.

NOTE! The unique number is the date and time (to the thousandth
of a second) that the patient record was originally created. Example:
20070609081320226.

Omit:

• Patient Name

• Day of birthday

In addition:

• Replaces the day of birth with 1.

For example, the birthday 10/22/1995 becomes 10/1/1995.

NOTE! For patients over 80 years old, the year of birth changes to
<current year> - 80.
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Option Description

Omit:

• Patient Name

• Day of birthday

• Month of birthday

(New Method)

Generates a unique identifier for the patient (does not correlate to the
patient name or birthday).

(Obsolete Method)

• Replaces patient's Last Name with the institution name.

• Replaces patient's First Name and  Patient ID with a unique 17-
character number.

• Replaces the day of birth and month of birth with 1.

For example, the birthday 10/22/1995 becomes 1/1/1995.

NOTE! The unique number is the date and time (to the thousandth
of a second) that the patient record was originally created. Example:
20070609081320226.

NOTE! For patients over 80 years old, the year of birth changes to
<current year> - 80.

Table 21: Identifier Omission Options

6.4.9 Import Data

6.4.9.1 Data Integrity of Imported Records

For all imported patient records, it is possible to import new scan
data and update patient data, including obscured patient records. If
during import the device encounters information associated with a
patient that was already imported, the device does the following:

• Imports all scan data (exams) not previously imported, but
never deletes nor overwrites any scan data already imported.

• Updates patient data only if it was created on a later date than
the data already imported. This action prevents overwriting of
newer patient data with older data.

6.4.9.2 Importing Data

NOTE ZIP files containing a large number of patients a great deal
of time to uncompress on import.

When importing data, you do not need to uncompress the ZIP file
prior to importing it; all data will be imported.

To import data:

Prerequisite þ Removable media is inserted (If saving to removable media
such as a USB flash drive)

þ Target system login is successful (If the target system requires a
password for access).

þ Log In as Operator or Data Analyst [} 123].

Action 1. Select Records > Import Exams.
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ð The Import  dialog opens.

2. Navigate to the exams to import.

3. To import specific exams, select the Exam Import tab.

4. To import by patient identifiers, select the Patient Import  tab.

5. Click on the patients to import. 
To select multiple patients, Ctrl-click.
To select all patients in the list, click Select All.

6. Click Import.

Result ü The records are imported into your current database.

6.5 Configuring Reports
Some types of analysis offer custom options for the printed reports.
The reports you can configure are: 

• Macular Thickness Report [} 113]

• ONH Report [} 115]

• HD Image Report [} 115]

• Guided Progression Reports [} 116]
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6.5.1 Configuring Macular Thickness Reports
There are three types of reports for the Macular Thickness analysis
[} 238]:

• Macula Thickness Report

• Macula Multi-Slice Report

• Macula Radial Report

You can choose whether to include one, two or all three types of
Macula Thickness reports.

Report Settings

Macula Thickness Report None

Macula Multi-Slice Report Includes images of the central fast B-scan and adjacent B-scans on a
series of pages, each showing a set of Macula slices.

You can set which slices to print, the number of scans to print per
region and the spacing between the scans (which determines the
number of page the report produces).

For each region, set:

• number of scans

• spaces between scans

Central Region the central 1 mm (1000 µm) of the cube (the equiv-
alent of 500 µm above and 500 µm below the central B-scan)

Mid–Regions the next 1.0 mm above and below the Central Region.

Outer Regions the 1.5 mm of area above and below the Mid Regions.

Print all Scans check or uncheck

OCT tomogram per page1 or 4
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Report Settings

Macula Radial Report Produces a radial line report; six B-scans at meridians of:

• 0 degrees

• 30

• 60

• 90

• 120

• 150 (right eye) or 300 x 330 (left eye).

If you select Macula Multi-Slice, complete additional settings for this
report on the Macula MultiSlice parameters tab.

NOTE! If the radial pattern position causes a portion of a lines to
extend outside the boundary, no OCT data appears.

To configure macular thickness reports:

Prerequisite þ Log In as Operator or Data Analyst [} 123].

Action 1. Select Tools > Print Configuration.

ð The Printout Configuration dialog opens.

2. Select the MTA Print Options tab.

3. To set report to the default, click Reset to Default.

4. To set report to Macular Multi Slice, check Macula Multi Slice,
click OK and select the Macula MultiSlice parameters tab.

ð Type the number of scans for each section or to omit scans
for the region, type 0.

ð Type the number of spaces between scans for each region.

ð To print all scans, check Print all scans.

ð Select whether to print 1 or 4 OCT tomograms per page.

5. To set report to Macular Radial, check Macula Radial .

6. Click OK.

Result ü Macular thickness analysis reports now include your new
selection(s).
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6.5.2 Configuring ONH Reports
You can customize the ONH OU report to include a second page
for the patient.

Figure 18: ONH OU Report with Patient Education Page

To configure ONH OU reports:

Prerequisite þ Log In as Operator or Data Analyst [} 123].

Action 1. Select Tools > Print Configuration.

ð The Printout Configuration dialog opens.

2. Select the ONH Print Options tab.

3. To include the patient education page, click Yes.

4. To omit the patient education page, click No.

5. Click OK.

6.5.3 Configuring HD Image Reports
The HD Image report includes:

• Fundus image showing the placement of the line scans

• thumbnails of the scan lines

• single larger image of the selected scan line (for HD Cross:
middle vertical and horizontal images)

You can customize the HD Image report to print all lines (multiple
pages) or only the selected line (single page).

To configure HD Image reports:

Prerequisite þ Log In as Operator or Data Analyst [} 123].

Action 1. Select Tools > Print Configuration.

ð The Printout Configuration dialog opens.

2. Select the Raster Print Options tab.
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3. To include only the line selected, choose Print Selected Line.

4. To include all lines, choose Print All Lines.

5. Click OK.

6.5.4 Configuring Guided Progression Reports
You can set the Guided Progression reports as 1-page or 2-page
reports. If you set 1-page reports, you can set whether the page
shows the summary or just the latest scan.

No Selection Summary Latest Scan

Table 22: Options for 1-Page Guided Progression Reports

Page 1 Page 2

Summary
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Page 1 Page 2

Latest Scan

Table 23: Options for Multi-Page Guided Progression Reports

To configure Guided Progression reports:

Prerequisite þ Log In as Operator or Data Analyst [} 123].

Action 1. Select Tools > Print Configuration.

ð The Printout Configuration dialog opens.

2. Select the GPA Print Options tab.

3. To generate guided progression as a one-page report, choose
Print Single Page and select Summary or Latest Scan Only.

4. To generate guided progression as multi-page report , choose
Print All Pages and select whether the first page includes
Summary or Latest Scan Only.

5. Click OK.

6.6 Customizing Settings

6.6.1 Customizing the Available Scans List

NOTE You must organize scans using the CIRRUS™ HD-OCT
instrument.

Since review stations do not acquire scans, you cannot organize
scan types from a review station.

NOTE Your instrument might show a different list of scan types.

The types of scans that are available on the instrument depends on
the licenses that you purchased for the instrument. Refer to: About
Licenses [} 61].
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You can change the list of scan types that appears at the top of the
Acquire screen to make it easier for the instrument operator to find
the type of scan(s) that your site uses most frequently. You can:

• Hide some types of scans from the list

• Re-organize the list

Prerequisite þ Log In as Operator or Data Analyst [} 123]

þ View Today's Patients Screen [} 134]

Action 1. Select Tools > Scan Organizer.

ð The scan organizer opens showing the full list of scans
types available for the instrument.

2. Under Available Scans, select the scan type(s) that you want
the instrument to display and click .

ð The scans appear under Visible Scans.

3. To hide a scan from the list select the scan type under Visible
Scans and click .

4. To move a scan higher on the list, select the scan type under
Visible Scans and click .

5. To move a scan lower on the list, select the scan type under
Visible Scans and click .

Result ü The new list you created under Visible Scans now appears
when an operator acquires scans.

6.6.2 Set Preferred Analyses

NOTE Your instrument might show a different list of scans and
analyses.

The types of scans and analyses available depends on the licenses
installed the instrument or review station. See: About Licenses
[} 61].

You can customize the preferred analyses to use for a particular
type of scan.

For example, if you:

1. Set Macular Change Analysis as the preferred analysis for
Macular Cube 512 x 128  scan.

2. Select a patient with Macular Cube 512 x 128 scans acquired
during two different visits and click Analyze.



Instructions for Use 6 Configuring Software
CIRRUS™ HD-OCT 6.6 Customizing Settings

2660021174149 Rev. D 2019-10 119 / 542

Macular Change Analysis opens automatically, showing the
patient's macular cube images from both visits for change
comparison.

You can set a preferred analyses for (up to) five types of scans. 

CIRRUS 6000 uses the first applicable preferred analyses for the
selected scan.

To set the preferred analysis for a type of scan:

Prerequisite þ Log In as Operator or Data Analyst [} 123]

þ View Today's Patients Screen [} 134]

Action 1. Select Records > Preferences.

ð The Preferences dialog opens.

2. Select the Preferred Analysis tab.

3. For the first available Select Scan Type, choose the scan you
want to associate with a preferred analysis.

ð The scan organizer shows the full list of scans types
available for the instrument.

4. For Select Preferred Analysis, choose the analysis you want
to associate to the scan.

5. To set additional preferred analyses, repeat the steps above.
You can associate up to five scans with a preferred analysis.

6. Click OK.

Result ü When you analyze a scan, CIRRUS 6000 opens the first
available scan specified in the preferred analysis list.

6.6.3 Turn FastTrac™ On or OFF
FastTrac™ performs two functions (see About FastTrac™ [} 217]):

• When acquiring an OCT scan, FastTrac™ tracks the position of
the eye to minimize the effects of eye motion.

• FastTrac™ also tracks an OCT scan to OCT scan acquired from
a previous visit.
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Before using the FastTrac™  feature the first time, make sure you
complete the Performance Verification Check.

Auto Repeat automatically reuses chinrest settings from an earlier
scan for the same patient and same type of scan for the same eye
(see About Auto Repeat [} 216]).

To enable FastTrac™:

Prerequisite þ Tracking is off (unchecked).

Action

1. Select Tools > Auto Repeat.

ð Auto Repeat is checked.

2. Select Tools > Tracking.

ð Tracking is checked.

ð The Capture button displays a green border for scans that
can use FastTrac™.

3. If this is the first time  FastTrac™ is enabled on the
instrument, complete the Performance Verification Check.

To disable FastTrac™:

Prerequisite þ Tracking is on (checked).

4. Select Tools > Tracking.

ð Tracking is unchecked.
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7 Before Every Use

7.1 Safety During Preparation for Use

 CAUTION! Improper operator training

could lead to poor scan quality, damage to system components, or
inadvertent patient safety compromise.

u Train all operators fully.

u Ensure all personnel are familiar with the information contained
in the Safety and Certifications chapter.

u Ensure that routine maintenance has been properly carried out
in conformance with the Maintenance Schedules described in
the Maintenance chapter.

 CAUTION! Neglecting to prompt the patient to move their head away
from the chinrest and sit back on completion of Patient ID or
Scanning

could result in injury to the patient when the chinrest repositions
itself.

u Before you click the Finish or ID Patient in the Acquire screen,
always prompt the patient to sit back and move their head
away from the chinrest.

 CAUTION! Patients who hold on to the instrument before or during
tests

risk having their fingers pinched and possibly injured.

u Make sure that the patient is not holding on to the instrument
before or during tests.

7.2 Prepare the Instrument for Use

 CAUTION! Neglecting to disinfect device could lead to cross infection
between patients.

u Refer to Cleaning the Chin Cup and Forehead Rest [} 409] for
more information.

NOTE If a database, installation files, or instrument error occurs:

u Do not use the instrument.

u Contact your Zeiss representative.

NOTE Make sure you archive scans frequently to ensure that there
is enough storage space to acquire new scans.
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Action 1. Wipe the chinrest and forehead rest with an alcohol pad and
allow it to dry.

2. Turn on the instrument (see: System Startup).

3. Select the Patient [} 124].

7.3 Read and Understand Physician Instructions
For each patient scheduled for scans today:

Action 1. Carefully read all instructions from the officiating physician or
researcher. 

2. Ensure that you fully understand all instructions before starting
the examination.
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8 Operation

8.1 User Login/Logout

8.1.1 Log In as Operator or Data Analyst

NOTE Passwords are case–sensitive.

You are prompted to log in:

• After system startup

• After application logout

For information about the features available for operators, data
analysts and administrators, refer to: User Types [} 70].

To log in as operator or data analyst:

Prerequisite þ The instrument is on: System Startup [} 54].

þ The administrator created your user account: Adding a New
User [} 71].

Action 1. Open the CIRRUS 6000 application.

2. Select your user name from the list.

3. Type your password.

4. Click OK.

5. The ID Patient screen opens.

8.1.2 Review Station Login

NOTE Passwords are case–sensitive.

You can use a Review Station to access, analyze, edit, save, and
export scans and print reports.

To log in to a Review Station:

Prerequisite þ The administrator created your user account: Adding a New
User [} 71].

þ Review Station software is installed on the computer (Installing
Review Station Software [} 42]).

Action 1. Open the CIRRUS 6000 application.
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2. Select your user name from the list.

3. Type your password.

4. Click OK.

5. The ID Patient screen opens.

8.1.3 Log Out

NOTE Inactivity causes the instrument to go into "sleep" mode.

You can set the time limit that triggers sleep mode and a password
to wake the instrument.

You can also set hibernate or hybrid options.

u Refer to the Windows documentation for Power Options.

Logging out locks the CIRRUS 6000 and prevents unauthorized
access.

To log out:

Prerequisite þ Patient ID screen is open.

Action 1. Select Logout.

Result
ü The login screen opens.

8.2 Select the Patient
You must select the appropriate patient record before you scan or
analyze images. You can add a new patient or select an existing
patient.

If your institution connects to a DICOM system, you can also search
a DICOM archive.

8.2.1 Add a New Patient
When you add a new patient, the patient automatically appears in
the View Today's Patients list.
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8.2.1.1 Add New Patient Screen

1

2

3

4 5

Figure 19: Add New Patient Screen

# Symbol Name Explanation

1 Find Existing
Patient Tab

Finds an existing patient by last name, ID or advanced search
criteria.

2 Add New Patient
Tab

Adds a new patient record.

3 View Today's
Patients Tab

Lists patients scheduled for a scan today, patients added today,
and patients who already had scans taken today.

4 Last Name (Required) Type the patient's last name.

First Name (Required) Type the patient's first name.

Middle Name

Suffix

Prefix

(Optional) Type additional patient information.

Date of Birth (Required) Type the patient's birthday.

Gender (Optional) Select the patient's gender.

Patient ID (Required) Type or generate a unique ID for the patient.

Spherical Equiv.
OD

(Optional) Type the patient's correction.

Spherical Equiv.
OS

Comments Allows you to add comments to the patient record.

5 Add/Remove
Categories Tab

Allows you to apply categories to the patient record (see: About
Patient Categories [} 87]).
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8.2.1.2 Adding a New Patient

NOTE If you include refractive error information in the patient's
record, it can save time when you acquire their scans.

When you add a new patient, you can enter their refractive error.
The CIRRUS 6000 uses this information to determine the scan
focus.

Each patient must have a unique patient ID for CIRRUS 6000 to
save acquired images in their record. Your institution can use its
own patient ID numbering system or have generate unique patient
ID numbers.

Patient ID numbers that CIRRUS 6000 generates start with CZMI.

To add a new patient:

Prerequisite þ Log In as Operator or Data Analyst [} 123].

Action 1. Select the Add New Patient tab.

2. Type the patient's Last Name and First Name.

3. If applicable, type the patient's Middle Name and Suffix (Jr.,
Sr., etc.) or Prefix (Mr., Ms., Mrs., etc.).

4. Type the patient's Date of Birth.

5. Select the patient’s Gender.

6. To have CIRRUS 6000 create a Patient ID, click Generate ID.

7. To use your own numbering system, type a unique Patient ID
number. NOTE! To fit on the page, reports only show the
first 23 characters of the patient ID (including spaces).

8. To save the patient's refractive error, type the diopters for
Spherical Equiv. OD and Spherical Equiv. OS.

9. To add comments to the patient's record, click More, type the
comments, and click Done.
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10. To apply categories to the new patient, select the Add/
Remove Categories tab and choose the applicable categories.
For more information about categories, see: Managing Patient
Categories [} 87].

11. Click Save.

12. To add another new patient, click New Patient.

13. Click Close.
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8.2.2 Find an Existing Patient

8.2.2.1 Find Existing Patient Screen

1 2 3

4

5

6

Figure 20: Find Existing Patient Tab

# Symbol Name Explanation

1 Find Existing Patient
Tab

Finds an existing patient by last name, ID or advanced search
criteria.

2 Add New Patient
Tab

Adds a new patient record.

3 View Today's
Patients Tab

Lists the following:

• New patients (added today) using the CIRRUS 6000
instrument.

• Patients scheduled CIRRUS 6000 scans today.

4 Search By Specifies all or part of a patient name or ID to include in results.

5 Results Lists the patients who fit the criteria (after you click Search).

6 Search Quick search to find a patient when all or part of their last name
or ID is known.

Advanced Search Additional criteria to narrow the search results further or to
search using different known criteria. 

8.2.2.2 Finding an Existing Patient Record
Tip: If you leave the name and ID
fields blank and click Search, the
results lists all patients.

Simple search uses the patient's last name or ID to locate their
record. If you want to search using other criteria or narrow the
results further, see: Advanced Search [} 132].

To find a patient record:
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Prerequisite þ Log In as Operator or Data Analyst [} 123].

Action 1. Select the Find Existing Patient tab.

2. Type the patient’s Last Name or Patient ID.

3. Click Search.

ð The Results list displays the patient (or list of patients that
have the same last name).

4. Select the patient's record.

8.2.2.3 Finding a Worklist Patient Record (DICOM)

NOTE Edit patient records in your EMR system (if used).

Changes made directly on the instrument do not get synchronized
into the EMR database.

u If you are connected to an EMR , always delete or edit patient
records directly in the EMR system. If you can make changes
directly on the instrument, the changes will only appear in the
instrument's database and not the EMR database.

Modality Worklist allows you to search a DICOM EMR archive.

A Broad Query allows searches using the following parameters:

• Date Range: Search for patients scheduled for an exam within
a selected range. To search for all dates, check All Dates.

• AE Title: Search for patients scheduled for a scan using a
particular instrument's AE Title.

• Modality:

– IOD

– OP
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– OPT

– OPT IOD

– OP IOD

A Patient Based Query allows searches using the following para-
meters:

• First Name

• Last Name

• Patient ID

• Accession Number (Determined from the Analysis screen
when the mouse cursor is over an exam date in the upper left
corner)

• Requested Procedure ID

You can set a preference that automatically searches the DICOM
archive for patients scheduled for a scan today (see Enabling
Automatic Worklist Search (DICOM)).

Prerequisite þ Log In as Operator or Data Analyst [} 123].

Action 1. Select Records > Search Worklist Patients.

2. To use broad search parameters, select Broad Query and
indicate what parameter(s) you want the search to include.

3. To use patient information parameters, select Patient Based
Query and indicate what parameter(s) you want the search to
include.

4. Click Search.

ð The list populates with all patient records that fit the para-
meters you indicated.

5. To view more information about a patient, select the patient
and click Details.

ð A dialog opens showing more details of the patient's
record.



Instructions for Use 8 Operation
CIRRUS™ HD-OCT 8.2 Select the Patient

2660021174149 Rev. D 2019-10 131 / 542

6. To add patient records to your instrument database, select the
patient(s), and click Save.

7. Click Close.

Result ü The patients you added are now listed in the View
Today's Patients tab.

8.2.2.4 Advanced Search

Advanced Search allows you to use additional criteria to search
for a patient. When you use Advanced Search, you can use as
many or as few different search criteria that you want to use. Each
criteria helps you narrow the results list.

8.2.2.4.1 Advanced Search Overview

1

2

3

4

5

6

7

8

9

10

# Group Name Explanation

1 Name Last Type all or part of the patient's name.

First

Middle
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# Group Name Explanation

2 Patient ID Patient ID** Type all or part of the patient's ID.

Issuer of Patient**
ID

Refer to: About Assigning the Issuer of Patient ID [} 58].

Obscured ID* If the patient identification information is obscured, you can type
all or part of the Obscured ID. All other search criteria is
ignored.

3 Group Category* Select a category assigned to the patient (see: About Patient
Categories [} 87]).

4 Exam Accession
Number

Exam Protocol*

Scan Type Select a type of scan acquired for the patient.

5 Exclude Obscured Patient*

6 Gender* Check the patient's gender.

7 Date of Birth Enable Check to enable this search criteria.

From: Select a start date for the search.

Through: Select an end date for the search.

8 Age* From: Select a start date for the search.

To: Select an end date for the search.

9 Exam Date All

Interval From: Select a start date for the search.

Through: Select an end date for the search.

Select

Use Import Date* From: Select a start date for the search.

Through: Select an end date for the search.

10 Buttons Clear Resets the search criteria.

Search Begins the search based on the criteria indicated.

Cancel Exits search.

* Not available for search in a DICOM archive.

** Case-Sensitive.

Table 24: Advanced Search Criteria

8.2.2.4.2 Advanced Search

To search an archive (or database) for a patient using
additional criteria:
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Prerequisite þ Log In as Operator or Data Analyst [} 123].

þ Finding an Existing Patient Record [} 128]

Action 1. Select the Find Existing Patient tab (Find an Existing Patient
[} 128]).

2. Click Advanced Search.

3. Fill in the known criteria for the patient you are searching for.

4. Click Search.

ð Search Preview opens.

5. To select a patient, click on the patient's name. Current patient
information appears on the left side of the Toolbar.

6. To select the whole list of patients, check Select All.

7. Click OK.



8 Operation Instructions for Use
CIRRUS™ HD-OCT8.2 Select the Patient

134 / 542 2660021174149 Rev. D 2019-10

8.2.3 Select from Today's Patients

8.2.3.1 View Today's Patients Screen
1 2

Figure 21: View Today's Patients Tab

# Name Explanation

1 Results Lists patient information for patients scheduled for a CIRRUS 6000 exam
today (from the electronic medical record system). Results also displays
patient's records that were imported on the present day. These will not be on
the list the following day.

2 Refresh List Synchronizes with the electronic medical record system and updates the list.
Pressing Refresh List will update the main patient list after the importing
patient data from another CIRRUS 6000.

8.2.3.2 Viewing Today's Patients

The View Today's Patients tab lists:

• Patients added today (Adding a New Patient [} 126])

• Patients that were scanned earlier today

• DICOM patients scheduled for a scan today.

To view today's patients:

Prerequisite þ Log In as Operator or Data Analyst [} 123].

Action 1. Select the View Today's Patients tab. 

2. To refresh this list, click Refresh List.

3. Select a patient's name.

ð Current Patient information appears on the left side of the
Toolbar.

4. To acquire a scan for this patient, click Acquire.
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8.3 Prepare the Patient

8.3.1 Dilate the Patient's Eyes (Optional)

NOTE You do not need to dilate the patient's eye(s) for scans using
this instrument.

Pupil size differences can cause variability in how the OCT beam
enters the eye that can influence results for a series of repeated
followup scans.

u If the patient's eye is dilated for their first scan, dilate the
patient's eye for subsequent scans.

The minimum pupil size for the CIRRUS 6000 is 2 mm, which can
usually be achieved without dilation. For optimal repeatability,
image the patient the same way at every visit.

8.4 Scan Selector
The scan selector, shown in the figure below, is used to select the
major options prior to capturing a scan.

The scan selector enables you to select the following buttons:

• Laterality: You can select either OD or OS, and the instrument
adjusts the chinrest and alignment. If you change the Laterality
button, it does not affect any of the other options in the scan
selector.

• Scan Speed: Two speeds are available for scan speed, and they
are 100 kHz and 200 kHz. Some scans, such as the Angio 3mm
x 3 mm are Dual-Speed (DS) so either speed can be selected,
but both buttons cannot be selected at the same time. Other
scans, however, are only available as 100 kHz or 200 kHz. Any
scan not available for a certain speed is greyed out and you
cannot select it.

• Scan Type: Five types are available for scan type, and they are:
Angio, Raster, Cube, ONH, and Montage. When you click on a
scan type, the scan details displayed below it change for that
type. The scan details appropriate for the scan types are listed
in the table below:

– Angio: 3 x 3 mm, 6 x 6 mm, 9 x 9 mm, 12 x 12 mm, 15 x 9
mm, HD 12 x 12 mm

– Raster: 51 Line (6 x 6 mm), 51 Line (12 x 12 mm), HD
Spotlight 1, UHD Spotlight 1

– Cube: 512 x 512, 800 x 800, 1024 x 1024

– ONH: 6 x 6 mm

– Montage: 12 x 12 mm, 15 x 9 mm
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• Scan History Lists: After capturing a scan, that scan and
previous ones of that type from the current session appear in
the Scan History list for the particular eye you scanned (OD/OS).
The list provides information about the scan type, its speed, and
how many scans were captured of that type. For example, if
two Angio (3 x 3 mm) scans were taken at a speed of 200 kHz,
the entry in the list would appear as follows: 2 Angio (3 x 3
mm)(200 kHz).

When you navigate to the Acquisition screen in CIRRUS 6000, the
default settings for the scan selector display as follows:

Scan Default

• Laterality: OD

• Scan Speed: 200 kHz

• Scan Type: Angio

• Scan Detail: None

8.4.1 Selecting a Scan with the Scan Selector
Action 1. Select the Laterality button for the eye you want to scan.

2. Select the scan speed you want to use for the scan type. If the
scan type is available for the speed, the buttons are available.
Otherwise, the Scan Type buttons are greyed out.

3. Select the available Scan Type button and Scan Details
button you want to use. If the scan details are available for the
speed, the buttons are available. Otherwise, the Scan Details
buttons are greyed out.

8.5 Scan Types
CIRRUS™ HD-OCT  software provides a variety of scan types for
in‑depth analysis of ocular features and possible abnormalities. The
three categories of scan types are:

• Posterior Segment Scans

• OCT Angiography Scans

• Anterior Segment Scans

Symbols for Scans and Analyses

The following lists include CIRRUS™ HD-OCT scans and analyses
using the following symbols:

 Indicates optional features; license may be required.

 Requires (or best with) image of both eyes.

 Requires (or best with) both Macular Cube and Optic Disc
Cube images.
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Macular

Scan Pattern Scan Analyses

512 x 128
200 x 200

• Macular Thickness

• Macular Thickness OU 

• Macular Change

• Advanced RPE

• Wellness Exam 

• Panomap 

• Advanced Visualization

• En Face

• 3D Visualization

• Ganglion Cell OU 

• Ganglion Cell Guided Progression (Extrapolate Progression )

• Single Eye Summary 

Table 25: Macular Cube Scans

Optic Disc

Scan Pattern Scan Analyses

200 x 200 • ONH/RNFL OU 

• Guided Progression (Extrapolate Progression )

• Advanced Visualization

• En Face

• 3D Visualization

• Wellness Exam 

• Panomap 

• Single Eye Summary 

Table 26: Optic Disc Cube Scan
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HD Raster (Including Smart Scans)

Scan Pattern Scan Analyses

HD 1 Line 100X High Definition Images

HD 5 Line

HD Radial

HD 21 Line

HD Cross

Table 27: HD Raster Scans (Includes Smart HD Scans)

AngioPlex

Scan Pattern Scan Analyses

3mm x 3mm • Angiography

• Angiography Change

• En Face

HD 6mm x 6mm 

6mm x 6mm 

HD 8mm x 8mm 

8mm x 8mm 

12mm x 12mm 

Table 28: Angiography Scans
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AngioPlex ONH

Scan Pattern Scan Analyses

4.5mm x 4.5mm • ONH Angiography

• ONH Angiography Change

• En Face

Table 29: AngioPlex ONH Scans

AngioPlex Montage

Scan Pattern Scan Analyses

6mm x 6mm Montage Angiography

8mm x 8mm 

Table 30: AngioPlex Montage Scans

Many anterior segment scans are optional (see: About Licenses
[} 61]).

Scan Pattern External Lens Scan Analysis

Anterior Segment Scans

- Anterior Segment Cube • Anterior Segment Analysis

• 3D Visualization

- Anterior Segment 5 Line Raster High Definition Images
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Scan Pattern External Lens Scan Analysis

- HD Angle HD Angle Analysis

Anterior Chamber Anterior Chamber Analysis

Wide Angle-to-Angle Wide Angle-to-Angle Analysis

HD Cornea HD Cornea Analysis

Pachymetry Pachymetry Analysis

Table 31: Anterior Segment Scans

8.6 Acquire Posterior Segment Overview

1

2 3

4 5

6

7

Figure 22: Acquire Screen

# Symbol Name Explanation

1 Protocols Selects a protocol (see: About Protocols [} 145]).

2 Scan Selector Selects OD scan type.

3 Selects OS scan type.
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# Symbol Name Explanation

4 Iris Viewport Displays the live image of the iris.

Pupil Target Indicates the pupil center alignment.

Brightness and Contrast Opens brightness and contrast adjustment controls.

Reset Resets your adjustments of the iris image.

Chinrest Controls Circular controls adjust the patient chinrest up, down, right
or left.

Left arrow moves chinrest toward patient.

Right arrow moves chinrest toward device.

5 B-scans Displays the live B-scan images.

Enhance Button automatically adjusts polarization of the live B-scan
images.

Arrows adjust polarization manually.

Center Button automatically centers the live B-scan images.

Arrows adjust centering manually.
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# Symbol Name Explanation

6 Identifies Selected Prior
Scan

Replicates the settings of a prior scan (to compare same
scans of the same eye using the same settings).

Fundus Viewport Displays the live image and scan pattern.

Fixation Target Displays the location of the fixation target.

Auto Focus Automatically focuses the live scan.

Manual focus Focus slider or arrows adjust focus manually.

Transparency Controls the opacity of the overlay.

Reset Scan Pattern Returns the scan pattern to its default position.

Reset Fixation Target Returns the fixation target to the center.

EDI Inverts the OCT signal profile so the strong part of the
signal is at the bottom of the B-scan.

7 Optimize Automatically centers and enhances the B-scan.

Capture Captures the scan.

FastTrac Indicates whether FastTrac is on or off.

Help Displays tips for acquiring the best scan.

Track to Prior Sets tracking to align and track the scan at the same
location on the retina as the selected prior scan.
NOTE! Tracking to prior automatically enables
FastTrac.

8.7 About Acquiring Scans
It typically takes several minutes per eye to acquire scans. In
general, the steps to acquire a scan are:
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1. Select the patient.

2. Click Acquire.

2

1

3. Select the scan.

3

4. Clean the chinrest and position the patient; raise or
lower the table, if required.

4

5. Move the Chinrest controls until the iris is aligned
and focused.

• Move the chinrest closer or farther from the
instrument as needed (right and left arrows).

• Move the chinrest right, left, up, and down as
needed (circle controls).

6. Click on the center of the pupil.
The red target is centered on the iris.

5

6

7. Click Auto Focus 
The fundus image focuses.

7

8. Click Optimize.
The B-scans align and focus.

8



8 Operation Instructions for Use
CIRRUS™ HD-OCT8.7 About Acquiring Scans

144 / 542 2660021174149 Rev. D 2019-10

9. Click Capture.

9

10.Check scan quality.

Table 32: Acquire Overview

Specific steps vary by the type of scan.

• Acquire Posterior Segment Scans [} 148]

– Macular Cube Scans [} 150]

– Optic Disc Cube Scans [} 153]

– HD Raster Scans [} 159]

– Angiography Cube Scans

– HD Angiography Scans

– ONH Angiography Scans

– Montage AngioPlex Scans [} 171]

• Acquire Anterior Segment Scans [} 179]

– Anterior Chamber Scans [} 184]

– HD Angle Scans [} 194]

– Wide Angle to Angle Scans [} 197]

– Anterior Segment 5-Line Raster Scans [} 191]

– HD Cornea Scans

– Pachymetry Scans
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8.7.1 About Protocols
A Protocol is a group of suggested scans for a particular purpose.
You can access protocols at the top of any Acquire page.

Figure 23: Protocol Overview

The protocol list only displays scans with an active license for the
instrument (see: About Licenses [} 61]).

Protocol OD / OS

Shows all scans available on the instrument.

(if this is a followup visit)

Selects the same set of images as the patient's last visit. 

• Macular Cube 512x128

•  AngioPlex 3x3 mm

•  HD AngioPlex 6x6 mm

•  HD AngioPlex 8x8 mm

•  AngioPlex 12x12 mm

•  Montage AngioPlex 6x6 mm

•  Montage AngioPlex 8x8 mm

• HD 1 Line 100x

• HD 21 Line

• HD Radial

• HD Cross

• 5 Line Raster

• Macular Cube 200x200
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Protocol OD / OS

•  AngioPlex 3x3 mm

•  HD AngioPlex 6x6 mm

•  HD AngioPlex 8x8 mm

•  AngioPlex 12x12 mm

•  Montage AngioPlex 6x6 mm

•  Montage AngioPlex 8x8 mm

•  ONH Angiography 4.5x4.5 mm

• Optic Disc Cube 200x200

•  ONH Angiography 4.5x4.5 mm

• Macular Cube 512x128

• Macular Cube 200x200

• HD Angle

• Anterior Segment 5 Line Raster

• Anterior Segment Cube 512x128

• HD Cornea

•  Pachymetry

• Anterior Chamber

• Wide Angle to Angle

• Macular Cube 512x128

• Optic Disc Cube 200x200

Table 33: Protocols

 Indicates optional features; license may be required.
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Protocol Page
Tip: The protocol page is a quick
way to view a patient's scan
history; it lists each visit and all
images acquired during each visit.

The Protocol page lists a patient's scan history, shows what scans
are available for each protocol, and allows you to select a protocol
for acquisition.

8.8 View Protocols
Access the Protocols page to see a list of the patient's prior scans,
view which scans are available in each protocol, and select a
protocol for acquisition.

To view protocols:

Prerequisite þ Log In as Operator or Data Analyst [} 123].

Action 1. Select the Patient [} 124].

2. Click Protocols.

3. Select a Protocol and click Acquire.

Result ü The Acquire screen opens with the protocol scans
selected.
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8.9 Acquire an Image Protocol
This procedure describes how to use the Protocol feature to filter
the scan list for a particular purpose. For instructions on acquiring a
scan, refer to acquisition instructions for the type of scan you are
acquiring.

The Protocol list filters the scans for a particular purpose, but there
might be more scans listed than you need to acquire.

To acquire an image protocol:

Action 1. Select the Patient [} 124].

2. Prepare the Patient [} 135]

3. Click Acquire.

4. Select a Protocol.

ð The scan lists filters the scans to show only scans for the
selected protocol.

5. Acquire the scans you need for analysis (see acquisition instruc-
tions for each type of scan).

8.10 Acquire Posterior Segment Scans
Tip: To see details better in high-
resolution images, switch to
grayscale (see: View Color or
Grayscale Image [} 375]).

Posterior segment scans provide detailed views of the patient's
retinal micro-structure.

• Macular Cube Scans [} 149] provide a three-dimensional image
of the macula.

• Optic Disc Scans [} 153] provide a three-dimensional image of
the optic nerve head.

• HD raster scans [} 156] offer a variety of different patterns that
provide two-dimensional details focused on specific areas or
structures.

• Angiography [} 163] scans provide visualization and
measurement of vascular structures of the retina and choroid.
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8.10.1 Macular Cube Scans
Macular scans generate a cube of data through a 6 mm square grid
with a central horizontal HD B-scan. 

Figure 24: Macular Scan Pattern

Tip: If it is difficult to center or see
the fovea (extreme edema,
cataract, or floaters impede the
view), center the circle on the optic
disc instead.

The Macular Cube scan pattern has a square that indicates the
scan area and the lines cross in the center where you align the
fovea.

You can also place the yellow circle over the optic disc, and the
fovea is centered within 1 mm for most patients.

You can use macular scans to analyze:

• Macular layer thicknesses

• Macular change

• Ganglions cells / IPL

• RPE elevation details

• A 3-dimensional view of the macula

Scans Horizontal Lines A-Scans / Line Description

200 x 200 200 200 Provides higher resolution vertically, but lower
resolution along each horizontal line.

512 x 128 128 512 Provides higher resolution along each horizontal line,
but lower resolution vertically.

Table 34: Macular Cube Scans
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8.10.1.1 Acquire a Macular Cube Scan

Figure 25: Macular Cube Scan

To acquire a macular cube scan:

Action 1. Select the Patient [} 124].

2. Prepare the Patient [} 135]

3. Under the appropriate eye (OD or OS), select Macular Cube
512x128 or  Macular Cube 200x200.

4. Align and Focus the Iris Image [} 214].

5. Ask the patient to hold their gaze steady and click Auto Focus.

ð The chinrest moves into place as the CIRRUS 6000
automatically corrects for the patient's refraction error and
balances fundus brightness and contrast.

6. To change the position of the scan or fixation target, see:
Select an Internal Fixation Target.

7. To manually focus the image, see: Focus the Fundus Image
[} 209].
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8. To manually adjust brightness or contrast, click brightness and
contrast adjustment tool.

9. Click Optimize.

ð CIRRUS 6000 automatically centers and optimizes B-Scan
settings. You can fine-tune these settings manually.

10. To fine-tune B-Scan image quality and centering, see: Manually
Enhance B-Scans [} 211].

11. To use automatic eye tracking, Turn FastTrac™ On [} 219]. 
NOTE! Once you turn FastTrac on, do not make further
scan adjustments. If you need to make additional adjust-
ments, turn off FastTrac, make adjustments, and turn
FastTrac on again.

12. Ask the patient to blink, then open their eyes wide.

13. Click Capture.

ð The Quality Check screen opens.

14. Check Macular Cube Scan Quality [} 151].

8.10.1.2 Check Macular Cube Scan Quality

When you save a macular cube scan, you can add a Smart HD
Scan  for the image. The Smart HD Scan  you save is the high-
definition image that doctors can select when they analyze the
scan.

For the Smart HD Scan , you can use the fovea location that
CIRRUS™ HD-OCT detects automatically or you can select any
other cube slice by navigating the cube data (see: Navigate Cube
Layers Manually [} 226]).

1

5

2

3

4

6

7

8
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1 Iris Image 2 Signal Strength

Fundus Image Rating

Tracking

Tracked to Prior

3 Fundus Image 4 B-Scan Images

5 Fundus Overlay 6 Fundus Overlay Trans-
parency

7 Try Again 8 Save

To check Macular Cube scan quality:

Prerequisite þ Acquire a Macular Cube Scan [} 150]

Action 1. Ensure that the target is centered on the pupil.

2. Ensure that light intensity is uniform across the image.

3. To view a full-screen version of an image, double-click on the
image.

4. If FastTrac is on, ensure that Tracked during scan is green
(successful) and the Fundus Image rating is 6 or higher.

ð A rating of 6 or higher is needed to reuse the scan settings
in the future (see: About Track to Prior [} 220]).

5. If this scan is tracked to a prior scan, ensure that it tracked scan
successfully. (Tracked to prior is marked green.)

6. If the fundus scan has an overlay, adjust the transparency of
the overlay.

7. Ensure that the fundus image is sharp and clear with good
visibility of the branching blood vessels.

8. Ensure that the color density is the same across the image.

9. Ensure that there are few or no artifacts cast shadows on the
OCT scan.

10. Ensure that the scan is complete in all windows (no missing
data).

11. If the scan is not acceptable, click Try Again and retake the
scan.

12. To select a slice for the Smart HD scan, navigate through the
slices until you find the slice you want to use (see to: Navigate
Cube Layers Manually [} 226]) and click Save and Add Smart
HD Scan.

13. To save the scan without an HD image, click Save.
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8.10.2 Optic Disc Scans
Optic Disc scans capture an image of the ONH. These scans
generate a cube of data through a 6 mm square grid with a central
horizontal HD B-scan.  

The fixation target is offset to center the optic nerve in the scan.
Concentric rings shown in the viewport help you align the optic
disc.

Figure 26: Optic Disc Scan Pattern

You can use ONH Cube Scans to:

• Measure RNFL thickness

• Observe RNFL progression

• Measure ONH parameters

Optic Disc Cube Scan Horizontal Lines A-Scans per Line

200 x 200 200 200

Table 35: ONH Cube Scan

8.10.2.1 Acquire an Optic Disc Cube Scan

NOTE You can select a different fixation target, but consider using
a fixation target near the center.
Optic disc detection works best when the optic disc is close
to the center of the image.

To acquire an optic disc cube scan:

Action 1. Select the Patient [} 124].
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2. Prepare the Patient [} 135]

3. Under the appropriate eye (OD or OS), select Optic Disc Cube
200x200 .

4. Align and Focus the Iris Image [} 214].

5. Ask the patient to hold their gaze steady and click Auto Focus.

ð The chinrest moves into place as the CIRRUS 6000
automatically corrects for the patient's refraction error and
balances fundus brightness and contrast.

6. To manually focus the image, see: Focus the Fundus Image
[} 209].

7. To change the position of the scan or fixation target, see:
Select an Internal Fixation Target.

8. Click Optimize.

ð CIRRUS 6000 automatically centers and optimizes B-Scan
settings. You can fine-tune these settings manually.

9. To fine-tune B-Scan image quality and centering, see: Manually
Enhance B-Scans [} 211].

10. To adjust the brightness or contrast of a b-scan image, see: Edit
Images (Hover Over) [} 370]

11. To use automatic eye tracking, Turn FastTrac™ On [} 219]. 
NOTE! Once you turn FastTrac on, do not make further
scan adjustments. If you need to make additional adjust-
ments, turn off FastTrac, make adjustments, and turn
FastTrac on again.

12. Ask the patient to blink, then open their eyes wide.

13. Click Capture.

ð The Quality Check screen opens.

8.10.2.2 Check Optic Disc Cube Scan Quality

To check optic disc scan quality:

Prerequisite þ Acquire Data (Scan).

Action 1. Ensure that the target is centered on the pupil.
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2. To view a sequence of cube slices as a movie, use the movie
controls.

3. Ensure that light intensity is uniform across the image.

4. To view a full-screen version of an image, double-click on the
image.

5. Ensure that the fundus image focus is sharp and clear with
good visibility of the branching blood vessels and that the
lighting is uniform across the image.

6. Ensure that the scan overlaying the Fundus image is centered
over the area to be analyzed. 

7. Ensure that the scan is complete in all windows (no missing
data).

8. If the scan is not acceptable, click Try Again and retake the
scan.

9. Click Save.
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8.10.3 HD Raster Scans
Different scan patterns help you spotlight an area of interest. You
can reposition, stretch, and rotate patterns to capture the size and
shape of the area you want to spotlight.

Pattern B-Scans Adjustments

HD 5-Line Raster Scan

Averaging per line: 5

A-scans per B-scan: 1024

• Length: 3mm, 6mm or 9mm

• Placement:  Any fundus location

• Rotation: -89° to 90°

• Spacing: 0 to 0.4mm (in increments of 0.025
mm)

HD 1-Line Raster Scan

Averaging per line: 100

A-scans: 1024

• Length: 3mm, 6mm, 9mm or 12mm

• Placement:  Any fundus location

• Rotation: -89° to 90°

HD 21-Line Raster Scan

Averaging per line: 8

A-scans: 1024

• Length: 3mm, 6mm or 9mm

• Placement:  Any fundus location

• Rotation: -89° to 90°

• Spacing: 0 to 0.4mm (in increments of 0.025
mm)

HD Cross (5 horizontal & 5 vertical
lines)

Averaging per line: 8

A-scans: 1024

• Length: 3mm or 6mm

• Placement:  Any fundus location

• Rotation: -89° to 90°

• Spacing: 0 to 1.5mm (in increments of 0.025
mm) between lines

HD Radial Scan (12 radial lines)

Averaging per line: 8

A-scans: 1024

• Length: 3mm or 6mm

• Placement:  Any fundus location

Table 36: Posterior Segment HD Scan Types and Patterns

8.10.3.1 About Enhanced Depth Imaging

CIRRUS™ HD-OCT optimizes the signal in the top portion of the
scan, which is the best option for most types of scans. However;
for some types of Raster Scans, you might want to optimize a
different area of the scan.

Enhanced Depth Imaging (EDI) improves image quality at the
bottom of B-scans.

8.10.3.2 Adjusting HD Raster Scan Patterns

Scan patterns overlay the fundus image when you are preparing to
acquire a scan. Most types of scans allow you to relocate the scan
pattern within the live fundus preview.
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Scan patterns help you center or place the scan in the location that
obtains the best image of a particular area of interest for the
patient's eye. 

8.10.3.2.1 Customize Raster Scan Patterns (Drag)

You can rotate, stretch, or shrink scan patterns-- or create a custom
scan pattern-- so you acquire the optimal area for each patient's
eyes.

Original Adjustment Example 1 Adjustment Example 2

Adjust Line Length

Rotate Scan Pattern

Adjust Line Spacing

You can customize scan patterns by dragging, pulling, or rotating
the scan pattern that overlays the fundus image. The line length,
spacing between lines, and rotation angle displays to show the
measurements.

Figure 27: Adjust Scan Pattern
Overlaying the Fundus Image

You can also click Custom to open the Custom Scan Pattern tool
and change the measurements numerically.

Adjustments apply to all lines. For example, if you are acquiring a 5-
Line raster scan and you rotate the scan pattern, all five lines rotate
as a block. You cannot rotate each line independently.

If you increase the distance between lines, the spacing between all
lines increases. You cannot change the distance between particular
lines of the scan pattern.

To adjust the scan pattern:

Prerequisite þ You are acquiring a scan and reached the step: Customize a
Raster Scan Pattern.
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Action 1. Mouse over the scan pattern that overlays the fundus image.

ð A set of blue adjustment bars and magenta rotation tools
for the scan pattern open and the mouse pointer becomes
a hand icon.

2. To lengthen the lines, drag a horizontal adjustment bar out.

3. To shorten the lines, drag a horizontal adjustment bar in.

4. To increase the spacing between lines, drag a vertical
adjustment bar out.

5. To decrease the spacing between lines, drag a vertical
adjustment bar in.

6. To rotate the scan pattern, drag a rotation tool to a different
angle.

7. To reset the scan pattern to its original settings, click Reset
Scan Pattern.

8. Complete the remaining steps of the acquire procedure.

8.10.3.2.2 Customize Raster Scan Patterns (Numeric)

To adjust the scan pattern using the Custom tool:

Prerequisite þ You are acquiring a scan and reached the step: Customize a
Raster Scan Pattern.

Action

1. Click Custom.

ð The Custom Scan Pattern tool opens.

2. To rotate the scan pattern: for Rotation, type a value between
0 (horizontal) and 360 that corresponds with the rotation angle
you want to set.
Values entered from 91 to 269 are automatically transposed
180 degrees to correspond with scan direction.

3. To change the line length: for Length, select the value you
want to set.

ð Depending on the scan, you can select 3, 6, or 9 mm.

4. To change the spacing between lines: for Spacing, select an
available value.

ð Depending on the scan, you can select a value between
0.00 and 1.25 mm in increments of 0.025 mm.

5. To reset the scan pattern to its original settings, click Reset.

6. Click Close.

7. Complete the remaining steps of the acquire procedure.



Instructions for Use 8 Operation
CIRRUS™ HD-OCT 8.10 Acquire Posterior Segment Scans

2660021174149 Rev. D 2019-10 159 / 542

8.10.3.3 Acquire an HD Raster Scan

NOTE Make sure that the B-scan images are not too high in the
viewport.

u If a B-scan image is too high, it can reflect a mirror image that
makes the image appear inverted.

If this is a followup visit and you want to replicate the settings of
an earlier scan, refer to: Repeating a Prior Scan (Track to Prior).

You can switch from a 5-Line HD Raster scan to a 1-Line HD
Raster scan using the toggle button.

Tip: For HD 5-Line and HD 1-Line
scans, position the scan pattern
before you toggle between 1-Line
and 5-Line.

To acquire an HD raster scan:

Action 1. Select the Patient [} 124].

2. Prepare the Patient [} 135]

3. Choose an HD Raster scan pattern (see: About HD Raster
Scans).

4. Under the appropriate eye (OD or OS), select HD 1 Line 100x,
HD 21 Line, HD Radial, HD Cross, or HD Raster (1 or 5
Line).

5. Align and Focus the Iris Image [} 214].

6. To adjust the scan pattern, refer to: Adjusting HD Raster Scan
Patterns [} 156]

7. If you selected HD Raster (1 or 5 Line), click Toggle to switch
between the 1-Line pattern and the 5-Line pattern.

ð If you adjust the 1-Line Raster scan pattern, the toggle
button becomes disabled.
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8. To enable EDI, check EDI.

ð EDI optimizes the signal in the lower portion of the scan.

9. Ask the patient to hold their gaze steady and click Auto Focus.

ð The chinrest moves into place as the CIRRUS 6000
automatically corrects for the patient's refraction error and
balances fundus brightness and contrast.

10. To manually focus the image, see: Focus the Fundus Image
[} 209].

11. Click Optimize.

ð CIRRUS 6000 automatically centers and optimizes B-Scan
settings. You can fine-tune these settings manually.

12. To fine-tune B-Scan image quality and centering, see: Manually
Enhance B-Scans [} 211].

13. Ensure that the live Iris, Fundus, and B-scan images are all
properly focused and aligned.

14. Ask the patient to blink, then open their eyes wide.

15. Click Capture.

ð The Quality Check screen opens.

16. Check HD Raster Scan Quality [} 161]
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8.10.3.4 Check HD Raster Scan Quality
Tip: To see more detail in high-
resolution images, switch to black-
and-white mode (hover over the
image and click the color button:

Figure 28: Quality Check for HD Raster 21-Line

To check HD Raster scan quality:

Prerequisite þ Acquire an HD Raster Scan [} 159]

Action

1. Ensure that the target is centered on the pupil.

ð The green arrow shows the iris target placed over the
pupil.

2. Ensure that the Signal Strength is 6 or higher.

3. If FastTrac is on, ensure that Tracked during scan is green
(successful) and the Fundus Image rating is 6 or higher.

ð A rating of 6 or higher is needed to reuse the scan settings
in the future (see: About Track to Prior [} 220]).
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4. Ensure that the fundus image focus is sharp and clear with
good visibility of the branching blood vessels and that the
lighting is uniform across the image.

ð The green arrow shows a good-quality fundus image.

5. To view a full-screen version of an image, double-click on the
image.

6. To adjust the brightness or contrast of the fundus image, hover
over the fundus image and select the Brightness or Contrast
tool (see:Edit Images (Hover Over) [} 370]).

7. Ensure that the B-scan(s) are centered.

ð The green arrows show a centered B-scan.

8. If the scan is not acceptable, click Try Again and retake the
scan.

ð See: Acquire an HD Raster Scan [} 159]

9. Click Save.
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8.11 Acquire AngioPlex Scans
AngioPlex OCT Angiography scans capture high quality images
of the retinal and choroidal vasculature. 

High-definition (HD) 6x6 mm and 8x8 mm scans provide very high
quality images, and the 12x12 mm scan offers the widest field of
view in a single scan.

There are three types of AngioPlex scans:

• AngioPlex Macular scans acquire a cube of data centered on
the fovea.

• AngioPlex ONH scans acquire a cube of data centered on the
optic nerve head.

• AngioPlex Montage scans acquire multiple images from
different areas and merge them into one larger, combined
image.

AngioPlex AngioPlex ONH AngioPlex Montage

Table 37: AngioPlex Scans

To image vascular flow, each AngioPlex scans acquire repeated,
consecutive B-scans, then compares them. Erythrocyte motion
shows areas of contrast changes over time in a particular location,
which indicates the location of a vessel.

8.11.1 Acquire an OCT Angiography Scan

NOTE AngioPlex OCT Angiography is not a substitute for
fluorescein angiography.

u Vascular findings with fluorescein angiography may be absent
or poorly defined with OCT angiography.

u OCT angiography does not feature leakage, staining, and
pooling.

For the best results, acquire OCT Angiography scans with FastTrac
turned on (see About FastTrac™ [} 217]).

You can choose from the following OCT Angiography scan sizes: 
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• 3x3 mm

• 6x6 mm

• HD 6x6 mm

• 8x8 mm

• HD 8x8 mm

• 12x12 mm

To acquire an OCT angiography cube scan:

Action 1. Select the Patient [} 124].

2. Prepare the Patient [} 135]

3. Scan Types [} 136] (if needed).

4. Align and Focus the Iris Image [} 214].

5. Ask the patient to hold their gaze steady and click Auto Focus.

ð The chinrest moves into place as the CIRRUS 6000
automatically corrects for the patient's refraction error and
balances fundus brightness and contrast.

6. To manually focus the image, see: Focus the Fundus Image
[} 209].

7. To change the position of the scan or fixation target, see:
Select an Internal Fixation Target.

8. Click Optimize.

ð CIRRUS 6000 automatically centers and optimizes B-Scan
settings. You can fine-tune these settings manually.

ð NOTE! Auto-centering moves the OCT B-scan higher in
the imaging window to maximize signal strength.

9. Confirm that the B-scan remains within the imaging window
approximately 100 µm below the top of the scan.

ð If tracking is on, the B-scan might shift upwards.

10. If the B-scan shifts upwards, reposition the B-scan to approxi-
mately 100 µm below the top.

11. To fine-tune B-Scan image quality and centering, see: Manually
Enhance B-Scans [} 211].

12. Turn FastTrac™ On [} 219]. NOTE! Once you turn FastTrac
on, you cannot make further scan adjustments. If you
need to make additional adjustments, turn off FastTrac,
make adjustments, and turn FastTrac on again.

13. Ask the patient to blink, then open their eyes wide.
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14. Click Capture.

ð The Quality Check screen opens.

15. Ask the patient to sit back.

16. Check AngioPlex Cube Scan Quality [} 165]

8.11.2 Check AngioPlex Cube Scan Quality

To check angiography cube scan quality:

Prerequisite þ Acquire an OCT Angiography Scan [} 163]

Action

1. Ensure that the target is centered on the pupil.

2. Ensure that the Signal Strength is 6 or higher.

3. Ensure that light intensity is uniform across the image.

4. Ensure that the fundus image is sharp and clear with good
visibility of the branching blood vessels.

5. If the fundus scan has an overlay, adjust the transparency of
the overlay.

6. To adjust the brightness or contrast of the fundus image, hover
over the fundus image and select the Brightness or Contrast
tool (see:Edit Images (Hover Over) [} 370]).

7. Ensure that there are few or no artifacts cast shadows on the
OCT scan.

8. Ensure that there are few or no saccades in the area to be
analyzed. 
Saccades appear as discontinuities of the blood vessels
(horizontal shifts of the vessel):

9. Ensure that the scan is complete in all windows (no missing
data).

10. Scan passes: RPE Acceptance Criteria [} 228]. 
Retina is not too low in the scan, which impacts sub-RPE slice
detection.

11. Scan passes: Signal Quality Acceptance Criteria [} 228].
Signal strength is 6 or higher; shadows and dark spots exhibit
floaters or disease.

12. Scan passes: Decorrelation Tails Acceptance Criteria [} 229].
Scan shows accurate motion, no decorrelation tails, no vascu-
lature in the RPE layer, and superficial and deep retinal layers
look appropriately different.
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13. Scan passes: Segmentation Acceptance Criteria [} 230].
Presence or absence of flow appears in layers as appropriate.

14. If the scan is not acceptable, click Try Again and retake the
scan.

15. Click Save.
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8.11.3 Acquire ONH AngioPlex Scans

8.11.3.1 Acquire ONH AngioPlex Overview

1

2 3

4 5

6

7

Figure 29: Acquire ONH AngioPlex Overview

# Symbol Name Explanation

1 Protocols Selects a protocol (see: About Protocols [} 145]).

2 Scan Selector Selects OD scan type.

3 Selects OS scan type.

4 Iris Viewport Displays the live image of the iris.

Pupil Target Indicates the pupil center alignment.

Brightness and Contrast Opens brightness and contrast adjustment controls.

Reset Resets your adjustments of the iris image.

Chinrest Controls Circular controls adjust the patient chinrest up, down, right
or left.

Left arrow moves chinrest toward patient.

Right arrow moves chinrest toward device.
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# Symbol Name Explanation

5 B-scans Displays the live B-scan images.

Enhance Button automatically adjusts polarization of the live B-scan
images.

Arrows adjust polarization manually.

Center Button automatically centers the live B-scan images.

Arrows adjust centering manually.

6 Identifies Selected Prior
Scan

Replicates the settings of a prior scan (to compare same
scans of the same eye using the same settings).

Fundus Viewport Displays the live image and scan pattern.

Fixation Target Displays the location of the fixation target.

Auto Focus Automatically focuses the live scan.

Manual focus Focus slider or arrows adjust focus manually.

Transparency Controls the opacity of the overlay.

Reset Scan Pattern Returns the scan pattern to its default position.

Reset Fixation Target Returns the fixation target to the center.

EDI Inverts the OCT signal profile so the strong part of the
signal is at the bottom of the B-scan.
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# Symbol Name Explanation

7 Optimize Automatically centers and enhances the B-scan.

Capture Captures the scan.

FastTrac Indicates whether FastTrac is on or off.

Help Displays tips for acquiring the best scan.

Track to Prior Sets tracking to align and track the scan at the same
location on the retina as the selected prior scan.
NOTE! Tracking to prior automatically enables
FastTrac.

8.11.3.2 Acquire an AngioPlex ONH Scan

AngioPlex ONH scans helps you make vascular assessments of the
optic nerve.

To acquire an AngioPlex ONH scan:

Action 1. Select the Patient [} 124].

2. Prepare the Patient [} 135]

3. Select the ONH Angio scan for the appropriate eye.

4. Align and Focus the Iris Image [} 214].

5. Ask the patient to hold their gaze steady and click Auto Focus.

ð The chinrest moves into place as the CIRRUS 6000
automatically corrects for the patient's refraction error and
balances fundus brightness and contrast.

6. To manually focus the image, see: Focus the Fundus Image
[} 209].

7. To change the position of the scan or fixation target, see:
Select an Internal Fixation Target.

8. Click Optimize.

ð CIRRUS 6000 automatically centers and optimizes B-Scan
settings. You can fine-tune these settings manually.

9. To fine-tune B-Scan image quality and centering, see: Manually
Enhance B-Scans [} 211].
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10. To use automatic eye tracking, Turn FastTrac™ On [} 219]. 
NOTE! Once you turn FastTrac on, do not make further
scan adjustments. If you need to make additional adjust-
ments, turn off FastTrac, make adjustments, and turn
FastTrac on again.

11. Ask the patient to blink, then open their eyes wide.

12. Click Capture.

ð The Quality Check screen opens.

13. Ask the patient to sit back.

14. Check ONH Angiography Scan Quality [} 170].

8.11.3.3 Check ONH Angiography Scan Quality

NOTE Check scans quality carefully to ensure appropriate criteria
for accurate disease diagnosis.

u If there are any questions regarding scan quality, rescan the
image.

To check ONH Angiography scan quality:

Prerequisite þ Acquire an AngioPlex ONH Scan [} 169]

Action 1. Ensure that the target is centered on the pupil.

2. Ensure that light intensity is uniform across the image.

3. Ensure that the fundus image is sharp and clear with good
visibility of the branching blood vessels.

4. If the fundus scan has an overlay, adjust the transparency of
the overlay.

5. To adjust the brightness or contrast of the fundus image, hover
over the fundus image and select the Brightness or Contrast
tool (see:Edit Images (Hover Over) [} 370]).

6. Ensure that there are few or no artifacts cast shadows on the
OCT scan.

7. Ensure that the scan is complete in all windows (no missing
data).

8. Ensure that the Signal Strength is 6 or higher.

9. Ensure that the scan passes all acceptance criteria (refer to the
Instructions for Use).

10. If the scan is not acceptable, click Try Again and retake the
scan.

11. Click Save.
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8.11.4 Acquire AngioPlex Montage Scans
AngioPlex Montage scans take a series of scans of an eye from
different positions and fixation locations, then joins them together
showing larger area of the retina.

Figure 30: AngioPlex Montage

You can acquire all scans in the sequence or skip of the scans that
you do not want to include in the montage.

6 x 6 mm Montage 8 x 8 mm Montage

2 13

4 5 6

This scan acquires six images at
different positions (four different
fixation targets) in the following
sequence:

1. Superior Nasal (SN)

2. Superior (S)

3. Superior Temporal (ST)

4. Inferior Temporal (IT)

5. Inferior (I)

6. Inferior Nasal (IN)

2

1

3

4 5

This scan acquires five images at
different positions (five different
fixation targets) in the following
sequence:

1. Central (C)

2. Superior Nasal (SN)

3. Superior Temporal (ST)

4. Inferior Temporal (IT)

5. Inferior Nasal (IN)

Table 38: Montage AngioPlex Scans
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8.11.4.1 Acquire Montage Overview

1

2 3

4

5

6

7

8

Figure 31: Acquire AngioPlex Montage Overview

# Symbol Name Explanation

1 Protocols Selects a protocol (see: About Protocols [} 145]).

2 Scan Selector Selects OD scan type.

3 Selects OS scan type.

4 Iris Viewport Displays the live image of the iris.

Pupil Target Indicates the pupil center alignment.

Brightness and Contrast Opens brightness and contrast adjustment controls.

Reset Resets your adjustments of the iris image.

Chinrest Controls Circular controls adjust the patient chinrest up, down, right
or left.

Left arrow moves chinrest toward patient.

Right arrow moves chinrest toward device.
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# Symbol Name Explanation

5 B-scans Displays the live B-scan images.

Enhance Button automatically adjusts polarization of the live B-scan
images.

Arrows adjust polarization manually.

Center Button automatically centers the live B-scan images.

Arrows adjust centering manually.

6 Identifies Selected Prior
Scan

Replicates the settings of a prior scan (to compare same
scans of the same eye using the same settings).

Fundus Viewport Displays the live image and scan pattern.

Fixation Target Displays the location of the fixation target.

Auto Focus Automatically focuses the live scan.

Manual focus Focus slider or arrows adjust focus manually.

Transparency Controls the opacity of the overlay.

Reset Scan Pattern Returns the scan pattern to its default position.

Reset Fixation Target Returns the fixation target to the center.

EDI Inverts the OCT signal profile so the strong part of the
signal is at the bottom of the B-scan.
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# Symbol Name Explanation

7 Optimize Automatically centers and enhances the B-scan.

Capture Captures the scan.

FastTrac Indicates whether FastTrac is on or off.

Help Displays tips for acquiring the best scan.

Track to Prior Sets tracking to align and track the scan at the same
location on the retina as the selected prior scan.
NOTE! Tracking to prior automatically enables
FastTrac.

8 Scan Positions

(6mm x 6mm)

Preset positions for each of the five component scans that
are stitched together to create a 14 mm x 10 mm
montage.

Scan Positions

(8mm x 8mm)

Preset positions for both component scans that are
stitched together to create a 14 mm x 14 mm montage.

Selected Scan Position Indicates which scan will be acquired next (outlined in
blue).

Acquired Scan Indicates which scans were already acquired.

Scan Not Yet Acquired Indicates scans they are not yet acquired.

Retake Scan Allows you to retake a component scan while acquiring
the montage series.

Done Ends the montage series before all component scans are
acquired.
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8.11.4.2 Acquire a Montage AngioPlex Scan

Montage AngioPlex scans increase the Field of View (FOV) by
combining scans to form a montage image. Montage images
provide high-resolution vascular imaging over a larger region of the
retina.

When you acquire a Montage AngioPlex  scan, you first acquire
each component scan in the series, then check the quality of all
component scans that make up the montage image at the same
time.

To acquire a montage AngioPlex scan:

Action 1. Select the Patient [} 124].

2. Prepare the Patient [} 135]

3. Under the appropriate eye (OD or OS), select Montage
Angiography 8x8 mm or  Montage Angiography 6x6 mm.

4. Align and Focus the Iris Image [} 214].

5. To change the position of the scan or fixation target, see:
Select an Internal Fixation Target.

ð The fixation target might look blurry or out of fucus.

6. Ask the patient to hold their gaze steady and click Auto Focus.

ð The chinrest moves into place as the CIRRUS 6000
automatically corrects for the patient's refraction error and
balances fundus brightness and contrast.

7. To manually focus the image, see: Focus the Fundus Image
[} 209].

8. Click Optimize.

ð CIRRUS 6000 automatically centers and optimizes B-Scan
settings. You can fine-tune these settings manually.

9. To fine-tune B-Scan image quality and centering, see: Manually
Enhance B-Scans [} 211].

10. To use automatic eye tracking, Turn FastTrac™ On [} 219]. 
NOTE! Once you turn FastTrac on, do not make further
scan adjustments. If you need to make additional adjust-
ments, turn off FastTrac, make adjustments, and turn
FastTrac on again.

11. Ask the patient to blink, then open their eyes wide.

12. Click Capture.

ð The instrument advances to the next image in the montage
series (outlined in blue).
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13. To acquire the next image in the series, repeat steps 5 - 13
above.

14. To select a different image in the series, click on the position of
the image you want to capture, (the box becomes outlined in
blue) and repeat steps 5 - 13 above.

15. To skip the remaining scans or finish the montage prior to
acquiring all scans, click Done.

16. After the final scan of the series, ask the patient to sit back.

ð The Quality Check screen opens.

17. Check Montage AngioPlex Scan Quality [} 177].

8.11.4.3 Quality Check Screen (Montage)

1

2

3

4

5
6

7

8
9

10

11

Figure 32: Angiography Montage Quality Check Overview

# Symbol Name Explanation

1 Iris Image Displays the iris image.

2 Fundus Image Displays the fundus image (montage or individual image).
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# Symbol Name Explanation

3 Scroll Images Navigates through the individual images that make up the
montage.

Individual Image
Positions

Selects an individual image position:

• SN - Superior Nasal

• S - Superior (Center)

• ST - Superior Temporal

• IN - Inferior Nasal

• I - Inferior (Center)

• IT - Inferior Temporal

4 Angiography Image Displays the angiography image (montage or individual
image).

5 Selected for retake Indicates which scan(s) will be retaken.

Retake selected Returns to the acquire screen to the re-scan the selected
image position (without saving).

6 Save All Saves the montage image and all individual images that
make up the montage.

7 Signal Strength Indicates the overall image signal strength.

8 Fundus Image Indicates the overall fundus image signal strength.

9 B-Scan Displays the B-scan of an individual image

10 Movie Controls Scrolls through the cube as a movie.

Movie Slider Scrolls through the cube movie faster.

11 Transparency Controls the opacity of the overlay.

8.11.4.4 Check Montage AngioPlex Scan Quality

To check Montage AngioPlex scan quality:

Prerequisite þ Acquire AngioPlex Montage Scans [} 171]

Action 1. Ensure that the target is centered on the pupil.

2. Ensure that the Signal Strength is 6 or higher.

3. Ensure that light intensity is uniform across the image.
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4. Ensure that the fundus image is sharp and clear with good
visibility of the branching blood vessels.

5. If the fundus scan has an overlay, adjust the transparency of
the overlay.

6. To adjust the brightness or contrast of the fundus image, hover
over the fundus image and select the Brightness or Contrast
tool (see:Edit Images (Hover Over) [} 370]).

Figure 33: Saccades

7. Ensure that there are few or no saccades in the area to be
analyzed. 
Saccades appear as discontinuities of the blood vessels
(horizontal shifts of the vessel):

8. Ensure that the scan is complete in all windows (no missing
data).

9. Ensure that the scan passes all acceptance criteria (refer to the
Instructions for Use).

10. If the scan is not acceptable, click Try Again and retake the
scan.

11. Click Save.
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8.12 Acquire Anterior Segment Scans

NOTE Features described in this section are licensed separately and
may not be available in all markets.

u For information about feature availability in your market and
obtaining a license:

ð in the U.S.A, call 1-877-486-7473.

ð outside the U.S.A , contact your local ZEISS distributer.

NOTE Ensure that the patient is not wearing contact lenses for
Anterior Segment scans.

Anterior segment measurements are not valid for patients wearing
contact lenses.

NOTE B-scan adjustment works differently for anterior segment
scans.

Enhance and Center adjustment tools are not available.

u Adjust the chinrest to center images vertically.

u Shift + mouse scroll wheel does not bring the scan into the
acquisition window.

CIRRUS™ HD-OCT images and measures structures in the anterior
segment.

For some  anterior segment scans, you must fist attach an external
lens (see: Attach External Lens [} 181]). There are two different
external lenses. Use the correct lens for the type of scan you are
acquiring.

When you install an external lens or select an anterior segment
scan:

• LSO illumination of the retina turns off

• Iris illumination dims (to avoid causing pupillary constriction)

• The internal lens clicks into position

• The internal fixation target centers

• The patient sees the green fixation target against a black
background and with a (blurred) red flashing scan pattern.

CIRRUS™ HD-OCT software corrects the bean scanning geometry
and refraction on the corneal surfaces for some anterior scan types.
For these scans, you can view the raw image or corrected image
during analysis. Corrected scans are:

• Anterior Chamber

• Wide Angle-to-Angle

• HD Cornea
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• HD Angle

• Pachymetry

Scan Pattern Scans Details

Anterior Segment Cube

• Creates a 3D image

• B-Scans: 128

• A-Scans: 512

• HD B-Scans: 2

• A-Scans per HD B-Scan: 1024

• Creates a 3D image

• Scan Depth: 2mm

• Scan Depth: 2mm

Anterior Segment 5 Line Raster View images of the anterior chamber angle and
cornea.

• Five parallel horizontal lines 0.25mm apart (1mm
width total).

• Length: 3.0mm (fixed)

Anterior Chamber

• Averaging per line: 20

• A-Scans: 1024

• Scan Depth: 5.8mm

• Length: 15.5mm (rotation may reduce to
14.0mm)

• Adjustments: -89 to 90°

HD Angle

• Averaging per line: 20

• A-Scans: 1024

Angle measurements for one iridocorneal angle

• Scan Depth: 2.9mm

• Length: 6.0mm

• Adjustments: -89 to 90°

Wide Angle-to-Angle

• Averaging per line: 20

• A-Scans: 1024

Angle measurements for a both iridocorneal angles
(0° and 180°)

• Scan Depth:2.9mm

• Length: 15.5mm (rotation may reduce to
14.0mm)

• Adjustments: -89 to 90°

HD Cornea

• Averaging per line: 20

• A-Scans: 1024

Shows a wider field of view (than 5-Line).

• Scan Depth: 2.0mm

• Length: 9.0mm

• Adjustments: -89 to 90°.

Pachymetry

• B-Scans: 24 (radial)

• A-Scans: 1024

Measure corneal thickness, epithelial thickness, and
view a color-coded thickness map of the cornea.

• Scan Depth:2.0mm

• Diameter 9.0mm

Table 39: Anterior Chamber Lens 

 Indicates optional features (see: About Licenses [} 61]).

• Anterior Chamber Scans [} 184]

• HD Angle Scans [} 194]
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• Wide Angle to Angle Scans [} 197]

• Anterior Segment 5-Line Raster Scans [} 191]

• Acquire HD Cornea Scans

• Acquire Pachymetry Scans

If this is a followup visit and you want to replicate the settings of
an earlier scan, refer to: Repeating a Prior Scan (Track to Prior).

8.12.1 Attach External Lens
There are two external lenses. Use the appropriate lens for the type
of scan.

Scans Lens Symbol Label

• Anterior Chamber

• Wide Angle to Angle

• HD Cornea

• Pachymetry

Table 40: External Lens Identification

To attach an external lens:

1. Install the external lens onto the instrument lens mount.

ð The instrument detects the lens, adjusts lens position, and
displays the scans appropriate for the lens.
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Action

8.12.2 Acquire Anterior Segment Overview
For descriptions of the common acquire buttons and features, see:
Acquire Posterior Segment Overview [} 140]

1

2

Figure 34: Acquire Anterior Chamber Scan Overview

# Symbol Name Explanation

1 Protocols Selects a protocol (see: About Protocols [} 145]).

2 Scan Selector Selects OD scan type.

3 Selects OS scan type.
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# Symbol Name Explanation

4 Iris Viewport Displays the live image of the iris.

Brightness and Contrast Opens brightness and contrast adjustment controls.

Reset Resets your adjustments of the iris image.

Customize Scan Pattern For scan patterns that adjust, set numeric values for line
length, spaces between lines, etc..

Chinrest Controls Circular controls adjust the patient chinrest up, down, right
or left.

Left arrow moves chinrest toward patient.

Right arrow moves chinrest toward device.

# Symbol Name Explanation

5 B-Scan

B-Scan Live display of alignment.

6 Capture

Identifies Selected Prior
Scan

Replicates the settings of a prior scan (to compare same
scans of the same eye using the same settings).

Capture Captures the scan.
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8.12.3 Anterior Chamber Scans
The Anterior Chamber  scan generates a wide field, speckle-
reduced raster scan of the front of the eye that is higher contrast
than the Anterior Segment 5 Line Raster scan. It produces 20 B-
scans, each comprised of 1024 A-scans.

By allowing the source and mirror images to overlap, the CIRRUS™
HD-OCT shows a scan depth of 5.8mm. NOTE! In the overlap
region (indicated by blue overlay), there is less detail.

The scan pattern is a single, horizontal line that you can rotate from
-89° to 90°. You cannot lengthen or shorten the line or reposition
it higher or lower.

You can enhance the image manually before you capture the scan.

Figure 35: Acquire Anterior Chamber Scan

Analysis Considerations

For analysis, CIRRUS™ HD-OCT software adjusts the scan to
account for beam scanning geometry and refraction on the corneal
surfaces. For accurate results, center the scan on the corneal
vertex, which generates a strong central reflection line on the live
OCT image. Typically the corneal vertex is just to the nasal side of
the pupil center.

Make sure you align the image for an Anterior Chamber scan
correctly:
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Incorrect Alignment Correct Alignment

Cornea and Iris are too close.

Cornea and Mirror Cornea are too close.

Image is not centered.

Table 41: Aligning the Anterior Chamber Image

The analysis available for this scan is: Analyze Anterior Chamber
Scans [} 342].

8.12.3.1 Acquire an Anterior Chamber Scan

To acquire an anterior chamber scan:

Action 1. Select the Patient [} 124].

2. Prepare the Patient [} 135]
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3. Attach the Anterior Chamber lens (Attach External Lens
[} 181]).

4. Align and Focus the Iris Image [} 214].

ð A strong vertical central reflection line on the B-scan
indicates the scan is centered on the corneal vertex.

5. To change the position of the scan or fixation target, see:
Select an Internal Fixation Target.

6. Instruct the patient to lean forward and fixate on the center of
the fixation target.

ð The fixation target might look blurry or out of fucus.

7. To adjust the brightness or contrast of a b-scan image, see: Edit
Images (Hover Over) [} 370]

8. If the anterior chamber is tilted, instruct the patient to shift
their gaze slightly (eft or right as needed) until the anterior
chamber is horizontal.

1

2

9. Use the chinrest controls to center and adjust the image:

ð Move the chinrest up or down as needed (1).

ð Move the chinrest right or left as needed (1).

ð Move the chinrest closer or further away as needed (2).

10. Adjust the image so that the cornea and iris are separated
(cornea and iris are not too close or touching).
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11. If the mirror image is turned on, align the image:

ð The cornea and mirror cornea image are separated properly
(mirror image is not too close to the cornea).

12. Ask the patient to blink, then open their eyes wide.

13. Click Capture.

ð The Quality Check screen opens.

14. Ask the patient to sit back.

15. Check Anterior Segment Cube Scan Quality [} 190].

8.12.3.2 Check Anterior Chamber Scan Quality

To check anterior chamber cube scan quality:

Prerequisite þ Acquire an Anterior Chamber Scan [} 185].

1. Ensure that the target is centered on the pupil.

ð The green arrow shows the iris target placed over the
pupil.

2. To view a full-screen version of an image, double-click on the
image.
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Action 3. If the scan is not acceptable, click Try Again and retake the
scan.

4. Click Save.

8.12.4 Anterior Segment Cube
The live iris image displays the position of the Anterior Segment
Cube 512x128 scan pattern.

When you acquire an anterior cube scan, the cornea appears flat in
the display. The instrument focuses the OCT beam onto the
anterior segment and scans in an arc to allow the curved cornea to
better fit into the 2 mm scan depth. The cornea appears with the
expected curvature during review and analysis.

1

2

3 4

The OCT B-scan images display:

• the horizontal scan lines of the selected cube slice
(1).

• the vertical scan lines of the selected cube slice
(2).

• the top horizontal cube slice (3) .

• the bottom horizontal cube slice (4) .

Aligning the Image

Make sure you align the image correctly:
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Incorrect Alignment Correct Alignment

Corneal reflection causing bright artifact. Moved slightly away from center to avoid corneal
reflection.

Table 42: Aligning the Anterior Chamber Cube B-Scan

8.12.4.1 Acquire an Anterior Segment Cube Scan

Action 1. Select the Patient [} 124].

2. Prepare the Patient [} 135]

3. Select the Anterior Segment Cube 512 x 128 scan for the
appropriate eye.

ð The instrument moves into place.

4. Instruct the patient to lean forward and fixate on the center of
the fixation target.

5. Align and Focus the Iris Image [} 214].
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6. Use the chinrest controls to center and align the cornea. Make
sure the cornea is between the gray bars outside the center B-
scan.

7. Center the scan between the gray bars in the middle B-scan
(slightly off center to avoid corneal reflection).

ð If the patient’s cornea is completely centered, a strong
reflection from the anterior cornea can produce unwanted
bright artifacts.

ð A strong vertical central reflection line on the B-scan
indicates the scan is centered properly on the corneal
vertex.

8. If the corneal reflection causes a bright artifact, adjust the
chinrest slightly to offset the image.

9. Ask the patient to blink, then open their eyes wide.

10. Click Capture.

ð The Quality Check screen opens.

11. Ask the patient to sit back.

12. Check Anterior Segment Cube Scan Quality [} 190].

8.12.4.2 Check Anterior Segment Cube Scan Quality

NOTE Always check scan quality before saving a scan.

Good quality scans are essential for accurate disease diagnosis.

u If you are not sure of the image quality, retake the scan.

A cube pattern with slice navigators below the iris image allows
you to sequence through cube slices.

To check anterior chamber cube scan quality:

Prerequisite þ Acquire an Anterior Chamber Scan [} 185]

Action 1. Ensure that the target is centered on the pupil.

2. To view a full-screen version of an image, double-click on the
image.

3. To navigate through the cube data, move the cyan or magenta
navigation lines (see: Navigate Cube Layers Manually [} 226]).

4. To view a sequence of cube slices as a movie, use the movie
controls.

5. If the scan is not acceptable, click Try Again and retake the
scan.

6. Click Save.
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8.12.5 Anterior Segment 5-Line Raster Scans
The live iris image displays the position of the five-line scan pattern.
You can move or rotate this pattern as needed. The B-scans corre-
spond to the 5 scan lines.

Figure 36: Acquire Anterior Segment 5 Line Raster Scan (Cornea)

8.12.5.1 Acquire an Anterior Segment 5-Line Raster Scan

To acquire an anterior segment 5-line raster scan:

Action 1. Select the Patient [} 124].

2. Prepare the Patient [} 135]

3. Attach the Anterior Chamber lens (Attach External Lens
[} 181]).

4. Select the Anterior Segment 5-Line Raster scan for the
appropriate eye.

ð The instrument moves into place.

5. Align and Focus the Iris Image [} 214].
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6. Use the chinrest controls to center and align the cornea. Make
sure the cornea is between the gray bars outside the center B-
scan.

7. To enhance image contrast and brightness, click Adjust.

8. Ask the patient to blink, then open their eyes wide.

9. Click Capture.

ð The Quality Check screen opens.

10. Ask the patient to sit back.

11. Check HD Angle Scan Quality [} 196].

8.12.5.2 Check Anterior Segment 5-Line Raster Scan Quality

To check Anterior Segment 5-Line Raster scan quality:

Prerequisite þ Acquire an Anterior Segment 5-Line Raster Scan [} 191].
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Action

1. Ensure that the target is centered on the pupil.

2. To view a full-screen version of an image, double-click on the
image.

3. To view a full-screen version of an image, double-click on the
image.

4. Ensure that the cornea image is clear and you can see the
layers of the cornea.

5. Ensure that light intensity is uniform across the image.

6. Ensure that the patient's eyelashes did not interfere with the
image

7. If the scan is not acceptable, click Try Again and retake the
scan.

8. Click Save.
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8.12.6 HD Angle Scans
The HD Angle scan gives the highest resolution and greatest detail
of one iridocorneal angle and provides the most accurate measure-
ments.

Figure 37: Acquire HD Angle Scan

• To view both angles and the iris shape in one image: Wide
Angle to Angle Scans [} 197].

• To view five slices of the angle in one image: Anterior Segment
5-Line Raster Scans [} 191].

8.12.6.1 Acquire an HD Angle Scan
Tip: Scroll the mouse to center the
B-scan.

Because there is no visible internal fixation target for the patient to
view, the external fixation target can help the patient fixate. 

To acquire an HD Angle scan:

Prerequisite þ Install and position the external fixation target.

Action 1. Select the Patient [} 124].

2. Prepare the Patient [} 135]

3. Select the HD Angle scan for the appropriate eye.

ð The instrument moves into place.

4. Instruct the patient to lean forward and look straight ahead.
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5. Align and Focus the Iris Image [} 214].

6. Click the edge of the iris where the angle you want to capture
is located.

7. Adjust the chinrest controls until the angle (corneoscleral
junction) is low in the B-scan viewport and the scan pattern is
still in the middle of the iris (vertically).

ð Center the B-scan in the lower quadrant of the viewport to
maximze the view of the cornea.

ð A strong vertical central reflection line on the B-scan
indicates the scan is centered on the corneal vertex.

8. If the angle recess in the B-scan appears shadowed by the
sclera, move the scan slightly along the limbus to minimize the
effect, or ask the patient to look slightly to the left or right as
needed.

9. Ask the patient to blink, then open their eyes wide.

10. Click Capture.

ð The Quality Check screen opens.

11. Ask the patient to sit back.

12. Check HD Angle Scan Quality [} 196].
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8.12.6.2 Check HD Angle Scan Quality

To check HD angle scan quality:

Prerequisite þ Acquire an HD Angle Scan [} 194].

Action 1. Ensure that the target is centered on the pupil.

2. To view a full-screen version of an image, double-click on the
image.

3. Ensure that the angle, the iris and scleral spur are visible and
clear.

4. Ensure that no shadows impede the angle view.

5. If the scan is not acceptable, click Try Again and retake the
scan.

6. Click Save.
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8.12.7 Wide Angle to Angle Scans
Wide Angle to Angle  scans highlights both 0 and 180 degree
iridocorneal angles.

Figure 38: Acquire a Wide Angle to Angle Scan

8.12.7.1 Acquire a Wide Angle to Angle Scan

You can change the rotation of the Wide Angle to Angle scan,
but you cannot resize or move the scan pattern to a different
location on the iris.

To acquire a wide angle to angle scan:

Action 1. Select the Patient [} 124].

2. Prepare the Patient [} 135]

3. Attach the Anterior Chamber lens (Attach External Lens
[} 181]).

4. Select the Wide Angle to Angle scan for the left or right eye.

ð The instrument moves into place.

5. Align and Focus the Iris Image [} 214].
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6. Instruct the patient to lean forward and fixate on the center of
the fixation target.

ð The fixation target might look blurry or out of fucus.

7. Click the center of the pupil.

ð NOTE! The iris appears slightly out of focus when
correctly aligned.

8. Adjust the chinrest until the anterior plane is straight and the
iris is very low in the view.

ð The green arrow shows proper alignment.

9. If the anterior chamber appears tilted, instruct the patient to
shift their gaze slight left or right (as needed) until the anterior
chamber appears horizontal.

1

2

10. Adjust the chinrest until both iridocorneal angles  (1) and iris (2)
are visible.

ð The entire cornea does not appear in the image.

ð A strong vertical central reflection line on the B-scan
indicates the scan is centered on the corneal vertex.

11. To rotate the scan pattern, click and drag the rotation corner 
of the cyan line to rotate that scan pattern into position.

ð You can adjust the scan pattern from –89 to 90 degrees.

ð NOTE! Rotation can reduce the field to 14.0 mm verti-
cally.
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12. Ask the patient to blink, then open their eyes wide.

13. Click Capture.

ð The Quality Check screen opens.

14. Ask the patient to sit back.

15. Check Wide Angle to Angle Scan Quality [} 199].

8.12.7.2 Check Wide Angle to Angle Scan Quality

NOTE Always check scan quality before saving a scan.

Good quality scans are essential for accurate disease diagnosis.

u If you are not sure of the image quality, retake the scan.

To check wide angle to angle scan quality:

Prerequisite þ Acquire a Wide Angle to Angle Scan [} 197].

Action 1. Ensure that the target is centered on the pupil.

2. Ensure that both angles are in view.

3. To view a full-screen version of an image, double-click on the
image.

4. Ensure that light intensity is uniform across the image.

5. If the scan is not acceptable, click Try Again and retake the
scan.

6. If the scan is acceptable, click Save.
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8.12.8 HD Cornea

Figure 39: Acquire HD Cornea Scan

The HD Cornea scan is a straight line across the center of the eye.
You can rotate the line to scan the cornea in a different direction.

8.12.8.1 Acquire an HD Cornea Scan

NOTE This scan does not appear as a selection until you install the
external lens.
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When you acquire HD Cornea scans, center the live iris image and
align the cornea between the guidelines in the B-scan image (see:
About Image Position and Focus [} 213]). 

To acquire an HD cornea scan:

Action 1. Select the Patient [} 124].

2. Prepare the Patient [} 135]

3. Attach the Cornea lens (Attach External Lens [} 181]).

4. Select the HD Cornea scan for the appropriate eye.

ð The instrument moves into place.

5. Align and Focus the Iris Image [} 214].
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6. Use the chinrest controls to center and align the cornea
between the red guidelines in the B-scan viewport.

7. Ask the patient to blink, then open their eyes wide.

8. Click Capture.

ð The Quality Check screen opens.

9. Ask the patient to sit back.

10. Check HD Cornea Scan Quality [} 202].

8.12.8.2 Check HD Cornea Scan Quality

NOTE Always check scan quality before saving a scan.

Good quality scans are essential for accurate disease diagnosis.

u If you are not sure of the image quality, retake the scan.

To check HD cornea scan quality:

Prerequisite þ Acquire HD Cornea Scans.
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Action 1. Ensure that the target is centered on the pupil.

2. Ensure that the corneal image is clear and you can see its
layers.

3. Ensure that the posterior and anterior surfaces are well-
defined.

4. Ensure that there are no motion artifacts or corneal reflections
on the central cornea (especially where measurements are
needed).

5. Ensure that light intensity is uniform across the image.

6. Ensure that the patient's eyelashes did not interfere with the
image.

7. If the scan is not acceptable, click Try Again and retake the
scan.

8. Click Save.
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8.12.9 Pachymetry
Pachymetry scans consist of 24 radial scan lines with a scan depth
of 2.0 mm that generate a color-coded thickness map of the
cornea. The scan uses 24 B-scans, each composed of 1024 A scans.

Figure 40: Acquire Pachymetry Scan

8.12.9.1 Acquire a Pachymetry Scan

NOTE This scan does not appear as a selection until you install the
external lens.
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CIRRUS™ HD-OCT automatically corrects Pachymetry scans for
beam scan geometry and refraction on the corneal surfaces. These
corrections work best when the corneal vertex is properly centered
between the two red guidelines in the Temporal / Nasal B-Scan.

Figure 41: Temporal / Nasal B-scan

To acquire a pachymetry scan:

Prerequisite þ The patient is not wearing contact lenses.

þ The patient's eyelashes are not impeding the images.

Action 1. Select the Patient [} 124].

2. Prepare the Patient [} 135]

3. Scan Types [} 136] (if needed).

4. Attach the Cornea lens (Attach External Lens [} 181]).

5. Select the Pachymetry scan for the appropriate eye.

ð The instrument moves into place.

6. Align and Focus the Iris Image [} 214].

7. Instruct the patient to lean forward and fixate on the center of
the fixation target.

ð The fixation target might look blurry or out of fucus.
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8. Use the arrow keys to adjust the Superior / Inferior  B-scan
until you see the corneal reflex in the Temporal- Nasal  B-
scan.

9. To make fine adjustments, click Ctrl + arrow keys.

10. To adjust the brightness or contrast of a b-scan image, see: Edit
Images (Hover Over) [} 370]

11. To enhance image contrast and brightness, click Adjust.

12. Ask the patient to blink, then open their eyes wide.

13. Click Capture.

ð The Quality Check screen opens.

14. Ask the patient to sit back.

15. Check Pachymetry Scan Quality [} 207].
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8.12.9.2 Check Pachymetry Scan Quality

NOTE Always check scan quality before saving a scan.

Good quality scans are essential for accurate disease diagnosis.

u If you are not sure of the image quality, retake the scan.

After you acquire a Pachymetry scan, the Quality Check screen
opens automatically for you to ensure that the scan quality is
acceptable. 

Pachymetry scans do not show signal strength to indicate scan
quality. Instead, an Image Quality indicator detects whether the
scan quality is acceptable.

Acceptable Image Low Quality Image Detected

Green Yellow

Table 43: Pachymetry Image Quality Indicator

CIRRUS™ HD-OCT Image Quality indicator detects:

• Poor scan quality:

– Patient blinked or partially blinked

– Patient eyelid or eyelash interference

– Scan contrast too low

• Scan not centered:

– Scan misaligned

– Scan not centered

• Excessive motion during scan
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Figure 42: Check Quality: Pachymetry

To check Pachymetry scan quality:

Prerequisite þ Acquire a Pachymetry Scan [} 204].

Action 1. Click on the iris image and use the mouse scroll wheel to select
a radial scan line.

2. To view a full-screen version of an image, double-click on the
image.

3. Check the image quality for each line.

4. To view the series of lines using the B-scans, click on the B-scan
and use mouse scrolling to view the lines.
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5. To view a sequence of the radial scan lines, use the movie
controls.

6. If Image Quality is green, click Save.

7. If Image Quality is yellow, click Try Again and ensure that the
lens is clean (see: Cleaning Optical Components [} 408]) , the
scan is properly centered, and retake the scan: Acquire a
Pachymetry Scan [} 204].

8.13 Acquisition Concepts, Tasks and Tools

8.13.1 Focus the Fundus Image
Tip: If a patient has floaters that
obscure parts of the scan, ask the
patient to shift their eyes several
times prior to the scan to move
floaters.

The fundus image is properly focused when the image is sharp and
clear and the branching blood vessels are visible.

Macular cube scans have an alignment tool that you can place over
the optic disc to help position followup scans more accurately--
especially when a patient's fovea is difficult to locate.

For optic disc scans, the alignment tool is turned on and centered
on the scan pattern.

Tip: If the patient's record includes
their refractive error, Auto Focus
adjusts accordingly-focusing the
fixation target and optimizing
fundus image brightness.

Auto Focus

Auto Focus automatically optimizes several settings:

• Adjusts focus to compensate for the patient’s refractive error

• Adjusts fundus image brightness and contrast

If the patient's refractive error is not saved in their record, you can
help the patient see the fixation target more clearly by manually
setting the correction.

Tip: If a patient has corneal
opacities, realign the pupil to
minimize effects.

For patients with unsteady fixation you can also set Rapid Refresh
View.

To focus the fundus image:

Prerequisite þ You are acquiring a scan and reached the step: Focus the
Fundus Image.

Action

1. Click Auto Focus and ask the patient to hold their gaze and
head steady while the instrument moves into place.

2. Ensure that the iris target is still centered on the pupil.
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3. If the patient cannot see the fixation target clearly, click the left
arrow to compensate for myopic corrections or the right arrow
to compensate for hyperopic corrections.

4. If the fundus image is not sharp and clear, manually adjust the
focus.

5. Ensure the fundus is illuminated uniformly (no dark corners on
the overlay).

6. If the fundus image is too dark, click Fine Adjustment.

ð The Fundus Image adjustment tool opens.

7. Click Auto B/C.

8. If needed, manually adjust image brightness and contrast
sliders separately.

9. Click Close.

10. To discard your adjustments and return to the default settings,
click Reset.

11. To increase the screen refresh rate, right-click on the image and
select Rapid Refresh View.

12. Complete the remaining steps of the acquire procedure.

8.13.2 Adjusting B-Scan Images
For Posterior Segment scans and Angiography scans, an
Optimize button automatically adjusts the B-scan(s) as follows:

1. Centers the image.

2. moves the B-scan higher to maximize signal strength. (Angiog-
raphy Cube only)

3. Optimizes image quality (polarization).

8.13.2.1 Automatically Optimize B-Scans

NOTE If tracking is turned on, the B-scan may shift upwards.

u If necessary, move the B-scan image down manually.

Tip: Press F9 to toggle between
color and grayscale images.

For best results, position the B-scan approximately 100 µm below
the top of the of the image area before capturing the image.

To adjust B-scans automatically:

Action 1. Instruct the patient to hold their gaze steady and do not blink.

2. Click Optimize.

ð The B-scan images are centered and polarization is
optimized.

ð
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3. Confirm that the B-scan is:
Visible in the imaging window
Approximately 100 µm below the top of the scan.

4. To adjust image centering and polarization manually, refer to:
Manually Enhance B-Scans [} 211].

5. Complete the remaining steps of the acquire procedure.

8.13.2.2 Manually Center B-Scans
Tip: Center the image first so you
can see image enhancements
better.

Optimize automatically centers the B-scan image, then optimizes
image quality (polarization). You can also manually adjust B-scan
centering and quality.

To manually center B-scans:

Prerequisite þ You are acquiring a scan and reached the step: Manually
Center or Enhance B-Scans.

Action

1. In the B-Scan panel, locate the control arrows that adjust
Centering.

2. To move the B-scan image up, click the Up arrow.

3. To move the B-scan image down, click the Down arrow.

4. Complete the remaining steps of the acquire procedure.

8.13.2.3 Manually Enhance B-Scans

Optimize automatically centers the B-scan image, then optimizes
image quality (polarization). You can also manually adjust B-scan
centering and quality.

To manually enhance B-scans:

Prerequisite þ You are acquiring a scan and reached the step: Manually
Center or Enhance B-Scans.

Action

1. In the B-Scan panel, locate the control arrows to adjust
Enhancement.

2. To increase polarization for the B-scan image, click the Up
arrow.

3. To decrease polarization for the B-scan image, click the Down
arrow.

4. Complete the remaining steps of the acquire procedure.
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8.13.3 About Fixation Targets
CIRRUS 6000 has 21 fixation target locations. You can select a
fixation target for the patient to fix their gaze during scan acqui-
sition. Select a fixation target that makes it easiest to obtain a
good-quality scan of the area of interest.

When you click on the fundus image, the nearest of the 21 fixation
targets is selected.

Figure 43: Fixation Targets

8.13.3.1 Position the Fixation Target

NOTE If the image is too close to the upper boundary, it could
reflect a mirror image or appear inverted.

u Center or adjust the image until the mirror image is eliminated
and image inversion is corrected.

Tip: Center the area of interest to
scan the deepest part of the bowl
of the retina and help keep the
image centered vertically.

For the best results, center the area of interest in the live fundus
view. You might need to:

• Select a different fixation target to redirect the patient's gaze.

• Move or rotate the scan pattern closer to the area of interest.

To select a different fixation target location:

Prerequisite þ You are acquiring a scan and reached the step: Position the
Fixation Target.
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Action

1. Click on the fundus image where you want the fixation target
to move (area of interest).

2. Instruct the patient to follow the fixation target and focus their
gaze on the target in its new location.

ð A different area of the retina is centered in the fundus
image.

3. To reset the fixation target back to the center, click Reset
Fixation Target.

4. To adjust the scan pattern to match the fixation target (area of
interest), see: Customize Raster Scan Patterns (Drag) [} 157].

5. Complete the remaining steps of the acquire procedure.

8.13.4 About Scan Patterns
Scan patterns overlay the fundus image when you are preparing to
acquire a scan. Most types of scans allow you to relocate the scan
pattern within the live fundus preview.

Scan patterns help you center or place the scan in the location that
obtains the best image of a particular area of interest for the
patient's eye. 

8.13.4.1 Position the Scan Pattern

If you want to capture a different area of the retina, you can move
the scan pattern to acquire the optimal area for a patient's eye.

To move the scan pattern:

Prerequisite þ You are acquiring a scan and reached the step: Reposition the
Scan Pattern.

Action 1. Mouse over the scan pattern that overlays the fundus image.

ð The mouse pointer becomes a finger pointing icon.

2. Click on the scan pattern and drag it to the location you want
to capture.

3. To reset the scan pattern (and all other adjustments), click
Reset.

4. Complete the remaining steps of the acquire procedure.

8.13.5 About Image Position and Focus
Once the patient's eye is aligned with the alignment mark on the
instrument, use the chinrest controls to center and focus the iris
image and B-scan images as needed. You might need to make a
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few adjustments before the image is both aligned and focused
properly. The following table explains how the controls move the
chinrest.

Buttons Chinrest Movement

1

2

3 4

5 6

7 8

9 10

1 Moves chinrest up.

2 Moves chinrest down.

3 Moves chinrest left.

4 Moves chinrest right.

5 Moves chinrest up and to the left.

6 Moves chinrest up and to the right.

7 Moves chinrest down and to the left.

8 Moves chinrest down and to the right.

9 Moves chinrest away from the acqui-
sition head.

10 Moves chinrest toward the acquisition
head.

Table 44: Chinrest Adjustments (Image Centering)

8.13.5.1 Align and Focus the Iris Image
Tip: For patients with opacities, try
clicking slightly off-center of the
pupil.

Proper alignment of the patient eye to the external marker is crucial
to obtaining a good quality scan.

Improper Alignment Proper Alignment

X
Eye is not aligned with the
instrument marker.

üEye is aligned with the instrument
marker.

Table 45: Alignment

To align the iris image:

Prerequisite þ You are acquiring a scan and reached the step: Align the Iris.
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üAction 1. Ensure that the patient's eye aligns with the marker on the
CIRRUS™ HD-OCT external surface.

1 2

34 5

2. Click on the center of the pupil (1).

ð The red target appears over the center of the pupil and
chinrest automatically moves into position to center the iris
in the viewport.

NOTE If you reposition the iris manually, the chinrest moves as you
make adjustments.

u Instruct the patient to:

ð Keep their chin down

ð Keep their teeth together

ð Place their forehead against the forehead rest

ð Move along with the chinrest
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3. To adjust the image position manually, click on center of the
pupil again (1) and move the chinrest controls (2) up, down,
right, and left as needed to position the iris in the viewport.

4. Focus the iris image by moving the chinrest forward or back as
needed (3).

5. To reset the chinrest position, click Reset (4).

6. Click Brightness / Contrast (5).

ð The adjustment panel opens.

7

6

8

7. To increase contrast, slide the contrast adjustment (6) up.

8. To decrease contrast, slide the contrast adjustment (6) down.

9. To brighten the image, slide the brightness adjustment (7) up.

10. To dim the image, slide the brightness adjustment (7) down.

11. To restore the default contrast and brightness, click Reset (8).

12. Complete the remaining steps of the acquire procedure.

8.13.6 About Auto Repeat

NOTE Auto Repeat only works for scans acquired on a prior day.

When you enable Auto Repeat, CIRRUS™ HD-OCT automatically
repeats the settings to match the patient's most recent scan.

Advantages of using Auto Repeat include:

• You can easily repeat the patient's earlier scans in a folow-up
visit.

• The patient can remain in position between scans.

With Auto Repeat enabled:
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1. Select the patient and the type of scan to acquire.

2. The instrument detects whether the patient already acquired
that type of scan for the same eye in a past visit.

3. If the instrument finds one (or more), it selects the most recent
scan and matches all of the settings used for that scan.

The instrument:

• Adjusts the ocular lens the same way

• Moves the chinrest into the same place

• Adjusts the scan pattern the same way (if applicable)

• Places the fixation target in the same place

• Adjusts to match all enhancements, positioning, focus,
brightness, contrast and illumination settings

• Displays the scan pattern and the fundus image from the prior
scan

The date and time of the most recent scan (with its settings reused
for this scan) appears on the acquisition screen .

8.13.7 About FastTrac™

NOTE FastTrac™ does not work properly for certain anatomical
features.

If a patient exhibits features that impede FastTrac™, turn off
FastTrac™ before capturing a scans. These features include:

u strongly tilted or curved retinas

u high myopia

u media opacities

u small pupils

NOTE For optic disc scans, Monitor Z Position is off.
Monitor Z Position setting does not work properly for
certain anatomical features:

If a patient exhibits features that impede alignment of the B-scan,
turn off Monitor Z Position. These features include:

u high myopia

u posterior staphylomas

CIRRUS™ HD-OCT FastTrac™ improves scans by: 
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• Minimizing effects of eye movements: FastTrac™
automatically detects a patient's eye movement in real time,
then minimizes its effect before you capture a scan.

• Tracking only if tissue is vertically centered: FastTrac™
monitors whether B-scans are vertically centered and stops
tracking if it detects that some or all of the tissue is outside the
B-scan window.

The patient's first scans using FastTrac™ takes a little longer to
process, but subsequent scans are faster and more accurate (see
Turn FastTrac™ On or OFF [} 119] and Turn FastTrac™ On [} 219]).

Advantages of using FastTrac™ retinal tracking include:

• Faster retakes: because FastTrac™ tracks eye motion,
retaking a scan only re-captures the areas impacted by
movement.

• More accurate alignment: by registering anatomical features
of the eye, CIRRUS™ HD-OCT allows you to repeat a patient's
scan precisely (see About Macular Scan Registration [} 247]).

• Faster follow-up scans:  when a patient returns for follow-up
visit, CIRRUS™ HD-OCT positions the instrument in the same
location as the last scan.

• Better change analysis: accurate alignment for a series of
scans over time facilitates better accuracy in assessing the
progression of pathology.

Some patient anatomy or pathology can inhibit tracking. When
tracking is on, you can turn it off for a particular scan (as needed).
When acquiring a scan, click green tracking to button turn tracking
off (the button becomes gray).

FastTrac™ Enabled FastTrac™ Turned
ON

FastTrac™ Turned
OFF

Auto Repeat and
Tracking are
checked.

Table 46: FastTrac™ Settings

You can further simplify re-taking a series of scans for a patient
when you use FastTrac™ with Track to Prior  to create a series
of matched images over time (see About Track to Prior [} 220]).
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8.13.7.1 Turn FastTrac™ On

FastTrac™ works best with when the fundus image is properly
focused, illumination is uniform, and the blood vessels are sharp.
While a tracked scan processes, the patient can remain focused on
the fixation target and blink normally. Blinking increases tear film,
which can improve signal quality.

If  FastTrac™ is interrupted during processing, the progress bar
turns red and stops.

To turn FastTrac™ on:

Prerequisite þ FastTrac™ is enabled (Turn FastTrac™ On or OFF [} 119]).

þ You are acquiring a scan and reached the step: turn on
FastTrac™.

1

Action

1. Click FastTrac™ (1) .

2. If the Capture button has a red border, FastTrac™ is not
ready.
Ensure the B-Scans are centered.

3. If illumination is not uniform across the fundus image, ensure
that the pupil is centered and the iris and pupil are in focus.

4. If a FastTrac™ scan does not process successfully, try turning
off the Monitor Z Position setting.

5. To turn of the Monitor Z Position setting, click the Fine
Adjustment icon (2) and uncheck Monitor Z Position  .

ð Fine Adjustment opens the OCT Tomogram settings.
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ð A FastTrac™ progress indicator opens after capture. It can
take a few moments to complete FastTrac processingl

6. If the OCT image centered indicator is red, recenter the
image and try the scan again.

7. If the Other factors for tracking OK indicator is red, check
that the iris and fundus image are adjusted properly and try the
scan again.

8. To stop a scan during processing, click Cancel.

9. Complete the remaining steps of the acquire procedure.

To turn FastTrac™ off:

Prerequisite þ FastTrac™ is enabled (Turn FastTrac™ On or OFF [} 119]).

þ You are acquiring a scan and reached the step: turn off
FastTrac™.

10. Click FastTrac.

ð The icon turns gray.

11. Complete the remaining steps of the acquire procedure.

8.13.8 About Track to Prior
If you want to use tracking for a follow-up scan and the prior scan
was acquired without FastTrac, you can track usingTrack to Prior.

Track to Prior allows you to select a patient's earlier scan and
CIRRUS™ HD-OCT automatically adjusts to the same settings.

If the patient will likely return for the same followup series of scans,
set up the initial scans using Track to Prior.

CIRRUS™ HD-OCT retains these settings so you can reuse them to
capture followup scans more efficiently. You can use this feature
for earlier scans that did not have Track to Prior turned on, but
for optimal results, turn on the feature for the initial scans also.

With Track to Prior enabled:

1. Select the patient and the type of scan to acquire.
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2. Turn on Track to Prior.

3. Select the Prior Scan linkand choose the scan to repeat.

The instrument automatically:

• Adjusts the ocular lens the same way

• Moves the chinrest into the same place

• Adjusts the scan pattern the same way (if applicable)

• Places the fixation target in the same place

• Adjusts to match all enhancements, positioning, focus,
brightness, contrast and illumination settings

• Displays the scan pattern and the fundus image from the prior
scan

Track to Prior ON Track to Prior OFF

Table 47: Track to Prior Settings

8.13.8.1 Track to a Prior Scan

Track to Prior allows you to reuse all the setting from an earlier
scan for the same patient (see About Track to Prior [} 220]).

To track to a prior scan:

Prerequisite þ You are acquiring a scan and reached the step: track to a prior
scan.

1

2

4

3

Action

1. Click Track to Prior (1) .

ð TheTrack to Prior icon turns green.

2. To select a prior scan to reuse its settings, click Please select
prior scan (2).

ð A scan selection dialog opens.

3. Choose the scan you want to repeat and click.



8 Operation Instructions for Use
CIRRUS™ HD-OCT8.13 Acquisition Concepts, Tasks and Tools

222 / 542 2660021174149 Rev. D 2019-10

ð The instrument moves into place and sets the same adjust-
ments as the prior scan. This process might take a few
moments. The fundus image and scan pattern from the
prior scan overlay the live fundus image.

4. Align the live fundus view with the fundus overlay from the
prior scan.

5. Click on the scan pattern (3) and drag it into position.

6. To view the live fundus image with the fixation target or
overlays better, adjust the overlay Transparency (4).

7. Complete the remaining steps of the acquire procedure.
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8.13.9 About Cube Scans
Cube scans stack and align consecutive axial-scans (A-scans) side by
side to produce a two-dimensional B-scan. Consecutive B-scans
align to produce a 3D cross-section of the retina.

2

3

1

1 En Face Scan Plane Yellow box indicates the scan area.

Click and drag cyan or magenta triangle to
move through the scan slices.

The number beside the line indicates which slice of
the cube is in view.
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2 Slow B-Scan Plane Reformatted, vertically parallel A-scans acquired in
successive line scans.

These slices are acquired more slowly; one per line
of horizontal A-scans.

3 Fast B-Scan Plane Slices parallel to the front of the cube; each line of
A-scans is acquired quickly .

You can quickly navigate through the slices of either plane. Simply
move the corresponding line displayed on the fundus image and
the B-scan image moves accordingly. The slice number helps you
know which area of the cube is selected.

CIRRUS™ HD-OCT displays scan images as follows:

• Horizontal scans:

– left of scan equals the left of scan display

– right of scan equals right of scan display

• Vertical scans

– bottom of scan equals left of scan display

– top of scan equals right of scan display

• Diagonal scans in 5 Line Raster

– left takes precedence over bottom

– left of scan equals left of scan display

– right of scan equals right of scan display

Cube Analysis

Because cube scans contain this volume of information, there is are
additional types of analyses available only for cube scans:
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Analysis Description

3D Visualization Shows a 3-dimensional image of the data.
You can navigate through the 3D slices,
adjust settings, and animate a series to save
as a movie (see: 3D Visualization Analysis
[} 289]).

En Face
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Analysis Description

Advanced Visualization

Table 48: Additional Visual Cube Scans

8.13.9.1 Navigate Cube Layers Manually

To ensure that the image shows the area of interest clearly for
analysis, you can scroll through the B-scans to check individual
layers to make sure the area is captured in the image.

By dragging the layer line to each area of interest, you can quickly
scan the cube layers.

Tip: You can also navigate through
layers by clicking the B-scan you
want to navigate and scrolling the
mouse.

Prerequisite þ You are acquiring, checking quality or analyzing a scan and
reach the step: navigate cube data.
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Action 1. Click on the magenta triangle and move the line to the right or
left to view different slices.

2. Click on the cyan triangle and move the line up or down to
view different slices.

3. Complete the remaining steps of the acquire procedure.

8.13.9.2 Navigate Through Cube Slices as a Movie

Action 1. Use to view a movie of the fast B-scans or sequence through
them one image at a time.

ð

2. Complete the remaining steps of the acquire procedure.

ð

You can view the scan as a movie that begins at the top of the B-
Scan slice and moves down through the tissue in 51 µm incre-
ments. You can stop the movie, reverse or advance the movie
frame by frame. 

NOTE! The default frame rate for scan movies is 51 µm/sec.

To view the image as a movie:

Prerequisite þ You reach the scan analysis step: Edit an Image.

þ Editing tools are open: Open Image Editing Tools [} 372].

3. Click  Play Movie.

ð The movie controls open.

1 2 3 4

5 6

7

4. To start the movie, click the play button (1).

5. To stop the movie, click the pause button (2).

6. To move backward one frame, click the previous button (3).

7. To move forward one frame, click the next button (4).

8. To decrease movie speed, move the slider toward Slow (5).

9. To increase movie speed, move the slider toward Fast (6).

10. To close the movie controls, click Close (7).

11. Complete the remaining steps of the acquire procedure.

8.13.10 Acceptance Criteria
FastTrac minimizes, but does not completely eliminate, the possi-
bility of saccades.
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For cube scans, the operator should review the OCT fundus image
to ensure there are minimal saccades and no saccades through the
area of interest (macula, for example).

A saccade can be detected by discontinuities in the appearance of
the blood vessels (for example, a horizontal shift of the vessel at a
specific location). Example: Saccades During the course of a scan
with FastTrac, the individual B-scans in a cube may be acquired at
different positions in the Z-direction (for example, tissue varies in
vertical position in the B-Scan window from B-Scan to B-Scan).

CIRRUS corrects for this motion when assembling the data for
analysis

. However, the OCT fundus image can have artifacts from grada-
tions in the intensity of each B-Scan.

These gradations appear as horizontal lines or bands in the OCT
fundus image, as shown in the OCT fundus image banding
examples (A and B) below

. As long as there are no saccades, scans with OCT fundus images
like these should be acceptable for analysis and the operator is
advised to save them.

When reviewing CIRRUS 6000 Angiography Scans for acceptability,
consider the following:

• RPE Acceptance Criteria [} 228]

• Signal Quality Acceptance Criteria [} 228]

• Decorrelation Tails Acceptance Criteria [} 229]

• Segmentation Acceptance Criteria [} 230]

Consider all these possibilities before accepting OCT Angiography
scans for further analysis.

8.13.10.1 RPE Acceptance Criteria

Test Pass Fail Explanation

Retina
Position

Retina is in an
appropriate position
in the scan

Retina is too low in the scan

Example of retina position too low: .

If the retinal tissue is captured too
low in the axial FOV of the scan,
there will not be enough contrast to
detect sub-RPE illumination.

Table 49: RPE Acceptance

8.13.10.2 Signal Quality Acceptance Criteria

CIRRUS 6000 OCT Angiography (AngioPLEXTM) is more sensitive to
signal quality than structural OCT imaging.
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Test Pass Fail Explanation

Signal
Strength

6 or higher Less than 5 Low signal strength causes poor
scan quality and can affect interpre-
tation of the images.

Shadows Shadows exhibit floaters or disease

• Floater: dark area appears in
different locations in multiple
scans (compare the flow en face
and structural en face image).

• Possible disease: Angiography
image is dark, but the B-scan
and the structural en face image
are normal.

Dark spots, dark or
blurry scans

OCT Angiography sensitivity
sometimes show dark spots resulting
from poor local signal, not capillary
dropout.

Poor signal quality appears
throughout the image; the B-scan
also looks dark or blurry.

Table 50: Signal Quality Acceptance

Enface Flow Image Enface Structural Image B-Scan Explanation

• Blue arrow shows a
floater

• Red arrow shows
possible impaired
capillary flow:

– Good signal in
the structural en
face and the B-
scan

– B-scan and en
face images
show a
decreased signal
in the same area

Table 51: Example: Signal Criteria Example: Angio 6mmx6mm

8.13.10.3 Decorrelation Tails Acceptance Criteria

Bright shadows of more superficial vessels that appear in posterior
layers are decorrelation tails. Decorrelation tails result from light
that passes through moving blood cells and returns to be detected.
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Test Pass Fail Explanation

Bright No Decorrelation
Tails; signal
detected shows
accurate motion.

• DRL has a
different
characteristic
appearance
than the SRL.

• RPE not
showing vascu-
lature

Decorrelation Tails
Appear

• DRL has the
same character-
istic appearance
as the SRL.

• Vessels appear
exactly the
same shape as
a layer superior
to it.

• RPE shows
vasculature
(exactly the
same shape as
a superior layer)

Inaccurately detected motion causes a weaker signal
to appear below the original signal.

Because the effect is correlated with the brightness
of the reflecting layer, decorrelation tails may seem
to disappear within the outer nuclear layer, but
appear strongly in the brightly-reflecting RPE.

Table 52: Decorrelation Tails Acceptance

Layer Enface B-Scan Explanation

SRL The larger vessels that appear similar
in SRL and DRL are decorrelation
tails and not present in the DRL.

DRL

Decorrelation Tails

DRL en face does not include the
larger vessels; they appear due to
the decorrelation tails.

Above RPE

Decorrelation Tails

RPE enface does not normally have
vessels; vasculature appears due to
decorrelation tails.

Table 53: Decorrelation Tails Example: Normal Eye

8.13.10.4 Segmentation Acceptance Criteria

Test Pass Fail Explanation

Flow
Detection

Appropriate presence or
absence of flow in the
layers of interest.

Unexpected presence or
absence of flow in the
layers of interest.

Segmentation errors can result in
incorrect visualization of flow.
Boundary lines that determine a
particular enface image appear as
pink dotted lines overlying the B-
scan. 

Table 54: Segmentation Acceptance
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EnFace B-Scan Explanation

• Boundary lines that determine
the enface image appear as
pink dotted lines overlying the
B-scan.

• En face image shows a bright
area not associated with patho-
logical flow.

• Bright area in the B-scan shows
that segmentation pushed
below the hyper-reflective
retinal pigment epithelium.
(Any signal detected here is
likely due to decorrelation tails
from the inner retinal vascu-
lature).

• B-scan shows that the segmen-
tation is not correctly passing
through the outer retinal layer
expected to be free of signal
(horizontal blue line location)

Table 55: Segmentation Criteria Example: Angio 6mmx6mm
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9 Analyzing Exam Data and Creating
Reports
Using the Analysis and Report screens, you can view, group,
characterize, measure, annotate, and adjust scanned data in
multiple ways and save the adjusted scans and create reports. 

9.1 About Analysis and Reports
Scan Pattern Scan Analyses

512 x 128
200 x 200

• Macular Thickness

• Macular Thickness OU 

• Macular Change

• Advanced RPE

• Wellness Exam 

• Panomap 

• Advanced Visualization

• En Face

• 3D Visualization

• Ganglion Cell OU 

• Ganglion Cell Guided Progression (Extrapolate Progression )

• Single Eye Summary 

200 x 200 • ONH/RNFL OU 

• Guided Progression (Extrapolate Progression )

• Advanced Visualization

• En Face

• 3D Visualization

• Wellness Exam 

• Panomap 

• Single Eye Summary 
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Scan Pattern Scan Analyses

HD 1 Line 100X High Definition Images

HD 5 Line

HD Radial

HD 21 Line

HD Cross

3mm x 3mm • Angiography

• Angiography Change

• En Face

HD 6mm x 6mm 

6mm x 6mm 

HD 8mm x 8mm 

8mm x 8mm 

12mm x 12mm 

4.5mm x 4.5mm • ONH Angiography

• ONH Angiography Change

• En Face
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Scan Pattern Scan Analyses

6mm x 6mm Montage Angiography

8mm x 8mm 

Table 56: Macular Cube Scans

Many anterior segment scans are optional (see: About Licenses
[} 61]).

Scan Pattern External Lens Scan Analysis

Anterior Segment Scans

- Anterior Segment Cube • Anterior Segment Analysis

• 3D Visualization

- Anterior Segment 5 Line Raster High Definition Images

- HD Angle HD Angle Analysis

Anterior Chamber Anterior Chamber Analysis

Wide Angle-to-Angle Wide Angle-to-Angle Analysis

HD Cornea HD Cornea Analysis

Pachymetry Pachymetry Analysis

Table 57: Anterior Segment Scans

 Requires (or best with) image of both eyes.

 Requires (or best with) both Macular Cube and Optic Disc
Cube images.

 Indicates optional features; license may be required.
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You can set a preferred analysis for scans (see: Set Preferred
Analyses [} 118]).

9.1.1 Analysis Overview
This section describes elements common to the analysis screens.

1
2

3
4

5

Figure 44: Analysis Screens

1 Information Bar

Patient Information Displays the patient's name, gender, and
date of birth.

OD / OS Indicator Indicates which eye is selected.

If the patient's other eye does not have a
comparable scan to select, it's is grayed out.

2 Print Tools (See: Printing Reports)

Save Saves the printed report with any changes
you made.

Export Exports the analysis with any changes you
made.

Print Prints the analysis with any changes you
made.

Delete Deletes the report.
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3 Scan Selection

Scan Date Selects the date of the scan to analyze.

OD Scans Selects a scan of the patient's right eye.

Analysis / Report
Selection

Allows you to select the type of analysis you
want to view.

This list varies depending on the type of scan
(see About Licenses [} 61]. )

4 Varies Scan Tools Displays information about the scan and tools
to make adjustments (varies depending on
the type of scan and analysis).

5 Varies Viewports Displays in the viewport(s) vary depending on
the type of scan and analysis.

Table 58: Posterior Segment Scans (Macula and Optic Nerve Head) Overview

9.1.2 About Reports
CIRRUS™ HD-OCT allows you to generate color reports that you
can print or export. Some information on the reports is truncated
to fit the page. For example, although a patient identification
number can have as many as 32 characters, only the first 23
characters (including spaces) print on the report. Truncated fields
are:

Possible Characters Characters on
Reports

Patient ID 32 23

Technician Name 64 32

Institution Name 36 24

You can customize reports (refer to: Configuring Reports [} 112]).

Exporting Reports

You can export a report to DICOM (if configured) or export data
into one of the following file formats:

• PDF

• BMP

• GIF 

• JPEG

• PNG 

• TIFF

• EMF

• WMF
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For XML export details, see: About XML Data Export [} 93].

9.2 Posterior Segment Scan Analysis

9.2.1 Macular Analysis

9.2.1.1 Analyze Macular Thickness

NOTE Good scan quality (strong signal strength) is essential for accurate
comparisons to normative data.

u Scans with low signal strength may not compare to the
normative data as accurately as higher quality scans.

Macular Thickness Analysis allows you to:

• View a retinal thickness map overlaying the fundus image and
identify the fovea location.

• Edit and measure the layers and their boundaries.

• View high-resolution B-scans.

• Compare the patient's thickness and volume measurements to
the normal reference range for their age.

• Scroll through automatically-detected IML - RPE three-dimen-
sional thickness maps.

• Navigate color-coded thickness maps of the cube slices and
identified layers.

Macular Thickness Analysis uses normative data to determine
whether the patient's macular thickness is normal, above normal,
or below normal. For more information about the normative data,
refer to: Macular Thickness Parameters [} 456]

Macular Thickness Analysis is available for the following scans: 

• Macular Cube 512x128

• Macular Cube 200x200

To study a series of scans and analyze macular thickness change
over time, see: Analyze Macular Change [} 247].

For a more detailed examination of RPE elevation and sub-RPE
illumination, see: Advanced RPE Analysis [} 257].

You can also view and navigate through the slices of any cube scan
as a three-dimensional image (see: 3D Visualization Analysis
[} 289]).
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9.2.1.1.1 Interpreting Macular Thickness Parameters

NOTE Normal reference ranges represent the general population.
However, when interpreting data, keep the following study
limitations in mind (especially for 1% and 99%):

u Subjects:

ð Ages 18-84

ð Refractive errors –12.00 D to +8.00 D

u Age ranges with fewest subjects:

ð 3 subjects over 80.

ð 28 subjects aged (70-79).

NOTE Normal reference range limits are adjust by age groups only
(unless noted).
Other differences might occur for some measurements;
however, the normal reference range does not adjust for
these factors, such as:

u Image Signal Strength

u Ethnicity

u Axial Length

u Refraction

u Optic Disc Area

Macular Thickness Parameters [} 456] studies determine the normal
reference range for the general population. The following table
shows some examples of analyses for macular cube images that
compare a patient's results to the normal reference range.

Color coding and measurements help you determine how a
patient's macular thickness compares to the normal reference
range for their age.

Color Code Study Population Comparison

 Above Normal Thickest 1% Higher than 99%.

 Suspected Above Normal Thickest 5% Higher than 95%.

 Normal Middle 90%.

 Below Normal Thinnest 1% Lower than 99%.

 Suspected Below Normal Thinnest 5% Lower than 95%

Table 59: Color Key for Macular Thickness Comparison
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The ETDRS grid shows the patients' average macular thickness
measurement for each sector of the grid. For more information
about the ETDRS grid, refer to: Macular Thickness Parameters
[} 456].

The following examples comparing a patient's measurements to
the general population subjects of the same age.

Analysis Interpretation

ETDRS Grid

• All sectors are green, which indicates that all measurements are Normal

ETDRS Grid

• Five sectors are green, which indicates that their measurements are Normal
(middle 90%).

• Four sectors are red, which indicates that their average macular thickness
measurements are Below Normal (lowest 1%).

ETDRS Grid

• Seven sectors are green, which indicates that their measurements are Normal
(middle 90%).

• Two sectors are yellow, which indicates that their average macular thickness
measurements are Possibly Below Normal (lowest 5%).

Macular Thickness Table

Combining the ETDRS Grid information with additional parameters in the table
provides data you can use to inform your assessment.

Table 60: Macular Thickness Interpretation Examples

Studies that included a diverse population to determine the normal
reference ranges for age. For more information about these
studies, see: Macular Images [} 455].

Additional studies included only an Asian population to determine
the normal reference ranges for age. For more information about
these studies, see: Macular Images [} 469].
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9.2.1.1.2 Macular Thickness Analysis

1

2

3

4

5

6

Figure 45: Macular Thickness Analysis Overview

# Symbol Name Explanation

1 Toolbar

Signal Strength Indicates scan quality level; more green indicates a higher
quality scan.

Edit Layers Opens the segment editing tools.

Caliper Adds a measurement line.

Delete Measurement Deletes a measurement line added with the caliper tool.

Show / Hide Layers Hides or shows the colored lines indicating the ILM and
RPE layers.

Edit Layers Opens the segment editing tools.

Snap to Center Moves the slice navigators to the center of the 6x6 mm
square.

Snap to ETDRS Grid
center

Moves the slice navigators to the ETDRS Grid center
position.

Center ETDRS Grid Moves the ETDRS Grid to center on the slice navigator
position.

Reset ETDRS Grid Moves the ETDRS Grid back to the CIRRUS-calculated fovea
center location.
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# Symbol Name Explanation

Show / Hide High-
Resolution Images

Displays the high-resolution scans or standard-resolution
scans.

NOTE! The ETDRS Grid does not change position
when the High–Resolution image is displayed.

2 Fundus Image Fundus image showing scan area and cube navigation
lines.

Select Overlay Selects which overlay to display over the fundus image.

3 Thickness Measurements and Normative Data Comparisons

ETDRS Grid Shows overall average macular thickness in nine sectors.

• central circle (radius = 500 micrometers; diameter =1
mm )

• superior sectors

• nasal sectors

• temporal sectors

• inferior sectors.

Color coding shows how this patient's scan compares to
the normal reference range for their age. See: Macular
Thickness Parameters [} 456]).

Thickness Measurement
Table

Color coding shows how this patient's scan compares to
the normal reference range for their age.

Calculations shows the average thickness and volume
measurements.

4 Fovea Finder Automatically identifies the fovea and shows the surface of
the area for the individual thickness measurements in the
grid and table.

5 B-Scans

Horizontal B-Scan Slice through cube front

Vertical B-Scan Slice through cube side
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# Symbol Name Explanation

6 3D Surface Maps (interactive)

ILM - RPE Map Shows the thickness between the ILM and RPEas a color-
coded three-dimensional surface.

ILM Map Shows the Anterior Layer (ILM) as a color-coded three-
dimensional surface.

RPE Map Shows the Posterior Layer (RPE) as a color-coded three-
dimensional surface.

9.2.1.1.3 Analyzing Macular Thickness and Macular Thickness OU

CIRRUS™ HD-OCT automatically traces retinal layers and calculates
their thickness. You can adjust these layer boundaries, if needed.
See (Editing Macular Thickness Layer Boundaries [} 245]).

If CIRRUS™ HD-OCT cannot detect the fovea, the measurement
circles and calculations are based on the center of the 6 mm
square.

High-Definition Images

You can view high–definition images and double-click for a full–
screen view. High-definition image behavior is slightly different:

• You cannot navigate through the high-definition image using
the slice navigators. If you move the slice navigators, the image
changes back to the standard resolution.

• The ETDRS Grid does not change positions for the high-
definition image.

Macular Thickness Analysis is available for the following scans: 

• Macular Cube 512x128

• Macular Cube 200x200

To analyze macular thickness:

Prerequisite þ The patient has at least one macular cube scan: (Acquire a
Macular Cube Scan [} 150]).

þ You are logged in (review station or instrument): Login [} 123].

Action 1. Select the patient and click Analyze.

2. Select a Macular Cube scan and select Macular Thickness
Analysis.

3. To show or hide the layer indicators, click Show/Hide Layers.

4. To edit the layer boundaries, refer to: Editing Layer Boundaries.
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5. To change the overlay for the fundus image select a different
overlay (or none).

6. To export the all images, click Export.

7. To add a caliper, click Caliper.

ð A caliper measurement appears over the image. You can
move, stretch, and rotate calipers. You can add (up to) ten.

8. To delete a measurement or annotation, select it and click
Delete.

9. To set the navigators to the center of the image, click Center.

10. To reposition the fovea, for Overlay, select ETDRS position.
Select and drag the fovea overlay to the correct position.

ð The data recalculates according to the new fovea position.

11. To center the navigators on the middle of te ETDRS grid, click
Center.

ð The slice navigation lines move to the center of the grid.

12. To center the ETDRS grid onto the slice navigator position, click
Center Grid.

13. To rest the ETDRS grid to its original position, click Reset Grid.

14. To show or hide the high-resolution image, click HD.

ð The image toggles between the original resolution and high
resolution versions.

15. To edit an image, right-click to access the edit menu (see:
Editing Images Using the Menu [} 369]).

16. To view a full-screen image, double-click on the image.

17. To print, save, or export a report, see: Creating a Report
[} 384].
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9.2.1.1.4 Export Thickness Map Values

You can save the ILM-RPE thickness map data as comma–delimited
values in a .csv file.  The .csv file saves the fast B-scans as rows
starting at the top and slow B-scans as columns starting at the far
left.

You can open and view .csv files in Microsoft Excel Matlab, or
other applications that accept the file .csv file type. Select this
button to

To export thickness map values:

Prerequisite þ Logged in to review station (or instrument): Log In as Operator
or Data Analyst [} 123]

þ The scan report or analysis is open: Opening a Report or
Analysis

Action

1. Click Export Data.

ð The navigation dialog opens.

2. Navigate to the folder where you want to save the file.

3. Click OK.

9.2.1.1.5 Editing Macular Thickness Layer Boundaries

NOTE Top and bottom boundaries are the same color for each
layer:

Blue line indicates the top layer.

Red line indicates the bottom layer.

CIRRUS™ HD-OCT automatically calculates Macular Thickness
layer boundaries. Sometimes a patient's retinal structure has
anomalies or pathology that causes algorithms to trace the bound-
aries inaccurately.

You can edit these boundaries per individual scan (as needed). You
can drag any portion(s) of the boundary lines, but you cannot cross
the top and bottom boundaries of a layer.

To edit layers:

Prerequisite þ Logged in to review station (or instrument): Log In as Operator
or Data Analyst [} 123].

þ Analyze Macular Thickness [} 238]

Action 1. Select the layer or preset that you want to edit.

2. Click Edit Layers.

ð The layer boundary editor opens showing the top layer in
blue and the bottom layer in red.
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3. To adjust the top layer, drag the blue (upper) line into place.

4. To adjust the bottom layer, drag the red (lower) line into place.

ð The new segmentation location blends with the automatic
segmentation and appears continuous.

5. To copy these changes to the next slice, click Copy Next.

6. To copy these changes to the previous slice, click Copy
Previous.

7. To view the next layer, click Next.

8. To view the previous layer, click Previous.

9. To show the vertical B-scan below the horizontal B-scan, check
Show Vertical B-Scan.

10. Click Done.

9.2.1.1.6 Create a Macular Thickness Report

Macula Thickness Reports

There are three different types of reports for macular thickness
analysis. To set which reports to include and customize their
settings, see: Configuring Macular Thickness Reports [} 113].
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Macula Thickness Report (One
Eye, Both Eyes)

Macula Multi-Slice Report Macula Radial Report

To create a macular thickness report, see: Creating a Report [} 384]

9.2.1.2 Analyze Macular Change

When you have two or more macular scans for the same patient
taken at different times, you can compare scans together to
analyze macular changes. The Macular Change analysis compares
two of the patients macular cube scans taken at different times.

By comparing each of the patient's scans to the normal reference
range and combining this information into one analysis, you can
easily see how the patient's measurements have changed over
time, which sectors changed, and how much change occurred
between the images captured at the first visit and the followup
visit.

Macular Change Analysis is available for the following scans: 

• Macular Cube 512x128

• Macular Cube 200x200

 An optional license provides progression analysis that compares a
series of scans over time (see: About Licenses [} 61]).

9.2.1.2.1 About Macular Scan Registration

Figure 46: Unregistered Areas
(Black Border)

When you compare a patient's scan to an earlier scan (of the same
type), CIRRUS™ HD-OCT automatically aligns, or registers, the
scans together. Registration synchronizes anatomical structures and
corrects differences in rotation, which can occur if the patient is
situated slightly differently for the two scans.

If areas in the current image do not overlap with the earlier image,
those areas are not included in the registered pair; they appear as
black borders along the edge of the fundus image and are not
included in the b-scan image.
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9.2.1.2.1.1 Automatic Scan Registration
There are two different methods for automatically registering
scans, R2 and R1.

CIRRUS™ HD-OCT's primary (preferred) registration method is R2.

However, if R2 cannot adequately register the images, the
instrument attempts R1 registration.

Analyses and reports that use scan registration inform you of which
method was applied.

Method Order Description

R2 Primary • Aligns scans using the blood vessels identified in the en face images of
both scans.

• For guided progression analyses, uses translation and rotation to align
the follow-up scan(s) to the baseline scan

R1 Secondary • Aligns scans using the center of the optic disc of both scans.

• R1 does not include rotation.

• R1 might cause additional variability at the super-pixel level, which can
affect change detection in a thickness map.

Table 61: Registration Types

If you want to override automatic registration, you can register
scans manually or select a different set of scans to register
together. (See: Manually Register Macular Images [} 253]).

9.2.1.2.1.2 No Registration
If automatic registration was not successful and no manual regis-
tration was applied yet, the scans will display No Registration. To
register the scans, refer to: Manually Register Macular Images
[} 253].

9.2.1.2.1.3 Manual Registration
When you manually register images, you set (up to five) corre-
sponding points between two images. When you identify the same
structure or feature in both images, click that structure in the first
image, then the second image.
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For example, use a blood vessel bifurcation or a bend in a blood
vessel as a point to mark. A matching set of marks indicates corre-
sponding features. Different colored marks indicate the next
feature you mark in each image.

Figure 47: Registration Mark Pairing

After you register two images, the second image might display
irregular black borders. These borders indicate areas that are not
present in both images.

9.2.1.2.2 Macular Change Analysis

1

2 4

5

3

Figure 48: Macular Change Analysis Overview

# Symbol Name Explanation

1 Toolbar

Signal Strength Indicates scan quality level; more green indicates a higher
quality scan.

Synchronize Images Synchronizes images so they move together when you
pan, zoom or navigate through the cube data.
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# Symbol Name Explanation

Show / Hide Layers Hides or shows the colored lines indicating the ILM and
RPE layers.

View Registration Opens the registration viewer that shows each image. It
also displays an overlay of both images with a transparency
slider you can move right and left to compare image
alignment.

Reset ETDRS Grid Moves the ETDRS Grid back to the CIRRUS-calculated fovea
center location.

Center ETDRS Grid Moves the ETDRS Grid to center on the slice navigator
position.

ETDRS Grid Color Selector Changes the ETDRS Grid and displayed measurements
color.

2 Macular Thickness Map Shows ILM-RPE thickness maps.

3 Fundus image with
ETDRS grid position
displayed.

To reposition the ETDRS grid, select Overlay > ETDRS
position and adjust the center or drag the lines.

Overlay Transparency Sets the overlay transparency level.

4 ETDRS Differences Shows the difference in measurements between the two
images for each section of the ETDRS grid.

5 Macular Cube B-Scan Slice through cube front.

9.2.1.2.3 Analyzing Macular Change

Macular Change Analysis is available for the following scans: 

• Macular Cube 512x128 (2 or more)

• Macular Cube 200x200 (2 or more)

To analyze macular change:

Prerequisite þ The patient has at least one macular cube scan: (Acquire a
Macular Cube Scan [} 150]).
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þ You are logged in (review station or instrument): Login [} 123].

Action 1. Select the patient and click Analyze.

2. Select a Macular Cube scan and select Macular Change
Analysis

3. To synchronizes both comparison images so they move
together when you pan, zoom or navigate through the cube
data, Lock synchronization.

4. To show or hide the layer indicators, click Show/Hide Layers.

5. To see how the images are matched together for comparison,
click Review Registration (see: Review Scan Registration
[} 251]).

6. To center the ETDRS grid onto the slice navigator position, click
Center Grid.

7. To rest the ETDRS grid to its original position, click Reset Grid.

8. To manually register the images, select Manual (see:Manually
Register Macular Images [} 253]).

9. To change the color of the ETDRS grid and measurements, click
Color and select a color (or create a custom color),

10. To show or hide the high-resolution image, click HD.

ð The image toggles between the original resolution and high
resolution versions.

11. To edit an image, right-click to access the edit menu (see:
Editing Images Using the Menu [} 369]).

12. To view a full-screen image, double-click on the image.

13. To print, save, or export a report, see: Creating a Report
[} 384].

9.2.1.2.4 Changing Thickness Colors

If automatic registration was not successful and no manual regis-
tration was applied yet, the scans will display No Registration. To
register the scans, refer to: Manually Register AngioPlex Images
[} 317].

9.2.1.2.5 Review Scan Registration

With Macular Change analysis, you can review and fine-tune
registration if automatic registration does not suit your needs. To
register scans, see: Register Scans Manually.
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9.2.1.2.5.1 Review Registration Overview

6

4

3

21

5

Figure 49: Review Registration Overview

Pos. Symbol Name Explanation

1 Original (Baseline) Image Fundus image of the earlier (baseline)
exam(s).

2 Registered (Current) Image En face image for the followup exam.

Black borders incidate areas that do not
correspond between the two images.

3 Overlay Adjustment Image slider to adjust the registration
overlay view:

• slide left to view image 1,

• slide right to view image 2.
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Pos. Symbol Name Explanation

4 Registration Overlay Overlays both exam images.

5 Manual Registration Opens Manual Registration.

6 Cancel Exit registration review and return to
analysis.

9.2.1.2.5.2 Manually Register Macular Images

Macular Registration

Registration Tool

Matched Marks

Marked Example

To adjust registration manually:

Prerequisite þ You are logged in (review station or instrument): Login [} 123].

þ You have a comparison analysis open and you want to change
the registration.

Action 1. For Registration, select Manual.
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ð The registration review tool opens.

2. Identify a feature that appears in both images, like a blood
vessel bifurcation or a bend in a blood vessel.

3. Mark the feature in each image.
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4. Identify and mark additional identifiable features in other
regions of the pair of images (between 3 and 5 marks in each
image).

5. To change the transparency of Image 1 or Image 2, move the
transparency slider right or left.

6. To view the manually-adjusted overlay, click Review Regis-
tration.

7. To return to the original registration, click Reset.

8. Click OK.

Result

ü The Registration succeeded message and a green flag
appear.

9.2.1.3 Analyze HD Images

HD Images Analysis is available for the following scans: 

• HD 1 Line 100X

• HD 5 Line

• HD Radial

• HD 21 Line

• HD Cross
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9.2.1.3.1 HD Images Analysis

6

4

21

3

5

Figure 50: HD Images Analysis Overview

# Symbol Name Explanation

1 Toolbar

Signal Strength Indicates scan quality level; more green indicates a higher
quality scan.

FastTrac Indicates that the operator used FastTrac when acquiring
the image.

Tracked Image Toggles:

 Show prior image used from tracking

 Retrun to current image (tracked)

Toggle Color Toggles among three options:

 Grayscale

 Reverse Grayscale

 Color

Caliper Adds a measurement line.

Delete Measurement Deletes a measurement line added with the caliper tool.
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# Symbol Name Explanation

2 Horizontal B-Scan Enlarged imaged of a selected horizontal B-Scan

3 Vertical B-Scan Enlarged imaged of a selected vertical B-Scan

4 Scan Pattern Image area showing the scan pattern with customization
adjustments (if applicable)

5 Thumbnails Thumbnails of the B-scans; cyan and magenta outlined
thumbnails are selected for enlarged view

9.2.1.3.2 Analyzing HD Images

To analyze HD images:

Prerequisite þ The patient has at least one macular cube scan: (Acquire a
Macular Cube Scan [} 150]).

þ You are logged in (review station or instrument): Login [} 123].

Action 1. Select the patient and click Analyze.

2. Select a Macular Cube scan and select Macular Thickness
Analysis.

3. To toggle black-and-white, reverse black-and-white, and color
images, click Colors.

ð A caliper measurement appears over the image. You can
move, stretch, and rotate calipers. You can add (up to) ten.

4. To delete a caliper, click Delete.

5. To view a different part of the HD image, select a different
thumbnail.

6. To edit an image, right-click to access the edit menu (see:
Editing Images Using the Menu [} 369]).

7. To view a full-screen image, double-click on the image.

8. To print, save, or export a report, see: Creating a Report
[} 384].

9.2.1.4 Advanced RPE Analysis

The Advanced RPE Analysis allows you to compare the current
scan to a prior scan and automatically measure drusen and
geographic atrophy. You can examine disturbances in the RPE to
identify and measure RPE elevations and sub–RPE illumination.
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By showing the RPE in greater detail, Advanced RPE Analysis can
help in managing age–related macular degeneration-- even in
advanced forms that exhibit RPE atrophy.

When you select a scan for Advanced RPE Analysis, CIRRUS™
HD-OCT automatically opens the latest prior scan for the same
patient (same eye, same scan). If the patient has multiple scans
taken over time, you can choose another scan for the comparison.

This analysis has two different screens:

• Screen 1: shows RPE elevation and the sub–RPE illumination
results separately as en face images

• Screen 2: shows combined the RPE Elevation Map and the sub–
RPE illumination segmentation images with calculated values.

Advanced RPE Analysis is available for the following scans: 

• Macular Cube 200x200

• Macular Cube 512x128

9.2.1.4.1 Advanced RPE Analysis - Screen 1

1

5

2

3

4

6

Figure 51: Advanced RPE Analysis - Screen 1 Overview

# Symbol Name Explanation

1 Toolbar

Signal Strength Indicates scan quality level; more green indicates a higher
quality scan.

Show / Hide High-
Resolution Images

Displays the high-resolution scans or standard-resolution
scans.

NOTE! The ETDRS Grid does not change position
when the High–Resolution image is displayed.

Show / Hide Layers Hides or shows the colored lines indicating the ILM and
RPE layers.
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# Symbol Name Explanation

Show / Hide Circles Toggles visibility of the Fovea Fields.

Snap to Center Moves the slice navigators to the center of the 6x6 mm
square.

Snap to ETDRS Grid
center

Moves the slice navigators to the ETDRS Grid center
position.

Reset ETDRS Grid Moves the ETDRS Grid back to the CIRRUS-calculated fovea
center location.

Center ETDRS Grid Moves the ETDRS Grid to center on the slice navigator
position.

2 Screen Selector Toggles between the first and second screen of the
analysis.

3 Fundus Image Overlaid with the RPE Elevation Map for both scans.

Scan Area The yellow box indicates the area included in the scan.

Fovea Fields A pair of circles centered on the fovea (at 3mm and 5mm)

Slice Navigators Navigates cube slices horizontally (cyan line) and vertically
(magenta line) and shows the slice number currently
selected.

Transparency Adjustment Increases or decreases the transparency of the RPE
elevation map overlay.

4 Sub-RPE Slab
Toolbar

Screen Selector Toggles between the first and second screen of the
analysis.

Edit Segments Opens editor for Sub-RPE Illumination segments.

Show Hide Sub-RPE
Illumination

Toggles visibility of the illumination of the Sub-RPE
segment.
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# Symbol Name Explanation

5 B-Scan Displays the horizontal topogram showing RPE elevation
segments.

6 Sub-RPE Slab Displays the sub-RPE illumination layer.

Fovea Indicates the location of the fovea

A red line connects the fovea to the closest Sub-RPE Illumi-
nation location- showing the distance (in mm).

Transparency Slider Increases or decreases the visibility of the sub-RPE illumi-
nation layer.

9.2.1.4.2 Advanced RPE Analysis - Screen 2

1

2

3

Figure 52: Advanced RPE Analysis - Screen 2 Overview

# Symbol Name Explanation

1 Toolbar

Caliper Adds a measurement line.

Delete Measurement Deletes a measurement line added with the caliper tool.

Show / Hide Circles Toggles visibility of the Fovea Fields.

Sub-RPE Toggles visibility of the sub-RPE illumination boundaries.
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# Symbol Name Explanation

2 RPE Elevation Compar-
isons

Shows the data and differences in area and volume for the
3mm and 5mm circles.

3 Sub-RPE Illumination
Comparisons

Shows the data and differences in area and the closest to
the fovea.

9.2.1.4.3 Analyzing RPE (Advanced Analysis)

NOTE Some characteristics can affect RPE elevation measurements,
including presence, size, and extent of:

geographic atrophy

choroidal neovascularization

extensive epiretinal membrane

vitreomacular traction

NOTE The minimum RPE elevation for calculations is 19.5 µm.

This analysis typically compares a patient's current scan to a prior
scan from a series of scans taken over time. However, you can use
some features of this analysis for a single patient scan.

Prerequisite þ You are logged in (review station or instrument): Login [} 123].

þ The patient has at least one macular cube scan: (Acquire a
Macular Cube Scan [} 150]).

Action 1. Select the patient and click Analyze.

2. Select a Macular Cube scan and select Advanced RPE
Analysis.

ð If the patient had the same macular cube scan of the same
eye taken during earlier visits, CIRRUS™ HD-OCT
automatically loads the most recent prior scan for
comparison.

3. To hide or show the circles around the fovea, click Show /
Hide Circles.

4. If the patient exhibits characteristics that affect elevation,
review the individual B-scans to determine where RPE elevation
overlaps.

5. Check RPE elevation borders (black and purple lines) in the
horizontal tomogram to ensure that retinal segments are
accurate.

6. To edit an image, right-click to access the edit menu (see:
Editing Images Using the Menu [} 369]).

7. To view a full-screen image, double-click on the image.

8. To print, save, or export a report, see: Creating a Report
[} 384].
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9.2.1.4.3.1 Editing Sub-RPE Illumination Segments

To edit the Sub RPE illumination boundaries:

Prerequisite þ An Advanced RPE analysis is open.

Action 1. Click Edit Illumination.

ð The Sub-RPE Illumination boundary editor opens showing
the sub–RPE illumination areas.

2. To draw fine details or outlines for Floodfill, select the Pencil,
click in the image and draw a fine detail or the outline of a
larger shape.

3. To fill the outline of a shape, select Floodfill and click inside
the shape.

4. To delete fine details or draw outlines for the Eraser, select the
Knife, click in the image and draw a fine detail or the outline
of a larger shape.

5. To remove a large area, select the Eraser and click inside the
shape drawn with the Knife.

6. To revert to the original (unedited) image, click Reset.

7. Click Apply.

9.2.2 Ganglion Cell Analysis

9.2.2.1 Analyze Ganglion Cell OU

Ganglion Cell OU Analysis measures the thicknesses for the sum
of the ganglion cell layer and inner plexiform layer (GCL + IPL
layers) using data from the Macular cube scan patterns. CIRRUS™
HD-OCT compares thickness information to the normative data
gathered for their age (see Ganglion Cell Parameters [} 457]).

Ganglion Cell OU Analysis is available for the following scans: 
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• Macular Cube 512x128

• Macular Cube 200x200

9.2.2.1.1 Interpreting Ganglion Cell Results

NOTE Normal reference ranges represent the general population.
However, when interpreting data, keep the following study
limitations in mind (especially for 1% and 99%):

u Subjects:

ð Ages 18-84

ð Refractive errors –12.00 D to +8.00 D

u Age ranges with fewest subjects:

ð 3 subjects over 80.

ð 28 subjects aged (70-79).

NOTE Normal reference range limits are adjust by age groups only
(unless noted).
Other differences might occur for some measurements;
however, the normal reference range does not adjust for
these factors, such as:

u Image Signal Strength

u Ethnicity

u Axial Length

u Refraction

u Optic Disc Area

CIRRUS™ HD-OCT compares the patient's measurements to the
normal reference range for their age. Different colors indicate the
normal distribution percentiles. For more about normal reference
range data, refer to: Ganglion Cell Parameters [} 457].

Indication Measurement
Comparison

Interpretation

Above normal Thickest 5% Thicker than 95% of the database sample.

Normal Middle 90% Middle 90%.

Suspected below
normal

Thinnest 5% Thinner than 95% of the database sample.

Below normal limit Thinnest 1% Thinner than 99% of the database sample.

Table 62: Color Key for GCL + IPL Thickness Comparison to Normal Range
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Analysis Interpretation

Ganglion Cell OU OD:

Deviation map - shows thin areas (yellow) and
thinnest areas (red)

Table - average = 67; minimum = 50. Both are
thinner than normal

Grid -

2 sectors are normal (green)

2 sectors are suspected thinner than normal (70 and
71)

2 sectors are thinner than normal  (50 and 62)

OS:

Deviation Map - shows very little thin areas (yellow)

Table - average = 72; minimum = 70. Both are
suspected thinner than normal

Grid -

4 sectors are normal (green)

1 sector is suspected thinner than normal (72)

1 sector is thinner than normal  (67)

PanoMap Grid

2 sectors are normal (green)

2 sectors are suspected thinner than normal (70 and
71)

2 sectors are thinner than normal  (50 and 62)

Table - average = 67; minimum = 50. Both are
thinner than normal

Deviation Map - shows thin areas (yellow) and
thinnest areas (red)

Table 63: Interpreting Normal Reference Range for Macular Thickness Results
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9.2.2.1.2 Ganglion Cell OU Analysis

1

23

4

5

6

Figure 53: Ganglion Cell OU Analysis Overview

# Symbol Name Explanation

1 Toolbar

Snap to Center Moves the slice navigators to the center of the 6x6 mm
square.

Snap to ETDRS Grid
center

Moves the slice navigators to the ETDRS Grid center
position.

Center ETDRS Grid Moves the ETDRS Grid to center on the slice navigator
position.

Reset ETDRS Grid Moves the ETDRS Grid back to the CIRRUS-calculated fovea
center location.

Show / Hide Layers Hides or shows the colored lines indicating the ILM and
RPE layers.

Show / Hide Circles Toggles visibility of the Fovea Fields.

Show / Hide High-
Resolution Images

Displays the high-resolution scans or standard-resolution
scans.

NOTE! The ETDRS Grid does not change position
when the High–Resolution image is displayed.

Advanced Export Exports maps of the ILM layer to RPE layer thickness values.

2 Deviation Map Compares GCL + IPL thickness to normative data.

• red indicates thinner than all but 1% of normals

• yellow indicates thinner than all but 5% of normals
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# Symbol Name Explanation

3 Thickness Map Shows thickness measurements of the GCL + IPL in the 6
mm x 6 mm cube with an elliptical annulus centered about
the fovea.

Signal strength indicates scan quality level.

4 Horizontal B-Scan Slice through cube:

• purple line indicates the inner boundary of the
ganglion cell layer (outer boundary of the retinal nerve
fiber layer)

• yellow line indicates the outer boundary of the retinal
nerve fiber layer

Vertical B-Scan

5 Normal Reference Range
Comparison

Shows overall average and minimum GCL+IPL layer
thickness with color-coded comparison to the normal
reference range for the patient's age.

6 ETDRS Grid Shows overall average macular thickness in nine sectors.

• central circle (radius = 500 micrometers; diameter =1
mm )

• superior sector

• nasal sector

• temporal sectors

• inferior sectors.

Color coding shows how this patient's scan compares to
the normal reference range for their age. See: Macular
Thickness Parameters [} 456]).

9.2.2.1.3 Analyzing Ganglion Cell OU

To analyze the ganglion cell layer for both eyes:

Prerequisite þ The patient has at least one macular cube scan: (Acquire a
Macular Cube Scan [} 150]).

þ You are logged in (review station or instrument): Login [} 123].

Action 1. Select the patient and click Analyze.

2. Select a Macular Cube scan and select Ganglion Cell OU
Analysis.

3. To reposition the center of the thickness map on the fovea,
click and drag the circles to a different location on the
thickness map.

4. To export the all images, click Export.

5. To show or hide the layer indicators, click Show/Hide Layers.

6. To set the navigators to the center of the image, click Center.
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7. To center the navigators on the middle of te ETDRS grid, click
Center.

ð The slice navigation lines move to the center of the grid.

8. To rest the ETDRS grid to its original position, click Reset Grid.

9. To center the ETDRS grid onto the slice navigator position, click
Center Grid.

10. To show or hide the high-resolution image, click HD.

ð The image toggles between the original resolution and high
resolution versions.

11. To edit an image, right-click to access the edit menu (see:
Editing Images Using the Menu [} 369]).

12. To view a full-screen image, double-click on the image.

13. To print, save, or export a report, see: Creating a Report
[} 384].

14. If you want to use a different scan, manually select it (Manually
Select a Scan [} 367]).

9.2.2.2 Ganglion Cell Guided Progression

NOTE Guided Progression is one component of a comprehensive
clinical assessment of glaucoma progression.

u Guided Progression shows changes in GCL/IPL thickness, not
the progression of glaucoma.

u Have a qualified professional evaluate all clinical factors for
diagnosis.

This analysis helps you follow changes to the GCL/IPL thickness. An
in-house study determined the normal reference ranges per age
(see: Macular Algorithms [} 476]).

This analysis compares 3-8 exams for changes to thickness
measurements over time and determines whether significant
changes have occurred.

This analysis is available for the following scans:

• Macular Cube 512 x 128

• Macular Cube 200 x 200

9.2.2.2.1 Interpreting Ganglion Cell Guided Progression Results

NOTE Normal reference ranges represent the general population.
However, when interpreting data, keep the following study
limitations in mind (especially for 1% and 99%):

u Subjects:

ð Ages 18-84
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ð Refractive errors –12.00 D to +8.00 D

u Age ranges with fewest subjects:

ð 3 subjects over 80.

ð 28 subjects aged (70-79).

NOTE Normal reference range limits are adjust by age groups only
(unless noted).
Other differences might occur for some measurements;
however, the normal reference range does not adjust for
these factors, such as:

u Image Signal Strength

u Ethnicity

u Axial Length

u Refraction

u Optic Disc Area

Tip: Choose a baseline pair of
images from a period when
treatment stabilized changes.

Guided Progression allows you to analyze information from 3 to
8 exams. Guided Progression includes a chronological display of
thickness maps and thickness change maps, average thickness
graphs representing rate of change, and thickness profiles
comparing the current exam to the baseline exams.

Guided Progression analysis shows how a patient's measure-
ments change over time by comparing images acquired in a series
of visits and the normal reference range for their age. It works by
establishing a baseline for the patient using images from two visits,
then displays the difference between the baseline and each subse-
quent image. Guided progression is available for:

• Macular Cube 512 x 128

• Macular Cube 200 x 200

Ganglion Cell: shows how the ganglion cell layer thickness
changed over time.

ONH and RNFL: shows how the RNFL thickness and other ONH
parameters changed over time.

• Optic Disc Cube 200 x 200
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Figure 54: Guided Progression Example

Detecting Changes

CIRRUS™ HD-OCT detects changes from the patient's baseline to
display progression. Using a good baseline pair established (with
more similar images) is important for a more accurate depiction of
progression.

Change Pesentation Description Interpretation

Thickness Maps Shows how each image
compares to the normal
reference range for the
patient's age.

Red and
Yellow

Thicker areas

Blue
and
Green

Thinner areas

Deviation Maps Shows changes from their
own baseline and areas that
are .

Shows how each image
compares to the normal
reference range for the
patient's age.

Yellow Thinner than 95% of people
the same age.

Red Thinner than 99% of people
the same age.

Graphs Charts measurements of
overall change.

Data Tables Lists measurement
summaries.
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Change Pesentation Description Interpretation

Summary indicates progressive
decrease detected and
confirmed by consecutive
follow-up exams.

indicates progressive
decrease detected once.

indicates possible improve-
ments.

Graphs

Checkmarks in the summary indicate significant changes. A number
of measurements must show statistically-significant changes:

• Baseline + one progression image - at least two measure-
ments

• Baseline + two or more progression images - at least three
measurements

Ensuring Accurate Results

Guided progression analysis works best when:

• Good registration: images are registered properly (see: About
Macular Scan Registration [} 247]).

• Strong signal: signal strength is 7 or higher for each image.

• Good baseline: baseline images with fewest detected changes

9.2.2.2.1.1 Interpreting Ganglion Cell Progression

NOTE Features described in this section are licensed separately and
may not be available in all markets.

u For information about feature availability in your market and
obtaining a license:

ð in the U.S.A, call 1-877-486-7473.

ð outside the U.S.A , contact your local ZEISS distributer.

CIRRUS™ HD-OCT compares the patient's gathered for their age.
Different colors indicate the normal distribution percentiles. For
more about normative data was obtained, refer to: Ganglion Cell
Parameters [} 457].

Color Indication Measurement
Comparison

Interpretation

Above normal Thickest 5% Thicker than 95% of the database sample.
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Color Indication Measurement
Comparison

Interpretation

Normal Middle 90% Middle 90%.

Suspected below
normal

Thinnest 5% Thinner than 95% of the database sample.

Below normal limit Thinnest 1% Thinner than 99% of the database sample.

Table 64: Color Key for Thickness Maps

Color Indication Measurement
Comparison

Interpretation

Possible increase Thickest 5% Thicker than 95% of the database sample.

Likely decrease Thinnest 1% Thinner than 99% of the database sample.

Possible decrease Thinnest 5% Thinner than 95% of the database sample.

Table 65: Color Key for Graphs and Summary

Analysis Interpretation

Ganglion Cell Guided Progression Analysis shows 8 images of the same patient, same eye
taken over several years.

Thickness maps R2 registration was successful for all images.

Signal strength is good for each image (6 or higher).

Scans look similar.

Deviation Maps Deviation maps show progression over time starting
with the 4th image.

Deviation maps -

Areas began to thin with a patch thinner than
95%.

By the last image, a larger path is thinner than
99%.
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Analysis Interpretation

Graph Series Also shows possible decrease starting with the 4th
image progressing to likely decrease.

 Extrapolate Progression: extends the progression line
showing expected future progression.

possible decrease

likely decrease

Summary Indicates likely decrease for both; detected statisti-
cally-significant change in measurements.

Table 66: Ganglion Cell Guided Progression Interpretation Examples

 Indicates optional features; license may be required.

9.2.2.2.2 Ganglion Cell Guided Progression Analysis Overview

4

5

6

1

7

3

2

Figure 55: Ganglion Cell Guided Progression Analysis Overview

# Symbol Name Explanation

1 Scan Information Top Row: Date & Time of acquisition.

Row 2: Serial Number of the instrument that
acquired the image.

Row 3: Registration type and signal strength.

Bottom row: Average thickness.
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# Symbol Name Explanation

2 Ganglion Cell Thickness
Maps

Shows a series of thickness maps over time.

3 Deviation Map Progression: The first two scans (blank images) establish the baseline.
Each subsequent scan shows deviation from the normal reference range
(changes over time) as compared to normal patients of the same age.

red areas indicate thinner than 99%.

yellow areas indicate thinner than 95%.

purple areas indicate thicker than normal.

Measurement Area The red circle on the fundus image represents
the measurement area for the charts and
graphs.

4 Average Thickness
Graph

Graphs the average of all 6 sectors of the
annulus for each scan showing change over
time.

5 Superior Thickness
Graph

Graphs the total of the top 3 sectors of the
annulus for each scan showing change over
time.

6 Inferior Thickness Graph Graphs the total of the bottom 3 sectors of
the annulus for each scan showing change
over time.

 Extrapolate
Progression

extends the progression line showing
expected future progression.
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# Symbol Name Explanation

7 GCL +IPL Thickness Map Progression (best for focal change) 

GCL +IPL Thickness Progression (best for diffuse change) 

Unchecked indicates no loss or increase detected.

red indicates Likely Decrease (progressive loss
detected once and confirmed by consecutive
follow–up exams).

yellow indicates Possible Decrease
(progressive loss detected once.)

purple indicates Possible Increase.

9.2.2.2.3 Analyzing Ganglion Cell Change Progression

You can customize Guided Progression reports. For customization
information, see: Configuring Guided Progression Reports [} 116].

To analyze ganglion cell progression:

Prerequisite þ You are logged in (review station or instrument): Login [} 123].

þ The patient has at least one macular cube scan: (Acquire a
Macular Cube Scan [} 150]).

Action 1. Select the patient and click Analyze.

2. Select a Macular Cube scan and select Guided Progression.

ð The analysis opens.

3. Ensure that the signal strength is 7 or higher for each image.

4. Ensure scans are registered properly; if needed, manually
register the scans (see: Manually Register AngioPlex Images
[} 317]).

5. To use a different scan, manually select it (Manually Select a
Scan [} 367]).

6. Check the deviation progression series:

ð Evaluate the rate of decrease, locations of the detected
decrease, age of the patient, stage of the disease, and
other clinical factors to make clinical decisions.

ð Correlate these results with other clinical tests (perimetry,
IOP) to confirm whether RNFL loss is clinically significant.

7. Check the GCL+IPL Summary.

8. If the GCL+IPL Summary indicates Possible decrease,
consider recommending additional follow–up visits to confirm
change.

9. To edit an image, right-click to access the edit menu (see:
Editing Images Using the Menu [} 369]).

10. To view a full-screen image, double-click on the image.
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11. To print, save, or export a report, see: Creating a Report
[} 384].

9.2.3 ONH Analysis

9.2.3.1 Interpreting ONH Results

NOTE Normal reference ranges represent the general population.
However, when interpreting data, keep the following study
limitations in mind (especially for 1% and 99%):

u Subjects:

ð Ages 18-84

ð Refractive errors –12.00 D to +8.00 D

u Age ranges with fewest subjects:

ð 3 subjects over 80.

ð 28 subjects aged (70-79).

NOTE normal reference range limits are adjust by age groups only
(unless noted).
Other differences might occur for some measurements;
however, the normal reference range does not adjust for
these factors, such as:

u Image Signal Strength

u Ethnicity

u Axial Length

u Refraction

u Optic Disc Area

9.2.3.1.1 Interpreting ONH Results

CIRRUS™ HD-OCT compares the patient's ONH parameters to the
normative data gathered for their age. Different colors indicate the
normal distribution percentiles. For more about normative data was
obtained, refer to: ONH Parameters [} 462].

CIRRUS™ HD-OCT compares the patient's disc area and age to the
general population "normal" reference range.
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Rim Area and Neuroretinal Rim Thickness

Color Indication Measurement
Comparison

Interpretation

No indicator No comparison Possible reasons include:

• disc area is larger than 2.5 mm2

• disc area is smaller than 1.33 mm2

• average cup-to-disc ratio is below 0.25

• vertical cup-to-disc ratio is below 0.25

• not licensed for the ONH Normative
Database (see: About Licenses [} 61]).

Suspected thick Largest 5% Larger than 95% of the database sample.

Normal Middle 90% Middle 90%.

Suspected thin Smallest 5% Smaller than 95% of the database sample.

Thin Smallest 1% Smaller than 99% of the database sample.

Table 67: Color Key for ONH Comparison (Rim Area and Neuroretinal Rim Thickess) to Normative Database

Average Cup-to-Disc Ratio and Vertical Cup-to-Disc Ratio

Color Indication Measurement
Comparison

Interpretation

No indicator No comparison Possible reasons include:

• disc area is larger than 2.5 mm2

• disc area is smaller than 1.33 mm2

• average cup-to-disc ratio is below 0.25

• vertical cup-to-disc ratio is below 0.25

• not licensed for the ONH Normative
Database (see: About Licenses [} 61]).

Suspected small Smallest 5% Smallest than 95% of the database sample.

Normal Middle 90% Middle 90%.

Suspected large Largest 5% Larger than 95% of the database sample.

Large Largest 1% Largest than 99% of the database sample.

Table 68: Color Key for ONH Comparison (Average & Vertical Cup-to-Disc Ratio) to Normative Database
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9.2.3.1.2 Interpreting RNFL Results

CIRRUS™ HD-OCT compares the patient's RNFL Thickness to the
normative data gathered for their age. For more about normative
data was obtained, refer to: ONH Parameters [} 462].

Color Indication Measurement
Comparison

Interpretation

Suspected thick Thickest 5% Thicker than 95% of the database sample.

Normal Middle 90% Middle 90%.

Suspected thin Thinnest 5% Thinner than 95% of the database sample.

Thin Thinnest 1% Thinner than 99% of the database sample.

Table 69: Color Key for RNFL Normative Database

Shape Indication

Quadrants (Superior, Nasal, Temporal, Inferior)

Clock Hours

Table 70: Shape Key for RNFL Normative Database
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Name Examples Interpretation

Thickness Map Two examples of thickness maps; interpreted as:

• blue and green = thinner areas

• yellow and red = thicker areas

• solid blue = optic disc

Deviation from Normal Map Two examples that show:

Red and yellow areas shows where this scan has areas
that are thinner than normal. (Normal and thicker areas
are omitted for image clarity.)

Thinner regions do not necessary indicate pathological loss
of RNFL. Red and yellow areas can also appear for:

• Strongly myopic or hyperopic eyes (which may have a
different distribution of measured RNFL thickness
values)

• Split-bundle anatomy

• A very tilted RNFL bundle

Quadrant Average (more detailed
comparison)

• Superior quadrant average is 86 µm and Suspected
Thin

• Nasal quadrant average is 45 µm and Suspected
Thin

• Inferior quadrant average is 81 µm and Thin

• Temporal quadrant average is 79 µm and Normal

• Superior quadrant average is 77 µm and Thin

• Temporal quadrant average is 70 µm and Normal

• Inferior quadrant average is 50 µm and Thin

• Nasal quadrant average is 45 µm and Suspected
Thin

Clock Hour Average (most
detailed comparison)

Shows the measurement for each clock hour and indicates
whether the measurement is Normal (green), Suspected
Thin (yellow) or Thin (red).
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Name Examples Interpretation

RNFL Table Symmetry shows the correlation coefficient (converted to
a percentage) that results from comparing the OD profile
(256 points) with the OS profile (256 points).

When the symmetry is close to 100%, the two eyes have
similar profiles. Symmetry value decreases with the dissimi-
larity between the two eyes.
NOTE! Symmetry can (rarely) be less than zero if the
two profiles are very different.

TSNIT Thickness Chart Displays thickness at each A-scan location along the
selected circle (which is automatically calculated, but you
can select a different position to calculate).

9.2.3.2 Analyze ONH/RNFL OU

ONH/RNFL OU Analysis is only available for Optic Disc Cube 200
x 200 scans.

You can also view and navigate through the slices of any cube scan
as a three-dimensional image (see: 3D Visualization Analysis
[} 289]).

9.2.3.2.1 About Advanced Export

Advanced Export produces two types of plain text files: DAT and
TXT.

DAT Files

DAT files contain comma–delimited values that applications such as
Excel or Matlab can read.

There is a DAT file for each A-scan thickness with rows (fast B-
scans) and columns (slow B-scans). The first row is top fast B-scan;
the first column is the left slow B-scan.

TXT Files

These files save patient information, exam information, and values
(temporal to superior, superior to nasal, nasal to inferior, and
inferior to temporal). Values are:

• Neuro–retinal rim thickness values at 180 points (2° each)

• RNFL thickness values at 256 points (1.41° each)
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9.2.3.2.2 ONH/RNFL OU Analysis

You can customize the ONH and RNFL Thickness report. For
customization information, see: Configuring ONH Reports [} 115].

1

4

63

2

7

8

5

9

Figure 56: ONH and RNFL Thickness Analysis Overview

# Symbol Name Explanation

1 Toolbar

Center ETDRS Grid Moves the ETDRS Grid to center on the slice navigator
position.

Show/Hide Radial Control Hides or shows the radial indicator that shows the rotation
angle selected.

Advanced Export Exports maps of the ILM layer to RPE layer thickness values.

Show / Hide Layers Hides or shows the red and black layer lines in the B-scan
that correspond to the Optic Disc and Optic Cup outlines.

Overlay Transparency Sets the overlay transparency level.
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# Symbol Name Explanation

2 Deviation Map

Purple (outer) circle RNFL calculation circle.

Interaction:

Move the RNFL calculation circle to recalculate:

• Deviation Map

• Optic Disc measurements

Black (middle) Circle Optic Disc Outline

Red (inner) Circle Optic Cup Outline

Rotation Indicators Cyan dots on the optic disc and optic dup outlines indicate
the direction of rotation.

When you change the angle of the ONH spoke, the circles
move to correspond to the new angle selected.

3 Normal Reference Range
Comparison

Displays measurements with color-coded comparison to
the normal reference range for the patient's age.

4 Quadrant Averages Shows overall average RNFL thickness for each eye in four
quadrants (Superior, Nasal, Temporal, Inferior)

RNFL Thickness Chart Displays thickness profiles. Right-click toggles the display
orientation:

• TSNIT

• NSTIN

5 RNFL Clock Hours Shows the measurement for each clock hour and indicates
whether the measurement is Normal (green), Suspected
Thin (yellow) or Thin (red).

6 RNFL Thickness Map RNFL thickness map.

7 ONH B-Scan Slice through cube front

8 RNFL B-scan Slice through cube front
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# Symbol Name Explanation

9 Angle Indicator Shows the angle of the ONH spoke.

Rotation Tool Changes the angle of the ONH spoke.

9.2.3.2.3 Analyzing ONH and RNFL

The ONH and RNFL OU Analysis uses two kinds of thickness
measurements:

• RNFL grid

When you move the RNFL grid, the thickness maps, deviation
maps, and ONH calculations update automatically.

• Super-pixels

A total of 50 x 50 (2500) super-pixels are analyzed (optic disc
excluded).

RNFL Thickness Maps report thickness by showing blue or green
for thinner areas and yellow or red for thicker areas (the optic disc
appears solid blue).

Deviation Maps compare the normal reference range for the
patient's age and show yellow and red areas for that are thinner
than 95% and 99% of the (age-adjusted) normal population,
respectively.

Interpretation Considerations

For some patients, deviation maps can show decrease due to
reasons other than pathology. such as:

• The patient has strongly myopic or hyperopic eyes

• The patient has split-bundle anatomy

• The patient has a tilted RNFL bundle pattern

If the patient's temporal RNFL that is very thin or absent, the maps
might show thickened RNFL

• average thickness around the RNFL grid.

• a percentage of thickness symmetry between the eyes, which is
the correlation coefficient (converted to a percentage)
comparing the OD profile (256 points) with the OS profile (256
points).
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CIRRUS™ HD-OCT compares the RNFL thickness and symmetry of
the scan(s) with the normal reference range for the patient's age.
For more information about how normal reference ranges were
derived, refer to: Diverse Population Study [} 451].

To analyze ONH and RNFL OU:

Prerequisite þ You are logged in (review station or instrument): Login [} 123].

þ The patient has at least one optic disc cube scan (Acquire an
Optic Disc Cube Scan [} 153]).

Action 1. Select the patient and click Analyze.

2. Select an Optic Disc Cube scan and select ONH and RNFL
OU Analysis.

3. To center the ETDRS grid onto the slice navigator position, click
Center Grid.

4. To show or hide the radial control over the fundus image, click
Radial.

5. To show or hide the layer indicators, click Show/Hide Layers.

6. To reposition the optic disc and cup over the fovea, click and
drag the circles into place.

7. To rotate the angle of the ONH spoke, click Up or Down.

8. To export the all images, click Export.

9. To use a different scan, manually select it (Manually Select a
Scan [} 367]).

10. To edit an image, right-click to access the edit menu (see:
Editing Images Using the Menu [} 369]).

11. To view a full-screen image, double-click on the image.

12. To print, save, or export a report, see: Creating a Report
[} 384].

9.2.3.3 ONH Guided Progression

This analysis helps you follow changes to the optic nerve head. In-
house studies determined the normal reference ranges per age
(see: ONH Algorithms [} 488]).
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This analysis compares 3-8 exams for changes to thickness
measurements over time and determines whether significant
changes have occurred.

This analysis is available for the following scans:

• Optic Disc Cube 200 x 200

9.2.3.3.1 ONH Guided Progression Analysis Overview
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Figure 57: ONH Guided Progression Analysis Overview

# Symbol Name Explanation

1 Scan Information Top Row: Date & Time of acquisition.

Row 2: Serial Number of the instrument that
acquired the image.

Row 3: Registration type and signal strength.

Bottom row: Average thickness.

2 RNFL Thickness Maps Shows a series of RNFL thickness maps over
time.

3 Deviation Map Progression: The first two scans (blank images) establish the baseline.
Each subsequent scan shows deviation from the normal reference range
(changes over time) as compared to normal patients of the same age.

red areas indicate thinner than 99%.

yellow areas indicate thinner than 95%.

purple areas indicate thicker than normal.

Measurement Area The red circle on the fundus image represents
the measurement area for the charts and
graphs.
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# Symbol Name Explanation

4 RNFL Average Thickness
(Overall)

Graphs the superior quadrant average
thickness trend for each exam.

5 RNFL Average Thickness
(Superior)

Graphs the superior quadrant average
thickness trend for each exam.

6 RNFL Average Thickness
(Inferior)

Graphs the inferior quadrant average
thickness trend for each exam.

 Extrapolate
Progression

extends the progression line showing
expected future progression.

7 RNFL Thickness Profile Plots RNFL thickness values in the red
measurement area centered on the optic
disc.

• B1: First baseline scan measurements.

• B2: Second baseline scan measurements.

• C: (Blue line) the most recent scan.

The RNFL Thickness Profile identifies
moderate focal thinning (at least 14 adjacent
A-scans showing significant change) by
comparing changes over multiple visits to
test–retest variability.

Shaded areas:

red shading indicates likely decrease.

yellow shading indicates possible decrease.

purple shading indicates possible increase.

8 Summary Unchecked indicates no loss or increase
detected.

red indicates Likely Decrease (progressive
decrease detected once and confirmed by
consecutive follow–up exams).

yellow indicates Possible Decrease
(progressive decrease detected once.)

purple indicates Possible Increase
(improvement).

9 Progression Setting Selects either:

• ONH: graphs the Average Cup–to–Disc
Ratio per patient's age

• RNFL: graphs the RNFL thickness per
patient's age

 Indicates optional features; license may be required.
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9.2.3.3.2 Analyzing RNFL Change Progression

You can customize Guided Progression reports. For customization
information, see: Configuring Guided Progression Reports [} 116].

To analyze RNFL progression:

Prerequisite þ You are logged in (review station or instrument): Login [} 123].

þ The patient has at least one optic disc cube scan (Acquire an
Optic Disc Cube Scan [} 153]).

Action 1. Select the patient and click Analyze.

2. Select an Optic Disc Cube scan and select Guided
Progression Analysis.

3. Ensure that the signal strength is 7 or higher for each image.

4. Ensure scans are registered properly; if needed, manually
register the scans (see: Manually Register AngioPlex Images
[} 317]).

5. To use a different scan, manually select it (Manually Select a
Scan [} 367]).

6. To view optic nerve measurements, select ONH.

7. To view retinal nerve fiber layer measurements, select RNFL.

8. Check the baseline scans to ensure consistent results for:
RNFL Thickness profiles
Average RNFL Thickness graphs
RNFL thickness maps

9. Check the deviation progression series:

ð Evaluate the rate of decrease, locations of the detected
decrease, age of the patient, stage of the disease, and
other clinical factors to make clinical decisions.

ð Correlate these results with other clinical tests (perimetry,
IOP) to confirm that RNFL loss is clinically significant.

10. Check the Summary.

11. To edit an image, right-click to access the edit menu (see:
Editing Images Using the Menu [} 369]).

12. To view a full-screen image, double-click on the image.

13. To print, save, or export a report, see: Creating a Report
[} 384].

9.2.4 Advanced Visualization Analysis
Advanced Visualization Analysis is available for the following
scans: 

• Macular Cube 512x128

• Macular Cube 200x200

• Optic Disc Cube 200 x 200
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9.2.4.1 Advanced Visualization Analysis

1

2 3

4 5

Figure 58: Advanced Visualization Overview

# Symbol Name Explanation

1 Toolbar

Signal Strength Indicates scan quality level; more green indicates a higher
quality scan.

FastTrac Indicates that the operator used FastTrac when acquiring
the image.

Show / Hide Layers Hides or shows the colored lines indicating the ILM and
RPE layers.

Snap to Center Moves the slice navigators to the center of the 6x6 mm
square.

Tag for Print Tags particular image(s) for printing a report.

2 Fundus Image Fundus image showing scan area and cube navigation
lines.

Select Overlay Selects which overlay to display over the fundus image.
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# Symbol Name Explanation

Overlay Transparency Sets the overlay transparency level.

3 Front plane navigator Shows cross–section of the cube front.

4 Side plane navigator Shows cross–section of the cube side.

5 Top Plane Navigator Shows cross–section of the cube top.

• None (default)

• Slice

• OCT Fundus

• Slab

• ILM – RPE

• ILM – RPEfit

• RPE – RPEfit

Interaction:

When you select Slab, the dashed lines depict slab
thickness in all three planes.

• To adjust the slab, drag the posterior line of the front
or side plane by its handle.

• To reposition the slab, drag the anterior line handle
and move both lines of the slab together.The image
shows an average signal intensity value for each A-
scan location through the depth of the slab.

For ILM, RPE, and RPEfit (variations of the slab), you
view the slab thickness relative to the layer.

9.2.4.2 Analyzing Advanced Visualization

Action 1. To edit an image, right-click to access the edit menu (see:
Editing Images Using the Menu [} 369]).

2. To view a full-screen image, double-click on the image.

3. To print, save, or export a report, see: Creating a Report
[} 384].
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9.2.5 3D Visualization Analysis
3D Visualization Analysis is available for the following scans: 

• Macular Cube 512x128

• Macular Cube 200x200

• Optic Disc Cube 200 x 200
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9.2.5.1 3D Visualization Analysis
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Figure 59: Optic Disc Cube 3D Visualization Overview
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Pos. Symbol Name Explanation

1 View Settings Brightness increases or reduces image brightness.

Contrast increases or reduces image contrast.

Threshold Threshold removes darker tissue in the
image.

Transparency • Use Same Transparency for all
Pixels equalizes transparency
allowing you to see through darker
tissue better.

• Transparency reduces or increases
the transparency for all pixels by the
same percentage

Intensity • Apply intensity filter adjusts
intensity settings.

• Intensity Value sets the grayscale
intensity range.

• Intensity Range limits the intensity
range.

Lighting • Lighting changes the external light
source (decreases the internal light of
the cube).

• Surface Light Weight changes the
intensity of light on the surface of the
image.

• Gradient Step Size

Save / Apply • Save As Global saves your settings
for all subsequent exams.

• Apply Global restores previous global
settings.

• Apply Defaults restores the default
settings.

Show Settings Fundus check to include the top / bottom fundus
images.

Resolution shows images in normal or high
resolution.

Surface check to include surface(s)

Volume check to include volume(s)

Box check to show a box around the cube.

Clip Selector selects the whole cube or a particular area
of the cube to view
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Pos. Symbol Name Explanation

2 Clip Surfaces selects which plane of tissue to clip or cut
away.

Lighting enables exterior lighting.

Light Direction Adjust adjusts the light direction.

Grayscale Mode shows color or grayscale image.

3 Animation Editor • Timeline selects a particular point in
the animation.

• Save snapshot  defines the length of
animation.

•  plays or pauses playback.

•  stops playback.

• Save saves the animation in CIRRUS™
HD-OCT-specific format.

• Load plays a previously-saved
animation.

• Save as Movie saves an animation in
a standard movie format.

• Close exits the animation editor.

4 AutoRecord • AutoRecord Keyframes starts
recording snapshots automatically at
specific intervals

• Stop AutoRecord  finishes recording
the animation

• Clear AutoRecording starts a new
animation.

• PlayEdit AutoRecording play backs,
allows you to edit, and saves the
recording.

• Close exits AutoRecord.
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Pos. Symbol Name Explanation

5 A-Scan Adjustments

• Width manually adjusts the red
sphere position.

• Height manually adjusts the blue
sphere position.

• A-Scan manually adjusts the green
sphere position.

6 Mouse Rotates mouse movement rotates the image.

Mouse Translates mouse movement translates the image.

Zoom zooms in or out.

7 Straighten Volume Data • Auto Straighten automatically
corrects the image tilt.

• Reset to Zero  resets corrections

• Units sets Degrees or Radians.

Straighten X  straightens the image
along the X axis.

• Straighten Y  straightens the image
along the Y axis.

8 Transparent Surfaces Check the view individual layers as trans-
parent surfaces and adjusts transparency
level.

NOTE! Transparent surfaces have
lower resolution.

9 Reset Reset returns the image to its default
settings.

10 Signal Strength Indicates scan quality level; more green
indicates a higher quality scan.

Track

11 3D Image • White lines show cube boundaries

• Red, Green, and Blue lines show the
slice planes.

• Drag sphere along the line of the
same color to change the slice.

9.2.5.2 Analyzing 3D Visualization

Action 1. Click Analyze.

2. Select a cube scan.

3. Select 3D Visualization.
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ð The 3D Visualization Analysis opens. The cube boundaries
are shown with white lines. Labels indicate the Nasal (N),
Superior (S), Temporal (T), and Inferior (I) sides of the cube.

4. To define the slice plane, drag the (red, green, or blue) sphere
along the matching line.

5. To zoom in or out, scroll the mouse.

6. To adjust brightness, contrast, threshold and transparency, click
View Settings.

7. To display settings, click Show Settings > Show...

8. To show or hide the cube boundary lines, and show or hide the
view from the top or bottom of the box, click Show Settings
and check the appropriate settings.

9. To select the whole cube or one of the four niches of the cube,
select Clip Selector .

10. To adjust the light direction, move the red and green spheres
left to right.

11. To toggle between color and grayscale, click Grayscale Mode.

12. To save a recorded animation, click Save or Save as Movie.

13. To close animation, click Close.

14. To record a movie in AVI format, click Record, make edits that
you want to record, and click Record again.

15. To play back a movie, click Play, navigate to the folder with the
movie file and click Open.

16. To start recording, click AutoRecord Keyframes.

17. To finish recording the animation, click Stop AutoRecord.

18. To play back, edit, and save, click Play/Edit AutoRecording.

19. To start a new animation, click Clear AutoRecording .

20. Click Close.

21. To capture an image of the screen, click Take Snapshot.

ð You can save the image as a BMP, JPG, or PNG file.

22. To automatically correct a tilted retina, click Auto Straighten.

23. To manually correct the retina angle, adjust the sliders,
numbers, or arrows.

24. Check whether to view ILM, RNFL, or RPE as transparent
surfaces.

ð Transparent surfaces cause the image to have lower
resolution.

25. Use the sliders to adjust the transparency level.

26. To return to the original image settings, click Reset.
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9.2.6 Combined (Macular and ONH) Analysis

9.2.6.1 Analyze Single Eye Summaries

When you select the  Single Eye Summary analysis for any
macular cube or optic disc scan, CIRRUS™ HD-OCT automatically
selects the best companion scan to complete the analysis. For
example, if you select a macular cube scan, the system selects the
optic disc scan from the same day to include in the analysis.

If you want to select a different companion scan, select Single Eye
Summary - Manual Selection.

Single Eye Summary Analysis is available for the following scans:

Either:

• Macular Cube 512x128

• Macular Cube 200x200

+ Optic Disc Cube 200 x 200

9.2.6.1.1 Single Eye Summary Analysis
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Figure 60: Single Eye Summary Analysis Overview

# Symbol Name Explanation

1 Toolbar

Show / Hide Circles Toggles visibility of the Fovea Fields.

Show / Hide High-
Resolution Images

Displays the high-resolution scans or standard-resolution
scans.

NOTE! The ETDRS Grid does not change position
when the High–Resolution image is displayed.

Snap to Center Moves the slice navigators to the center of the 6x6 mm
square.
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# Symbol Name Explanation

Snap to ETDRS Grid
center

Moves the slice navigators to the ETDRS Grid center
position.

Reset ETDRS Grid Moves the ETDRS Grid back to the CIRRUS-calculated fovea
center location.

Center ETDRS Grid Moves the ETDRS Grid to center on the slice navigator
position.

Show / Hide Layers Hides or shows the red and black layer lines in the B-scan
that correspond to the Optic Disc and Optic Cup outlines.

FastTrac Indicates that the operator used FastTrac when acquiring
the image.

2 Macular Thickness Map Shows ILM-RPE thickness maps.

3 Deviation Map

Purple (outer) circle RNFL calculation circle.

Interaction:

Move the RNFL calculation circle to recalculate:

• Deviation Map

• Optic Disc measurements

Black (middle) Circle Optic Disc Outline

Red (inner) Circle Optic Cup Outline

Rotation Indicators Cyan dots on the optic disc and optic dup outlines indicate
the direction of rotation.

When you change the angle of the ONH spoke, the circles
move to correspond to the new angle selected.

4 Fovea Finder Automatically identifies the fovea and shows the surface of
the area for the individual thickness measurements in the
grid and table.

5 Measurements Table Displays measurements with color-coded comparison to
the normal reference range for the patient's age.
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# Symbol Name Explanation

6 RNFL Thickness Map RNFL thickness map.

7 Neuro-Retinal Rim
Thickness Graph

RNFL Thickness Graph

Displays thickness at each A-scan location along the
selected circle

Interaction:

Recalculate according to position if you:

• Move the blue line right or left.

• Toggle the lines to display OD, OS, or OU.

8 Macular Thickness Infor-
mation

Shows overall average macular thickness in nine sectors.

• central circle (radius = 500 micrometers; diameter =1
mm )

• superior sectors

• nasal sectors

• temporal sectors

• inferior sectors.

Color coding shows how this patient's scan compares to
the normal reference range for their age. See: Macular
Thickness Parameters [} 456]).

9 Macular Cube B-Scan Slice through cube front.

10 ONH B-Scan Slice through cube front

Rotation Angle Allows you to change the angle of rotation for the optic
nerve head spoke.

Interaction:

Changing rotation changes:

• B-scan view

• Cyan dots along the optic disc outline.

• Cyan dots along the optic cup outline.

9.2.6.1.2 Analyzing a Single Eye Summary

Interactivity provided for this analysis includes:

• Navigate through the OCT B-scans (macula and ONH).

• Toggle between Macula B-scans in the same window.

• Toggle between the Macula Cube B-scans and HD Cross Hair
scans in the same window.
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• Reset fovea location, which will update the data table and the
ETDRS grid thickness measurements.

• Reset peripapillary RNFL circle location, which updates the RNFL
and ONH analysis.

• Turn on and off the segmentation lines.

• Turn on and off the disc and cup boundaries and fovea
indicator.

To analyze macular thickness and optic disc of the same eye:

Prerequisite þ The patient has at least one macular cube scan: (Acquire a
Macular Cube Scan [} 150]).

þ You are logged in (review station or instrument): Login [} 123].

Action 1. Select the patient and click Analyze.

2. Select a Macular Cube or Optic Disc scan and select Single
Eye Summary.

3. To export the all images, click Export.

4. To show or hide the circle guides overlaying the fundus image,
click Show/Hide Circles.

5. To show or hide the high-resolution image, click HD.

ð The image toggles between the original resolution and high
resolution versions.

6. To set the navigators to the center of the image, click Center.

7. To center the navigators on the middle of te ETDRS grid, click
Center.

ð The slice navigation lines move to the center of the grid.

8. To rest the ETDRS grid to its original position, click Reset Grid.

9. To center the ETDRS grid onto the slice navigator position, click
Center Grid.

10. To reposition the optic disc and cup over the fovea, click and
drag the circles into place.

11. To rotate the angle of the ONH spoke, click Up or Down.

12. To edit an image, right-click to access the edit menu (see:
Editing Images Using the Menu [} 369]).

13. To view a full-screen image, double-click on the image.

14. To print, save, or export a report, see: Creating a Report
[} 384].
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9.2.6.2 Analyze PanoMap

The PanoMap analysis combines information from the Macular
Thickness analysis, RNFL and ONH analysis, and Ganglion Cell OU
analysis to provide an integrated, wide-field perspective for
comprehensive analysis.

PanoMap Analysis is available for the following scans: 

Either:

• Macular Cube 512x128

• Macular Cube 200x200

+ Optic Disc Cube 200 x 200

For more information about interpreting data displayed in this
analysis, refer to: Interpreting Normal Reference Range Comparison
Data.

9.2.6.2.1 Panomap Analysis

1

2

3

6

5

4

7

Figure 61: PanoMap Analysis Overview

# Symbol Name Explanation

1 Macula and RNFL
Thickness Map

Shows thickness maps.

Overlay Transparency Sets the overlay transparency level.

Select Overlay Selects which overlay to display over the fundus image.

• ONH/RNFL thickness map for the optic disc cube and
macular cube scans (default)

• GC+IP layer thickness map for the macular cube scan

• ILM-RPE layer thickness map for the macular cube scan
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# Symbol Name Explanation

3 Normal Reference Range
Comparison

Displays measurements with color-coded comparison to
the normal reference range for the patient's age.

4 Combined GCA and RNFL
Deviation Map

Compares Ganglion Cell and RNFL thickness to the normal
reference range for the patient's age.

• Red indicates thinner than 99% of the (age-adjusted)
normal reference population.

• Yellow indicates thinner than 95% of the (age-
adjusted) normal reference population.

5 Normal Reference Range
Comparison

Shows overall average and minimum GCL+IPL layer
thickness with color-coded comparison to the normal
reference range for the patient's age.

6 ETDRS Grid Shows overall average macular thickness in nine sectors.

• central circle (radius = 500 micrometers; diameter =1
mm )

• superior sector

• nasal sector

• temporal sectors

• inferior sectors.

Color coding shows how this patient's scan compares to
the normal reference range for their age. See: Macular
Thickness Parameters [} 456]).

7 Neuro-Retinal Rim
Thickness Graph

RNFL Thickness Graph

Displays thickness at each A-scan location along the
selected circle

Interaction:

Recalculate according to position if you:

• Move the blue line right or left.

• Toggle the lines to display OD, OS, or OU.

8 Macular Thickness Infor-
mation

Shows overall average macular thickness in nine sectors.

• central circle (radius = 500 micrometers; diameter =1
mm )

• superior sectors

• nasal sectors

• temporal sectors

• inferior sectors.

Color coding shows how this patient's scan compares to
the normal reference range for their age. See: Macular
Thickness Parameters [} 456]).
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9.2.6.2.2 Analyzing a PanoMap

To analyze a panomap:

Prerequisite þ The patient has at least one macular cube scan: (Acquire a
Macular Cube Scan [} 150]).

þ The patient has at least one optic disc cube scan (Acquire an
Optic Disc Cube Scan [} 153])

þ You are logged in (review station or instrument): Login [} 123].

Action 1. Select the patient and click Analyze.

2. Under OD or OS, select a Macular Cube scan and select
PanoMap.

ð The PanoMap analysis opens showing the selected
macular cube scan and the most recent optic disc cube
scan.

3. To change the overlay for the fundus image select a different
overlay (or none).

4. To adjust the overly transparency, slide the adjustment tool to
the right or left.

5. If you want to use a different scan, manually select it (Manually
Select a Scan [} 367]).

6. Analyze the macular thickness and RNFL maps, charts and
graphs. For more information, see: Interpreting Macular
Thickness Parameters [} 239] and Interpreting RNFL Results.

7. To edit an image, right-click to access the edit menu (see:
Editing Images Using the Menu [} 369]).

8. To view a full-screen image, double-click on the image.

9. To print, save, or export a report, see: Creating a Report
[} 384].

9.2.6.3 Wellness Exam

NOTE This report is intended to provide an eye health summary of
both eyes for the patient.

u Acquire both macular and optic disc cube scans for each eye to
provide a complete wellness report.

The Wellness Exam  combines macular and optic disc image infor-
mation to provide an integrated, easy-to-read, patient-focused
report.

This analysis requires at least one macular  and one optic disc 
image for the same patient, same eye, acquired the same day.

This analysis is available for the following scans:
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Macular Cube Scan:

512x128*
or

200x200

*512x128 is the default

+ Optic Disc Cube Scan:

200 x 200

You can select this analysis for any macular or optic disc cube scan.
When you select a scan and the Wellness Exam, CIRRUS™ HD-
OCT automatically finds the most recent companion scans needed
for this report.

For example, if you select a patient's OD macular cube 200x200
image, CIRRUS™ HD-OCT finds the following companion images to
use in the report:

• OD optic disc cube

• OS macular cube

• OS optic disc cube

9.2.6.3.1 Wellness Exam Overview

1

3

6

2

4

5

Figure 62: Wellness Exam Overview

# Symbol Name Explanation

1 B-Scan Images Shows OD and OS B-scans of the macula.

Cube Navigation Sliders Slides up and down to navigate through the slices.



Instructions for Use 9 Analyzing Exam Data and Creating Reports
CIRRUS™ HD-OCT 9.2 Posterior Segment Scan Analysis

2660021174149 Rev. D 2019-10 303 / 542

# Symbol Name Explanation

2 B-Scan Image Tools

Layers (Segmentation) Hides or shows the lines that indicate segmentation
boundaries.

HR Images Displays the high-resolution scans or standard-resolution
scans.

Snap to Center Moves the slice navigators to the center of the image.

Snap to ETDRS Grid
Center

Moves the slice navigators to the ETDRS grid center
position.

3 Ganglion Cell and RNFL
Deviation Map

Compares Ganglion Cell and RNFL thickness to the normal
reference range for the patient's age.

• red indicates thinner than 99% of the (age-adjusted)
normal population.

• yellow indicates thinner than 95% of the (age-
adjusted) normal population.

4 Quadrant Averages Shows overall average RNFL thickness for each eye in four
quadrants (Superior, Nasal, Temporal, Inferior)

RNFL Thickness Chart Displays thickness profiles. Right-click toggles the display
orientation:

• TSNIT

• NSTIN

5 Macular Thickness Infor-
mation

Shows overall average macular thickness in nine sectors.

• central circle (radius = 500 micrometers; diameter =1
mm )

• superior sectors

• nasal sectors

• temporal sectors

• inferior sectors.

Color coding shows how this patient's scan compares to
the normal reference range for their age. See: Macular
Thickness Parameters [} 456]).

6 Scan Information

OD Macula Scan • Signal strength (out of 10)

• Date and time the scan was captured

• Scan type and size.
OS Macula Scan

OD Optic Disc Scan

OS Optic Disc Scan
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9.2.6.3.2 Creating a Wellness Exam Report

To create a Wellness Exam report:

Prerequisite þ The patient has at least one macular cube scan: (Acquire a
Macular Cube Scan [} 150]).

þ (Optional) The patient has at least one optic disc cube scan
(Acquire an Optic Disc Cube Scan [} 153]).

þ You are logged in (review station or instrument): Login [} 123].

Action 1. Select the patient and click Analyze.

2. Under OD or OS, select a Macular Cube or Optic Disc Cube
scan and select Wellness Exam.

ð The Wellness Exam opens showing the selected macular
cube scan and the most recent optic disc cube scan (for
both eyes, if available).

3. If you want to use a different scan, manually select it (Manually
Select a Scan [} 367]).

4. To view a full-screen image, double-click on the image.

5. To navigate through slices, slide the slice navigator up, down,
right and left as needed.

ð The slice number updates as you move the slider.

6. To show or hide the high-resolution image, click HD.

ð The image toggles between the original resolution and high
resolution versions.

7. To set the navigators to the center of the image, click Center.

8. To center the navigators to the middle of the ONH, click
Center ONH.

ð The slice navigation lines move to the center of the grid.

9. Analyze the ganglion cell and RNFL maps, charts and graphs.
For more information, see: Interpreting Ganglion Cell Results
[} 263] and Interpreting RNFL Results.

10. To print, save, or export a report, see: Creating a Report
[} 384].
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9.2.7 En Face Analysis
En-face Analysis (facing forward) is the same perspective as the
fundus image-- looking directly into the eye.

En Face Analysis is available for the following scans: 

• Macular Cube 512x128

• Macular Cube 200x200

• Optic Disc Cube 200 x 200

• Angiography 3mm x 3mm

• Angiography 6mm x6mm

• Angiography 8mm x 8mm

• Angiography 12mm x 12mm

• HD Angiography 6mm x6mm

• HD Angiography 8mm x 8mm

• ONH Angiography 4.5mm x 4.5mm

9.2.7.1 En face Presets

You can click on the preset to overlay the en face image and adjust
its transparency.

1 2 3 4 5 6 7

Figure 63: En Face Presets and Boundaries

# Slab Features Example

Boundary Boundary

1 Thickness Map

Displays a color-coded slab of thicknesses ranging from 0 (black)
to 500 (white).

Each color bar is 25 micrometers (µm).

2 Fundus

Displays the structural view of the retina.
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# Slab Features Example

Boundary Boundary

3 VRI

Highlights disorders of the VRI such as epiretinal membranes
(ERM) and vitreomacular traction (VMT).

• Bright areas may indicate vitreous attachments.

• Variations in the background intensity may indicate macular
pucker.

ILM + 133 µm ILM - 33 µm

4 Mid-Retina

Highlights fluid and exudates occurring from the Inner Nuclear
Layer to the Outer Nuclear Layer.

Follows contours that are fractions of the distance between ILM
and RPE.

Follows the RPE contour and is elevated slightly to put it at the
level of the IS/OS – Ellipsoid Zone.

Central 1/3 of retinal thickness based on the
ILM and RPE layers

5 IS/OS Ellipsoid

Highlights disruptions to the IS/OS – Ellipsoid Zone (shown as
dark areas).

Follows the RPE contour and is elevated slightly to put it at the
level of the IS/OS – Ellipsoid Zone.

RPE + 39 µm RPE + 9 µm

6 Choroid

Highlights choroidal vasculature - below the RPE-Fit, (approxi-
mately Haller's Layer), deep in the choroid.

• Dark areas indicate vessels.

• Bright areas may indicate RPE disturbance (such as GA).

Choroid thickness can vary; borders may need adjustment.

RPE Fit - 72 µm RPE-Fit - 128 µm

7 Minimum Intensity 

Shows patterns of minimum scan intensity in the retina to help
identify areas of fluid or other disruptions (see: About Minimum
Intensity Projection (Min-IP)).

• Dark areas may indicate fluid build-up.

• Bright areas may indicate disruption of the retina.

90% ILM + 10% RPE RPE
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# Slab Features Example

Boundary Boundary

• ILM = Inner Limiting Membrane

• IS/OS = Inner Segment / Outer Segment; IS/OS = RPE Fit - 70 µm

• RPE = Retinal Pigment Epithelium

• Min IP = Minimum Intensity Projection

9.2.7.2 En Face Analysis

1

2 3

4

Figure 64: En Face Analysis Overview

# Symbol Name Explanation

1 Toolbar

Toggle Prior and Current
Scan

Toggles:

 Show prior image

 Return to current image

Hide/Show LSO

Signal Strength Indicates scan quality level; more green indicates a higher
quality scan.



9 Analyzing Exam Data and Creating Reports Instructions for Use
CIRRUS™ HD-OCT9.2 Posterior Segment Scan Analysis

308 / 542 2660021174149 Rev. D 2019-10

# Symbol Name Explanation

2 varies Selected Preset Displays the preset slab selected from the thumbnails.

3 varies B-Scan Displays the B-scan

Adjustment Tools Offset: Adjusts the boundary line up or down.

Thickness: Adjust the space between the two boundary
lines.

Hide Lines: Hides or shows the boundary lines.

4 varies Preset Selector Selects the Preset.

9.2.7.3 Analyzing En Face Images

Prerequisite þ The patient has a scan that provides En Face Analysis.

þ You are logged in (review station or instrument): Login [} 123].

Action 1. Select the patient and click Analyze.

2. Select a scan that provides En Face Analysis, ans select En Face
Analysis.

ð The analysis opens.

3. Select a preset (see: En face Presets [} 305]).

4. To edit or adjust the image, hover over the image and select an
adjustment tool (refer to: Edit Images (Hover Over) [} 370].

5. To view a full-screen image, double-click on the image.

6. To print, save, or export a report, see: Creating a Report
[} 384].

9.2.8 Position the Fovea
CIRRUS™ HD-OCT software identifies reduced reflectivity below the
retina to detect the fovea automatically for the following analyses:

• Analyze Macular Thickness [} 238]

• Analyze Macular Change [} 247]

• Analyze Ganglion Cell OU [} 262]

• Advanced RPE Analysis [} 257]

If the algorithm could not detect the fovea location or if the fovea
was detected inaccurately, you can manually reposition the fovea.
When you manually reposition the fovea, the data tables and
ETDRS thickness measurements update accordingly.

The set of tools that help you position the fovea include:

# Symbol Name Explanation

Snap to Center Moves the slice navigators to the center of the 6x6 mm
square.
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# Symbol Name Explanation

Snap to ETDRS Grid
center

Moves the slice navigators to the ETDRS Grid center
position.

Reset ETDRS Grid Moves the ETDRS Grid back to the CIRRUS-calculated fovea
center location.

Center ETDRS Grid Moves the ETDRS Grid to center on the slice navigator
position.

9.3 Analyze Angiography Images

NOTE 12x12 cubes and 12 mm raster scan the resolution has
changed compared to the case of the A-scan size of 2.0 mm.
Using the sum projection, weaker details of the images are
enhanced. Specifically, by mathematical definition of the
sum projection, with the sum projection the slower flow is
enhanced and therefore smaller capillaries are more visible.

Before analyzing an Angiography image, re-assess scan quality,
segmentation errors, and decorrelation tails.

Angiography Analysis is available for the following scans: 

• Angiography 3mm x 3mm (  AngioPlex Metrix)

• Angiography 6mm x 6mm (  AngioPlex Metrix)

• Angiography 8mm x 8mm

• HD Angiography 6mm x 6mm

• HD Angiography 8mm x 8mm

• Angiography 12mm x 12mm

 Indicates optional features; license may be required.

9.3.1 About Angiography Analysis

9.3.1.1 About AngioPlex® Metrix

When analyzing angiography scans, you can observe and measure
vessel density and capillary perfusion using AngioPlex Metrix. 

AngioPlex Metrix provides both visual results (map, trace, FAZ)
with color overlays and measurement results.

AngioPlex Metrix measurements are available for the following
images:

• Angiography cube (Superficial layer)

– 3 mm x 3 mm

– 6 mm x 6 mm

• ONH Angiography cube (RPC layer)
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– 4.5 mm x 4.5 mm

AngioPlex Cube ONH AngioPlex Cube

Table 71: AngioPlex Metrix Examples

Map, Trace, and measurement information changes when you
toggle between Vessel and Perfusion.

Table 72: Overlays
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9.3.1.1.1 About FAZ Measurements

CIRRUS™ HD-OCT automatically detects the Foveal Avascular
Zone (FAZ) and outlines it.

If the application cannot detect the FAZ or if you want to change
the outline, you can Edit the FAZ Outline [} 311].

AngioPlex Metrix  calculates the values for Area, Perimeter, and
Circularity of the FAZ.

FAZ Metrix Units Description

Area mm2 The area within the FAZ boundary.

Perimeter mm The length of the FAZ boundary.

Circularity - FAZ boundary similarity to a circle (range: 0-1).

• 1 = FAZ forms a perfect circle

• 0 = very different from a circle.

Table 73: FAZ Metrix

FAZ Circularity

Low circularity can result from loss in capillaries immediately
surrounding the FAZ.

High Circularity Low Circularity

Circularity = 0.75 Circularity = 0.58

Table 74: Circularity Examples

9.3.1.1.1.1 Edit the FAZ Outline
CIRRUS™ HD-OCT software automatically outlines the FAZ and
calculates AngioPlex Metrix . You can manually edit the FAZ
outline (must be a single closed shape).

When you draw a new outline for the FAZ, CIRRUS™ HD-OCT
software automatically connects the end point and the beginning
point where the line intersects, then recalculates the FAZ area,
perimeter, and circularity using the new outline.

To Edit the FAZ:

Prerequisite þ You are logged in (review station or instrument): Login [} 123].

þ The patient has at least one angiography scan: (Acquire an OCT
Angiography Scan [} 163]).

Action 1. Select the Patient [} 124].

2. Under OD or OS, select a Angiography scan and select
Angiography Analysis.
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ð If licensed, AngioPlex Metrix appear.

3. Select a Density Measure (Vessel or Perfusion).

4. Under Overlays, click FAZ.

ð ETDRS features are disabled (if selected).

5. Under FAZ, click Edit.

ð If the application detected and outlined the FAZ, an
additional confirmations open.

6. If a confirmation opens, click Delete.

ð The cursor becomes a pencil.

7. Click on a point along the FAZ boundary and drag the pen
around the outline until you reach the starting point.

ð The drawing tool automatically connects the end point to
the beginning point when they intersect.

ð When you release the mouse, the FAZ area appears shaded
yellow.

ð The CIRRUS™ HD-OCT application recalculates the Area,
Perimeter, and Circularity of the new shape.

9.3.1.1.2 About Density Measurements

AngioPlex Metrix provide two different ways to measure vascular
density:

• Vessel Density

• Perfusion Density

Vessel Density

Vessel Density is the total length of perfused vasculature per unit
area in a region of measurement. Vessel Density is expressed as
mm/mm2 (total vessel length per unit area), similar to how road
density is expressed (km of road per square kilometer of land, for
example).

Vessel Density =  the total length of perfused
vasculature per unit area in a region of
measurement 
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Vessel Density measurements helps to detect the loss of individual
capillaries because vessel size does not influence the measurement.
However, this measure is more sensitive to noise.

Perfusion Density

Perfusion Densitymeasures the percent total area of perfused
vasculature in a given region of measurement. Perfusion Density
accounts for the width (caliber) of the vessels in addition to the
length. It provides the percent of the region that contains perfused
vasculature, regardless of intensity of the OCTA signal.

Perfusion Density = number of pixels with perfused
vasculature / total number of pixels in the
region

The result is a percent ranging from 0 (no perfusion) to 100%.

In Perfusion Density, vessel size (caliber) does influence the
measurement.

9.3.1.1.3 Viewing AngioPlex Metrix Measurements

AngioPlex Metrix measurements display as color maps and as
numeric measurements of the ETDRS grid regions.

If you check Grid and Values, CIRRUS™ HD-OCT displays each
section of the ETDRS grid and the AngioPlex Metrix values.

Measurements are dynamic; they change if you move the ETDRS
grid to a different area of the image.

The options for centering options the ETDRS grid are:

Center on Slice Navigators: Centers the ETDRS grid on the
current position of the slice navigators.

Center on the Fovea:Centers the ETDRS grid on the fovea.

9.3.1.2 About Analysis Presets
Tip: If CIRRUS™ HD-OCT does not
detect segments successfully, you
can use the layer segmentation
editor to set layer boundaries (see:
Edit Layer Boundaries).

Some analyses have preset slab views that highlight different
features or locations. You can also create your own custom presets.

Presets provide a calculated slab location as a starting point.
However, since exact layer location can vary by patient anatomy
and pathology, you can drag these segmentation lines to adjust
layers more precisely.

You can make additional image adjustments (such as brightness
and contrast) and save the adjusted images.

Presets are available for the following analyses:
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• Analyze Angiography Images [} 320]

• Compare Angiography Images [} 327]

• Analyze ONH Angiography Images [} 331]

• Compare ONH Angiography Images [} 333]

• Analyze En Face Images

9.3.1.2.1 Organize AngioPlex Presets

Not all AngioPlex presets appear in AngioPlex analysis. You can
choose which presets to hide and which to display (including your
own custom presets) by organizing the thumbnails.

To organize presets:

Prerequisite þ You are logged in (review station or instrument): Login [} 123].

þ You are analyzing an AngioPlex image and you want to
organize the presets.

Action

1. Open the Thumbnail Organizer.

ð Some thumbnails are displayed and others are hidden.

2. Move the presets you want to display under Displayed
Thumbnails.

3. Move the presets you want to hide under Hidden Thumb-
nails.

4. To change to order of the presets, drag a displayed thumbnail
to a new position.

Result ü The thumbnails you set for display appear for AngioPlex
analysis in the same order.

9.3.1.2.2 Offset Preset Layer Boundaries
Tip: You can also left-click on the
pink triangle and drag the layer
boundary line into place.

Editing layers allows you to fine-tune layer boundaries. If a patient's
retinal structure has anomalies or if the patient's retinal pathology
causes CIRRUS™ HD-OCT algorithms to trace the boundaries
inaccurately, you might need to adjust layer boundaries.

You can drag any portion(s) of the boundary lines, but you cannot
cross the upper and lower boundaries.

To offset layer boundaries:

Prerequisite þ You are logged in (review station or instrument): Login [} 123].

þ An angiography cube scan is open: Analyze Angiography
Images [} 309].

Action

1. Under Segmentation Lines, check Show.
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ð Dashed lines indicating the top and bottom layers overlay
the B-scan image.

2. To adjust the top layer, change the Offset number for Top.

3. To adjust the bottom layer, change the Offset number for
Bottom.

4. Complete the analysis.

9.3.1.2.3 Custom Presets

There are two blank presets for you to create and reuse your own
slab presets. There are two different types of custom presets:

Custom Scan Presets

You can create one or two custom presets to define your own
boundaries and segmentation lines to use for the scan you are
analyzing.

Custom Global Presets

You can also create one or two custom presets to define your own
boundaries and segmentation lines to use for all Angiography
Analyses. You can use custom presets to choose an inner
boundary and an outer boundary, and then shift them to visualize
the vasculature between existing presets.

You can step through the scan and drag segmentation lines to
offset the outer and inner boundaries. However, you cannot use
segmentation lines when images are overlaid with a thickness map.

9.3.1.3 About Angiography Registration

When you compare a patient's scan to an earlier scan (of the same
type), CIRRUS™ HD-OCT automatically aligns, or registers, the
scans together. Registration synchronizes anatomical structures and
corrects differences in rotation, which can occur if the patient is
situated slightly differently for the two scans.

Figure 65: Unregistered Areas
(Black Border)

9.3.1.3.1

Automatic Scan Registration

There are two different methods for automatically registering
scans, R2 and R1.

CIRRUS™ HD-OCT's primary (preferred) registration method is R2.

However, if R2 cannot adequately register the images, the
instrument attempts R1 registration.

Analyses and reports that use scan registration inform you of which
method was applied.
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Method Order Description

R2 Primary • Aligns scans using the blood vessels identified in the en face images of
both scans.

• For guided progression analyses, uses translation and rotation to align
the follow-up scan(s) to the baseline scan

R1 Secondary • Aligns scans using the center of the optic disc of both scans.

• R1 does not include rotation.

• R1 might cause additional variability at the super-pixel level, which can
affect change detection in a thickness map.

Table 75: Registration Types

If you want to override automatic registration, you can register
scans manually or select a different set of scans to register
together. (See: Manually Register AngioPlex Images [} 317]).

9.3.1.3.2 No Registration

If automatic registration was not successful and no manual regis-
tration was applied yet, the scans will display No Registration. To
register the scans, refer to: Manually Register AngioPlex Images
[} 317].

9.3.1.3.3 Manual Registration

When you manually register images, you set (up to five) corre-
sponding points between two images. When you identify the same
structure or feature in both images, click that structure in the first
image, then the second image.

For example, use a blood vessel bifurcation or a bend in a blood
vessel as a point to mark. A matching set of marks indicates corre-
sponding features. Different marks indicate the next features you
mark (see: Manually Register AngioPlex Images [} 317]).

Figure 66: Registration Mark Pairing

After you register two images, the second image might display
irregular black borders. These borders indicate areas that are not
present in both images.
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9.3.1.3.4 Manually Register AngioPlex Images

AngioPlex Registration

Registration Tool

Matched Marks

Marked Example

To adjust registration manually:

Prerequisite þ You are logged in (review station or instrument): Login [} 123].

þ You have a comparison analysis open and you want to change
the registration.

Action 1. For Registration, select Manual.
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ð The registration review tool opens.

2. Identify a feature that appears in both images, like a blood
vessel bifurcation or a bend in a blood vessel.

3. Mark the feature in each image.
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4. Identify and mark additional identifiable features in other
regions of the pair of images (between 3 and 5 marks in each
image).

5. To change the transparency of Image 1 or Image 2, move the
transparency slider right or left.

6. To view the manually-adjusted overlay, click Review Regis-
tration.

7. To return to the original registration, click Reset.

8. Click OK.

Result

ü The Registration succeeded message and a green flag
appear.

9.3.1.4 Verifying the Avascular Slab

Reviewing the Avascular Layer

NOTE The Avascular slab was constructed with the goal of
bounding the parts of the retina that are expected to have
no vasculature in normal anatomy. There are many situations
for which there may appear to be bright patches or areas in
this image that are not necessarily due to pathology. These
are listed below.

Examine the segmentation, flow, and intensity of B-scans carefully
for abnormal-appearing vasculature in the Avascular slab.

• Errors in segmentation may cause there to be apparent vascu-
lature. This is particularly common in the presence of
geographic atrophy. Bright areas below the Bruch’s Membrane
are common in the presence of geographic atrophy due to the
fact that the highly scattering RPE is missing. When this
happens, the RPE segmentation can frequently fall into the
choroidal areas and be irregular.

• Because the boundaries of the inner layers of the retina are
estimated rather than segmented, they may incorrectly include
bright areas that could contain decorrelation tails or even actual
vasculature.
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• The brightness and contrast of the avascular layer is enhanced
in order to assist in visualizing any potential abnormal vascu-
lature, but this can also tend to emphasize both noise and weak
decorrelation tail signals.

• Exudates or migrated RPE may cause there to be artifacts in
different layers. This should be uncommon in the outer retina,
but it can occur.

• The segmentation, flow, and intensity of B-scans should be
examined carefully if there is abnormal-appearing vasculature in
the Avascular slab.

9.3.2 Analyze Angiography Images

9.3.2.1 Angiography Presets

1 2

4 3

5 6

7 8

Figure 67: Angiography Analysis Presets and Boundaries

# Slab Features Example

Top Boundary Bottom Boundary

1 VRI

Highlights disorders of the VRI such as epiretinal membranes
(ERM) and vitreomacular traction (VMT).

• Bright areas may indicate vitreous attachments.

• Variations in the background intensity may indicate macular
pucker.

ILM - 300 µm ILM



Instructions for Use 9 Analyzing Exam Data and Creating Reports
CIRRUS™ HD-OCT 9.3 Analyze Angiography Images

2660021174149 Rev. D 2019-10 321 / 542

# Slab Features Example

Top Boundary Bottom Boundary

2 Superficial

Displays the superficial retinal layer slab with the ILM layer
segmented in the same manner as structural images. The IPL is
approximate.

ILM IPL

3 Retina

Illustrates vasculature of the entire retina.

The lower boundary is offset by 70 µm to minimize the contri-
bution of the hyper-reflective RPE.

ILM RPE fit – 70µm

4 Retina Depth Encoded

A color encoded slab with different colors representing different
layers.

• Red: Superficial

• Green: Deep

• Blue: Asascular

ILM RPE

5 Deep Retinal Layer (DRL)

Displays the deep retina layer slab.

IPL* OPL

6 Avascular

Displays parts of the retina that normally do not have vascu-
lature. You can adjust brightness and contrast to help visualize
potential abnormal vasculature, but these adjustments could
also emphasize noise and weak decorrelation tail signals.

OPL IS/OS

7 Choriocapillaris

Choriocapillaris

OPL RPE fit + 38 µm

8 Choroid

Uses the summation of pixel values as the default.

RPE RPE Fit
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# Slab Features Example

Top Boundary Bottom Boundary
*Estimated

• ILM = Inner Limiting Membrane

• IPL = Inner Plexiform Layer IPL = ILM + 70% * (Thickness of ILM - Thickness of
OPL)

• DRL = Deep Retinal Layer

• IS/OS = Inner Segment / Outer Segment IS/OS = RPEfit – 70 µm

• OPL = Outer Plexiform Layer

• RPE = Retinal Pigment Epithelium

• VRI = VitreoRetinal Interface
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9.3.2.2 Angiography Analysis Overview

1

2 3

4 5

7

8 9

Figure 68: Angiography Analysis Overview

# Symbol Name Explanation

1 Tools and Indicators

Back Navigates to the prior preset

Preset Organizer Rearranges, hides, or shows presets.

FastTrac Indicator Green indicates the scan was acquired with FastTrac on.

Advanced Export Exports images and thickness values.

Signal Strength Indicates image quality level; more green indicates a higher
quality image.

Watermark Turns on or off the watermark.

2 AngioPlex Imagae Displays the angiography image for the slab.

3 Structure Image Displays the structure image for the slab.
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# Symbol Name Explanation

4 B-Scan Slice through cube front

5 Overlay Tools (AngioPlex
and Structure images)

Thickness Map: shows or hides the thickness map over
AngioPlex® or Structure image (or both).

Transparency: increases or deceases transparency of the
thickness map overlaying the image.

Fundus Image: shows or hides the fundus image over
both AngioPlex® and Structure images.

Slice Navigators: shows or hides the cyan (fast B-scans) and
magenta (slow B-scans) over both AngioPlex® and
Structure images.

6 Superficial
Preset only

AngioPlex Metrix Tools to observe and measure vessel density, capillary
perfusion and FAZ (see:About AngioPlex® Metrix [} 309] )

7 Presets Preset slabs (see:Angiography Presets [} 320]).

8 B-Scan Settings B-Scan Flow shows or hides an overlay depicting blood
flow on the B-scan image:

• 1 color: shows all aspects of the flow in light red.

• 2 color:

light red shows flow data above the RPE;

green shows flow data below the RPE.

Segmentation Lines:

Show: shows or hides the dashed magenta layer lines of
the selected slab over the B-scan image.

Edit:  opens segmentation editing.

9 Slab Boundaries Shows the top and bottom boundaries for the selected
slab preset.
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9.3.2.3 Analyze an Angiography Image
Tip: You can use the toolbar
arrows to navigate through the
presets. The left arrow selects the
prior preset. The right arrow
selects the next preset.

You can edit the AngioPlex, Structure, and B-scan images individ-
ually. To access the editing tools, right click on the image you want
to edit.

You can edit the images in the following ways:

• Adjust brightness and contrast

• Zoom in and zoom out

• Arrow

• Save your edits

• Copy the image

• Save as a movie

• View full screen

• Reset

• Add caliper measurements and text annotations

• Remove a caliper or annotation

To analyze an angiography image:

Prerequisite þ You are logged in (review station or instrument): Login [} 123].

þ The patient has at least one angiography scan: (Acquire an OCT
Angiography Scan [} 163]).

Action 1. Select the patient and click Analyze.

2. Under OD or OS, select a Angiography scan and select
Angiography Analysis.

ð The analysis opens.

3. Select a preset (About Analysis Presets [} 313]).

ð The selected slab opens in Slab, Structure, and B-scan
views.

4. To view a full-screen image, double-click on the image.
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5. To overlay the B-scan image with flow data, check Show under
B-Scan Flow .

ð Select 1 color to show all flow data in red or select 2 color
to show areas above the RPE in light red and below the RPE
in green.

6. To show the layer segmentation lines over the B-scan image:
under  Segmentation Lines , check Show.

ð Dashed magenta lines show the layer boundaries over the
B-scan.

7. To adjust a layer boundary, refer to: Offset Preset Layer Bound-
aries [} 314].

ð The AngioPlex and Structure images update to match the
adjusted layer boundary.

8. To remove image artifacts such as decorrelation tails, check
Remove Projections.

9. To adjust image brightness or contrast, right-click on the image
and select Brightness/Contrast.

10. To show a color image, right-click on the image and select 
Color.

11. To hide the image, right-click on the image and select Hide.

12. To exit any editing mode and save the changes, right-click on
the image and select Normal.

13. To show the thickness map over the angiography image, check
AngioPlex.

14. To show the thickness map over the structure image, check
Structure.

ð NOTE! You cannot use segmentation lines on an
image showing a thickness map.

15. To adjust the transparency of the thickness map(s), increase or
decrease Transparency.

16. To show the fundus image over the AngioPlex and Structure
images, check Fundus Image.

17. To turn on slice navigators that allow you to navigate the cube
layers, check Slice Navigators. See: Navigate Cube Layers
Manually [} 226].

ð Cyan (fast B-scans) and magenta (slow B-scans) navigators
show over both AngioPlex and Structure images.

18. To set the navigators to the center of the image, click Center.

19. To center the navigators to the middle of the ONH, click
Center ONH.

ð The slice navigation lines move to the center of the grid.

20. To edit or adjust the image, hover over the image and select an
adjustment tool (refer to: Edit Images (Hover Over) [} 370].
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21. To view a full-screen image, double-click on the image.

22. To print, save, or export a report, see: Creating a Report
[} 384].

9.3.3 Compare Angiography Images

9.3.3.1 Angiography Change Analysis

Angiography Change Analysis allows you to compare multiple
scans to visualize changes in retinal vasculature over time. 

This analysis is available for the following scans:

• Angiography 3mm x 3mm

• Angiography 6mm x6mm
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9.3.3.1.1 Angiography Change Analysis Overview

1

2

4

7

3

5

6

Figure 69: Angiography Change Analysis Overview

# Symbol Name Explanation

1 Tools and Indicators

Preset Slabs Selects the slab to view.

FastTrac Indicator Green indicates the scan was acquired with FastTrac on.

Signal Strength Indicates scan quality level; more green indicates a higher
quality image.

Prior Scan and
Selected Scan

Exam 1 and Exam 2 Indicates the Date and Time each image was acquired.

Registration Indicates whether images are aligned to each other.

Advanced Export Exports images and thickness values.

2 Prior Images Shows the slab and the structure for the earlier image.

3 Selected Images Shows the slab and the structure for the selected image.

4 Prior Image B-Scan Displays the B-scan image.

5 Selected Image B-Scan
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# Symbol Name Explanation

6 Overlays

AngioPlex Check to overlay thickness maps.

Structure Check to overlay thickness maps.

Transparency Adjusts overlay transparency.

Remove Projections Check to remove projections.

Watermark Check to add a watermark to images

Slice Navigators Shows or hides slice navigators on slab and structure
images.

Fundus Image Check Fundus to overlay fundus image (instead of
thickness maps).

B-Scan Flow Shows or hides an overlay depicting blood flow on the B-
scan image:

• 1 color: shows all aspects of the flow in light red.

• 2 color:

– light red shows flow data above the RPE.

– green shows flow data below the RPE.

Segmentation Lines Shows or hides magenta lines that indicate top and
bottom layers of slabs.

9.3.3.1.2 Analyze Angiography Change

To analyze angiography change:

Prerequisite þ You are logged in (review station or instrument): Login [} 123].

þ The patient has at least one angiography scan: (Acquire an OCT
Angiography Scan [} 163]).

Action 1. Select the patient and click Analyze.

2. Under OD or OS, select a Angiography scan and select
Angiography Analysis.

ð The analysis opens.

3. Select a preset (About Analysis Presets [} 313]).

ð The selected slab opens in Slab, Structure, and B-scan
views.

4. To view AngioPlex Metrix, select the Superficial slab.

5. To view AngioPlex Metrix for a different part of the image or
a different cube slice, select the part image you want to
measure.

ð AngioPlex Metrix recalculates measurements based on
the new selection.

6. To view a full-screen image, double-click on the image.
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7. To overlay the B-scan image with flow data, check Show under
B-Scan Flow .

ð Select 1 color to show all flow data in red or select 2 color
to show areas above the RPE in light red and below the RPE
in green.

8. To show the layer segmentation lines over the B-scan image:
under  Segmentation Lines , check Show.

ð Dashed magenta lines show the layer boundaries over the
B-scan.

9. To adjust a layer boundary, refer to: Offset Preset Layer Bound-
aries [} 314].

ð The AngioPlex and Structure images update to match the
adjusted layer boundary.

10. To remove image artifacts such as decorrelation tails, check
Remove Projections.

11. To adjust image brightness or contrast, right-click on the image
and select Brightness/Contrast.

12. To show a color image, right-click on the image and select 
Color.

13. To hide the image, right-click on the image and select Hide.

14. To exit any editing mode and save the changes, right-click on
the image and select Normal.

15. To show the thickness map over the angiography image, check
AngioPlex.

16. To show the thickness map over the structure image, check
Structure.

ð NOTE! You cannot use segmentation lines on an
image showing a thickness map.

17. To adjust the transparency of the thickness map(s), increase or
decrease Transparency.

18. To show the fundus image over the AngioPlex and Structure
images, check Fundus Image.

19. To turn on slice navigators that allow you to navigate the cube
layers, check Slice Navigators. See: Navigate Cube Layers
Manually [} 226].

ð Cyan (fast B-scans) and magenta (slow B-scans) navigators
show over both AngioPlex and Structure images.

20. To set the navigators to the center of the image, click Center.

21. To center the navigators to the middle of the ONH, click
Center ONH.

ð The slice navigation lines move to the center of the grid.

22. To print, save, or export a report, see: Creating a Report
[} 384].
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9.3.4 Analyze ONH Angiography Images
Before analyzing an ONH Angiography image, re-assess scan
quality, segmentation errors, and decorrelation tails.

ONH Angiography Analysis is available for the following scans: 

• ONH Angiography 4.5 x 4.5 mm

9.3.4.1 ONH Angiography Presets

1

2

3

4

Figure 70: ONH Angiography Presets and Boundaries

# Slab Features Example

Top Boundary Bottom Boundary

1 Retina

Illustrates vasculature of the entire retina.

The lower boundary is offset by 70 µm to minimize the contri-
bution of the hyper-reflective RPE.

ILM RPE fit – 70µm

2 VRI

Highlights disorders of the VRI such as epiretinal membranes
(ERM) and vitreomacular traction (VMT).

• Bright areas may indicate vitreous attachments.

• Variations in the background intensity may indicate macular
pucker.

ILM - 300 µm ILM

3 Retina Depth Encoded

Color encoded slab with different colors representing different
layers (Red: Superficial; Green: Deep; Blue: Avasculature).

ILM RNFL
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# Slab Features Example

Top Boundary Bottom Boundary

4 Whole Eye

Illustrates the vasculature of entire posterior segment, including
vitreous, retina and choroid.

• ILM = Inner Limiting Membrane

• RNFL = Retinal Nerve Fiber Layer

9.3.4.2 Analyze ONH Angiography

To analyze ONH angiography images:

Prerequisite þ You are logged in (review station or instrument): Login [} 123].

þ The patient has at least one ONH Angiography scan (Acquire
an AngioPlex ONH Scan [} 169]).

Action 1. Select the patient and click Analyze.

2. Under OD or OS, select an ONH Angiography 4.5 x 4.5mm
scan and select ONH Angiography Analysis.

ð The analysis opens.

3. To create custom slab presets or rearrange, hide or show
existing presets, click Organize Presets (see: Organize
AngioPlex Presets [} 314]).

4. Select a preset (About Analysis Presets [} 313]).

ð The selected slab opens in Slab, Structure, and B-scan
views.

5. Ensure that the Signal Strength is 6 or higher.

6. To view or edit a full-screen image, double-click on the image.

7. To show the fundus image over the AngioPlex and Structure
images, check Fundus Image.

8. To remove image artifacts such as decorrelation tails, check
Remove Projections.

9. To turn on slice navigators that allow you to navigate the cube
layers, check Slice Navigators. See: Navigate Cube Layers
Manually [} 226].

ð Cyan (fast B-scans) and magenta (slow B-scans) navigators
show over both AngioPlex and Structure images.

ð The slice navigation lines move to the center of the grid.

10. To overlay the B-scan image with flow data, check B-scan
Flow and select 1 color or 2 color.

ð Select 1 color to show all flow data in red or select 2 color
to show areas above the RPE in light red and below the RPE
in green.
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11. To show layer segmentation lines over the B-scan image, check
Segmentation Lines.

ð Dashed magenta lines show the layer boundaries over the
B-scan.

12. To set the navigators to the center of the image, click Center.

13. To adjust a layer boundary, refer to: Offset Preset Layer Bound-
aries [} 314].

14. To export the all images, click Export.

15. To edit or adjust the image, hover over the image and select an
adjustment tool (refer to: Edit Images (Hover Over) [} 370].

16. To view a full-screen image, double-click on the image.

17. To print, save, or export a report, see: Creating a Report
[} 384].

9.3.5 Compare ONH Angiography Images

9.3.5.1 ONH Angiography Change Analysis

ONH Angiography Change Comparison Analysis allows you to
view any two ONH angiography scans from a patient’s history to
visualize changes in vasculature.

This analysis is available for the following scans:

• ONH Angiography 4.5mm x 4.5 mm
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9.3.5.1.1 ONH Angiography Change Analysis

1

3 4

5 6

7

8 9

2

Figure 71: ONH Angiography Change Comparison Overview

# Symbol Name Explanation

1 Tools and Indicators

Preset Slabs Selects the slab to view.

FastTrac Indicator Green indicates the scan was acquired with FastTrac on.

Signal Strength Indicates scan quality level; more green indicates a higher
quality image.

Prior Scan and
Selected Scan

Exam 1 and Exam 2 Indicates the Date and Time each image was acquired.

Registration Indicates whether images are aligned to each other.

Advanced Export Exports images and thickness values.
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# Symbol Name Explanation

2 Overlays

Overlay Slider Opens the overlay panel.

Fundus Image Check Fundus to overlay fundus image (instead of
thickness maps).

Remove Projections Check to remove projections.

Slice Navigators Shows or hides slice navigators on slab and structure
images.

B-Scan Flow Shows or hides an overlay depicting blood flow on the B-
scan image:

• 1 color: shows all aspects of the flow in light red.

• 2 color:

– light red shows flow data above the RPE.

– green shows flow data below the RPE.

Segmentation Lines Shows or hides magenta lines that show the upper and
lower boundary in the B-scans.

2 Prior Images Shows the slab and the structure for the earlier image.

3 Selected Images Shows the slab and the structure for the selected image.

7 Comparison Table Shows the measurement differences between the two
visits.

8 Prior Image Heat Map RNFL thickness map.

9 Current Image Heat Map

9.3.6 Analyze Montage AngioPlex Images
Wide-field montage images increase the Field of View (FOV) to
produce high-resolution vascular imaging over a larger region of
the retina.

Montage Angiography Analysis is available for the following
scans: 

• Montage AngioPlex 6x6mm

• Montage AngioPlex 8x8mm
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9.3.6.1 Montage AngioPlex Analysis

1

2

3

4

5

6

7

8

9

Figure 72: Montage Angiography Analysis Overview

# Symbol Name Explanation

1 Toolbar

Toggle Toggles between showing the AngioPlex and Structure
image.

Angio Shows or hides the AngioPlex image.

Structure Shows or hides the Structure image.

Both Shows both theAngioPlex and Structure images.

Watermark Turns on or off the watermark.

Advanced Export Exports maps of the ILM layer to RPE layer thickness values.

2 AngioPlex Image Displays the AngioPlex image of the selected slab.

3 Structure Image Displays the Structure image of the selected slab.
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# Symbol Name Explanation

4 Scan Positions Shows the positions of the individual images that make up
the montage.

Select a position to view its thumbnail.

5 Selected
Image

Blue outline indicates selected image.

6 Selected
Presets

Outlined in blue.

7 Presets Preset slabs (see:Angiography Presets [} 320]).

8 Thumbnail Thumbnail of the individual image.

9 Slab Boundaries Shows the top and bottom boundaries for the selected
slab preset.

9.3.6.2 Analyze an Angiography Montage Image

To analyze a montage image:

Prerequisite þ You are logged in (review station or instrument): Login [} 123].

þ The patient has at least one montage angiography scan
(Acquire AngioPlex Montage Scans [} 171]).

Action 1. Under OD or OS, select a Montage scan and select Montage
Angio Analysis.

ð The Montage Angio Analysis opens.

2. Select a preset (About Analysis Presets [} 313]).

ð The selected slab opens in AngioPlex andStructure views.

3. To view the boundaries of the selected slab, refer to the table.

4. To view a full-screen image, double-click on the image.

5. To switch the positions of the AngioPlex and Structure images,
click the arrows toggle.

6. To view the AngioPlex image only, click Angio.

7. To view the Structure image only, click Structure.

8. To view both AngioPlex and Structure images, click Both.

9. To export all montage images, click Export.
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10. To view a thumbnail of an individual image from the montage,
click on the position of the image.

ð The thumbnail under the selector shows the image of the
selected position.

11. To analyze an individual image that makes up the montage,
expand the montage, select the image and analysis you want
to use.

12. To edit or adjust the image, hover over the image and select an
adjustment tool (refer to: Edit Images (Hover Over) [} 370].

13. To view a full-screen image, double-click on the image.

14. To print, save, or export a report, see: Creating a Report
[} 384].

9.4 Analyze Anterior Segment Scans
Typical Applications Anterior

Chamber
Anterior
Segment
Cube

5-Line
Raster

HD Angle Wide
Angle to
Angle

HD
Cornea

Pachymet
ry

Measure Iridocorneal
Angles

X

Most
accurate
angle
measure
ment

- X X

Highest
resolutio
n and
greatest
detail of
individual
angle

X

Both
angles in
one
image

- -

Measure additional angles X - - - - - -

Measure anterior chamber
depth, angle-to-angle
distance

X - - - - - -

Measure angle-to-angle
distance

X X

Measure lens vault X

Measure corneal thickness X X X X X

Measure central corneal
thickness

X X X X

Measure angle to angle
distance

X X

Navigate through slices
horizontally and vertically

- X - - - - -

Measure corneal tissue and
anterior segment struc-
tures below the cornea
(vertically)

X X
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Typical Applications Anterior
Chamber

Anterior
Segment
Cube

5-Line
Raster

HD Angle Wide
Angle to
Angle

HD
Cornea

Pachymet
ry

View a color-coded
thickness map of the
cornea with detailed
thickness measurement
data

- - - - - - X

View color-coded thickness
map of the corneal
epithelium with detailed
thickness measurement
data

X

9.4.1 About Analyzing Anterior Segment Scans
Anterior segment reports do not include customization or
additional options.

Many anterior segment scans are optional (see: About Licenses
[} 61]).

Scan Pattern External Lens Scan Analysis

Anterior Segment Scans

- Anterior Segment Cube • Anterior Segment Analysis

• 3D Visualization

- Anterior Segment 5 Line Raster High Definition Images

- HD Angle HD Angle Analysis

Anterior Chamber Anterior Chamber Analysis

Wide Angle-to-Angle Wide Angle-to-Angle Analysis

HD Cornea HD Cornea Analysis

Pachymetry Pachymetry Analysis

Table 76: Anterior Segment Scans
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9.4.2 About Central Corneal Thickness Measurement
Some conditions make it more difficult to obtain an image that
measures Central Corneal Thickness (CCT) accurately, including:

• Patient wearing contact lenses (obscuring the junction of
contact lenses and the corneal surface).

• Patient with poor visual acuity (cannot maintain fixation).

• Patient with intraocular lenses, corneal abrasions or corneal
opacities that cause excessive corneal reflection.

• Have the patient remove contact lenses.

• Use  HD Cornea and Anterior Chamber scans to measure
CCT more easily.

9.4.3 About Angle Measurement
There are two types of tools that measure angles: Angle tools and
IC Angle tools.

Angle Tools

Left Angle tool ( ) and Right Angle tool ( ) allow you to
place three points over an image and measure the angle.

When you place an angle tool, place the intersection at the scleral
spur and the other two points at the corneal endothelium and iris.
CIRRUS™ HD-OCT calculates the angle.
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IC Angle Tools

IC Left Angle tool ( ) and IC Right Angle tool ( ) allow
you to place multiple points over an image to measure additional
aspects of the angle.

1

2

3

4

5

6

AOD500 Angle Opening Distance at 500 mm

(Distance between 1 and 2)

AOD750 Angle Opening Distance of 750mm

(Distance between 3 and 4)

TISA500 Trabecular Iris Space Area 500 (mm2)

(Area of the polygon that joins points 1, 2, 5, and 6)

TISA750 Trabecular Iris Space Area 750 (mm2)

Area of the polygon that joins points 1, 2, 5, and 1, 3, 4, 2.

SSA Scleral Spur Angle:

(Angle formed by 1, 5, and 2)
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9.4.4 Analyze Anterior Chamber Scans
Anterior Chamber analysis is only available for Anterior Chamber
Cube Scans [} 184], which produce a 512 x 128 image 20 B-scans
comprised of 1024 A-scans across the center of the eye at the
depth of 5.8 mm.

Using this analysis you can measure:

• anterior chamber depth

• central corneal thickness

• left or right angles

• corneal tissues

• anterior chamber structures

You can also view and navigate through the slices of any cube scan
as a three-dimensional image (see: 3D Visualization Analysis
[} 289]).

9.4.4.1 Anterior Chamber Depth Tool

NOTE You can place the Anterior Chamber Depth Tool in any
position on the image.

Although this tool is designed to facilitate routine measurements,
you can place the endpoints in other locations to measure different
structures.

When you place the  Anterior Chamber Depth Tool, the cornea
caliper automatically positions itself to the cornea aligned to the
anterior and posterior (corneal vertex) surfaces.

You can drag the caliper along the cornea to adjust its position.
Once you drag the endpoints into each angle and the base line to
the anterior surface of the crystalline lens, CIRRUS™ HD-OCT
automatically calculates and displays measurements for:

• corneal thickness

• angle-to-angle distance
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• anterior chamber depth

• lens vault

NOTE! For eyes with aphakia or pseudophakia, drag the base
line to the pupillary plane.

9.4.4.2 Anterior Chamber Analysis

1
3

5

2

4

Figure 73: Anterior Chamber Analysis Overview

# Symbol Name Explanation

1 Iris Image Shows the scan pattern over the iris image and indicates
the rotation direction set during acquisition.

2 Angle Measurements (See: About Angle Measurement [} 340]).

3 Mirror Image Preview Shows a thumbnail image with the corneal mirror image.

2 Toolbar

Raw / Processed Image Toggles between the raw acquired image and the
processed (corrected) image.

Show / Hide Mirror
Images

Shows or hides the corneal mirror image.

Show / Hide Layers Overlays lines to indicate:

• Green: anterior cornea

• Red: posterior cornea

• Magenta: residual stromal line

Anterior Depth Tool (See: Anterior Chamber Depth Tool [} 342]).
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# Symbol Name Explanation

Annotate Image Adds your notes onto the image.

Right Angle
Measurement Tool

(See: About Angle Measurement [} 340]).

Left Angle Measurement
Tool

Caliper Adds a measurement line.

Delete Deletes an angle or caliper measurement line.

5 B-Scan (See: Anterior Chamber Depth Tool [} 342]).

9.4.4.3 Analyzing Anterior Chamber Scans

NOTE The Anterior Chamber Angle measurements are not intended
as a substitute for gonioscopy, which is the current reference
standard for evaluating the anterior chamber angle configu-
ration.

During gonioscopy the operator can dynamically view the mirror/
prism to examine full extent of the angle.

The Anterior Chamber Depth analyzes a single location.

NOTE The Anterior Chamber scan uses a full axial field of view to
display both the true image data and an inverted mirror
artifact.
Even if you hide the mirror image, distinct bars remain
where the mirror intersect the image.

To see these parts of the cornea, use the HD Cornea scan.

When you place the Anterior Chamber Depth, CIRRUS™ HD-OCT
displays the measurements over the image and in the summary
table.

Prerequisite þ The patient has at least one Anterior Chamber scan: (Anterior
Chamber Scans [} 184])

þ You are logged in (review station or instrument): Login [} 123].

Action 1. Select the patient and click Analyze.

2. Under OD or OS, select an Anterior Chamber scan and select
Anterior Chamber Analysis.

ð The Anterior Chamber analysis opens.
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3. To view the raw (unprocessed) image, click Raw / Processed
Image.

4. To view the mirror image, click Show / Hide Mirror.

ð The mirror image appears on the image.

5. To show the layer lines for cornea anterior and posterior
surfaces and the residual stromal line, click Hide / Show
Layers.

ð Layer lines indicate: Green: anterior cornea; Red: posterior
cornea; Magenta: residual stromal line.

6. Click the Anterior Chamber Depth tool.
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ð The tool opens with the corneal caliper aligned to the top
and bottom surfaces of the cornea at the posterior vertex.

7. To adjust the corneal caliper, drag the caliper along the cornea.

8. Drag the base line to the anterior surface of the crystalline lens.
NOTE! For eyes with aphakia or pseudophakia, drag the
base line to the pupillary plane.

ð CIRRUS™ HD-OCT calculates and displays the anterior
chamber depth and lens vault.

9. Drag the endpoints of the base line into each angle.

ð CIRRUS™ HD-OCT calculates and displays the angle-to-
angle distance.

10. To add a text annotation to the image, click Annotate and
type text.

ð You can change the color and size of the text or move it
somewhere else in the image (see: Add Annotations to
Images [} 377]).

11. To place an angle measurement, click (right or left) Angle
Tool  and place the intersection at the scleral spur and the
other two points at the corneal endothelium and iris.

ð CIRRUS™ HD-OCT calculates the angle.

12. To add a caliper, click Caliper.

ð A caliper measurement appears over the image. You can
move, stretch, and rotate calipers. You can add (up to) ten.

13. To delete a measurement or annotation, select it and click
Delete.

14. To edit or adjust the image, hover over the image and select an
adjustment tool (refer to: Edit Images (Hover Over) [} 370].

15. To view a full-screen image, double-click on the image.
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16. To print, save, or export a report, see: Creating a Report
[} 384].

9.4.5 Analyze Anterior Segment Cube Scans
The Anterior Segment Analysis is the only analysis available for
the Anterior Segment Cube [} 188] scan.

The Fast B-scan displays above the Slow B-scan.

9.4.5.1 Anterior Segment Cube Analysis

1

2

3

Figure 74: Anterior Segment Cube Overview

# Symbol Name Explanation

1 Iris Displays the iris, scan area (yellow square) and scan pattern
placement.

2 Toolbar

Caliper Adds a measurement line.

Delete Measurement Deletes a measurement line added with the caliper tool.

Snap to Center Moves the slice navigators to the center of the 6x6 mm
square.

Show / Hide High-
Resolution Images

Displays the high-resolution scans or standard-resolution
scans.

NOTE! The ETDRS Grid does not change position
when the High–Resolution image is displayed.
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# Symbol Name Explanation

3 Horizontal B-Scan

Vertical B-scan

9.4.5.2 Analyzing Anterior Segment Cube Scans

Prerequisite þ The patient has at least one Anterior Segment Cube scan:
(Anterior Segment Cube [} 188]).

þ You are logged in (review station or instrument): Login [} 123].

Action 1. Select the patient and click Analyze.

2. Under OD or OS, select an Anterior Segment Cube  scan and
select Anterior Segment Cube Analysis

ð The Anterior Segment Cube  analysis opens.

3. To add a caliper, click Caliper.

ð A caliper measurement appears over the image. You can
move, stretch, and rotate calipers. You can add (up to) ten.

4. To lock the length of the caliper, right-click on the caliper to
open its settings, check Lock Length and click Accept.
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5. To delete a caliper, click Delete.

6. To navigate through the vertical slices of the cube, click on the
magenta triangle and drag the line right or left.

ð The current slice number changes dynamically as you
navigate through slices.

7. To navigate through the horizontal slices of the cube, click on
the cyan triangle and drag the line up or down.

ð The current slice number changes dynamically as you
navigate through slices.

8. To set the navigators to the center of the image, click Center.

9. To show or hide the high-resolution image, click HD.

ð The image toggles between the original resolution and high
resolution versions.

10. To open movie tools, right-click on the image and select 
Movie.

ð The movie player opens and automatically scrolls through
the slices. For more information about these controls, refer
to: Navigate Through Cube Slices as a Movie [} 389].

11. To edit an image, right-click to access the edit menu (see:
Editing Images Using the Menu [} 369]).

12. To view a full-screen image, double-click on the image.

13. To print, save, or export a report, see: Creating a Report
[} 384].

9.4.6 Analyze HD Angle Scans

NOTE Features described in this section are licensed separately and
may not be available in all markets.

u For information about feature availability in your market and
obtaining a license:

ð in the U.S.A, call 1-877-486-7473.

ð outside the U.S.A , contact your local ZEISS distributer.
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9.4.6.1 HD Angle Analysis

1

2

3

4

Figure 75: HD Angle Analysis Overview

Pos. Symbol Name Explanation

1 Iris Image Shows the scan pattern over the iris image
and indicates the rotation direction set
during acquisition.

2 Angle Measurements (See: About Angle Measurement [} 340]

3 Toolbar

Dewarp Shows the curvature-adjusted image or
the original (flat) image.

Annotate Image Adds your notes onto the image.

IC Angle Measurement Tool (See: About Angle Measurement [} 340]).

Angle Measurement Tool

Caliper Adds a measurement line.

Delete Deletes an angle or caliper measurement
line.
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Pos. Symbol Name Explanation

4 Angle Image Editing Options:

• View Images in Full-Screen Mode
[} 373]

• Adjust Image Brightness [} 373]

• Adjust Image Contrast [} 374]

• Zoom In and Out [} 378]

• Save Edited Images [} 381]

• Reset Edited Images [} 379]

9.4.6.2 Analyze an HD Angle Scan

Editing available for the HD Angle images:

• View Color or Grayscale Image [} 375]

• Adjust Image Brightness [} 373]

• Adjust Image Contrast [} 374]

Prerequisite þ The patient has at least one HD Angle scan: ( HD Angle Scans
[} 194])

þ You are logged in (review station or instrument): Login [} 123].

Action 1. Select the patient and click Analyze.

2. Under OD or OS, select an HD Angle scan and select HD
Angle Analysis.

ð The HD Angle analysis opens.

3. To view the raw (unprocessed) image, click Raw / Processed
Image.

4. To add a text annotation to the image, click Annotate and
type text.
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ð You can change the color and size of the text or move it
somewhere else in the image (see: Add Annotations to
Images [} 377]).

5. To place an angle measurement, click (right or left) Angle
Tool  and place the intersection at the scleral spur and the
other two points at the corneal endothelium and iris.

ð CIRRUS™ HD-OCT calculates the angle.

6. To place an iridocorneal angle measurement, click (right or left)
IC Angle Tool, drag the trapezoid into position over the angle
you want to measure and adjust the points to touch the
corneal endothelium and iris.

ð CIRRUS™ HD-OCT calculates the measurements (see: About
Angle Measurement [} 340]).

7. To add a caliper, click Caliper.

8. To delete a measurement or annotation, select it and click
Delete.

9. To edit or adjust the image, hover over the image and select an
adjustment tool (refer to: Edit Images (Hover Over) [} 370].

10. To view a full-screen image, double-click on the image.
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11. To print, save, or export a report, see: Creating a Report
[} 384].

Also see

2 HD Angle Scans [} 194]

9.4.7 Analyze HD Cornea Images
The HD Cornea  scan helps you analyze the residual stromal bed
on post-LASIK patients.

When acquiring the scan, the operator can rotate the scan pattern,
but not change its length or central position.

9.4.7.1 HD Cornea Analysis Overview

1

2

3

Figure 76: HD Cornea Analysis Overview

# Symbol Name Explanation

1 Iris Image Shows the scan pattern over the iris image and indicates
the rotation direction set during acquisition.

2 Toolbar

Raw / Processed Image Toggles between the raw acquired image and the
processed (corrected) image.

Annotate Image Adds your notes onto the image.

Show / Hide Layers Overlays lines to indicate:

• Green: anterior cornea

• Red: posterior cornea

• Magenta: residual stromal line
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# Symbol Name Explanation

Cornea Caliper Adds a measurement line across the cornea that snaps to
the anterior and posterior corneal surfaces and slides along
the corneal contour.

Caliper Adds a measurement line.

Delete Measurement Deletes a measurement line added with the caliper tool.

3 Cornea Image Corneal layer lines show:

• Green: anterior corneal surface

• Magenta: adjustable residual stromal line (RSL)

• Red: posterior corneal surface.

9.4.7.2 Analyze an HD Cornea Scan

HD Cornea Analysis is only available for HD Cornea Scans.
Tip: You can also move the pink
line by typing a different value for
"Stromal Tool Distance"

Editing available for the HD Cornea images:

• View Color or Grayscale Image [} 375]

• Adjust Image Brightness [} 373]

• Adjust Image Contrast [} 374]

To analyze an HD Cornea scan:

Prerequisite þ You are logged in (review station or instrument): Login [} 123].

þ The patient has at least one HD Cornea scan: (Acquire HD
Cornea Scans)

Action 1. Select the patient and click Analyze.

2. Under OD or OS, select an HD Cornea scan and select HD
Cornea Analysis.

ð The HD Cornea Analysis opens.

3. To view the raw (unprocessed) image, click Raw / Processed
Image.

ð You cannot add measurement calipers to the raw (unpro-
cessed) image.

4. To add a text annotation to the image, click Annotate and
type text.

ð You can change the color and size of the text or move it
somewhere else in the image (see: Add Annotations to
Images [} 377]).

5. To show or hide the green, pink and red layer indicators, click
Show/Hide Layers.
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6. To adjust the residual stromal bed indicator (pink line) move the
slider (right of the image) up or down.

7. To add a corneal thickness measurement, click Corneal
Caliper.

ð A Corneal Caliper with an internal marker appears over
the image. You can add (up to) ten.

8. To reposition the Corneal Caliper, select and drag it along the
cornea.

ð CIRRUS™ HD-OCT automatically detects the corneal
surfaces and measures the thickness dynamically as you
move the caliper along the cornea.

9. To move the internal measurement mark, click on it and drag it
up or down.

ð CIRRUS™ HD-OCT automatically measures (and displays)
the following information:
Horizontal distance from the center of the scan.

Distance between the anterior corneal surface and the
demarcation line. 

Distance between the demarcation line and the posterior
corneal surface.

Total corneal thickness.

10. To add a caliper, click Caliper.

ð A caliper measurement appears over the image. You can
move, stretch, and rotate calipers. You can add (up to) ten.

11. To lock the length of the caliper, right-click on the caliper to
open its settings, check Lock Length and click Accept.

12. To delete a measurement or annotation, select it and click
Delete.
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13. To edit or adjust the image, hover over the image and select an
adjustment tool (refer to: Edit Images (Hover Over) [} 370].

14. To view a full-screen image, double-click on the image.

15. To print, save, or export a report, see: Creating a Report
[} 384].

9.4.8 Analyze Pachymetry Scans
Pachymetry Analysis uses the 24 radial scan lines of the
Pachymetry scan to display a color-coded map of the cornea
allowing you to measure corneal thickness variation.

9.4.8.1 Pachymetry Analysis

1 2

3 4

Figure 77: Pachymetry Analyses

1 Pachymetry Maps 2 Epithelial Thickness Maps

3 All Maps 4 OD or OS
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1

2

3

4

5

6

Figure 78: Pachymetry Analysis Overview

# Symbol Name Explanation

1 View Selection Changes the view of the scan:

• Pachymetry Map

• Epithelial Thickness Map

• All Maps

• OD Images

• OS Images

2 Show / Hide Overlays Shows or hides the grid and numbers.
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# Symbol Name Explanation

3 Color Scale Sets the color coding options (right-click on the color
scale):

• Standard (default ): Shows a constant thickness for
red at 750 mm and blue at 350 mm.

• Auto:  Adjusts the maximum and minimum thickness
values to the thickness variation for the selected scan.

• Custom: Opens a custom color scale tool for you to
set your own color coding.

Your selection applies to both scans and is saved with the
analysis.

Pachymetry Map Shows the corneal thickness of any area on the map and
allows you to mark thickness points on the map (for
reports).

NOTE! Note: Towards the periphery of the cornea,
the data may have lower signal and the boundaries
of the surfaces may be difficult to detect. If the
algorithm has low confidence in a region, that region
does not appear on the map.

Epithelial Thickness Map Shows a map of the epithelial thickness with a grid
centered on the corneal vertex (the intersection of the
visual axis with the corneal surface).

X indicates the vertex.

Grid ring diameters:

• Central ring: 2 mm

• Inner ring: 5 mm

• Third ring: 7 mm

• Outer ring: 9 mm

Thickness measurements for each sector display inside the
sector.

NOTE! Note: Towards the periphery of the cornea,
the data may have lower signal and the boundaries
of the surfaces may be difficult to detect. If the
algorithm has low confidence in a region, that region
does not appear on the map.

OD Images Shows all 24 B-scan images for the Pachymetry scan.

OS Images

4 Vertex Shows the location of the corneal vertex.

5 Minimum Corneal
Thickness

shows the location of minimum corneal thickness.
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# Symbol Name Explanation

6 Cornea Thickness Table Provides details of the corneal thickness within annular
ranges. For each ring of the grid, the table displays:

Range = inner and outer diameters of the annular region.

Min = minimum thickness.

Avg = average thickness.

Max = maximum thickness.

S-I = average value in the Superior (S) sector - average
value in the Inferior (I) sector

SN-IT =  average value in the Superior Nasal (SN) sector -
average value in the Inferior Temporal (IT) sector.

Epithelial Thickness Table Provides details of the epithelial thickness within annular
ranges.

Range =inner and outer diameters of the annular region.

Min = minimum thickness.

Avg = average thickness.

Max = maximum thickness.

S-I = average value in the Superior (S) sector - average
value in the Inferior (I) sector

SN-IT =  average value in the Superior Nasal (SN) sector -
average value in the Inferior Temporal (IT) sector.

9.4.8.2 Analyzing Pachymetry

Pachymetry analysis displays a color-coded map showing corneal
thickness variation. 

Data tables below the Epithelial maps show minimum, average,
and maximum thickness measurements (in micrometers) for the
four radial zones.

Zone range is defined in millimeters away from the center of the
map:

1

2

3

4 • Central ring (1): diameter corresponds to 2 mm

• Second ring (2): diameter corresponds to 5 mm

• Third ring (3): diameter corresponds to 7 mm

• Fourth ring (4): diameter corresponds to 9 mm

The grid centers on the corneal vertex (white "X") at the inter-
section of the visual axis with the corneal surface.

S-I values: average value of Superior (S)  - 
average value of Inferior (I) at the same
distance

SN-IT values: average value of SN  - average value
of IT at the same distance
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To analyze pachymetry:

Prerequisite þ You are logged in (review station or instrument): Login [} 123].

þ The patient has at least one pachymetry scan: (Acquire a
Pachymetry Scan [} 204])

Action 1. Select the patient and click Analyze.

2. Under OD or OS, select a Pachymetry scan and select
Pachymetry Analysis.

ð The analysis opens showing the corneal thickness map and
details table. White areas indicate peripheral regions with
low signal that were not quantified for the map.

3. To view the thickness (in micrometers) and location (relative to
the center of the map) of any point on the map, hover over the
point.

4. To mark a point on the map, click on the point.

ð The point's location, thickness and map coordinates are
marked for reports.

5. To delete a marked location, right-click on the marked point
and check Clear User Selection.

6. To show all three values of per sector, (Min, Max, Avg.), right-
click a point on the map and uncheck Show Mean Only.

7. To hide all data values on a map, right-click a point on the map
and check Hide Data.

8. To view epithelial thickness maps, select View > Epithelial
Thickness Map.

9. To view both the pachymetry and epithelial thickness maps,
select View > All Maps.

ð A green line indicates the anterior surface of the cornea.
(No line indicates that he algorithm has low confidence in
the posterior surface of the cornea and did not calculate
the value.)

ð A red line indicates the posterior surface of the cornea.

ð A yellow line indicates the Bowman’s Layer.

10. To view all 24 thumbnail scans that make up a pachymetry
map, select View > OS or View > OD.

11. To view a full-screen image, double-click on the image.

12. To print, save, or export a report, see: Creating a Report
[} 384].
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9.4.9 Analyze Wide Angle-to-Angle Scans

NOTE Features described in this section are licensed separately and
may not be available in all markets.

u For information about feature availability in your market and
obtaining a license:

ð in the U.S.A, call 1-877-486-7473.

ð outside the U.S.A , contact your local ZEISS distributer.

9.4.9.1 Wide Angle-to-Angle Analysis

1

2

3

Figure 79: Wide Angle to Angle Analysis Overview

# Symbol Name Explanation

1 Iris Image Shows the scan pattern over the iris image and indicates
the rotation direction set during acquisition.

2 Toolbar

Annotate Image Adds your notes onto the image.

Right Angle
Measurement Tool

(See: About Angle Measurement [} 340]).

Left Angle Measurement
Tool

Caliper Adds a measurement line.
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# Symbol Name Explanation

Delete Deletes an angle or caliper measurement line.

Right IC Angle Adds a (trapezoid-shaped) Iridocorneal angle tool onto the
image to help determine angle measurements.

Adjust the shape to fit the structures in the image:

• angle opening distance

• trabecular iris space area

• sclera spur angle

Left IC Angle

3

9.4.9.2 Analyzing Wide Angle-to-Angle Scans

To analyze Wide Angle to Angle scans:

Prerequisite þ The patient has at least one Wide Angle to Angle scan: (Wide
Angle to Angle Scans [} 197])

þ You are logged in (review station or instrument): Login [} 123].

Action 1. Select the patient and click Analyze.

2. Select an Wide Angle to Angle scan and select Wide Angle
to Angle Analysis.

ð The HD Angle analysis opens.

3. To add a text annotation to the image, click Annotate and
type text.

ð You can change the color and size of the text or move it
somewhere else in the image (see: Add Annotations to
Images [} 377]).

4. To place an angle measurement, click (right or left) Angle
Tool  and place the intersection at the scleral spur and the
other two points at the corneal endothelium and iris.
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ð CIRRUS™ HD-OCT calculates the angle.

5. To place an iridocorneal angle measurement, click (right or left)
IC Angle Tool, drag the trapezoid into position over the angle
you want to measure and adjust the points to touch the
corneal endothelium and iris.

ð CIRRUS™ HD-OCT calculates the measurements (see: About
Angle Measurement [} 340]).

6. To delete a measurement or annotation, select it and click
Delete.

7. To edit or adjust the image, hover over the image and select an
adjustment tool (refer to: Edit Images (Hover Over) [} 370].

8. To view a full-screen image, double-click on the image.

9. To print, save, or export a report, see: Creating a Report
[} 384].

9.4.10 Analyze Anterior Segment 5-Line Raster Scans

NOTE Features described in this section are licensed separately and
may not be available in all markets.

u For information about feature availability in your market and
obtaining a license:

ð in the U.S.A, call 1-877-486-7473.

ð outside the U.S.A , contact your local ZEISS distributer.

You can use the Anterior Segment 5 Line Raster scan to create
images of the cornea or the iridocorneal angle. Since this analysis is
the same for all HD scans, there are no angle measurement tools
available for this scan.

To measure angles, use one the following scans and their custom
analysis tools:
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• HD Angle [} 349] for the most accurate measurements of an
angle

• Wide Angle to Angle [} 361] to view and measure both irido-
corneal angles of an eye

To analyze a high-definition cornea cube scan that has 1024 A-
scans and 20 B-scans, refer to:HD Cornea [} 353].

9.4.10.1 Anterior HD 5-Line Raster Analysis

You can use the Anterior Segment 5 Line Raster scan to create
images of the cornea or the iridocorneal angle. Since this analysis is
the same for all HD scans, there are no angle measurement tools
available for this scan. To measure angles, use one the following
scans and their custom analysis tools:

• HD Angle [} 349] for the most accurate measurements of an
angle

• Wide Angle to Angle [} 361] to view and measure both irido-
corneal angle angles

of an eye

1

4

2

3

2

3

1

4

Figure 80: Anterior HD Image Analysis Overview (Cornea)

# Symbol Name Explanation

1 Toolbar

Caliper Adds a measurement line.

Delete Measurement Deletes a measurement line added with the caliper tool.
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# Symbol Name Explanation

2 Cornea Iris Image Shows the scan pattern over the iris image and indicates
the length, line spacing, and rotation direction set.

For Angle, offset to capture the angle.

Angle

3 Cornea B-scan Selection Panel Shows the B-scan slices and allows you to select a slice to
display.

Angle

4 Cornea B-scan Shows a larger view of the selected B-scan.

The number inside the TSNIT square (lower left) corre-
sponds to the B-scan slice number in the selection panel.

Angle

9.4.10.2 Analyzing Anterior Segment 5-Line Raster Images

You can use the Anterior Segment 5 Line Raster scan to create
images of the cornea or the iridocorneal angle. Since this analysis is
the same for all HD scans, there are no angle measurement tools
available for this scan. To measure angles, use one the following
scans and their custom analysis tools: 
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• HD Angle [} 349] for the most accurate measurements of an
angle

• Wide Angle to Angle [} 361] to view and measure both irido-
corneal angle angles

of an eye

Prerequisite þ You are logged in (review station or instrument): Login [} 123].

þ The patient has at least one Anterior Segment 5-Line Raster
scan of the cornea or angle: (Acquire HD Cornea Scans)

Action 1. Under OD or OS, select an Anterior Segment 5-Line Raster
scan.

ð The HD Images analysis opens.

2. To display a different B-scan, select a different image from the
selection panel.

ð The B-scan you selected displays.

3. To exit any editing mode and save the changes, right-click on
the image and select Normal.

4. To reset an image to default settings, Normal

5. To zoom in our out, right-click on the image and select  Zoom.
Unzoom returns the image to the original size.
Rectangle selects a rectangular zoom area.
Continuous allows you to zoom in or out (click and drag).

6. To pan a zoomed image, right-click on the image, select Pan ,
and drag to image to view a different part of the image.

7. To view a full-screen image, double-click on the image.

8. To save an image, right-click on the image, select  Save image
as..., select a file type, name, and path for the image.

9. To show or hide the navigator lines, right-click on the image
and select Hide Slice Navigator.

10. To adjust image brightness or contrast, right-click on the image
and select Brightness/Contrast.

11. To show a color image, right-click on the image and select 
Color.

12. To print, save, or export a report, see: Creating a Report
[} 384].
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9.5 Common Analysis Tasks and Tools

9.5.1 Manually Select a Scan
Some analyses automatically select a companion scan for the most
comprehensive information. You can choose a different scan
instead. For example, if CIRRUS™ HD-OCT selects a scan that does
not have good signal strength or is not centered properly, you can
select a different scan for the analysis. 

This feature is available for the following analyses:

• Analyze Macular Change [} 247]

• Analyze Ganglion Cell OU [} 262]

• Advanced RPE Analysis [} 257] 

• Analyze ONH/RNFL OU [} 279] 

• Analyze Single Eye Summaries [} 295] 

• Analyze PanoMap [} 299]

• Wellness Exam [} 301]

• Compare Angiography Images [} 327]

To manually select a different scan:

Prerequisite þ You are using an analysis listed above and you want to select a
different scan.

Action 1. Under OD or OS, select a scan for an analysis in the list above.

2. Click the same analysis with an suffix: – Manual Selection.

ð A dialog opens listing scans you can use for comparison
(two examples shown).

3. Click the scan you want to use.

4. Click Close.
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9.5.2 Edit Images

9.5.2.1 About Image Editing

During image analysis, you can view and edit images. There are
two different ways to access editing tools:

• Right-click to select from a menu

• Hover over the image to open editing icons.

Editing tool access depends on the type of analysis you are using.

Access Type Analyses

Hover • Angiography

• Compare Angiography

• ONH Angiography

• Compare ONH Angiography

• Montage AngioPlex

• En Face

• Anterior Chamber

• HD Angle

• HD Cornea

• Wide Angle to Angle

• Macular Thickness

• Macular Change

• Ganglion Cell OU

• Guided Progression: Ganglion Cell

• Advanced RPE Analysis

• ONH Guided Progression

• ONH/RNFL OU

• HD Images

• Same Eye Summary

• Panomap

• Wellness Exam

• Advanced Visual Analysis

• Anterior Segment

• Pachymetry

• Anterior Segment 5-Line Raster
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The following image shows how the same editing functions access
correlates.

Figure 81: Menu and Toolbar Buttons

9.5.2.2 Editing Images Using the Menu

This method of accessing image editing tools applies to the
following analyses:

• Macular Thickness

• Macular Change

• Ganglion Cell OU

• Guided Progression: Ganglion Cell

• Advanced RPE Analysis

• ONH Guided Progression

• ONH/RNFL OU

• HD Images

• Same Eye Summary

• Panomap

• Wellness Exam

• Advanced Visual Analysis

• Anterior Segment
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• Pachymetry

• Anterior Segment 5-Line Raster

To edit images using the menu:

Prerequisite þ You are logged in (review station or instrument): Login [} 123].

þ You reach the scan analysis step: Edit an Image.

Action 1. To view a full-screen image, double-click on the image.

2. To adjust image brightness or contrast, right-click on the image
and select Brightness/Contrast.

3. To show a color image, right-click on the image and select 
Color.

4. To hide the image, right-click on the image and select Hide.

5. To exit any editing mode and save the changes, right-click on
the image and select Normal.

6. To pan a zoomed image, right-click on the image, select Pan ,
and drag to image to view a different part of the image.

7. To reset an image to default settings, Normal

8. To zoom in our out, right-click on the image and select  Zoom.
Unzoom returns the image to the original size.
Rectangle selects a rectangular zoom area.
Continuous allows you to zoom in or out (click and drag).

9. To save an image, right-click on the image, select  Save image
as..., select a file type, name, and path for the image.

9.5.2.3 Edit Images (Hover Over)

NOTE The image editing tools vary depending on the type of
analysis.

u Refer to a particular analysis to see which editing tools you can
use for its images.

This method of accessing image editing tools applies to the
following analyses:

• Angiography

• Compare Angiography

• ONH Angiograpju

• Compare ONH Angiograpju

• Montage AngioPlex

• En Face

• Anterior Chamber

• HD Angle
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• HD Cornea

• Wide Angle to Angle

You can adjust and edit most images in an analysis viewport. Right-
click on an image to open the editing toolbar.

Tool Reference Tool Reference

Adjust Image Contrast [} 374] Export a Movie [} 380]

Adjust Image Brightness [} 373] View Images in Full-Screen Mode [} 373]

Zoom In and Out [} 378] Reset Edited Images [} 379]

Adjust Image Transparency [} 375] Hide / Show Toolbar [} 372]

View the Images as a Movie [} 379] Add Freeform Shapes to Images [} 376]

View Color or Grayscale Image [} 375]
(toggles):

Add Circles to Images [} 376]

Copy Edited Images [} 380] Add Calipers to Images [} 378]

Save Edited Images [} 381] Add Annotations to Images [} 377]

Remove Shapes, Tools and Annotations
[} 379]

Table 77: Image Editing Tools
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9.5.2.3.1 Open Image Editing Tools

NOTE Not all image tools are available for all images.

Image tools vary by type of image.

You can adjust, edit, annotate, export and save most images in the
viewport. Each image has its own toolbar that opens when you
right-click on the image.

To open the image editing tool:

Prerequisite þ You are logged in (review station or instrument): Login [} 123].

þ You reach the scan analysis step: Edit an Image.

Action 1. Click on the image that you want to edit.

ð Adjustments open at the top right side and annotations
open at the bottom.

9.5.2.3.2 Hide / Show Toolbar

To hide or show the image editing toolbar:

Prerequisite þ Editing tools are open: Open Image Editing Tools [} 372].

Action 1. To hide the toolbar, click Hide Toolbar.

ð The toolbar collapses.

2. To show the toolbar, click Show Toolbar.
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ð The toolbar expands.

3. Complete the analysis.

9.5.2.3.3 View Images in Full-Screen Mode
Tip: You can also click Esc to close
full-screen mode.

To view an image in full-screen mode, you can either double-click
on the image or click on the full-screen icon.

To view an image in full-screen mode:

Prerequisite þ Editing tools are open: Open Image Editing Tools [} 372].

Action

1. Click Full-Screen. 

ð The image opens in full-screen mode.

2. Click Close.

3. Complete the analysis.

9.5.2.3.4 Adjust Image Brightness

To adjust image brightness:

Prerequisite þ Editing tools are open: Open Image Editing Tools [} 372].

Action

1. Click Brightness.

ð An adjustment slider opens below the Brightness icon.

2. To increase image brightness, slide the marker up.

ð The image lightens.
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ð The brightness level also appears as a number from 0
(lowest brightness level) to 255 (highest brightness level).

3. To decrease image brightness, slide the marker down.

ð The image dims.

4. Save Edited Images [} 381].

9.5.2.3.5 Adjust Image Contrast

To adjust image contrast:

Prerequisite þ Editing tools are open: Open Image Editing Tools [} 372].

Action

1. Click Contrast.

ð An adjustment slider opens below the contrast icon.

2. To increase image contrast, slide the marker up.

ð Image contrast increases.



Instructions for Use 9 Analyzing Exam Data and Creating Reports
CIRRUS™ HD-OCT 9.5 Common Analysis Tasks and Tools

2660021174149 Rev. D 2019-10 375 / 542

3. To decrease image contrast, slide the marker down.

ð Image contrast decreases.

4. Save Edited Images [} 381].

9.5.2.3.6 Adjust Image Transparency

To adjust image transparency:

Prerequisite þ Editing tools are open: Open Image Editing Tools [} 372].

Action

1. Click Transparency .

ð An adjustment slider opens below the transparency icon.

2. To increase image transparency, slide the marker down.

ð The image becomes more transparent.

3. To decrease image transparency, slide the marker up.

ð The image becomes less transparent.

4. Save Edited Images [} 381].

9.5.2.3.7 View Color or Grayscale Image

The image toggles among three color options:
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Option Example

Color

Grayscale

Reverse Grayscale

Table 78: View Color Options

To toggle color settings:

Prerequisite þ Editing tools are open: Open Image Editing Tools [} 372].

Action 1. To toggle among a color, grayscale image, and reverse
grayscale, click Color.

2. Click Save ( ).

3. Complete the analysis.

9.5.2.3.8 Add Circles to Images

When you add a circle to an image, CIRRUS™ HD-OCT
automatically calculates the perimeter and area of the circle.

To add a circle to an image:

Prerequisite þ Editing tools are open: Open Image Editing Tools [} 372].

Action 1. Click Add Circle. 

ð A circle annotation appears in the center of the image.

ð The area and diameter of the circle are displayed.

2. To make the circle larger or smaller, click on a corner and drag
the corner in or out.

ð The area and diameter of the circle update.

3. To move a circle, click on the middle of the circle and drag it to
a new location.

4. Save Edited Images [} 381].

9.5.2.3.9 Add Freeform Shapes to Images

When you create a free-form shape on an image, CIRRUS™ HD-
OCT automatically calculates the perimeter and area of the shape.
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To draw a free-form shape on an image:

Prerequisite þ Editing tools are open: Open Image Editing Tools [} 372].

Action 1. Click Free-Form Shape. 

2. Click on the image where you want the shape to start and drag
in any direction to draw a freeform shape.

3. Continue to draw the shape and complete the shape by
returning to the starting point. 
NOTE! You do not end exactly at the starting point. The
shape automatically closes.

ð The area and perimeter of the shape are displayed.

4. To move a freeform shape, click on the middle of the shape
and drag it to a new location.

5. To delete a freeform shape, click on the shape to select it and
click Delete.

6. Save Edited Images [} 381].

9.5.2.3.10 Add Annotations to Images

In each annotation, you can enter up to 32 characters, including
spaces. You can change the size and color for each annotation
individually. You can also add an arrow to any annotation.

To add annotations to images:

Prerequisite þ Editing tools are open: Open Image Editing Tools [} 372].

Action 1. Click Annotations.

ð The annotation tool appears in the image.

2. Type your annotation.

3. To move the text, click to select it and drag it to a new location
on the image.

4. To edit the text, click to select the text and type .

5. To start a new line in an annotation, click Enter, thenOK.

6. To customize the text, double-click an existing text annotation
on the image.

ð Annotations Settings open.
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7. To add an arrow, check Show Arrow.

8. To change the text color, click on the Text Color pallette and
select a color.

9. To change the size of the text, slide Text Size to the right to
enlarge or left to shrink the text.

ð The annotation displays the new size, color and arrow (if
selected).

10. To resize an arrow, click on the arrow tip and drag it in to
make the arrow smaller or out to make the arrow larger.

11. Save Edited Images [} 381].

9.5.2.3.11 Add Calipers to Images

NOTE For some analyses, calipers detect and measure a particular
structure.

For example, HD Cornea Analysis  adds a caliper that detects and
measures the cornea, so you can move it along the cornea, but not
to other areas of the image.

You can add up to ten calipers on an image or B-Scans. Calipers
add a line that measures microns (µm).

To add calipers to images:

Prerequisite þ Editing tools are open: Open Image Editing Tools [} 372].

Action 1. Click the Caliper. 

ð A caliper tool appears in the image.

2. To move a caliper, click on the middle of the caliper and drag it
to a new location.

3. To change the direction of the caliper, click on an end and drag
to rotate it. 

4. To shorten or lengthen a caliper, click on and end and drag it in
or out.

5. To move the measure callout, click on the number and drag it
to another location.

6. Save Edited Images [} 381].

9.5.2.3.12 Zoom In and Out

To zoom in:

Prerequisite þ Editing tools are open: Open Image Editing Tools [} 372].

Action 1. Click  Zoom In.

ð The image zooms in.

2. To zoom in again, click  Zoom In again.

ð The image zooms in further.
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To zoom out:

3. Click  Zoom Out.

ð The image returns to its original dimensions.

4. Save Edited Images [} 381].

5. Complete the analysis.

9.5.2.3.13 Remove Shapes, Tools and Annotations

You can remove measurements, shapes, and annotations individ-
ually. To undo all editing and reset the image, see: Reset Edited
Images [} 379] 

To remove an item from an image:

Prerequisite þ Editing tools are open: Open Image Editing Tools [} 372].

Action

1. Select a shape or annotation added to the image.

2. Click Delete.

ð The item is removed from the image.

3. Save Edited Images [} 381].

9.5.2.3.14 Reset Edited Images

When you reset an image, all editing and adjustments are removed
from the image and the image returns to its last saved state.

To reset an image:

Prerequisite þ Editing tools are open: Open Image Editing Tools [} 372].

Action 1. Click Reset. 

2. Save Edited Images [} 381].

9.5.2.3.15 View the Images as a Movie

You can view the scan as a movie that begins at the top of the B-
Scan slice and moves down through the tissue in 51 µm incre-
ments. You can stop the movie, reverse or advance the movie
frame by frame. 

NOTE! The default frame rate for scan movies is 51 µm/sec.
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To view the image as a movie:

Prerequisite þ You reach the scan analysis step: Edit an Image.

þ Editing tools are open: Open Image Editing Tools [} 372].

Action 1. Click  Play Movie.

ð The movie controls open.

1 2 3 4

5 6

7

2. To start the movie, click the play button (1).

3. To stop the movie, click the pause button (2).

4. To move backward one frame, click the previous button (3).

5. To move forward one frame, click the next button (4).

6. To decrease movie speed, move the slider toward Slow (5).

7. To increase movie speed, move the slider toward Fast (6).

8. To close the movie controls, click Close (7).

9.5.2.3.16 Export a Movie

Movies are available for En Face, B-scan, and Angiography images.
You can export a movie as an avi file type. 

To export a movie:

Prerequisite þ Editing tools are open: Open Image Editing Tools [} 372].

Action 1. Click Export Movie.

2. Navigate to the location you want to save the movie file.

3. Click OK.

ð A dialog with a progress bar opens.

4. Click Save.

Result ü The movie takes a few moments to save.

9.5.2.3.17 Copy Edited Images

You can copy an image or an edited image onto the clipboard,
then paste it into a separate document or image file.

To add copy an image to the clipboard:

Prerequisite þ Editing tools are open: Open Image Editing Tools [} 372].

Action 1. Click Copy. 

ð The image or edited image is saved to the clipboard.

2. To paste the image into a document or image, open the file
and select Paste or CTRL+V.

ð The image is pasted into the file.

3. Complete the analysis.
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9.5.2.3.18 Save Edited Images

After you complete adjustments and edits, save the changes.

To save an edited image:

Prerequisite þ Editing tools are open: Open Image Editing Tools [} 372].

Action 1. Click Save.

2. Complete the analysis.
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9.5.3 Reports Overview

1

5

2 3

4

Figure 82: Reports Overview
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Pos. Name Explanation

1 Header

Name: Patient name

ID: Patient identification number

DOB: Patient date of birth

Gender: Patient gender

Technician: Instrument operator name

OD / OS Patient eye(s) included in the report

Exam Date: Date the scan was acquired.

Exam Time: Time the scan was acquired.

Serial Number: Serial number of the instrument that acquired
the scan.

Signal Strength: The signal strength of the scan.

Institution Name: The name of your institution.

ZEISS logo

2 Report Name The type of analysis used to create the report.

Scan Type The type of scan used for the analysis.

3 OD / OS Indicates which eye(s) is included in the report.

4 Report Content The content varies by scan and analysis type.

5 Footer

Comments: Field to add written comments on the printed
report.

Analysis Edited: The date and time the analysis was edited.

Doctor's Signature Field to sign the printed report.

ZEISS Software and copyright information

Page x of x Page number and total number of pages of the
report.
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9.5.4 Creating a Report
You can create a report to print, save or export. You can access
report features from any analysis screen. The cross-sections and/or
surface maps currently displayed in the analysis are included in the
report.

To create a report:

Prerequisite þ You are logged in (review station or instrument): Login [} 123].

þ Open and edit an analysis.

Action 1. Click Print.

ð The print menu expands.

2. To print a report without preview, select Print.

ð The report prints on the default printer.

3. To see a preview of the report (all pages), select Print
Preview....

ð A preview opens showing all pages of the report. You can
zoom, pan, print, or save the report from the preview
toolbar.

4. To save a PDF report, click select Save as PDF....

5. To save a high-definition report, select Save as HD PDF....

6. To save the report in another format, select Print Preview...,
click Save, and select a file format.

7. To export the report to DICOM, select Export to DICOM.

8. To export as XML, select XML Export.
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9.5.5 Navigating Cube Scans
Cube scans stack and align consecutive axial-scans (A-scans) side by
side to produce a two-dimensional B-scan. Consecutive B-scans
align to produce a 3D cross-section of the retina.

2

3

1

1 En Face Scan Plane Yellow box indicates the scan area.

Click and drag cyan or magenta triangle to
move through the scan slices.

The number beside the line indicates which slice of
the cube is in view.
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2 Slow B-Scan Plane Reformatted, vertically parallel A-scans acquired in
successive line scans.

These slices are acquired more slowly; one per line
of horizontal A-scans.

3 Fast B-Scan Plane Slices parallel to the front of the cube; each line of
A-scans is acquired quickly .

You can quickly navigate through the slices of either plane. Simply
move the corresponding line displayed on the fundus image and
the B-scan image moves accordingly. The slice number helps you
know which area of the cube is selected.

CIRRUS™ HD-OCT displays scan images as follows:

• Horizontal scans:

– left of scan equals the left of scan display

– right of scan equals right of scan display

• Vertical scans

– bottom of scan equals left of scan display

– top of scan equals right of scan display

• Diagonal scans in 5 Line Raster

– left takes precedence over bottom

– left of scan equals left of scan display

– right of scan equals right of scan display

Cube Analysis

Because cube scans contain this volume of information, there is are
additional types of analyses available only for cube scans:
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Analysis Description

3D Visualization Shows a 3-dimensional image of the data.
You can navigate through the 3D slices,
adjust settings, and animate a series to save
as a movie (see: 3D Visualization Analysis
[} 289]).

En Face
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Analysis Description

Advanced Visualization

Table 79: Additional Visual Cube Scans

9.5.5.1 Navigate Cube Layers Manually
Tip: You can also navigate through
layers by clicking the B-scan you
want to navigate and scrolling the
mouse.

You can drag the vertical and horizontal slice lines to scroll through
the image cube. The current slice number displays on the opposite
side of the arrow you use to select and drag the line.

Prerequisite þ You are acquiring, checking quality or analyzing a scan and
reach the step: navigate cube data.

Action

1. To navigate through the vertical slices of the cube, click on the
magenta triangle and drag the line right or left.

ð The current slice number changes dynamically as you
navigate through slices.
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2. To navigate through the horizontal slices of the cube, click on
the cyan triangle and drag the line up or down.

ð The current slice number changes dynamically as you
navigate through slices.

3. Complete the remaining steps of the acquire procedure.

9.5.5.2 Navigate Through Cube Slices as a Movie

Action 1. Use to view a movie of the fast B-scans or sequence through
them one image at a time.

ð

2. Complete the remaining steps of the acquire procedure.

ð

You can view the scan as a movie that begins at the top of the B-
Scan slice and moves down through the tissue in 51 µm incre-
ments. You can stop the movie, reverse or advance the movie
frame by frame. 

NOTE! The default frame rate for scan movies is 51 µm/sec.

To view the image as a movie:

Prerequisite þ You reach the scan analysis step: Edit an Image.

þ Editing tools are open: Open Image Editing Tools [} 372].

3. Click  Play Movie.

ð The movie controls open.

1 2 3 4

5 6

7

4. To start the movie, click the play button (1).

5. To stop the movie, click the pause button (2).

6. To move backward one frame, click the previous button (3).

7. To move forward one frame, click the next button (4).

8. To decrease movie speed, move the slider toward Slow (5).

9. To increase movie speed, move the slider toward Fast (6).

10. To close the movie controls, click Close (7).

11. Complete the remaining steps of the acquire procedure.
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10 Networking

10.1 Safety During Network Configuration

 WARNING! Use of a power strip

may cause an electric shock.

u To avoid the risk of electric shock, this equipment must only be
connected to a supply mains with protective earth.

 WARNING! Connecting the NAS device Directly to the instrument using a
shielded network patch cable

could cause electrical shock to the patient and/or operator.

u Use a network patch cable with an unshielded RJ–45 connector
to connect the NAS device directly to the instrument.

 CAUTION! Not archiving data daily

increases the risk of data loss.

u We strongly recommend that you archive daily to a network
archive location (a network file server or network attached
storage device). If you do not archive at all, paper records are
the only way to retain patient information in case of system
hard drive malfunction.

 CAUTION! Connecting the instrument to the Internet

increases its vulnerability to serious security risks, including viruses
and worms that could disable your system or adversely affect its
performance and may void the instrument warranty.

u Transfer data through internal networks.

u Ensure that all firewalls and internet security applications are
up-to-date and running.

u Connecting the device to the internet or transferring data via
USB devices may result in compromised patient privacy and
expose the network to malware.

 CAUTION! It is strongly recommended that you allow a knowledgeable
IT professional to assist you with network configuration and
software installation.
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 CAUTION! Installation of any unapproved software, including drivers

could degrade the performance of the instrument and/or lead to
corrupted diagnostic or therapeutic information and may void the
instrument warranty.

When connected to the Internet, the instrument may be vulnerable
to serious security risks, including viruses and worms that could
disable your system or adversely affect its performance.

Internet connectivity enables third-party software, software drivers
and updates to be downloaded to your system, either automatically
or intentionally.

u Do not download or install any unapproved software or drivers.

NOTE ZEISS does not provide technical support for the use of third
party hardware or software.

NOTE Users are responsible for network setup and maintenance.
Users are responsible for installing and configuring all
networking hardware and software.

ZEISS Technical Support is limited to testing instrument network
connectivity.

u ZEISS Technical Support cannot troubleshoot or repair
problems with network connectivity.

u Observe all guidelines in this document regarding instrument
networking.

NOTE ZEISS does not provide technical support for the use of third
party hardware or software.

NOTE Do not perform a virus scan while acquiring exam data.

NOTE These instructions assume that a TCP/IP network is already
installed in your institution. If you are unsure of your
network status or if you want to set up a network, consult a
networking professional.

10.2 Network Capabilities
The CIRRUS 6000 is designed for network data transfer. Software
supports the following networks and network activities: 

• Windows and Novell ® networks

• Creating user accounts

• Networking via a local area network or intranet
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• Archiving to and retrieving from a network file server

• DICOM gateway connection

 Indicates optional features; license may be required.

10.2.1 About Local Connections (Remote Desktop)

NOTE Only Administrators can complete this task.

To connect locally, use Remote Desktop. If you need help using
Remote Desktop, ask your institution's local IT personnel or consult
the documentation for Remote Desktop.

10.2.2 Select the Installation Mode
Your CZMI Representative installs your CIRRUS 6000

• Software is installed correctly.

• Software is configured properly for your network.

• Archiving is configured.

• Software connects to your archive.

10.2.2.1 Installation Modes

Stand-alone Native DICOM/FORUM

Typical Use Very small office (not
recommended).

Most practices. Office or practice that
shares data between two
or more instruments or
uses FORUM Retina or
Glaucoma Workplaces.

ZEISS Instrument
Connections

None Connects instruments to
review stations.

Connects instruments to
review stations,
additional CIRRUS 6000
instruments, and other
types of ZEISS instru-
ments.

Data Storage CIRRUS 6000 internal storage. Separate, sometimes
remote FORUM archive
storage device.

(CIRRUS 6000 internal
storage cleared when
data is archived to
FORUM storage.

Storage Limit CIRRUS 6000 internal drive limit.

When the instrument's internal drive is full, the oldest
data is archived and cleared to make room for new
data.

External storage device
(any size; expandible).

When the instrument's
internal drive does not
become full.
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Stand-alone Native DICOM/FORUM

Data exchange DICOM MWL and EPDF compatible. DICOM MWL, EPDF, and
Raw data compatible
using FORUM, integrates
with other DICOM-
compatible systems.

Additional Storage
Requirements

None (provided the CIRRUS 6000). • DICOM/FORUM
License.

• DICOM-compatible
storage or EMR
system.

Table 80: Mode Comparison

10.3 Network File Server Minimum Requirements
Using a Network File Server is recommended in offices that have a
local area network and want to archive data to a network storage
location.

The network file server must meet the following minimum require-
ments:

• 256 MB RAM

• Windows, Unix or Linux server operating system. (You can use
SAMBA with Unix and Linux file servers).

• NTFS drive partition(s) for CIRRUS 6000 data.

• 250 GB available disk space for data storage

• Tape backup unit

• BaseT network connection

10.3.1 Additional Recommendations
In addition to the minimum requirements listed above, we
recommend the following for the network file server:

• A mirrored RAID array for data storage—strongly recom-
mended.

• An uninterruptible power supply (UPS)—strongly recom-
mended.

• 1000 BaseT network connection.

• Removable backup drive with capacity of at least 250 GB.

10.4 Connect to a Networked Storage Device
You can archive your data using Network Attached Storage
(NAS).

You can use one, multiple or mirrored NAS devices to back up your
data.
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When you use two or more NAS devices concurrently, you must
also use a switch or router that is connected to the network or
directly to the instrument.

10.4.1 NAS Requirements
To use a NAS device for archiving your data, the NAS device must
meet the following minimum requirements:

• 1000Base Ethernet capable: For safety reasons, do not
connect the NAS directly to the instrument.

• Network patch cord:  for direct connection to the instrument,
UTP CAT5e cord with an unshielded RJ-45 connector.

• Compliance: The NAS device you select must comply with local
requirements.

– In Europe, CE approval is required

– In North America, UL, CSA, or equivalent and FCC approval
is required.

10.4.2 Configure Networked Storage Device Connections
Most NAS devices have a default name on the network. We
recommend that you retain the default name for the NAS device.
Workgroup Name Must Match the CIRRUS HD-OCT Workgroup
Name:

Some NAS devices automatically map the NAS device to a drive
letter on the instrument.

To configure NAS connections:

Prerequisite þ The NAS device is on and initialization is complete (see
manufacturer's instructions)

Action 1. Start up the CIRRUS 6000 (see: System Startup [} 54]).

2. Note the name of the NAS.

3. Open Windows Explorer and navigate to This PC.

4. Ensure the NAS device appears in your network.



10 Networking Instructions for Use
CIRRUS™ HD-OCT10.5 Connect to a DICOM Gateway

396 / 542 2660021174149 Rev. D 2019-10

5. If necessary, map a drive for the NAS device. Refer to the
Windows documentation or online help for instructions on
mapping a public drive.

10.5 Connect to a DICOM Gateway

NOTE This section is intended for an IT or DICOM network adminis-
trator.

For assistance:

u In the U.S., call Zeiss at 800-341-6968.

u Outside the U.S., contact your local CZM distributor

DICOM Gateway allows you to connect CIRRUS 6000 instruments
to other patient scheduling, record management, and storage
applications such as:

• DICOM-compatible EMR or patient management system

• DICOM archive, such as a PACS server

10.5.1 Review Station Requirements
Review stations must meet the minimum requirements listed in this
section for DICOM Gateway connections.

10.5.1.1 Operating System Requirements

To use the DICOM Gateway, your review station must run one of
the following operating systems:

• Windows 7 SP1, 64-bit

• Windows 8.1, 64-bit

• Windows 10, 64-bit

• Windows Server 2008 R2

• Windows Server 2012 R2

• Windows Server 2008 / 2012 RDS support

10.5.1.2 Computer Requirements

To use the DICOM Gateway, your review station must meet the
following minimum system requirements:

Requirement Minimum and Recommendations

CPU 2.0 GHz

Recommend: Intel Quad Core

Available Disk Space 20 GB

Memory (RAM) 4 GB

Recommend:8 GB
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Requirement Minimum and Recommendations

USB Port 1 (required for installation)

Network Card (TCP/IP Protocol) 100 MB

Screen Resolution 1024 x 768 pixels

Table 81: Review Station Requirements for DICOM Connection

10.5.2 Configure DICOM Connections

NOTE ZEISS FORUM application enables you to use AutoConnect.

Each instrument and review station connected to the DICOM
network must have a unique Application Entity (AE) title registered
with your DICOM system.

To configure DICOM connections:

Prerequisite þ On the CIRRUS™ HD-OCT instrument, Log in as Admin [} 58].

þ AE Titles are registered in the DICOM system

Action 1. From the Windows desktop, navigate to C: \ Program Files \
Carl Zeiss Meditec \ DICOM Gateway.

2. Double-click Configuration Tool.

ð The DICOM Gateway tool opens.

3. Select the General tab.

4. For IP Address , set to: 127.0.0.1 (instruments and Review
Stations).

5. For AE Title, type the DICOM Gateway  title registered in the
DICOM system.

6. For  DICOM Port, type the local port number for DICOM
Gateway (e.g., FORUM).

7. For Host Name, type the server address.

8. Click AutoConnect.
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ð If multiple FORUM servers are discovered, a selection dialog
opens.

ð If only one FORUM server is discovered, the DICOM-regis-
tered AE Title,Host Name, and Port for the MWL
Providerand Storage Provider populate automatically.

9. If the Storage Provider, Storage Commitment Provider,
and Retrieve Provider are the same, check Same as Storage
Provider.

10. If the Storage Provider, Storage Commitment Provider,
and Retrieve Provider are the different, type the DICOM-
registered AE Title,Host Name, and Port for the providers.

11. Click Save and Test.

ð When the network testing is complete, a green indicator
confirms success.

12. For advanced configuration options, refer to: DICOM Advanced
Configuration [} 399].

13. To view a detailed list of the connection testing, select the Test
Details tab.

ð A detailed list of connection testing opens.

14. If indicators are not red, confirm the connection data and click
Save and Test
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15. If the connections are not working properly, refer to:
Troubleshooting Connections [} 427].

16. Click OK.

10.5.3 DICOM Advanced Configuration

NOTE Not all systems use Extended Negotiation.

Make sure you use the correct settings for your system. Setting
Enable DICOM Extended Negotiation:

u Uncheck for United States Veterans Administration’s VistA™

u Check for FORUM

The recommended default values for the Advanced tab are listed
in the table below.

Setting Value

Maximum Query Responses 100

Timeouts

Maximum Association Idle Time 30

DIMSE RSP Timeout 20

Network Timeout 20

Enable DICOM Extended Negotiation Checked

Allow Local AETitle Edit

(if Review Stations are included in the network)

Checked

Table 82: Recommend Values for Advanced Configuration for Connec-
tions

You can adjust these values as needed to optimize performance or
allow for slower network connections.

To configure DICOM advanced configuration settings:

Prerequisite þ Log in to the computer.

Action 1. From the Windows desktop, navigate to C:\ Program Files >
Carl Zeiss Meditec > DICOM Gateway.

2. Double-click Configuration Tool.

ð The DICOM Gateway tool opens.
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3. Make adjustments as needed to accommodate your network's
response time.

4. Click OK.

Also see

2 Log In as Operator or Data Analyst [} 123]

10.6 Connecting Review Stations to Instrument Data
Archives

NOTE Some IT departments only allow computer administrators to
map network drives.

If your computer does not allow you to map network drives,
contact your institution's IT representative to request that a
computer administrator map this drive for you.

When a review station connects to one or more CIRRUS 6000
instruments, a reviewer can access patient scans. After an operator
saves a patient's scans, a doctor can view, compare, annotate, edit
them from their review station computer on the same networks. 

This procedure describes how map a network drive using the
Windows control panel. When you map a network drive from the
review station to the instrument, the review station retains this
connection for future access.

Prerequisite þ The instrument 's data folder is shared: (Setting Up a Network
File Server (external NAS)).

þ Review software is installed on the review station: (Installing
Review Station Software [} 42]).

þ The review station is on the same network as the instrument:
(Networking [} 391]).

þ You have administrator rights to the review station.
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Action u Map a network drive to the instrument's shared folder on the
network. Refer to the Windows documentation or online help
for instructions on mapping a drive.

10.7 Connecting to Printers

 WARNING! Adding peripheral equipment

may result in noncompliance with the safety requirements of IEC
60601-1.

u You are responsible for ensuring that the system meets the
safety requirements of IEC60601-1.

u Place any AC-powered, non-medical device peripherals at least
1.5 m away from the device and connect them to a separation
device, or else use an isolation transformer.

 WARNING! Placing peripheral devices closer than 1.5 meters (4.9 feet)
from the patient

could result in electrical shock to the patient and/or operator.

u Use a wireless configuration, if possible.

u Use an isolation transformer in the USB configuration.

u Ensure that patients cannot touch a peripheral device with any
part of his or her body while being examined.

u Ensure the instrument operator does not attempt to touch the
patient and a peripheral device at the same time.

 WARNING! Powering peripherals directly through a wall socket

could result in electrical shock to the patient and/or examiner.

u When using a printer in the USB configuration, always power
the printer through an isolation transformer. Some ZEISS
equipment comes with an isolation transformer that may be
used by plugging into a special power strip provided with the
equipment. Talk to your ZEISS Service Representative to
determine if this is true for your equipment.

u If you are not sure, plug all peripherals (such as a printer), into
an isolation transformer. This requires a special power cable. In
North America, the required cable has an IEC–320–14
connector on one end and a NEMA S–15R connector on the
other end. This cable is included in the accessory kit shipped
with the instrument.
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 WARNING! Use of the acquisition device, a printer, or the power table
with an extension cord or a power strip (multiple portable
socket outlet)

could cause electrical shock to the patient or operator.

u Do not use extension cords with the instrument.

u If you plug something other than an instrument into the
Multiple Socket Outlet (MSO), the MSO may not have the
designed level of safety.

u Do not use power strips with the instrument.

u Do not plug in any other equipment into the same wall outlet
as the instrument.

u To avoid the risk of electric shock, this equipment must only be
connected to a supply mains with protective earth.

This section provides generic requirements and recommendations
for printers. Specific configuration instructions vary by printer. Refer
to the printer manufacturer's instructions. If you use a third-party
device, seek technical support from the device manufacturer.
Repairs necessitated by the attempt to use a non-approved device
are not covered under warranty. 

Direct Connection
(USB)

General steps for USB connection:

1. Install the ZEISS approved printer drivers on the instrument (if needed).

2. Connect the printer power cord plug  to an isolation transformer.

3. Connect the printer to the instrument using a USB cable.

4. Power on the printer.

Local Area Network
Connection

Use any of the following connection methods:

• Connect both the instrument and the printer to the local area network

• Connect instrument and printer with the network (Ethernet) cable

• Connect the printer to a network switch/router/hub connected to the
instrument

NOTE! Use the same kind of network cable. Do not use an RJ-45
crossover cable to connect the printer to the instrument.
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WiFi Network
Connection

General steps for Wi-Fi connection:

1. Connect the wireless access point to the network.

2. Install the ZEISS-approved wireless access point drivers on the
instrument (if needed).

3. Turn on the printer.

4. Install the ZEISS approved printer drivers on the on the instrument (if
needed).

5. Connect the printer follow the manufacturer’s instructions for wireless
operation.

6. Configure the printer to use WPA2 encryption.

7. Configure the wireless access point as necessary to communicate with
the printer.

Table 83: General Steps to Connect a Printer

10.8 Database Selection
Like CIRRUS 6000 instruments, Review Stations typically have a
designated primary database. When data is imported, it is placed
into this database. The option Database Selection is available on
Review Stations for this purpose. For more information about
connecting review stations with instruments, see Networking
[} 391].

Operators and Administrators can select the working database.
However, it is recommended that the Administrators oversee
databases to ensure that patient data is kept cohesive and trans-
parent within the institutional environment.

10.8.1 Select a Database
Action 1. From the Toolbar, select Tools > Options > Select Database,

and an Explorer window appears.

2. Navigate to the location of the database of interest. Database
files have an ".ib" extension. For example: C:\SSOCT
\Database\ZDB.ib is a valid CIRRUS 6000 database.

3. Click Open.

4. Restart the software.

10.8.2 Copy a Database
Action 1. From the review station desktop, click the Windows Explorer

icon from the Desktop.

2. Navigate to C:\Program Files\CZM\CIRRUS HD-OCT
\Database.
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3. Select ZDB.ib. This file is the software database. Do not
modify this database. It is empty and intended to be copied
as a database template for the database you will use to store
patient data.

4. Right-click and select Copy.

5. Navigate to the location where you want your database to
reside, preferable in an empty folder. Note where on the
system you are storing the database, because you will periodi-
cally need it.

6. Right-click and select Paste.

7. Right-click the copied database and select Properties.

8. In the General tab, uncheck the Read-only attribute and then
select Apply > OK.

9. Launch the CIRRUS 6000 application software.

10. During startup, the Equipment Edit dialog box will appear.

ð Enter information in the Station Name field (if needed).

ð Enter information in the DICOM AE Title field (if needed).
This information should match the AE Title assigned in the
DICOM Gateway.

ð Enter the model number in the Model Number field. The
model number is the first set of numbers before the dash
and after the SN box on the Instrument Serial Number
label.

ð Enter the sequence number in the Sequence Number
field. The sequence number is the second set of numbers
after the dash and after the SN box on the Instrument
Serial Number label.

ð Select Save.
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11. Log in using the Admin user and then create the CIRRUS 6000
Operator user. Refer to the CIRRUS™ HD-OCT Instructions for
Use for Managing User Accounts [} 70].

12. Log out of the CIRRUS™ HD-OCT application software.
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11 Cleaning and Disinfection

11.1 Safety During Cleaning and Disinfection

 CAUTION! Improper care and cleaning of optical components

could lead to coating failure.

Contaminants on the optical surfaces increase scatter off the
surface and absorb light energy.

u Do not use alcohol prep wipes to clean lenses or optical
surfaces.

u Wipe gently and carefully to avoid scratching the instrument
and auxiliary lenses.

 CAUTION! Cleaning lenses too frequently

can damage optic surfaces.

u Clean optics only when necessary.

u Keep the protective cover on your device when not in use.

 CAUTION! Using aerosols near or placing containers of liquid on or near
the instrument

could damage the equipment. The instrument is not designed with
any specific measures to protect against harmful ingress of water
or other liquids (classified IPXO - ordinary equipment).

u Do not place containers of liquid, or use aerosols on or near
the equipment.

11.2 Cleaning Agents
Item Explanation

Latex Finger Cots and Gloves Solvents are harsh to the skin; wear protection.

Optics Cleaning Tissue Soft, absorbent, lint-free lens tissue is best.

Swabs Cotton swabs with wooden handles or polyester swabs with
polypropylene handles are best.

Blower Filtered dry nitrogen blown through an antistatic nozzle is best. Canned
dusters also work. Bulb-type blowers and brushes must be kept clean to
prevent recontamination.

Mild Soap Neutral soap, 1% in water. Avoid perfumed, alkali, or colored soaps.
Several drops of green soap (available at a pharmacy) per 100 cc of
distilled water is acceptable.

Isopropyl Alcohol Spectroscopic grade; evaporates more slowly than acetone.

Acetone Spectroscopic grade.
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Item Explanation

Hemostats For holding lens tissue.

Bright Light For inspection.

11.3 Cleaning Optical Components

11.3.1 Brush Cleaning Method

NOTE Edges on mounted optics

are often hard to reach.

u Wrap a lens tissue around a swab.

u Soak the covered swab in acetone.

u Brush around the edge of the lens and then across the middle
using a continuous figure-eight stroke.

u Repeat if necessary.

Use this technique to clean small lenses. Hold a folded lens tissue
with a hemostat to brush the surface clean.

Action 1. Fold a lens tissue about as wide as the lens. Do not touch the
area of the tissue that will contact the lens.

2. Using hemostats, hold the tissue near the fold.

3. While holding the optic, using tweezers if necessary, blow off
any dust.

4. Soak the tissue with acetone.

5. Brush the fold in the tissue across the surface of the optic using
light pressure.

6. Repeat as necessary until the optic is clean, using a new lens
tissue with each wipe.

11.3.2 Wipe Cleaning Method
Use this technique to clean very dirty lenses and mirrors.

Action 1. Blow off dust.

2. Fold a lens tissue as with the brush method.

3. Apply acetone to the tissue.

4. Holding the lens tissue in your hand with the fold near the tip
of your fingers, apply uniform pressure while gently wiping
across the surface of the optic.

5. Repeat as necessary until the optic is clean, using a new lens
tissue with each wipe.
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11.3.3 Dust Cleaning
Static electricity can bind dust tightly onto optics. Blowing removes
some dirt; use a wet alcohol swab to remove the remainder.
Acetone dries the optic quicky, which helps eliminate streaks.

Action 1. Blow off dust.

2. If any dust remains, twist lens tissue around a swab, soak in
alcohol, and wipe the optic in one direction with a gentle
figure-eight motion.

3. Repeat as necessary.

4. Repeat the steps above, using acetone.

11.3.4 Cleaning Heavy Contamination

NOTE Always clean fingerprints, oil, and water spots from lens and
optics immediately.

Skin acids can permanently damage optical coatings. Solvents can
redistribute dirt and oil.

u Use soap or other wetting agent to clean the optical surfaces.

u Use water to remove the soap.

u Use alcohol to remove the water.

u Use acetone to speed drying and eliminate streaks.

Use this technique to clean fingerprints, oil, or water spots.

Action 1. Blow off dust.

2. Using a soap-saturated lens tissue placed around a swab, wipe
the optic gently in a figure-eight motion.

3. Repeat as necessary.

4. Repeat this procedure with distilled water.

5. Repeat again with alcohol.

6. Repeat once more with acetone.

11.4 Cleaning the Chin Cup and Forehead Rest

 WARNING! Strong solvents such as Acetone or Methyl Alcohol

will damage the chin cup and forehead rest.

u Use a gentler disinfectant such as isopropyl alcohol.

Action 1. Clean the chin cup and forehead rest with a disinfectant such
as isopropyl alcohol.

2. If disinfectant contacts the ocular lens during cleaning, gently
wipe the lens (see: Wipe Cleaning Method [} 408]).
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11.5 Cleaning Peripherals and Table

 CAUTION! Do not use any cleaning agent on the screen.

Action 1. Wipe the monitor with a soft, non-linting cloth.

2. Regularly dust or wipe down the table.
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12 Maintenance and Repair

NOTE Expected Service Life

The expected service life of CIRRUS 6000 is 7 years.

12.1 Safety During Maintenance

 WARNING! Opening instrument covers

could result in exposure to electrical and optical hazards.

u Do not open the instrument covers.

u Exception: You may remove the rear cover to access labels,
change connectors, or clean fans.

 CAUTION! Unauthorized modification or dismantling of the instrument
or system components

could result in damage to the instrument or components, or harm
to the operator or other personnel.

u Only authorized ZEISS personnel may make modifications to, or
dismantle, the instrument or its components.

Before performing cleaning or maintenance, refer to: Safety [} 12].

12.2 Maintenance Schedule
Periodically inspect the CIRRUS 6000 system to ensure that:

• The system is well maintained and free of dust

• Wiring is intact and connected.

• Optics are clean (see: Cleaning and Disinfection [} 407]).

The frequency of these inspections depends on the frequency of
use and the environmental conditions where the system resides.

12.2.1 Every Week (Before Use)

Component Activity Time required

Scan Alignment Performance Verification Check 2 minutes

12.2.2 Every Month

Component Activity Time required

Instrument Computer Defragment the Disk Drives [} 417] (Varies)
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12.2.3 Every 6 Months

Component Activity Time required

Fan Filter Inspect, Clean or Replace the Fan Filter [} 416] 2 minutes

12.3 Run the Verification Test

12.3.1 Verification Test Tool Overview

1

3

3 2

4

2

Figure 83: Verification Test Tool

1 Thumbscrews 2 Peg mounts

3 Thumbscrew mounts 4 Ocular lens housing

12.3.2 Install the Verification Test Tool
Install the Verification Test Tool before you Run the Verification
Test [} 413].

Do not drop the Verification Test Tool; hold the test tool in place
until you tighten the thumbscrews.

To install the Verification Test Tool:

Action 1. Install the Verification Test Tool on the face of the ocular
lens housing.
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2. Align the short pegs with holes on upper left and lower right.

3. Align the thumbscrews with holes on the upper right and lower
left.

4. Tighten the thumbscrews with your fingers.

12.3.3 Run the Verification Test

NOTE You do not need to make adjustments for image appearance
or signal strength.

You can adjust brightness and contrast in the Analyze step.

NOTE You cannot edit or delete the Performance Verification
patient record.
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NOTE If a performance verification check fails, the data acquired
since the last successful check may not be reliable.

Evaluating this test is somewhat subjective. The examples provided
are guidelines. Note that:

• The alignment target defines a stringent range of tolerance.

• There is only a two or three-pixel difference between PASS and
FAIL.

Before confirming that a test FAILED:

• Switch between 0% and 100% transparency multiple times to
confirm navigation line alignment (see steps below).

• Remove and reinstall the Verification Test Tool to make sure
it is seated properly and rerun the test.

To verify performance:

Prerequisite þ The Verification Test Tool is installed (Install the Verification
Test Tool [} 412]).

þ The Patient window is open (Select the Patient [} 124]).

Action 1. Select the patient: Performance Verification and click
Acquire.

ð The Acquire screen opens.

2. Select Macular Cube 200x200 and click Auto Focus.

3. Click Capture.

ð The Select Eye dialog opens.

4. Select either OD or OS.

5. Click Save.
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6. Click Finish.

ð The Patient page opens.

7. Select the patient: Performance Verification and click
Analyze.

ð The Analysis screen opens.

8. Select the scan saved in the steps above.

9. For Overlay, choose OCT Fundus.

10. Set Transparency to 0%.

11. Double-click on the fundus image.

ð The fundus image opens in full-screen mode.

12. Drag the horizontal and vertical navigation lines to center them
directly over the alignment target (white crossed lines) in the
center of the circle.

13. Exit full-screen mode.

14. Set Transparency to 100%.

ð The circles fade and the fundus image panel is black
showing only the alignment target and navigation lines.

15. Double-click on the fundus image.

ð The fundus image opens in full-screen mode.
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16. If both the horizontal and vertical navigation lines are centered
on the alignment target or are touching the alignment target,
the verification test PASSES.

17. If either the horizontal and vertical navigation lines are in the
black (above, below, to the right or left of the alignment
target), the verification test FAILS.

18. If the test FAILS, contact Zeiss customer service.

ð In the U.S., call 800–341–6968.

ð Outside the U.S., contact your local Zeiss distributor.

19. If you are not sure of the results, remove the verification test
tool and repeat the test.

20.

21. Click Finish.

12.4 Inspect, Clean or Replace the Fan Filter
Inspect the fan filter at least twice a year to determine if it needs
cleaning or replacement.
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To check or replace the fan filter:

Action u Press the snap connector (1) and gently pull the cover back (2).

3

2

1

u If the filter (3) does not need replacement, gently clean the
filter with water or alcohol and wipe dry with a clean, soft
cloth.

u If the filter (3) needs replacement, remove and discard the old
fan filter.

u Install the new fan filter (3) in the fan cover (2).

u Carefully install the fan cover (2) and snap the connector (1)
into place.

12.5 Defragment the Disk Drives

NOTE Hard disk defragmentation usually requires several hours to
complete

u We recommend that you start defragmentation at the end of
the day and let the process run overnight.

This procedure explains how to determine whether a drive needs
defragmentation and now to defragment it.

If defragmentation does not complete by the time you need to use
the instrument, stop defragmentation and start again when the
instrument will not be in use for several hours.

When you clear archived exams regularly, the database and system
performance degrade over time. Defragment the drives to maintain
peak performance.

The CIRRUS™ HD-OCT might be segmented into several drives. For
example, an instrument could have the disk drives:
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• D:

• E:

Check each drive and defragment all drives that require it.

To defragment the computer:

Prerequisite þ The instrument is not needed for several hours (overnight
recommended).

Action u Exit the CIRRUS™ HD-OCT software (Log Out [} 124]).

u From Windows, select Search and type Defrag.

u Open the app Defragment and Optimize Drives.

ð The Windows Optimize Drives tool opens.

u Select the first disk drive.

u Click Analyze.

ð The app analyzes the disk to determine whether it requires
optimization.

u If the analysis recommends optimization, click Optimize.

ð This process takes several hours. Do not use the system
during the optimization process.

u Repeat these steps for each remaining disk drive and optimize
as needed.

12.6 Calibrate the Anterior Segment Lenses

NOTE Do not touch the Calibration Tool, External Lens, or
instrument while the calibration is in progress.

To calibrate the anterior segment lenses:

Action 1. In Windows, navigate to the Carl Zeiss Meditec folder.

2. Double-click the Anterior Segment Module Calibration
Wizard file.

ð The calibration wizard opens.
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3. Click Next.

ð Hardware initializes and the calibration tool installation
dialog opens.

4. Click Next.

ð The lens selection dialog opens.

5. Select Internal Lens.

6. Click Next.
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ð Lens calibration starts. When calibration is complete, a
confirmation opens.

7. If your instrument does not have an Anterior Segment
license, click Finish and exit calibration.

8. If your instrument has an Anterior Segment license, install the
Anterior Chamber lens (see: Attach External Lens [} 181]).

9. Click Next.

ð Lens calibration starts. When calibration is complete, a
confirmation opens.

10. Install the Cornea lens (see: Attach External Lens [} 181]).

11. Click Next.

ð Lens calibration starts. When calibration is complete, a
confirmation opens.
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12. Click Exit.
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13 Troubleshooting

13.1 Safety During Troubleshooting

 WARNING! Opening Instrument Covers

can lead to exposure to electrical and optical hazard.

u Do not open the instrument covers.

u Exceptions:

ð You may remove the rear cover to access labels and
connectors.

ð You may remove the instrument's top cover to inspect or
replace the fan filter.

 CAUTION! Reconfiguring system components on the table, or adding
non-system devices or components to the table, or replacing
original system components with substitutes not approved
by ZEISS

could result in failure of the table height adjustment mechanism,
instability of the table, tipping and damage to the instrument, and
injury to operator and patient.

u Do not reconfigure system components on the table, nor add
non–system devices or components to the table, nor replace
original system components with substitutes not approved by
ZEISS.

 CAUTION! Improper care and cleaning of optical components

could lead to coating failure.

Contaminants on the optical surfaces increase scatter off the
surface and absorb light energy.

u Do not use alcohol prep wipes to clean lenses or optical
surfaces.

u Wipe gently and carefully to avoid scratching the instrument
and auxiliary lenses.
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 CAUTION! Attempting to carry out activities not specifically endorsed
by ZEISS

may void your warranty and could result in damage to the
instrument.

u Read the user documentation.

u Follow directions carefully.

u Do not make upgrades, or carry out repairs or modifications,
without specific guidance and instruction from ZEISS or an
authorized ZEISS represenative.

 CAUTION! Using a non-approved or incorrectly connected device

could invalidate the system safety approval.

u Follow all indications in this user document to ensure that all
connections are approved and correctly configured.

NOTE Report Serious Accidents

u If a serious incident has occurred in relation to this medical
device, to the user, or to another person, then the user (or
responsible person) must report the serious incident to the
medical device manufacturer or the distributor. In the European
Union, the user (or responsible person) must also report the
serious incident to the Competent Authority in the state where
the user is established.
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13.2 Status Messages

NOTE Qualification recommendation for these solutions: Local IT.

Instrument Status

Message / Fault Cause Solution

The instrument is ready
for use.

N/A

 Critical Storage Not enough storage
space for patient data.

u Archive patient data or add an external storage device.

u Turn instrument power off and then on.

u If the problem persists, contact ZEISS customer service.

Hard Drive Status

Message / Fault Cause Solution

Adequate free data
storage space

N/A

 Low disk space Hard drive space is low at
startup.

u You can continue to use the instrument software.

u Free some space on the hard drive soon.

 Critically low hard
drive space.

Not enough hard drive
space to acquire or
analyze patient data.

You cannot Acquire  or
Analyze data.

u Create additional hard disk space by deleting unused,
saved exams.

u Save the exams to an external storage unit or an
additional NAS.

u Shut down and restart the software to enable the
Acquire button.

u If using a Review Station and you only plan to review
one or two scans, you can temporarily change the
storage requirements.

Result

ü When you have adequate space on the hard
drive, status changes to green.

Network Archive Status

Message / Fault Cause Solution

Network available with
adequate storage for
data.

N/A

 Low network disk
space

Low network disk space
for data storage, or
network unavailable.

u Verify the network connection.

u When connected, change the database location. 
(You can use the database temporarily.)

 Critically low
archive storage
space.

Not enough free space
on the archive to save
additional patient data.

u Save the exams locally and consider attaching to an
additional archive storage space.
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13.3 System Startup Troubleshooting

Figure 84: System Startup Results Example

Fault Cause Solution

 Database The system cannot access
patient records success-
fully.

You cannot log in or use the instrument.

Action

u Call ZEISS customer service: In the U.S., call
800-341-6968. Outside the U.S., contact your local
CZM distributor.

 Instrument
Storage Space

The CIRRUS™ HD-OCT
instrument storage is low
or full.

u Clear archived exams.

u To bypass the error and login, click Continue.

ð You might not be able to archive additional
data

 Network
Storage Space

Network archive storage
space is low or full.

u Click Details for more information. Correct the failure
reported in details. If free space is critically low, you
may need to clear archived exams or add storage
before you acquire new scans.

u If prompted, shutdown to archive exams data.

u To bypass the error and login, click Continue.
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Fault Cause Solution

 Installation
Files

Critical system software
files are not available or
were altered.

u Click Details and note system check details.

u Call ZEISS customer service: In the U.S., call
800-341-6968. Outside the U.S., contact your local
CZM distributor.

 Instrument Checks the connectivity
of the instrument
hardware with the
system computer.

 Fail Instrument startup
failure.

Table 84: Startup Check Failure (Operator)

13.4 Troubleshooting Instrument Power
Fault / Indicator Cause Solution

The instrument will not turn on. General power outage. u Ensure that there is not a
localized power outage in
your office or a general power
outage in your neighborhood.

Power cord is not attached to the
instrument.

u Ensure that the power cord is
properly plugged into the
instrument.

The table's power cord is not
plugged into the wall outlet.

u Ensure that the power cord is
properly plugged into the wall
outlet.

Table 85: Troubleshooting Instrument Power

13.5 Troubleshooting Connections
Fault / Indicator Cause Solution

Review station cannot connect to an instrument.

Review station does not
connect to the network.

The internet protocol
version is set incorrectly.

u Set the internet protocol version correctly
(see: Setting the Internet Protocol Version
[} 86]).
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Fault / Indicator Cause Solution

Connection to the current
database failed. Do you want
to specify another database?

The database service is
not turned on.

u Open Windows Task Manager.

u Select Services.

u Start the sevice: Interbase XE3
Guardian CZM_DB.

Firewall rules are
configured incorrectly.

Ensure that the following Windows Firewall
rules are enabled for Public, Private and
Domain network profiles:

• Interbase Server

• File and Printer Sharing (SMB-
In)

• File and Printer Sharing (Edho
Request-ICMPv4-In)

• File and Printer Sharing (Edho
Request-ICMPv6 -In)

Server Port 3051 needed
for instrument and
review station communi-
cation is not available,
blocked or already in use.

u Contact an IT professional to assist you to
make port 3051 available (both the review
station and instrument).

u Assign a different port for communication
on both review station and instrument. To
change the port, use a text edit (like
Notepad) to open the file: C:\WINDOWS
\system32\drivers\etc\services
(no file extension) and find the line that
starts: czm_db.

TCP/IP filtering is blocking
the port.

u Turn off TCP/IP filtering: From the Windows
desktop, open Control Panel > Network
Connections, right-click Local Area
Connection and select Properties.

u Select the General tab, select Internet
Protocol (TCP/IP), click Properties, and
click Advanced.

u Select the Options tab, select TCP/IP
filtering and click Properties.

u Add port 3051 to the list of permitted
ports.

Failure to load scanned data.
Unable to open DICOM File for
Retrieval.

Network drive not
mapped properly or
inadequate permissions
for the network drive.

u On the review station, map a drive to the
archive and set shared permissions.
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Fault / Indicator Cause Solution

Frequent connection timeouts. The network drive map
uses the name of the
storage computer.

u Remap the drive using the IP address
instead of the computer name.

Slow or weak network
connection.

u Increase timeout values (see: DICOM
Advanced Configuration [} 399]).

LAN adapter setting is
disabled.

u From the Windows desktop, open Control
Panel > Network and Internet
>Network and Sharing Center.

u Click Change adapter settings.

u Right-click Local Area Connection and
select Properties.

DICOM connection status
indicator is red

Connection information
is set incorrectly.

u Set the internet protocol version correctly
(see: Setting the Internet Protocol Version
[} 86]).

Connect test failed.

United States Veterans Admin-
istration’s VistA™ is not
connecting properly.

DICOM Extended
Negotiation is enabled.

u Uncheck DICOM Extended Negotiation
(see: DICOM Advanced Configuration
[} 399]).

FORUM is not connecting
properly.

DICOM Extended
Negotiation is disabled.

u Check DICOM Extended Negotiation
(see: DICOM Advanced Configuration
[} 399]).

During DICOM configuration,
AE Title and DICOM Port
fields are not editable.

Allow Local AETitle
Edit is disabled.

u Check Allow Local AETitle Edit (see:
DICOM Advanced Configuration [} 399]).

Worklist records searches
timeout or message: " exceeds
the configured maximum"

The Maximum Query
Response is too low for
the network.

u Use additional search criteria to return
faster, narrower search results.

u Increase  Maximum Query Response
value (see: DICOM Advanced Configuration
[} 399]).

FORUM/DICOM is not
automatically connecting.

Auto-query is disabled. u Enable auto-query (see: Configure DICOM
Archiving [} 84]).

13.6 Troubleshooting Archive Management
Fault / Indicator Cause Solution

Cannot set an archive location. You are using a review station in
Instrument mode.

u Use a CIRRUS™ HD-OCT
instrument or review station
set to DICOM mode to set up
an archive.
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13.7 Troubleshooting User Management
Fault / Indicator Cause Solution

Cannot add a user. You are logged in as an operator
or analyst.

u Log in as Admin [} 58].

Cannot delete a user. The user is assigned to one or
more existing patient scans.

u Retain the inactive user to
keep their association to
existing scans.

13.8 Troubleshooting Patient Management
Fault / Indicator Cause Solution

Cannot open the scan organizer. You are using a review station. u Use a CIRRUS™ HD-OCT
instrument to organize scans.

13.9 Troubleshooting Scan Acquisition
Fault / Indicator Cause Solution

Cannot obtain a complete image. The patient's eyelid is obstructing
the image.

u Elevate the patient's eyelid
during scan acquisition (see: ).

Image has breaks or saccades. The patient is moving their eyes
during the scan or blinking exces-
sively.

u Turn FastTrac™ On [} 219].

Poor image quality and blurry B-
scan.

Weak signal strength. u Re-take the scan.

FastTrac stalls or does not
complete.

The image is too high or too low. u Center the B-scan image (see:
Adjusting B-Scan Images
[} 210]).

The iris target is not centered on
the pupil.

u Align and Focus the Iris Image
[} 214].

The fundus image is not focused. u Focus the Fundus Image
[} 209].

The patient's pathology or
anatomical features make it
difficult to center all B-scans.

u Turn off Z position
monitoring (see: ).

The patient is not fixating properly
during the scan.

u Ask the patient to try to move
and blink less frequently
during the scan.

The patient is blinking or moving
too much during the scan.

Cannot center all of the B-scans at
the same time.

The patient's pathology or
anatomical features make it
difficult to center all B-scans.

u Turn off Z position
monitoring (see: ).

Cannot turn on FastTrac. FastTrac is disabled. u Enable FastTrac (see: Turn
FastTrac™ On or OFF [} 119]).
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Fault / Indicator Cause Solution

HD image appears inverted. The B-scan image is too high in the
viewport (creating a reflection).

u Center the B-scan image (see:
Adjusting B-Scan Images
[} 210]).

Fundus image is partially or
completely obscured.

The B-scan is too low in the
viewport; light is not passing
directly through the center of the
pupil.

13.9.1 Troubleshooting FastTrac

Fault / Indicator Cause Solution

The image is not
centered properly (too
high or too low).

For patients with certain
pathologies or
anatomical features, it
may be difficult to ensure
centering across all B-
scans in a cube.

u Use the up and down arrows to center the
image.

u Cancel the scan.

u Turn off the monitoring of the Z position.

u Re-scan with FastTrac.

FastTrac stalls or cannot
successfully track using
FastTrac.

The iris image is not
aligned properly

u Adjust the position in the Iris viewport.

The fundus image is not
focused properly.

u Manually adjust the focus.

Fixating problems. u Ensure that the patient is fixating in the same
position throughout scan acquisition.

Excessive blinking or
moving.

u Ensure that the patient remains still and blinks
less frequently throughout scan acquisition.

13.10 Troubleshooting Image Analysis
Fault / Indicator Cause Solution

Fovea Not Found The system's automatic fovea
location algorithm could not
detect the Fovea.

u Manually position the Fovea.

The Fovea location was not
detected properly.

The systems' automatic fovea
location algorithm detected a
depression in the reflectivity
around the ILM that is not related
to the fovea.

The patient's fovea is very far from
the center.

Table 86: Troubleshooting Posterior Segment Image Analysis
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13.11 Troubleshooting Image Registration
Success or failure of registration is based on a cross-correlation
metric computed from the two images after registration. A
threshold for this metric concludes whether registration failed or
succeeded.

Fault / Indicator Cause Solution

Red Flag

Registration Failed Message

Weak signal strength u If another image is available,
select another image for
comparison.

u To register the images, see:
Manually Register AngioPlex
Images [} 317].

u To proceed without regis-
tering the images, select No
Registration.

Poor alignment

Opacities

Differences between the scan
areas

Differences in retinal anatomy
between the images.
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14 Specifications

14.1 Imaging Specifications
CIRRUS 6000

Methodology Spectral domain OCT

Optical source Superluminescent diode (SLD), 840
nm

Optical power Nominal 1200 +/– 300 μW at
cornea

Maximum Scan speed 100k A-scans/sec

14.1.1 Posterior Segment Imaging Specifications

CIRRUS 6000

A-scan depth 2.9 mm for 12 mm 1 line 100x
Raster, Angio HD 8x8, Angio 8x8
and 12x12

2.0 mm for all other scans

Axial resolution 5 µm

Transverse resolution 12 µm

14.1.2 Anterior Segment Imaging Specifications

Scan A-Scan Depth Axial resolution Transverse resolution

Anterior Segment Cube
512x128

2.0 mm, 1024 points 5 µm <20 µm

Anterior Segment 5 Line
Raster

HD Cornea <25 µm

Pachymetry

HD Angle 2.9 mm, 1024 points <20 µm

Wide Angle-to-Angle <45 µm

Anterior Chamber 5.8 mm, 2048 points

14.1.3 Fundus Imaging Specifications

CIRRUS 6000

Methodology Line scanning

ophthalmoscope
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CIRRUS 6000

Live fundus image During alignment and during OCT
scan

Optical source Superluminescent diode (SLD), 750
nm

Optical power < 1.5 mW at the cornea

Field of view 36 degrees W x 30 degrees H

Frame rate > 20 Hz

Transverse resolution 25 µm (in tissue)

14.1.4 Iris Imaging Specifications

CIRRUS 6000

Methodology CCD camera

Resolution 1280 x 1024

Live iris image During alignment

14.1.5 Imaging Properties
The following tables lists the optical properties of the four light
sources incorporated into the CIRRUS 6000 instrument:

OCT

Source Super-luminescent diode (SLD)

Wavelength 840 nm 
Wavelength range: 795 nm – 885 nm (10 dB width, approximate Gaussian
intensity distribution)

Scan Angle 10° minimum, 42° maximum

Maximum Beam Power 2.2 mW at cornea

Operating Beam Power 0.9 to 1.5 mW at cornea

LSO

Source SLD, lensed to illuminate a line subtending 30°

Center Wavelength 750 nm 
Wavelength range: 740 nm – 760 nm (3 dB width, approximate Gaussian
intensity distribution)

Scan Angle 36° horizontal scan of the 30° vertical line

Operating Beam Power 1.0 mW at cornea

Iris View

Source Infrared LED
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Iris View

Wavelength 700 nm 
Wavelength range: 678 nm – 722 nm (45 nm 3 dB width, approximate Gaussian
intensity distribution)

Radiance 260 mW/cm2/sr

Internal Fixation

Source Green LED

Wavelength 523 nm 
Wavelength range: (Approximate
Gaussian intensity distribution)

x-Axis = wavelength λ (nm)

y-Axis = Relative intensity %

1=Blue

2=Green

Luminance 0.31 lumens/cm2/sr

External Fixation

Source Red LED

Wavelength 627 nm 
Wavelength range: 604 nm – 650
nm (45 nm 3dB width, approx-
imate Gaussian intensity distri-
bution)

x-Axis = wavelength λ (nm)

y-Axis = Relative radiant intensity

Radiance 0.64 mW/cm2/sr

Based on an analysis of relevant laser and ophthalmic standards, all
CIRRUS™ HD-OCT light sources together comprise a safe
instrument, for which the standards prescribe no warnings or
limitations on viewing the light sources beyond the label “Class 1
laser product.” The analysis includes consideration of the spatial
distribution of intensities of the light sources on the cornea and
retina during scanning to determine the hazard classification of the
product.
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14.2 Mechanical Specifications

14.2.1 Physical Specifications

CIRRUS 6000

Weight 35 kg (77 lbs) 
(without monitor)

Dimensions 62.2L x 42.5W x 29.2H (cm)
(without monitor)

Input devices keyboard

mouse

Fixation Internal, external

Internal Fixation (focus adjustment) -20D to +20D (diopters)

14.2.2 Computer Specifications

CIRRUS 6000

Processor i7 Intel® processor (7th gen)

Internal storage > 80,000 scans

USB ports 6

Monitor 22” Widescreen HD

Operating system (Instrument) Windows 10

Operating system (Review Station) Windows 10

Windows 8.1

Windows 7 (64 Bit)

Table 87: Computer Specifications

14.3 Electrical Specifications
Rating CIRRUS 6000

Electrical (115V) 100-120 V~ 50-60 Hz 6.3A 
220-240 V~ 50-60 Hz 3.15A

Fuse T 6.3A L 250V

Electrical (230V) 220-240 V~ 50-60 Hz 3.15A

Table 88: CIRRUS 6000 Electrical Specifications

14.4 Conditions for Use
CIRRUS 6000

Temperature +10º C to +35º C
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CIRRUS 6000

Relative humidity 30% to 75% (excluding conden-
sation)

Atmospheric pressure 700 hPa to 1060 hPa

Altitude (above sea level) Up to 3000m

Room Lighting Standard indoor office fluorescent
lamp environment; not to be used
in direct sunlight or near a
window.

14.5 Conditions for Transport and Storage
CIRRUS 6000

Temperature –40 to +70º C

Relative humidity 10% to 100% (including conden-
sation)

Atmospheric pressure 500 hPa to 1060 hPa
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15 Legal Notices

Software Copyright

The software program (“Software”) included with your CIRRUS
6000 is a proprietary product of Zeiss and in certain instances
contains material proprietary to Microsoft Corporation and other
third party licensors, suppliers and vendors. These proprietary
products are protected by copyright laws and international treaty.
You must treat the Software like any other copyrighted material.
Copyright ©2019 Carl Zeiss Meditec, Inc. All rights reserved.

End User Software License Agreement

Upon initial configuration of your CIRRUS 6000, you will be
presented with an End User Software License Agreement (the
“EULA”), which you must accept in order to use the Software. The
EULA is a legal contract between You and Carl Zeiss Meditec, Inc.,
which governs Your use of the Software. If you do not agree with
the terms and conditions of the EULA and do not agree to be
bound by the EULA, do not use the Software. If You have any
questions concerning the EULA, contact Carl Zeiss Meditec, Inc.,
Attention: Customer Service, 5160 Hacienda Drive, Dublin, CA
94568. Telephone 800–341–6968.

Acknowledgment

You acknowledge that you have read all the provisions in this
Chapter, including End User Software License Agreement, under-
stand them, and agree to be bound by their terms and conditions.
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16 Accessories and User Replaceable Spare
Parts
This section contains parts lists and associated information for the
device. It also contains instructions for ordering parts and returning
defective parts.

NOTE The procedure for returning defective parts from Interna-
tional operations differs somewhat from that for U.S.
domestic operations

These differences are noted in the instructions.

u Please follow the instructions carefully.

16.1 Accessories and User Replaceable Parts

 WARNING! Using parts that are not authorized by ZEISS

may compromise device safety during operation.

u Use only accessories authorized by ZEISS.

u In the U.S., call 800–341–6968. Outside the U.S., contact your
local Zeiss distributor. You can find the ZEISS contact partner
for your country on our website: www.zeiss.com.

16.2 Parts Orders

16.2.1 U.S. Domestic Parts Ordering
Spare parts may be ordered as needed following established parts
ordering procedures. Parts needed overnight may be ordered by
phone from the Parts Department. The cost of shipping parts for
next day delivery is very high and should be used only in
emergencies. The Parts Department phone number is:

• 1-800-341-6968 (domestic toll-free)

• 1-925-557-4843 (domestic)

• 1-925-557-4652 (domestic fax)

16.2.2 International Service Operations
Customers are billed for shipping charges, including any customs
fees required.

For International Service Operations, please use the ordering proce-
dures that have been established for your area of operations, and
which meet the requirements of the Carl Zeiss Meditec Interna-
tional Parts Department.
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16.3 Returning Defective Parts
The return of defective parts is a very important part of ZEISS'
responsibility to its customers and helps us to:

Action u Evaluate returned parts to assist in root cause analysis.

u Rebuild and return them to service stock, so they are available
in the future as needed.

16.4 Equipment Return Authorization
Authorization must be obtained from Carl Zeiss Meditec before
equipment is returned for repair. A Return Material Authorization
(RMA) number is required on each return shipment to Carl Zeiss
Meditec. The procedure for obtaining an RMA number varies,
depending on your area of operation. Use the procedure that has
been established by Carl Zeiss Meditec for your area of operations.

16.5 International Service Operations
Customers are billed for shipping charges, including any customs
fees required.

For International Service Operations, please use the ordering proce-
dures that have been established for your area of operations, and
which meet the requirements of the Carl Zeiss Meditec Interna-
tional Parts Department.

16.6 Part Numbers

NOTE Part numbers are subject to change

u When ordering, confirm all part numbers with your ZEISS
Representative.

16.6.1 Power Cords

Designation Specification Part Number

Power Cord IEC 320 1 m/39 Inch 0000001217033

Power Cord IEC 320 to
NEMA

.3 m/12 In 2660021115973

16.6.2 Cables

Designation Length Part Number

Ethernet CAT5E Shielded 14 ft. 2660021121819

Cable, USB MA-MB 6 ft. 2660021116418
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16.6.3 Cleaner

Designation Specification Part Number

Alcohol Wipes - 2660100006566

Camera Lens Cleaner - 2660100007672

Camera Lens Wipes - 2660100007673

16.6.4 Kit, Test Eye

Designation Specification Part Number

The Kit includes:

• Verification Test Tool

• Fixation Device

• Occluding Sleeve for
Fixation Device

• Red Fixation Lamp

- 2660021161047

16.6.5 Miscellaneous Spare Parts

Description Specification Part Number

Anterior Chamber Lens - 2660021158406

Anterior Segment
Calibration Tool

- 2660021150088

Instrument Dust Cover - 2660021174524

Cornea Lens - 2660021158407

Fan Filter - 2660021161991

Fixation Device (External) 2660021149361

Fixation Lamp Red 3013509052000

Occluding Sleeve for
Fixation Device

- 3197519005000

Ocular Lens Cover - 2660021124008

Verification Test Tool - 2660021160365
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17 Decommissioning

17.1 Safety During Decommissioning

 CAUTION! Attempting to decommission your system

may result in damaged equipment and danger to personnel.

u Never attempt to decommission a ZEISS system or device. Only
ZEISS approved field service representatives are qualified to
safely decommission your system.

u Contact your ZEISS Representative to set up an appointment for
system/device decommissioning.
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18 Packaging and Transport

18.1 Safety During Packaging and Transport

 CAUTION! Packaging and transport by non-ZEISS personnel

could result in damage, loss, or non-compliance within the country
of transit.

u Allow only change to Zeiss approved representative to prepare
the instrument and associated components for transport.

u Allow only ZEISS-approved personnel to transport the
instrument and associated components.
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19 Disposal

19.1 Packaging Disposal
• Keep instrument packing material in the event of a relocation or

repair.

• If you want to dispose of the packing material: Dispose of
packing material by sending it for recycling through an
acknowledged collection system.

19.2 Device Disposal
The device contains electronic components with integrated
batteries.

• Dispose of the device and integrated batteries correctly, in
accordance with national legislation.

The device specified on the delivery note must not be disposed of
via household waste or communal disposal companies according to
the applicable EU guidelines valid at the time the device was placed
on the market.

For more information about the disposal of the device, please
contact the ZEISS contact partner in your country.

If you want to sell the device or its components: Inform the
purchaser that they must dispose of the device according to the
regulations valid at that time.
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A Diverse Population Study

NOTE Normal reference ranges represent the general population.
However, when interpreting data, keep the following study
limitations in mind (especially for 1% and 99%):

u Subjects:

ð Ages 18-84

ð Refractive errors –12.00 D to +8.00 D

u Age ranges with fewest subjects:

ð 3 subjects over 80.

ð 28 subjects aged (70-79).

NOTE Normal reference range limits are adjusted only by age
(unless noted).
Other differences might occur for some measurements;
however, the normal reference range does not adjust for
these factors, such as:

u Image Signal Strength

u Ethnicity

u Axial Length

u Refraction

u Optic Disc Area

This appendix explains how normal reference ranges were deter-
mined for the general population. 



A Diverse Population Study Instructions for Use
CIRRUS™ HD-OCTA.1 Purpose

452 / 542 2660021174149 Rev. D 2019-10

A.1 Purpose

Initial Study

The purpose of the original normative study was to establish
normal reference ranges for:

• Macular Thickness (macular images)

• RNFL Thickness (ONH images)

Follow-up Study

A later study analyzed the same data (collected in the original
study) to establish normal reference ranges for:

• Ganglion Cell Thickness (macular images)

• ONH Features (ONH images)

A.2 Results in Image Analysis
CIRRUS™ HD-OCT analyses compare a patient's results to the
normal reference range and depict the results visually in different
ways.

The following table shows examples of different visual results.

Table Chart Graph Maps

Key:

•  Within normal reference range.

•  Near upper/lower limit of stand range.

•  Above/below normal reference range.

Table 89: Examples of Visual Results
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A.3 Study Subjects
The following table describes the selection criteria for subjects of
this study.

Inclusion Criteria Exclusion Criteria

• 18 years or older.

• Willing to make the
required study visits.

• Willing to give consent
and follow study instruc-
tions.

• Normal and valid
Humphrey 24-2 SITA.

• Standard visual field in
both eyes.

Ophthalmic

• Best corrected visual acuity in either eye worse than 20/40.

• Refractive error (spherical equivalent) outside -12.00 D to +8.00 D range.

• Glaucoma or glaucoma suspect diagnosis in either eye.

• Presence or history of ocular hypertension (IOP ≥ 22 mm Hg) in either eye.

• Occludable angle or history of angle closure in either eye.

• Presence or history of disc hemorrhage in either eye.

• RNFL defect in either eye.

• Amblyopia in either eye.

• Previous laser or incisional surgery.

• Active infection in anterior or posterior segments.

• Evidence of diabetic retinopathy, diabetic macular edema, or other vitreo-retinal
disease.

Systemic

• History of diabetes, leukemia, AIDS, uncontrolled systemic hypertension, dementia or
multiple sclerosis.

• Life-threatening or debilitating disease.

• Current or recent use of an agent with photosensitizing properties (Visudyne®,
ciprofloxacin, Bactrim®, doxycycline, etc.).

Table 90: Subject Selection Criteria

Subject Medical History

Investigators took medical and ophthalmic histories and conducted
an ophthalmic examination on each subject prior to enrollment,
which included:

• Distance visual acuity.

• Humphrey 24-2 SITA perimetry (standard threshold test).

• Goldmann applanation tonometry.

• Keratometry.

• Axial length measurement using an IOLMaster.

• Slit lamp examination of the anterior segment of both eyes.

• Gonioscopy.

• Dilated ophthalmoscopic examination, bilaterally.

• Fundus and stereodisc photography of the maculas and the
optic nerves of both eyes.

• Corneal thickness measurement using ultrasound pachymetry.
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A.4 Age Groups

NOTE For the study, subjects were categorized into age groups.
Image analyses compare a patient's measurements to
subjects of the same age (not age group).

For the study, subjects were divided into age groups as follows:

Group Age Range Gender Diversity Ethnic Diversity

1 18-29 Macula & Ganglion Cell
Study

• 133 Male

• 149 Female

• Median age: 46.6

RNFL & ONH Study

• 134 Male

• 150 Female

• Median age: 46.5

• 43% Caucasian

• 24% Asian

• 18% African American

• 12% Hispanic

• 1% Indian

• 2% mixed ethnicity

2 30-39

3 40-49

4 50-59

5 60-69

6 70-84

Observations:

• 0 subjects under 19 years old.

• 28 subjects between 70 and 79 years old.

• 3 subjects 80 and older.

Table 91: Age Groups

A.5 Data Collection
CIRRUS™ HD-OCT operators obtained the following images from
each subject:

Subjects Scan Type # of Scans Eyes

284 Optic Disc Cube 200x200 3 OD & OS

Macular Cube 200x200 3

Macular Cube 512x128 1

Table 92: CIRRUS™ HD-OCTStudy Images

All 284 subjects qualified for the RNFL study.

282 subject eyes qualified for the Macula, Ganglion Cell, and
ONH study.

A.6 Image Selection
Investigator reviewed each image to determine:

• Poor quality images to exclude, such as images with:

– Signal strength of 5 or lower.

– Saccade(s) within the central 80% of the image (due to
excessive eye motion during image acquisition).

– Data loss greater than 10% at the edge of the scan area.

– Floaters obscuring the macular area (macular images).

– Floaters obscuring the measurements of ONH image.

• The best quality image for each eye.
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A.7 Data Analysis
By defining a set a normal reference ranges, CIRRUS™ HD-OCT
image analysis can compare a patient's measurements to determine
whether a patient's measurements are within the normal reference
range for their age.

The subject's age is a clinically important factor for determining
normal reference ranges.

Regression model analyses estimated the limits of thickness para-
meters adjusted by age.

A.7.1 Deriving Percentiles and Limits
The following table provides the formulas that derived the normal
reference range limits:

Purpose Formula

Derive residuals for fitted regression model (each eye). Residual = Obs(age0) - ET(age0)

Established estimated 1%, 5%, 95% and 99% limits for a normal
subject with an age of age0.
Empirical distribution of the residual estimated the percentiles.

ET(age0) + NL(100xα %) < Obs(age0)

• ET(age0) = the estimated expected mean reading

• Obs(age0) = the measured or observed reading

• NL(100xα %)  = the normative limit of the residuals

A.8 Macular Images
Measurement Parameters Analyses

Macular Thickness • Macular thickness

• Average macular thickness

• Average volume (ILM-RPE)

• Macular Thickness [} 238]

• Macular Change [} 247]

• *Panomap [} 299]

• *Single Eye Summary [} 295]

• Wellness Report [} 301]

Ganglion Cell Thickness • Ganglion cell thickness • Ganglion Cell OU [} 262]

• Ganglion Cell Guided Progression
[} 267]

• *Panomap [} 299]

Table 93: Normal Reference Ranges for Macular Images
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A.8.1 Macular Thickness Parameters

Figure 85: Early Treatment
Diabetic Retinopathy Study (ETDRS)
Grid

Normal reference ranges for macular thickness provides the basis to
compares a patient's macular thickness to the normal reference
range for their age.

Normal reference ranges apply to the following measurements:

• Macular Thickness: Average thickness for the ILM - RPE tissue
layer for each sector of the ETDRS grid.

• Average Thickness: Overall average thickness for the ILM -
RPE tissue layer over the entire scanned area.

• Volume: Overall average volume for the ILM - RPE tissue layer
over the entire scanned area.

A.8.1.1 Examples

Macular Thickness Analysis PanoMap
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A.8.1.2 Factors That Affect Normal Reference Ranges

A.8.1.2.1 Affect of Age

Central Subfield Key:

• X-axis (horizontal) = Age in years

• Y-axis (vertical) = Average Retinal Thickness (µm)

• Line = Fitted regression line

Average Thickness (all ETDRS subfields)

Average Volume (all ETDRS subfields) Key:

• X-axis (horizontal) = Age in years

• Y-axis (vertical) = Average Retinal Volume (mm3)

• Line = Fitted regression line

A.8.2 Ganglion Cell Parameters
The Ganglion Cell normal reference ranges provide normative
data for the thickness of the ganglion cell and the inner plexiform
layer in healthy subjects ages 19 to 84.
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To establish reference values, the images from the original study
were analyzed using a (proprietary) segmentation algorithm that
identifies the thickness of the combined ganglion cell and inner
plexiform layers.

Figure 86: GCL + IPL Thickness Grid

Average GCL + IPL thickness  sectors:

• 60º segments of an elliptical annulus

• inner minor axis radius of 0.5 mm

• outer minor axis radius of 2.0 mm

• stretched by 20% in the horizontal direction

Minimum average value:

A set of 360 spokes, (average of the pixels along each spoke).

NOTE! The thinnest portion of the ganglion cell plus inner
plexiform layers in the perifoveal region likely shows if there
is ganglion cell damage.

A.8.2.1 Examples

Ganglion Cell OU Ganglion Cell Guided Progression

A.8.2.2 Ganglion Cell Data

Parameter Mean Std Min Max

Average GCL + IPL Thickness 84.7 7.1 67.7 104.2

Sector 1 82.9 6.3 68.0 102.0

Sector 2 86.4 7.9 67.0 113.0

Sector 3 86.8 8.3 65.0 112.0

Sector 4 85.3 9.0 62.0 111.0

Sector 5 83.2 7.8 62.0 109.0

Sector 6 83.8 6.5 68.0 106.0

Minimum Average Axial Thickness 82.1 6.9 53.2 101.8

Table 94: Ganglion Cell Data

A.8.2.3 Factors That Effect Normal Reference Ranges

Normal reference ranges are adjusted by age. Factors that influ-
enced ganglion cell normal reference range limits for some parame-
ters included:
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• Age (12% variability)

• Image Signal Strength (4% variability).

• Refractive error and axial length (< 2% variability)

A.8.2.3.1 Effect of Age

Key:

• X-axis (horizontal) = Age in years

• Y-axis (vertical) = Ganglion Cell Average Thickness (µm)

• Line = Fitted regression line

A.8.2.3.2 Effect of Ethnicity

Descent Mean Std

European 84.1 7.8

Hispanic 88.8 6.4

African 86.3 7.8

Asian 89.4 7.2

Observations:

• There are statistically significant differences among different ethnic groups in GCL + IPL thickness.

The mean difference in the average thickness between any two race groups is within 4.3 mm.

• Subjects of European Descent have thinner GCL + IPL thickness (on average).

• Subjects of Hispanic and Chinese descent have thicker GCL + IPL thickness (p < 0.001).

A.8.2.3.3 Effect of Axial Length and Refractive Error

Key

• X-axis (horizontal) = Age in years

• Y-axis (vertical) = Average Ganglion Cell Thickness
(microns)

• Line = Fitted regression line

Observations:
GCL + IPL thickness decreases slightly with axial length (less than 2% of the total variability of the ganglion cell para-
meters).
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A.9 ONH Images
Measurement Parameters Analyses

RNFL [} 456] Thickness • Average RNFL Thickness

• Superior RNFL Thickness

• Inferior RNFL Thickness

• RNFL Quadrants (TSNIT)

• RNFL Clock Hours

• RNFL Symmetry

• ONH/RNFL OU [} 279]

• Guided Progression Analysis [} 283]

• *Panomap [} 299]

• *Single Eye Summary [} 295]

• Wellness Report [} 301]

ONH Features [} 462] • Rim Area (mm2)

• Disc Area (mm2)

• Average Cup-to-Disc Ratio

• Vertical Cup-to-Disc Ratio

• Cup Volume (mm2)

• ONH/RNFL OU [} 279]

• Guided Progression Analysis [} 283]

• *Panomap [} 299]

• *Single Eye Summary [} 295]

Table 95: Estimated Normal Reference Ranges for ONH Images

A.9.1 RNFL Parameters
This study determined the normal reference ranges for the
following the retinal nerve fiber layer (RNFL) parameters in healthy
subjects ages 19 to 84:

• Average RNFL Thickness

• Superior RNFL Thickness

• Inferior RNFL Thickness

• RNFL Thickness for Quadrants (TSNIT)

• RNFL Thickness for Clock Hours

A.9.1.1 Examples

ONH and RNFL OU ONH Guided Progression
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A.9.1.2 Factors That Effect Normal Reference Ranges

A.9.1.2.1 Effect of Age

Superior Quadrant Average Key:

• X-axis (horizontal) = Age in years

• Y-axis (vertical) = RNFL Thickness (µm)

• Line = Fitted regression line

Inferior Quadrant

Average Key:

• X-axis (horizontal) = Age in years

• Y-axis (vertical) = Average RNFL Thickness (µm)

• Line = Fitted regression line

A.9.1.2.2 Effect of Ethnicity

Ethnicity [1] [2] [3] RNFL Thickness

Caucasian Thinner mean average thickness, superior quadrant average, and inferior quadrant average.

Asian Thinner mean nasal quadrant average and thicker temporal quadrant average.

[1] Artes, Crabb: Estimating normative limits of Heidelberg Retina Tomograph optic disc rim area with quantile regression, Invest
Ophthalmol Vis Sci. 2010 Jan;51(1):335-61

[2] Knight, Oakley, Durbin, Callan, Budenz: Cirrus Normative Database Study Group: Effect of Ethnicity, Age, and Axial Length on Optic
Nerve Head Parameters Measured by Cirrus™ HD-OCT, ARVO abstract 2010.

[3] Spaeth, Henderer, Steinmann: The disc damage likelihood scale: its use in the diagnosis and management of glaucoma, Highlights
Ophthalmol 31: 4-16, 2003.
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Ethnicity [1] [2] [3] RNFL Thickness

Observations:

• The mean difference in the average thickness between any two race groups is within 6 µm.

• People of Asian descent have thinner mean nasal quadrant average and thicker temporal quadrant average. 

• The largest difference in the RNFL thickness between two race groups is for the temporal quadrant average between
Asian and African American, with a difference of 16 µm. 

A.9.1.2.3 Effect of Axial Length and Refractive Error

Key

• X-axis (horizontal) = Age in years

• Y-axis (vertical) = Average GCA (microns)

• Line = Fitted regression line

Observations:
decreases slightly with axial length (less than 2% of the total variability of the Ganglion Cell parameters)

A.9.2 ONH Parameters

NOTE These ONH parameters are adjusted for age and optic disc
area.

u Refer to: Factors That Effect Normal Reference Ranges [} 464].

The data originally collected for the database was analyzed again
to create the normal reference ranges for the following ONH para-
meters:

• Rim Area (mm2)

• Disc Area (mm2)

• Average Cup-to-Disc Ratio

• Vertical Cup-to-Disc Ratio

• Cup Volume (mm3)

Additional Image Analysis Criteria

All three scans for each subject were reviewed again after
processing with the optic nerve head analysis algorithm to ensure
that:

• no floaters impacted the optic nerve head region

• optic nerve head data was within the axial field-of-view

In three instances, it was necessary to select a different scan for
one eye to obtain acceptable results for both ONH and RNFL.
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A.9.2.1 Examples

ONH and RNFL OU ONH Guided Progression

A.9.2.1.1 Analysis Application and Limitations

If there was not enough data for an adequate representative for a
particular normal reference range, the results have gray shading.
Results in this category include:

• Disc Area < 1.3 mm2

• Disc Area > 2.5 mm2

• Average Cup-to-Disc Ratio ≤ 0.25

• Vertical Cup-to-Disc Ratio ≤ 0.25

OU Analysis

A patient can have different disc areas for each eye, which applies
a different normal reference range to each. OU analysis uses the
normal reference range for the average disc area.

A.9.2.2 Quantile Regression Data Analysis

Because the subject's age and disc size are both a clinically
important factors for determining normal reference ranges, we
used quantile regression to determine limits for Disc Area.

Quantile regression fits slope and offset independently for each
limit[4].

Regression model analyses estimated the limits of thickness para-
meters adjusted by age. Cup-to-Disc Ratios ≤ 0.25 were excluded
prior to quantile regression.

A.9.2.3 ONH Parameter Data

Parameter Average Standard
Deviation

Minimum Maximum

Rim Area (mm2) 1.311 0.218 0.720 2.272

Disc Area (mm2) 1.769 0.340 1.003 2.925

Average Cup-to-Disc Ratio 0.458 0.173 0.071 0.812

[4] Artes, Crabb: Estimating normative limits of Heidelberg Retina Tomograph optic disc rim area with quantile regression, Invest
Ophthalmol Vis Sci. 2010 Jan;51(1):335-61
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Parameter Average Standard
Deviation

Minimum Maximum

Vertical Cup-to-Disc Ratio 0.435 0.166 0.058 0.762

Cup Volume (mm3) 0.137 0.134 0.000 0.796

Observations:

• 11 subjects (less than 5%) had discs larger than 2.5 mm2.

• 11 subjects (less than 5%) had discs smaller than 1.3 mm2.

• Disc area did not depend on age.

Table 96: ONH Parameter Data[5]

In earlier studies, researchers measured the disc's vertical diameter
with a slit-lamp and classified the discs as small, medium, and
large[6].

In this study we measured disc area, which considers all meridians.
The classifications for disc area are:

• Smallest ⅓:  < 1.58 mm2

• Medium ⅓: 1.58 mm2  to 1.88 mm2

• Largest ⅓: > 1.88 mm2

A.9.2.4 Factors That Effect Normal Reference Ranges

This study found that optic disc area and age had the greatest
effect on the ONH parameters.

• Disc Area: as much as 40% of variability for some parameters

• Age: no more than 5% of variability for ONH parameters

• All Other Factors: (refractive error, axial length, etc.) no more
than 7% of variability for ONH parameters

A.9.2.4.1 Effect of Age

Measurement Slope R2 p

Rim Area -0.002 mm2 / year 0.033 0.002

Average Cup-to-Disc Ratio +0.002 / year 0.032 0.002

Vertical Cup-to-Disc Ratio +0.002 / year 0.041 0.001

Observations :

• Average and Vertical Cup-to-Disc Ratios slowly increase with age.

• Rim Area slowly decreases with age.

• Disc area does not change with page (p>0.05).

A.9.2.4.2 Effect of Ethnicity

Measurement Slope R2 p

Rim Area -0.002 mm2 / year 0.033 0.002

Average Cup-to-Disc Ratio +0.002 per year 0.032 0.002

Vertical Cup-to-Disc Ratio +0.002 per year 0.041 0.001

[5] Knight, Oakley, Durbin, Callan, Budenz: Cirrus Normative Database Study Group: Effect of Ethnicity, Age, and Axial Length on Optic
Nerve Head Parameters Measured by Cirrus™ HD-OCT, ARVO abstract 2010.

[6] Spaeth, Henderer, Steinmann: The disc damage likelihood scale: its use in the diagnosis and management of glaucoma, Highlights
Ophthalmol 31: 4-16, 2003.
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Measurement Slope R2 p

Observations :

• Subjects of African descent had the largest discs on average (1.93 ± 0.33 mm2).

• Subjects of European descent had the smallest discs on average (1.68 ± 0.30 mm2).

• Rim Area show no significant difference among different ethnic groups.

Measurement Mean Difference p

Average Cup-to-Disc Ratio 0.10 0.008

Vertical Cup-to-Disc Ratio 0.09 0.027

Cup Volume 0.09 mm3 0.003

A.9.2.4.3 Effect of Optic Disc Area

Measurement Slope 
(of rim / mm2 of disc)

R2 p

Rim Area +0.24 mm2 0.13 0.002

Average Cup-to-Disc Ratio +0.35 mm2 0.35 0.042

Vertical Cup-to-Disc Ratio +0.29 mm2 0.34 0.001

Cup Volume +0.25 mm2 0.39 0.011

Observation:

• Most disc areas are between 1.3 mm2 and 2.5 mm2.

• All parameters increase with disc size.

A.10 Conclusions
Doctors can use these normal reference ranges to compare a
patient's measurements to the general population.
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B Asian Population Study

NOTE Features described in this section are licensed separately and
may not be available in all markets.

u For information about feature availability in your market and
obtaining a license:

ð in the U.S.A, call 1-877-486-7473.

ð outside the U.S.A , contact your local ZEISS distributer.

NOTE Normal reference ranges represent the general population.
However, when interpreting data, keep the following study
limitations in mind (especially for 1% and 99%):

u Subjects:

ð Ages 18-84

ð Refractive errors –12.00 D to +8.00 D

u Age ranges with fewest subjects:

ð 0 subjects over 79.

ð 0 subjects under 19.

The normal reference range limits for the Diverse Population Study
[} 451] do not adjust for ethnic differences.

An additional study established normal reference range limits for
the same parameters adjusted for Asian populations. This appendix
explains how normal reference ranges were determined for Asian
populations. 

Five new centers participated in the study; these results combined
with data from Hong Kong (part of the diverse population study) to
establish normal reference range limits for Asian populations.

When you license the Asian Normative Database, you can select
whether to apply the Asian Normative Database or Diversified
Normative Database as the default database for new patients.

Although the system automatically assigns the default database to
each new patient, you can override the default and select the other
database for individual patients. For more information, refer to:

• About Licenses [} 61]

• Changing the Default for Normative Data [} 84]

• Database Selection [} 403]
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B.1 Purpose
This study establishes normal reference ranges for the following pa-
rameters for Asian populations:

Macular Images

• Macular Thickness

• Ganglion Cell Thickness

Optic Nerve Head Images

• RNFL Thickness

• ONH Features

B.2 Study Subjects
This study included 315 subjects.

This study used the same inclusion and exclusion criteria as the
Diverse Population Study (see: Study Subjects [} 453]).

B.3 Age Groups
Subjects were divided into age groups as follows:

Group Age Range Gender Ethnicity

1 18-29 • 159 male

• 156 female

• Median age: 47

• 44% Japanese

• 44% Chinese

• 12% Indian

2 30-39

3 40-49

4 50-59

5 60-69

6 70-80

Observations:

• 0 subjects under 19 years old.

• 0 subjects over 79 years old.

Table 97: Asian Normative Database Subjects

B.4 Data Collection
This study used the same data collection, image selection and
analysis techniques as the diverse population study. Refer to:

• Data Collection [} 454]

• Image Selection [} 454]

• Data Analysis [} 455]
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B.5 Macular Images

B.5.1 Macular Thickness Parameters
This study establishes the same macular thickness parameters as
the diverse population study (see: Macular Thickness Parameters
[} 456]).

B.5.1.1 Factors That Effect Normal Reference Ranges

B.5.1.1.1 Effect of Age

Central Subfield (Asian Population) Key:

• X-axis (horizontal) = Age in years

• Y-axis (vertical) = Macular Thickness (µm)

• Line = Fitted regression line

Average Thickness (all ETDRS subfields) (Asian
Population)

Key:

• X-axis (horizontal) = Age in years

• Y-axis (vertical) = Average Macular Thickness (µm)

• Line = Fitted regression line

Observations:

• Central subfield thickness has almost no dependence on age.

• All other subfields decrease very gradually when the age increases.

B.5.2 Ganglion Cell Parameters (Asian)
This study establishes the same ganglion cell thickness parameters
as the diverse population study (see: Ganglion Cell Parameters
[} 457]).
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B.5.2.1 Ganglion Cell Data

Parameters Mean Standard
Deviation

Minimum Maximum

Average Thickness 83.2 5.3 67.8 99.5

Minimum Thickness 80.9 5.4 63.8 95.2

Temporal–Superior Thickness 82.2 5.6 65.0 99.0

Superior Thickness 84.6 5.9 62.0 102.0

Nasal–Superior Thickness 85.8 5.9 70.0 103.0

Nasal–Inferior Thickness 83.0 5.9 66.0 105.0

Inferior Thickness 80.7 6.0 65.0 98.0

Temporal–Inferior Thickness 82.8 5.5 70.0 102.0

Observations:

• All ganglion cell parameters decrease slowly with age.

• GCL + IPL thicknesses, which are measured in an annulus around the fovea, have a homogeneous distribution.

• The mean thicknesses of the six zones in the annulus ranged from 80.7 to 85.8 µm.

This finding is consistent with the expectation that in a healthy eye, the retinal nerve fibers are uniformly distributed in
a radial pattern around the fovea.

Table 98: Ganglion Cell Data

B.6 ONH Images

B.6.1 RNFL Parameters
This study establishes the same macular thickness parameters as
the diverse population study (see: RNFL Parameters [} 460]).
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B.6.1.1 Factors That Effect Normal Reference Ranges

B.6.1.1.1 Effect of Age

Superior Quadrant Key:

• X-axis (horizontal) = Age in years

• Y-axis (vertical) = Average RNFL Thickness (µm)

• Line = Fitted regression line

Inferior Quadrant

Overall Key:

• X-axis (horizontal) = Age in years

• Y-axis (vertical) = Average RNFL Thickness (µm)

• Line = Fitted regression line
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B.6.1.1.2 Efffect of Axial Length and Refractive Error

Key

• X-axis (horizontal) = Age in years

• Y-axis (vertical) = Average GCA (microns)

• Line = Fitted regression line

Observations:
RNFL Thickness decreases slightly with axial length (less than 2% of the total variability of the Ganglion Cell parame-
ters).

B.6.2 ONH Parameters
This study establishes the same ONH parameters as the diverse
population study (see: ONH Parameters [} 462]).

B.6.2.1 ONH Parameter Data

There are a few differences for ONH parameter data for Asian
populations, including:

• An additional parameter: Neuroretinal Rim (NR) thickness plot
around the disc.

• Disc area is calculated and presented, but not compared to
normal limits.

Parameter Minimum Maximum Average Standard
Deviation

Average Cup–to–Disc Ratio 0.06 0.78 0.51 0.15

Vertical Cup–to–Disc Ratio 0.05 0.77 0.48 0.15

Disc Area (mm2) 1.15 3.14 1.87 0.36

Rim Area (mm2) 0.75 2.27 1.29 0.21

Cup Volume (mm3) 0.00 0.73 0.16 0.14

Observations

• 90% of the subjects' disc areas were between 1.3 mm 2 and 2.5 mm 2.

• Disc area showed no dependence on subject age.

• 13 subjects (less than 5%) had discs larger than 2.5 mm 2 in the study eye.

• 10 subjects (less than 5%) had discs smaller than 1.3 mm 2:

– 1/3 of the subjects had discs 1.7 mm 2  or smaller

– 1/3 of the subjects had discs between 1.7 and 2.0 mm 2 .

– 1/3 of the subjects had discs larger than 2.0 mm 2 .
Table 99: ONH Parameters for Asian Populations
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B.6.2.2 Factors That Effect Normal Reference Ranges

This study found that optic disc area and age had the greatest
effect on the ONH parameters.

• Disc Area: as much as 40% of variability for some parameters

• Age: no more than 5% of variability for ONH parameters

• All Other Factors: (refractive error, axial length, etc.) no more
than 7% of variability for ONH parameters

B.6.2.2.1 Effect of Age

Measurement Slope R2 p

Rim Area -0.002 mm2 / year 0.033 0.002

Average Cup-to-Disc Ratio +0.002 per year 0.032 0.002

Vertical Cup-to-Disc Ratio +0.002 per year 0.041 0.001

Observations :

• Average and Vertical Cup-to-Disc Ratios slowly increase with age.

• Rim Area slowly decreases with age.

B.6.2.2.2 Effect of Optic Disc Area

Parameter Slope R2 P

Cup Volume +0.25 mm3 of cup per mm2 of disc 0.39 0.011

Rim Area +0.24 mm2 of rim per mm2 of disc 0.13 0.042

Cup-to-Disc Ratio (Average) +0.35 per mm2 of disc 0.35 0.001

Cup-to-Disc Ratio (Vertical) +0.29 per mm2 0.34 0.001

Observation:

• All parameters increase with disc size.

B.7 Conclusions
The following observations were made:

• The mean difference in the average RNFL thickness between
any two race groups is within 5 µm.

• Chinese subjects have thicker mean average thickness, superior
quadrant average, and inferior quadrant average.

• Indian subjects have the thickest mean average thickness,
superior quadrant average, and inferior quadrant average.

• The largest difference in the RNFL thickness between two race
groups is for the temporal quadrant average between Chinese
and Indian subjects (difference of 15 µm).

The doctor can use these normative databases to compare
individual patient measurements to those acquired in a normal
population.
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C Algorithm Performance Studies
Algorithm Studies evaluated the performance of the CIRRUS™ HD-
OCT software algorithms by repeating scans of the same subjects
or comparing the scans with similar scans using a different OCT
instrument. This appendix describes the studies, study results, and
conclusions.

C.1 Posterior Segment Algorithms
CIRRUS™ HD-OCT posterior segment algorithm results appear in
the scan analyses shown below.

Algorithm Studied Parameters Applicable Analyses

Retinal Segmentation Performance
[} 476]

Segmentation performance for RPE layer
and ILM layer by pathology:

• AMD

• Diabetic Retinopathy

• VRI Disorder

• Other Retinal Disease

• Macular Edema

• No Retinal Disease

• Analyze Macular Thickness [} 238]

• Analyze Macular Change [} 247]

• Analyze Ganglion Cell OU [} 262]

• Ganglion Cell Guided Progression
[} 267]

• Advanced RPE Analysis [} 257]

• Advanced Visualization Analysis
[} 286]

• Analyze PanoMap [} 299]

• Wellness Exam [} 301]

• Analyze Single Eye Summaries
[} 295]

Ganglion Cell Measurement Perfor-
mance [} 485]

GCL + IPL thickness performance in
glaucoma subjects grouped by: mild,
moderate, and severe glaucoma
measurements--

• Average

• Minimum

• Temporal-Superior

• Superior

• Nasal-Superior

• Nasal-Inferior

• Inferior

• Temporal-Inferior

• Analyze Ganglion Cell OU [} 262]

• Ganglion Cell Guided Progression
[} 267]

• Analyze PanoMap [} 299]

• Wellness Exam [} 301]

RPE Illumination Performance [} 481] Comparing automated algorithm to
expert manual editing for both sizes of
macular scans.

Advanced RPE Analysis [} 257]

RPE Elevation Performance [} 483] Performance of RPE elevation algorithm
(area and volume) for both sizes of
macular scans.
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Algorithm Studied Parameters Applicable Analyses

Optic Nerve Head Measurement Perfor-
mance [} 488]

Optic nerve measurement performance
in glaucoma subjects grouped by: mild,
moderate, and severe glaucoma -and-
Optic nerve measurement performance
for same visit scans and follow-up visits
in glaucoma subjects grouped by: mild,
moderate, and severe glaucoma for pa-
rameters:

• Average cup-to-disc ratio

• Vertical cup-to-disc ratio

• Disc Area

• Rim Area

• Cup Volume

• ONH Guided Progression [} 283]

• Analyze PanoMap [} 299]

• Wellness Exam [} 301]

• Analyze Single Eye Summaries
[} 295]

• Analyze ONH/RNFL OU [} 279]

Table 100: Posterior Algorithms

C.1.1 Terms and Acronyms

Term Explanation

CV Coefficient of variation = SD ÷ Mean.

N Reproducibility DSS divided by the mean

Repeatability Limit the upper 95% limit for the difference between repeated results.
Repeatability limit = 2.8 x Repeatability SD (ISO 5725-1 and 5725-6) .

Repeatability SD the square root of the random variance component.

Reproducibility Limit
Visit-to-Visit Variability Limit

the upper 95% limit calculated for the difference between individual measurements
using different operators and instruments. 
Reproducibility Limit = 2.8 x Reproducibility SD (ISO 5725-1 and 5725-6).

Reproducibility SD the square root of the sum of all contributions to variance except subject variance.

SD Standard Deviation

Table 101: Posterior Segment Algorithm Study Terms

C.1.2 Macular Algorithms

C.1.2.1 Retinal Thickness Measurement Performance

ZEISS partnered with the academic and clinical community to study
the performance and precision of the CIRRUS™ HD-OCT retinal
segmentation algorithm in a prospective, non-randomized, multi-
center study. The study group consisted of faculty, fellows, and
physicians at: 

• Medical University of Vienna (MUV)

• Bascom Palmer Eye Institute (BPEI) - University of Miami Miller
School of Medicine

• Wilmer Eye Institute (WEI) - Johns Hopkins University School of
Medicine

• Northern California Retina-Vitreous Associates (NCRVA)
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Reports of these results presented at conferences and submitted for
publication. [7] [8] [9]

Purpose

The primary objectives of the study were:

• evaluate the performance of CIRRUS™ HD-OCT retinal thickness
segmentation algorithms.

• compare CIRRUS™ HD-OCT measurements to Stratus OCT
measurements.

A secondary objective of the study was to evaluate data regis-
tration effectiveness.

Figure 87: ETDRS Grid

For the CIRRUS™ HD-OCT scans, investigators reviewed scan image
quality and selected the best scan for each eye. CIRRUS 6000
software calculates retinal thickness for every sector of the ETDRS 6
mm grid centered on the fovea.

Fourteen trained investigators assessed performance using the
following procedure:

1. Manually segmented B-scans from one scan per subject.

2. Compared manually-segmented B-scans with automatically-
segmented B-scan.

3. Compared average retinal thickness measurements in all sectors
to Stratus OCT measurements and analyzed the variance.

4. Assessed performance of the average measurement for each
sector.

5. Assessed automatic and manual registration performance.

6. Assessed automatic and manual fovea alignment for all sectors.

Investigators determined that segmentation was accurate when
CIRRUS™ HD-OCT ILM and RPE automatic segmentation agreed
with manual segmentation in 100% of A-scans evaluated.

Agreement definition:

• Within 16 µm for the central sector.

• Within 32 µm for all remaining sectors.

Because the segmentation strategy is different, there is a mean
difference in the retinal thickness found by each instrument. The
mean difference between instruments varies with pathology
because the integrity of the layers detected varies with pathology.

[7] Weisbrod, Stetson, Wieland, Bressler, Schmidt–Erfurth, Knighton, Gregori:Comparison of Hand–Drawn ILM and RPE Segmentation to
the Retinal Segmentation Algorithm of the CIRRUS HD-OCT, ARVO 2008, poster 4240.

[8] Chang, Durbin, Weiland, Schmidt–Erfurth, Gregori, Bressler: Repeatability of retinal thickness measurements using CIRRUS HD-OCT
Spectral Domain Technology, ARVO 2008, poster 4253.

[9] Geitzenauer, Kiss, Durbin, Abunto, Wieland, Bressler, Gregori, Schmidt–Erfurth: Comparing Retinal Thickness Measurements From
CIRRUS Spectral–Domain and Stratus Time–Domain OCT, ARVO 2008, poster 930.
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After accounting for the mean difference, there is a residual
difference in the standard deviation. Because of the residual
difference, it is better to compare scans between Stratus OCT and
CIRRUS™ HD-OCT qualitatively (looking for changes in retinal
morphology), not quantitatively.

C.1.2.1.1 Subjects

Demographics Inclusion Criteria Exclusion Criteria

• Number of Subjects: 137

• Age Range: 25-69

• Males or females 18 years of age or
older.

• Able and willing to make the required
study visits.

• Able and willing to give consent and
follow study instructions.

Subjects were classified into six groups
based on the primary diagnosis causing
the most pathologic abnormalities in the
study eye as follows:

History of leukemia, AIDS, uncontrolled
systemic hypertension, dementia or
multiple sclerosis.
If both eyes were eligible, the principal
investigator arbitrarily assigned the study
eye.

Table 102: Subject Demographics

Pathology Description

AMD Age-related macular degeneration

DR Diabetic retinopathy

VRI Vitreoretinal interface abnormalities (including macular holes)

Other Other retinal pathology

ME Macular edema for which treatment was planned

Normal No retinal pathology

Table 103: Subject Pathology Groups

C.1.2.1.2 Method: Instrument Variability

CIRRUS™ HD-OCT 5000 Scans Study Eye Fellow
Eye

Before analyzing the data, investigators excluded poor
quality scans.

Macular Cube
200x200

1 1

Macular Cube
512x128

1 1

Table 104: Instrument Variability Study

C.1.2.1.3 Method: Instrument Comparison

Stratus Scans Study Eye Fellow
Eye

Before analyzing the data, investigators excluded poor
quality scans.

Fast Macula Scan 1 1

Table 105: Instrument Comparison Study

Poor quality scans include:
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• Poor signal strength.

• Poor scan placement in the axial field of view (causing missing
data or shifts in location between scans).

• Data missing from the center.

• Data loss greater than 10% of the scan area.

• Large shifts (greater than 3mm).

• Poor image quality.

C.1.2.1.4 RPE and ILM Boundary Performance Results

Pathology 200 x 200 Scans 512 x 218 Scans

n/N (%) 95% CI n/N (%) 95% CI

RPE Layer Segmentation Performance

AMD 60/70 (85.7%) (77.5%, 91.3%) 62/72 (86.1%) (78.1%, 98.5%)

DR 40/42 (95.2%) (86.6%, 98.4%) 41/42 (97.6%) (90.0%, 99.5%)

VRI 27/28 (96.4%) (85.5%, 99.2%) 25/28 (89.3%) (76.0%, 95.5%)

Other 44/51 (86.3%) (76.5%, 92.4%) 46/52 (88.5%) (79.2%, 93.9%)

ME 27/28 (96.4%) (85.5%, 99.2%) 27/29 (93.1%) (82.2%, 97.7%)

Normal 37/37 (100.0%) (93.2%, 100%) 40/40 (100.0%) (93.7%, 100%)

ILM Layer Segmentation Performance

AMD 68/70 (97.1%) (91.7%, 99.1%) 73/74 (98.6%) (94.2%, 99.7%)

DR 40/42 (95.2%) (86.6%, 98.4%) 40/42 (95.2%) (86.6%, 98.4%)

VRI 26/28 (92.9%) (80.6%, 97.6%) 26/27 (96.3%) (85.0%, 99.2%)

Other 50/51 (98.0%) (91.7%, 99.6%) 51/52 (98.1%) (91.8%, 99.6%)

ME 28/28 (100.0%) (91.2%, 100%) 28/29 (96.6%) (85.9%, 99.2%)

Normal 37/37 (100.0%) (93.2%, 100%) 40/40 (100.0%) (93.7%, 100%)

Observations:
Segmentation performance varied between layers (RPE, ILM) and among different disease categories.
More than 85% of scans are correctly segmented.

Table 106: Segmentation Performance By Pathology

C.1.2.1.5 Repeatability Standard Deviation by Pathology

Pathology Central Sector Macular Thickness Repeatability SD (µm)

N 200 x 200 N 512x128

AMD 77 17.5 66 11.6

DR 51 16.8 50 13.7

VRI 44 14.4 44 8.4

Other 62 10.1 61 9.5

ME 41 13.5 39 27.2

Normal 44 4.8 47 3.6

Table 107: Repeatability Standard Deviation by Pathology

Repeatability Standard Deviation - Adjusted

These results show the repeatability standard deviation for central
sector measurements of the 200 x 200 scan using:

• v 3.0 Macular Thickness Analysis

• v 4.0 Macular Thickness Analysis with adjustable fovea position
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• v 4.0 Macular Change Analysis using registration and adjustable
fovea position

Pathology N Mean ±SD
CSMT (µm)

CSMT Repeatability SD (µm)

CIRRUS 4.0 CIRRUS 3.0 CIRRUS 4.0
Fovea

CIRRUS 4.0
Fovea / Registration

Macular Thickness Analysis Macular Change Analysis

AMD 77 255 ±65 17.5 6.3 8.7

DR 51 335 ±109 16.8 9.8 8.1

VRI 44 360 ±128 14.4 5.4 4.3

Other 62 303 ±114 10.1 7.5 4.5

ME 41 339 ±141 13.5 7.9 7.0

Normal 44 256 ±21 4.8 2.2 2.5

Observations:
Repeatability improves with the (correctly-identified) fovea as the reference point for sector average thickness calculations.
Repeatability improves when scans are registered to each other.
Features introduced with CIRRUS 4.0 software improve repeatability standard deviation.
Registration and fovea placement improved repeatability.

Table 108: 200 x 200 Scan Standard Deviation - Adjusted



Instructions for Use C Algorithm Performance Studies
CIRRUS™ HD-OCT C.1 Posterior Segment Algorithms

2660021174149 Rev. D 2019-10 481 / 542

C.1.2.1.6 Instrument Comparison Results

Pathology Mean Difference (SD) OCT (µm)

N CIRRUS™ HD-OCT Stratus OCT Difference

AMD 63 271.3 (60.6) 217.7 (54.2) 53.6 (35.0)

DR 39 356.6 (118.7) 316.6 (135.8) 40.0 (47.1)

VRI 45 386.3 (128.0) 342.5 (125.0) 43.8 (35.9)

Other 53 310.6 (99.5) 268.9 (101.6) 41.7 (47.1)

ME 35 351.1 (140.3) 305.7 (127.9) 45.5 (45.3)

Normal 48 256.1 (18.6) 196.7 (18.6) 59.4 (11.7)

Observations:
There is good correlation between the two instruments.

Table 109: Difference between CIRRUS™ HD-OCT and Stratus OCT

C.1.2.1.7 Fovea Finder Accuracy Results

CIRRUS™ HD-OCT automatically detects the fovea. This study also
examined the rate of failure of the algorithm that detects the fovea
location.

Pathology N Scans with fovea failures

Not found Incorrect

AMD 77 11% 6%

DR 51 19% 10%

VRI 44 24% 5%

Other 62 10% 6%

ME 41 18% 6%

Normal 44 0% 0%

Observations:
Pathology can influence the algorithm's ability to locate the fovea.

Table 110: Rate of failure of the Fovea Finding Algorithm by Pathology

C.1.2.1.8 Conclusion

CIRRUS™ HD-OCT retinal thickness measurements are accurate and
repeatable.

C.1.2.2 Sub-RPE Illumination Performance

This study determined the repeatability and reproducibility of the
CIRRUS™ HD-OCT measurement of illumination areas under the
retinal pigment epithelium (RPE). 

The study (Instrument Variation or Operator Variation) with the
larger random error variation was selected as the random error
variation for the corresponding endpoint (and scan type), and was
used to calculate the repeatability.

The reproducibility includes variation due to random error,
operator, device, interaction between subject and device, and
interaction between subject and operator.
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The repeatability and reproducibility limits affect the ability to
determine when measurements change due to pathology or
random variability.

Trained investigators evaluated each scan to determine if the
algorithm accurately:

• identified the outline of the lesion automatically.

If not, the investigator manually edited the scan to outline the
lesion accurately.

• centered the fovea automatically.

If not, the investigator manually edited the scan to center the
fovea accurately.

C.1.2.2.1 Method: Instrument Variability

CIRRUS™ HD-OCT 5000 Scans Instrument

1 2 3

• Number of Subjects: 37

• Eyes: 49
A single operator acquired scans using three different
CIRRUS™ HD-OCT instruments.

Macular Cube 200x200 3 3 3

Macular Cube 512x128 3 3 3

C.1.2.2.2 Method: Operator Variability

CIRRUS™ HD-OCT 5000 Scans Operator

A B C

• Number of Subjects: 39

• Eyes: 53
Three operator acquired scans using the same CIRRUS™ HD-
OCT instrument.

Macular Cube 200x200 3 3 3

Macular Cube 512x128 3 3 3

C.1.2.2.3 Measurement Performance Results

Sub-RPE Illumination Macular Cube Scan Repeatability (mm2) Reproducibility (mm2) CV%

SD Limit SD Limit

Automated Algorithm 200 x 200 0.8887 2.4885 0.9450 2.6460 12.5%

512 x 128 0.8683 2.4313 1.0317 2.8889 15.8%

Manually Edited 200 x 200 0.2273 0.6365 0.3823 1.0705 4.3%

Observations:
Repeatability for both sized scans is similar.
Reproducibility for 200 x 200 scans is lower.
Repeatability and Coefficient of Variation for manually-edited scans is much lower.

Table 111: Repeatability and Reproducibility of Sub-RPE Illumination Algorithm

Closest Distance to Fovea Macular Cube Scan Repeatability (mm) Reproducibility (mm)

SD Limit SD Limit

Automated Algorithm 200 x 200 0.0739 0.2070 0.0762 0.2133

512 x 128 0.1247 0.3492 0.1257 0.3520

Manually Edited 200 x 200 0.0354 0.0990 0.0439 0.1229
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Closest Distance to Fovea Macular Cube Scan Repeatability (mm) Reproducibility (mm)

SD Limit SD Limit

Observations:
Repeatability and Reproducibility for 200 x 200 scans is lower.
Coefficient of Variation for manually-edited scans is much lower.

Table 112: Repeatability and Reproducibility of the Closest Distance to the Fovea Algorithm

C.1.2.3 RPE Elevation Performance

This study evaluated the performance of macular retinal pigment
epithelium (RPE) elevation area and volume measurements. 

C.1.2.3.1

Method: Instrument Variability

CIRRUS™ HD-OCT 5000 Scans Instrument

1 2 3

• Eyes: 26
A single operator acquired scans using three different
CIRRUS™ HD-OCT instruments.

Macular Cube 200x200 3 3 3

Macular Cube 512x128 3 3 3

C.1.2.3.2 Method: Operator Variability

CIRRUS™ HD-OCT 5000 Scans Operator

A B C

• Eyes: 24
Three operator acquired scans using the same CIRRUS™ HD-
OCT instrument.

Macular Cube 200x200 3 3 3

Macular Cube 512x128 3 3 3

C.1.2.3.3 Measurement Performance Results

Macular Cube Scan Repeatability (mm2) Reproducibility (mm2) CV%

SD Limit SD Limit

200 x 200 3mm Circle 0.1295 0.3626 0.1568 0.4389 10.1%

5mm Circle 0.1012 0.2834 0.1455 0.4073 4.9%

512 x 128 3mm Circle 0.0837 0.2343 0.0998 0.2794 7.5%

5mm Circle 0.1537 0.4304 0.1936 0.5422 9.6%
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Macular Cube Scan Repeatability (mm2) Reproducibility (mm2) CV%

SD Limit SD Limit

Observations:
Repeatability for 200 x 200 scans, 3 mm circle is higher.
Repeatability for 512 x 128 scans, 5 mm circle is higher.
Reproducibility for 200 x 200 scans, 3 mm circle and 5 mm circle is about the same.
Reproducibility for 512 x 128 scans, 5 mm circle is much higher (double).
Coefficient of Variation for 200 x 200 scans, 3 mm circle is the highest.
Coefficient of Variation for 200 x 200 scans, 5 mm circle is the lowest.
Repeatability for 200 x 200, manually-edited scans is much lower.
Coefficient of Variation for 200 x 200, manually-edited scans is much lower.

Table 113: Repeatability and Reproducibility of Area of RPE Elevations

Macular Cube Scan Repeatability (mm3) Reproducibility (mm3) CV%

SD Limit SD Limit

200 x 200 3mm Circle 0.0117 0.0327 0.0122 0.0341 15.2%

5mm Circle 0.0098 0.0275 0.0106 0.0298 8.3%

512 x 128 3mm Circle 0.0074 0.0206 0.0084 0.0235 12.0%

5mm Circle 0.0088 0.0245 0.0103 0.0288 11.4%

Observations:
Coefficient of Variation for 200 x 200 scans, 3 mm circle is highest.
Coefficient of Variation for 200 x 200 scans, 5 mm circle is lowest.

Table 114: Repeatability and Reproducibility of Volume of RPE Elevations

The repeatability and reproducibility limits affect the ability to
determine when measurements have changed due to a change in
pathology as opposed to random variability.
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C.1.2.4 Ganglion Cell Measurement Performance

This study determined ganglion cell and IPL thickness measurement
performance.

C.1.2.4.1 Normal Eyes

C.1.2.4.1.1 Subjects

Demographics Inclusion Criteria Exclusion Criteria

• Number of Subjects: 63 • Normal eyes.

• Males or females 18 years of age or
older.

• Able and willing to make the required
study visits.

• Able and willing to give consent and
follow study instructions.

History of leukemia, AIDS, uncontrolled
systemic hypertension, dementia or
multiple sclerosis.
Subjects in groups 1 through 4 who were
scheduled for treatment of macular
edema were moved into group 5. If both
eyes were eligible, the principal investi-
gator arbitrarily assigned the study eye.

C.1.2.4.1.2 Method: Instrument Variability

CIRRUS™ HD-OCT Scans Instrument

1 2 3 4

Operator used four different instruments; same eye. Macular Cube Scan 3 3 3 3

Table 115: Ganglion Cell Measurement Instrument Variability

C.1.2.4.1.3 Method: Operator Variability

CIRRUS™ HD-OCT Scans Operator

A B C D

Each operator used the same instrument; same eye. Macular Cube Scan 3 3 3 3

Table 116: Ganglion Cell Measurement Operator Variability
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C.1.2.4.1.4 GCL Thickness Performance Results

GCL + IPL Thickness Repeatability (µm) Reproducibility (µm) CV%

SD Limit SD Limit

Average 0.5839 1.6348 0.7479 2.0942 0.7%

Minimum 2.8630 8.0165 2.8935 8.1018 2.5%

Temporal–Superior 0.8394 2.3502 0.9496 2.6590 1.0%

Superior 0.9115 2.5522 1.0723 3.0024 1.1%

Nasal–Superior 0.9198 2.5753 1.0412 2.9154 1.0%

Nasal–Inferior 1.6735 4.6857 1.7330 4.8525 1.5%

Inferior 0.9962 2.7894 1.1907 3.3339 1.2%

Temporal–Inferior 0.8196 2.2948 0.9177 2.5696 1.0%

Observations:
Repeatability, Reproducibility, and Coefficient of Variation for minimum thickness is highest.
Repeatability, Reproducibility and Coefficient of Variation for average thickness is lowest.

Table 117: Ganglion Cell Algorithm Performance

C.1.2.4.2 Glaucoma

C.1.2.4.2.1 Subjects

Demographics Inclusion Criteria Exclusion Criteria

• Number of Subjects: 94

• Age Range: 43-89

• Mean Age: 66.9

• Normal eyes.

• Males or females 18 years of age or
older.

• Able and willing to make the required
study visits.

• Able and willing to give consent and
follow study instructions.

History of leukemia, AIDS, uncontrolled
systemic hypertension, dementia or
multiple sclerosis.

Mild (45) Mild Glaucoma

Moderate (20) Moderate Glaucoma

Severe (19) Severe Glaucoma

C.1.2.4.2.2 Method: Instrument / Operator Variability

CIRRUS™ HD-OCT 4000 Scans Operator

A B C

Each operator used a different instrument; same eye. Macular Cube 200x200 3 3 3

Macular Cube 512x128 3 3 3

Table 118: Operator Variability of Ganglion Cell Measurements
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C.1.2.4.2.3 Method: Instrument / Operator Variability (5000)

CIRRUS™ HD-OCT 5000 Scans Operator

A B C

Each operator used a different instrument; same eye. Macular Cube 200x200 3 3 3

Macular Cube 512x128 3 3 3

Table 119: Operator and Instrument Variability of Ganglion Cell Measurements

C.1.2.4.2.4 Method: Instrument Comparison

Visante Compare Scans Operator

• One operator used one Visante OCT instrument.

• The first qualified Visante OCT image was compared to
the first qualified CIRRUS 6000 image.

HD Angle (Nasal) 3

HD Angle (Temporal) 3

Table 120: Instrument Comparison of Ganglion Cell Measurements

C.1.2.4.2.5 Measurement Performance Results

Mild Moderate Severe

GCL + IPL Thickness SD Limit CV% SD Limit CV% SD Limit CV%

Average 0.5099 1.4277 0.7% 0.7661 2.1352 1.2% 0.7071 1.9799 1.2%

Minimum 0.9000 2.5200 1.4% 1.1132 3.1169 2.1% 2.6682 7.4708 5.3%

Temporal–Superior 0.8062 2.2574 1.2% 1.3433 3.7611 2.1% 1.7728 4.9639 2.9%

Superior 1.0198 2.8555 1.4% 1.8238 5.1065 2.9% 1.0235 2.8659 1.6%

Nasal–Superior 0.8367 2.3426 1.1% 0.8209 2.2986 1.2% 0.7868 2.2030 1.2%

Nasal–Inferior 1.1489 3.2170 1.6% 0.8341 2.3354 1.4% 1.3093 3.6661 2.1%

Inferior 1.0677 2.9896 1.6% 1.1325 3.1711 2.0% 0.9386 2.6281 1.6%

Temporal–Inferior 1.0488 2.9367 1.6% 0.8723 2.4424 1.5% 1.7795 4.9826 3.3%

Table 121: Ganglion Cell Algorithm Performance: Glaucoma

GCL + IPL Thickness SD Limit CV%

Average 0.6274 1.7567 1.0%

Minimum 1.5246 4.2689 2.6%

Temporal–Superior 1.2204 3.4171 1.8%

Superior 1.2653 3.5429 1.8%

Nasal–Superior 0.8219 2.3013 1.2%

Nasal–Inferior 1.1204 3.1371 1.7%

Inferior 1.0569 2.9593 1.7%

Temporal–Inferior 1.2160 3.4049 2.0%

Table 122: Overall Ganglion Cell Algorithm Performance: Glaucoma
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C.1.3 ONH Algorithms

C.1.3.1

ONH Measurement Performance

This study determined the repeatability and reproducibility of Optic
Nerve Head (ONH) parameters.[10]

C.1.3.2 ONH and RNFL Normal Eye Measurement Performance

This study determined the repeatability and reproducibility of Optic
Nerve Head (ONH) parameters.

C.1.3.2.1 Method: Instrument Variability

CIRRUS™ HD-OCT 5000 Scans Instrument

1 2 3 4

• Subjects: 63
A single operator acquired scans using four different
CIRRUS™ HD-OCT instruments.

ONH Cube 3 3 3 3

C.1.3.2.2 Method: Operator Variability

CIRRUS™ HD-OCT 5000 Scans Operator

A B C D

• Subjects: 63
Three operators acquired scans using the same
CIRRUS™ HD-OCT instrument.

ONH Cube 3 3 3 3

C.1.3.2.3 Measurement Performance Results

Repeatability Reproducibility CV %

SD Limit SD Limit

Average Cup–to–Disc Ratio 0.0136 0.0380 0.0242 0.0679 5.4%

Vertical Cup–to–Disc Ratio 0.0243 0.0681 0.0302 0.0846 7.1%

Disc Area (mm2) 0.0538 0.1506 0.0942 0.2637 5.4%

Rim Area (mm2) 0.0420 0.1177 0.0619 0.1733 4.7%

Cup Volume (mm3) 0.0065 0.0181 0.0102 0.0287 7.8%

Table 123: Repeatability and Reproducibility of Optic Nerve Head Algorithms (Normal Subjects)

[10] Mwanza, Chang, Budenz, Durbin, Gendy, Ski, Feauer: Reproducibility of Peripapillary Retinal Nerve Fiber Layer Thickness and Optic
Nerve Head Parameters Measured with Cirrus HD-OCT in Glaucomatous Eyes. IOVS 2010; 51:5724-5730 (derived from).
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C.1.3.3 Glaucoma Measurement Performance

Repeatability Reproducibility CV%

SD Limit SD Limit

Normal Subjects

Average Cup–to–Disc Ratio 0.0136 0.0380 0.0242 0.0679 5.4%

Vertical Cup–to–Disc Ratio 0.0243 0.0681 0.0302 0.0846 7.1%

Disc Area (mm2) 0.0538 0.1506 0.0942 0.2637 5.4%

Rim Area (mm2) 0.0420 0.1177 0.0619 0.1733 4.7%

Cup Volume (mm3) 0.0065 0.0181 0.0102 0.0287 7.8%

Glaucoma Subjects

Average Cup–to–Disc Ratio 0.0136 0.0380 0.0242 0.0679 5.4%

Vertical Cup–to–Disc Ratio 0.0243 0.0681 0.0302 0.0846 7.1%

Disc Area (mm2) 0.0538 0.1506 0.0942 0.2637 5.4%

Rim Area (mm2) 0.0420 0.1177 0.0619 0.1733 4.7%

Cup Volume (mm3) 0.0065 0.0181 0.0102 0.0287 7.8%

Table 124: Repeatability and Reproducibility of Optic Nerve Head Algorithms

Repeatability Visit-to-Visit CV %

SD Limit SD Limit

Average Cup–to–Disc Ratio 0.009 0.025 0.009 0.025 1.2%

Vertical Cup–to–Disc Ratio 0.014 0.039 0.015 0.042 1.9%

Disc Area (mm2) 0.084 0.233 0.084 0.233 4.4%

Rim Area (mm2) 0.045 0.125 0.045 0.125 6.6%

Cup Volume (mm3) 0.032 0.089 0.063 0.175 11.7%

Observations:
Repeatability and Reproducibility for disc area measurement is highest and cup volume measurement is lowest.
Coefficient of Variation for cup volume measurement is highest and rim area is lowest.

Table 125: Repeatability and Reproducibility of Optic Nerve Head Algorithms (Glaucoma Subjects)

General observations:

• The optic nerve head algorithm might show increased variability
in certain anatomical variants.

• For tilted discs and discs with large clusters of blood vessels,
shadowing of the underlying RPE and Bruch's membrane may
render the disc edge difficult to identify.

Ambiguity in cup marker placement may increase variability for:

– small, crowded discs with shallow cups

– discs with large clusters of blood vessels

• Cups with excavation or embryonic tissue remnants may have
variable cup volume measurements.

C.1.3.3.1 Subjects: Glaucoma Same Visit

This study included four sites.

Subject Demographics Subject Pathology

• Subjects: 94

• Age range: 43 to 89

• Mean age: 66.9

• Mild Glaucoma: 45 subjects

• Moderate Glaucoma: 20 subjects

• Severe Glaucoma: 19 subjects

Table 126: Glaucoma Same Visit Study Subjects
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C.1.3.3.2 Method: Operator Variability

CIRRUS™ HD-OCT 5000 Scans Operator

A B C D

• Subjects: 63
Three operators acquired scans using the same
CIRRUS™ HD-OCT instrument.

ONH Cube 3 3 3 3

C.1.3.3.3 Subjects: Glaucoma Follow-Up Visit

Demographics Inclusion Criteria Exclusion Criteria

• Number of Subjects: 84

• Age Range: 43-89

• Mean age: 66.9

• Males or females 18 years of age or
older.

• Able and willing to make the required
study visits.

• Able and willing to give consent and
follow study instructions.

• Glaucoma diagnosis.

Mild (45) Mild Glaucoma Normal Eyes

Moderate (20) Moderate Glaucoma

Severe (19) Severe Glaucoma

C.1.3.3.4 Method: Follow-up Visit

Glaucoma: Follow-up Visit Variation

A clinical study was conducted to determine the intra–visit and
inter–visit repeatability of CIRRUS™ HD-OCT optic nerve head para-
meters. [10]

Subject Demographics Subject Pathology

• Subjects: 55

• Age range: 46 to 87

• Mean age: 70.7 ± 11.1

• Mild Glaucoma: 26 subjects

• Moderate Glaucoma: 11 subjects

• Severe Glaucoma: 18 subjects

Table 127: Glaucoma Follow-up Visit Study Subjects

CIRRUS™ HD-OCT 5000 Visits Scans Instrument 1

At each visit, one operator acquired scans using the
same CIRRUS™ HD-OCT instrument.

Visit 1 ONH Cube 3

Visit 2 3

Visit 3 3

Visit 4 3

C.1.3.3.5 Measurement Performance Results

Repeatability Visit-to-Visit CV %

SD Limit SD Limit

Average Cup–to–Disc Ratio 0.009 0.025 0.009 0.025 1.2%

Vertical Cup–to–Disc Ratio 0.014 0.039 0.015 0.042 1.9%

Disc Area (mm2) 0.084 0.233 0.084 0.233 4.4%

Rim Area (mm2) 0.045 0.125 0.045 0.125 6.6%

Cup Volume (mm3) 0.032 0.089 0.063 0.175 11.7%
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Repeatability Visit-to-Visit CV %

SD Limit SD Limit

Observations:
Repeatability and Reproducibility for disc area measurement is highest and cup volume measurement is lowest.
Coefficient of Variation for cup volume measurement is highest and rim area is lowest.

Table 128: Repeatability and Reproducibility of Optic Nerve Head Algorithms (Glaucoma Subjects)

C.1.3.4 General Observations

• The optic nerve head algorithm might show increased variability
in certain anatomical variants.

• For tilted discs and discs with large clusters of blood vessels,
shadowing of the underlying RPE and Bruch's membrane may
render the disc edge difficult to identify.

Ambiguity in cup marker placement may increase variability for:

– small, crowded discs with shallow cups

– discs with large clusters of blood vessels

• Cups with excavation or embryonic tissue remnants may have
variable cup volume measurements.

C.2 AngioPlex Metrix Algorithms
CIRRUS™ HD-OCTAngioPlex Metrix algorithm results appear in
the scan analyses shown below.

Macular AngioPlex Metrix ONH AngioPlex Metrix

Algorithm Studied Parameters Applicable Analyses

Vessel Density Performance [} 494]
Vessel Profusion Performance [} 496]

Vessel Density  and Vessel Perfusion
performance comparing ground truth
images and vasculature phantom
images that simulate:

• Vessel distribution

• Vessel sizes

• Vessel widths

• Background speckle

• Vessel dropouts

• Analyze Angiography Images
[} 320]

• Angiography Change Analysis
[} 327]

Vessel Density Performance [} 498]
Wellness Exam [} 301]

• Analyze ONH Angiography Images
[} 331]

• ONH Angiography Change Analysis
[} 333]

Table 129: AngioPlex Metrix Algorithms

C.2.1 Terms and Acronyms

Term Explanation

Phantom Image Coefficient of variation = SD ÷ Mean.
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Term Explanation

Ground Truth Number of subjects

Table 130: Posterior Segment Algorithm Study Terms

C.2.2 AngioPlex Metrix Macular Algorithms
An analysis of the accuracy of Cirrus AngioPlex density metrics was
done using digital phantoms. This analysis found that the metrics
are most valuable when viewed or analyzed as relative values,
rather than as being representations of the absolute density of
vasculature. The study found some differences between ground
truth and the Cirrus measurement due to the 15-20 microns beam
width associated with OCT imaging.

Because the Perfusion Density attempts to account for vessel width,
while Vessel Density reduces all Vessels to a single pixel wide, the
Perfusion Density is more affected than the Vessel Density by the
fact that the beam width is larger than the smallest capillary
widths. Some of the inaccuracies observed were also due to the
density of A-scans, which is lower for the 6x6mm scan than for the
3x3mm scan. Overall, the 6x6 scans were less accurate than the
3x3 scans, and the Perfusion Density was less accurate than the
Vessel Density. In spite of the lack of agreement, the analysis
showed a good correlation between the underlying ground truth
and the reported measurement that supports the utility of these
types of measurements in evaluating microvascular density. In
particular, as the ground truth density decreases, the reported
Vessel Density and Perfusion Density both also decrease, for both
the 3x3 and the 6x6 scans.

The results in the study showed that the ability to monitor change
over time is best with Vessel Density in the 3x3 scans.

Because of its axial resolution, OCTA enables visualization of fine
retinal vasculature that is difficult to achieve with conventional dye-
based angiography. This gives rise to the opportunity to quantita-
tively analyze vasculature data obtained on OCTA. Zeiss has
developed algorithms to measure vascular density by examining en
face slabs generated from the superficial retinal layer of the 3-
dimensional OCTA data.

This report evaluates the accuracy of Cirrus AngioPlex density
measurement algorithms in determining the density of microvascu-
lature in the eye as compared to a ground truth determined by
newly developed digital phantoms. These digital phantoms are
images designed to have characteristics such as noise and speckle
similar to Cirrus and vascular features that resemble those in the
human eye.

Cirrus offers two measures of vascular density in the superficial
retinal layer (SRL). These are referred to as Vessel Density and
Perfusion Density. Both metrics attempt to quantify blood vessels
per unit area in a region of measurement.
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Perfusion Density is the total area of perfused vasculature per unit
area in a region of measurement. It is a ratio and has no units.

Vessel Density is the total length of perfused vasculature per unit
area in a region of measurement and has units of mm/mm2.

To calculate the perfusion density and the vessel density, a thresh-
olding algorithm is applied to the SRL en face images to create a
binary slab that assigns to each pixel a 1 (perfused) or 0
(background). From this slab, a skeletonized slab is created, repre-
senting vessels with a trace of 1 pixel in width. If there is flow,
white pixels will be present. We define the Perfusion Density as the
total area of perfused vasculature per unit area in a region of
measurement, calculated by taking the mean of the binary slab
within a desired region of interest. We define the Vessel Density as
the total length of perfused vasculature per unit area in a region of
measurement.

We calculate the Vessel Density by taking the mean of the skele-
tonized slab within a desired region of interest and scaling the
result by the distance between pixels (in this case, 512 pixels per 3
mm). The mean of the skeletonized slab is only a first-order
estimate of the length of perfused vasculature. A more accurate
calculation would require considering the relationship between
neighboring pixels with a value of 1 in the skeletonized slab. Cirrus
AngioPlex OCT Angiography scans have been demonstrated to
correspond to the clinical status of eyes with diabetic retinopathy
both qualitatively and quantitatively]. In particular, reference 1
demonstrates that both Vessel Density and Perfusion Density show
good diagnostic efficacy when evaluated in a population of normal
eyes and eyes with early diabetic retinopathy (with an area under
the receiver operating characteristic curve of 0.893 for Vessel
Density and of 0.794 for Perfusion Density).

The density metrics have also been shown to be repeatable and
reproducible in normal eyes and eyes with a wide range of severity
of diabetic retinopathy and retinal vein occlusions. Ideally, we
would like to understand the accuracy of Cirrus density measure-
ments compared to a gold standard, but because OCT Angiography
shows the retinal microvasculature over the macular region in more
detail than has previously been possible in vivo, no validated gold
standard exists. For this reason, we developed a set of digital
phantoms to mimic the vasculature in the eye as well as the image
capture process, which can serve as a gold standard for
comparison.

The goal of this report is to determine how accurate the metrics
are. Since no gold standard exists, we constructed a set of digital
phantoms consisting of features similar to those typically seen in
Cirrus AngioPlex images of the superficial retinal layer, and
compared the quantitative outputs to the known values defined in
the artificially created images.
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C.2.2.1 Vessel Density Performance

This study determined the repeatability and reproducibility of the
CIRRUS™ HD-OCT

C.2.2.1.1 Method: Image Comparison

CIRRUS™ HD-OCT 5000 Scans Instrument

1 2 3

• Number of Subjects: 37

• Eyes: 49
A single operator acquired scans using three different
CIRRUS™ HD-OCT instruments.

Macular Cube 200x200 3 3 3

Macular Cube 512x128 3 3 3

C.2.2.1.2 Method: Image Comparison Over Time

CIRRUS™ HD-OCT 5000 Scans Operator

A B C

• Number of Subjects: 39

• Eyes: 53
Three operator acquired scans using the same CIRRUS™ HD-
OCT instrument.

Macular Cube 200x200 3 3 3

Macular Cube 512x128 3 3 3

C.2.2.1.3 Comparison Results

Observations (3x3 scans):

• The overall mean difference: -1.5 mm/mm2 ; measurements
range: 12.5 to 27.5 mm/mm2.

• The offset is worse for eyes with higher density (more for
normal eyes).

• The errors in accuracy are consistent with the fact that OCT
Angiography is imaging with limited resolution that is not
perfectly matched to the size of the features we are attempting
to image. That is, capillaries are expected to be as small as 5
um, and the beam width of Cirrus is approximately 15 um,
while the pixel spacing for the 3x3 scan is 12 um. It makes
sense to expect some inaccuracy in measurement for images of
the most densely packed and smallest vessels. There is
nonetheless a strong relationship between the Vessel Density as
measured in ground truth images and as measured in simulated
Cirrus images. As an individual eye experiences capillary loss, it
is reasonable, based on these results, to expect that the loss will
be reflected as a reduction in the Vessel Density measurements.
See Figure 6 for an example of this using one specific case.

Factor Higher Impact for: Mean Difference

Morphology Morphological factor applied
to the smallest vessels

30-micron vessels: -2.17 (SD
0.87)

Vessel Density Densely-packed vessels with
fewest dropouts

6-micron vessels: -3.8
12-micron vessels: 1.6

Table 131: Factors that Impact the Mean Difference
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Factor Low Impact for Mean Difference

Morphology Morphological factor applied
to larger vessels

36-micron vessels: -0.81 (SD
0.54)

Vessel Density Vessels with more spacing
and more dropouts

6-micron vessels: -1.2
12-micron vessels: -0.2

Noise level did not impact the mean
offset.

Hand-drawn large and
medium vessel phantom

Measurements

Table 132: Factors that Do Not Impact the Mean Difference

For vessels with more spacing and more dropouts, the error could
reduce to as little as -1.2 for 6 micron thick microvessels and -0.2
for 12 micron thick microvessels. The size of the morphological
factor applied to the larger vessels has a very small effect on the
magnitude of error. Noise level did not affect the mean offset.
Choice of hand-drawn large and medium vessel phantom did not
affect the mean offset. The errors in accuracy are consistent with
the fact that OCT Angiography is imaging with limited resolution
that is not perfectly matched to the size of the features we are
attempting to image. That is, capillaries are expected to be as small
as 5 um, and the beam width of Cirrus is approximately 15 um,
while the pixel spacing for the 3x3 scan is 12 um. It makes sense to
expect some inaccuracy in measurement for images of the most
densely packed and smallest vessels. There is nonetheless a strong
relationship between the Vessel Density as measured in ground
truth images and as measured in simulated Cirrus images. As an
individual eye experiences capillary loss, it is reasonable, based on
these results, to expect that the loss will be reflected as a reduction
in the Vessel Density measurements. See Figure 6 for an example of
this using one specific case

, the error could reduce to as little as -1.2 for 6 micron thick
microvessels and -0.2 for 12 micron thick microvessels. The size of
the morphological factor applied to the larger vessels has a very
small effect on the magnitude of error.

Key for graphs shown in the following table:

• x axis = ground truth

• y axis= CIRRUS™ HD-OCT imaging and algorithm

Linear Regression (mm/mm2) Bland-Altman Analysis (mm/mm2)

y r2 SSE n RPC CV SD p

3x3 Vessel Density 0.86x+1.42 0.97 1700 3240 1.9 (8.1%) 5.1% 1.96 -1.5
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Linear Regression (mm/mm2) Bland-Altman Analysis (mm/mm2)

y r2 SSE n RPC CV SD p

6x6 Vessel Density 0.57x+4.92 0.74 8000 3240 5.1 (23%) 14% 1.96 -3.9

Observations (6x6 scans):

Table 133: Comparisons of CIRRUS™ HD-OCT Vessel Density algorithm to digital ground truth for angiography
scans.

C.2.2.2 Vessel Profusion Performance

This study evaluated the performance of

C.2.2.2.1 Method: Instrument Variability

CIRRUS™ HD-OCT 5000 Scans Instrument

1 2 3

• Eyes: 26
A single operator acquired scans using three different
CIRRUS™ HD-OCT instruments.

Macular Cube 200x200 3 3 3

Macular Cube 512x128 3 3 3
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C.2.2.2.2 Method: Operator Variability

CIRRUS™ HD-OCT 5000 Scans Operator

A B C

• Eyes: 24
Three operator acquired scans using the same CIRRUS™ HD-
OCT instrument.

Macular Cube 200x200 3 3 3

Macular Cube 512x128 3 3 3

C.2.2.2.3 Measurement Performance Results

Macular Cube Scan Repeatability (mm2) Reproducibility (mm2) CV%

SD Limit SD Limit

200 x 200 3mm Circle 0.1295 0.3626 0.1568 0.4389 10.1%

5mm Circle 0.1012 0.2834 0.1455 0.4073 4.9%

512 x 128 3mm Circle 0.0837 0.2343 0.0998 0.2794 7.5%

5mm Circle 0.1537 0.4304 0.1936 0.5422 9.6%

Observations:
Repeatability for 200 x 200 scans, 3 mm circle is higher.
Repeatability for 512 x 128 scans, 5 mm circle is higher.
Reproducibility for 200 x 200 scans, 3 mm circle and 5 mm circle is about the same.
Reproducibility for 512 x 128 scans, 5 mm circle is much higher (double).
Coefficient of Variation for 200 x 200 scans, 3 mm circle is the highest.
Coefficient of Variation for 200 x 200 scans, 5 mm circle is the lowest.
Repeatability for 200 x 200, manually-edited scans is much lower.
Coefficient of Variation for 200 x 200, manually-edited scans is much lower.

Table 134: Repeatability and Reproducibility of Area of RPE Elevations

Macular Cube Scan Repeatability (mm3) Reproducibility (mm3) CV%

SD Limit SD Limit

200 x 200 3mm Circle 0.0117 0.0327 0.0122 0.0341 15.2%

5mm Circle 0.0098 0.0275 0.0106 0.0298 8.3%

512 x 128 3mm Circle 0.0074 0.0206 0.0084 0.0235 12.0%

5mm Circle 0.0088 0.0245 0.0103 0.0288 11.4%

Observations:
Coefficient of Variation for 200 x 200 scans, 3 mm circle is highest.
Coefficient of Variation for 200 x 200 scans, 5 mm circle is lowest.

Table 135: Repeatability and Reproducibility of Volume of RPE Elevations

The repeatability and reproducibility limits affect the ability to
determine when measurements have changed due to a change in
pathology as opposed to random variability.
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C.2.3 AngioPlex Metrix ONH Algorithms
An analysis of the accuracy of Cirrus AngioPlex density metrics was
done using digital phantoms. This analysis found that the metrics
are most valuable when viewed or analyzed as relative values,
rather than as being representations of the absolute density of
vasculature. The study found some differences between ground
truth and the Cirrus measurement due to the 15-20 microns beam
width associated with OCT imaging. The analysis showed a good
correlation between the underlying ground truth and the reported
measurement that supports the utility of these types of measure-
ments in evaluating microvascular density.

C.2.3.1 ONH Measurement Performance

This study determined the repeatability and reproducibility of Optic
Nerve Head (ONH) parameters.[11]

C.2.3.2 Vessel Density Performance

This study determined the repeatability and reproducibility of Optic
Nerve Head (ONH) parameters.

C.2.3.2.1 Method: Instrument Variability

CIRRUS™ HD-OCT 5000 Scans Instrument

1 2 3 4

• Subjects: 63
A single operator acquired scans using four different
CIRRUS™ HD-OCT instruments.

ONH Cube 3 3 3 3

C.2.3.2.2 Method: Operator Variability

CIRRUS™ HD-OCT 5000 Scans Operator

A B C D

• Subjects: 63
Three operators acquired scans using the same
CIRRUS™ HD-OCT instrument.

ONH Cube 3 3 3 3

C.2.3.2.3 Measurement Performance Results

Repeatability Reproducibility CV %

SD Limit SD Limit

Average Cup–to–Disc Ratio 0.0136 0.0380 0.0242 0.0679 5.4%

Vertical Cup–to–Disc Ratio 0.0243 0.0681 0.0302 0.0846 7.1%

Disc Area (mm2) 0.0538 0.1506 0.0942 0.2637 5.4%

Rim Area (mm2) 0.0420 0.1177 0.0619 0.1733 4.7%

[11] Mwanza, Chang, Budenz, Durbin, Gendy, Ski, Feauer: Reproducibility of Peripapillary Retinal Nerve Fiber Layer Thickness and Optic
Nerve Head Parameters Measured with Cirrus HD-OCT in Glaucomatous Eyes. IOVS 2010; 51:5724-5730 (derived from).
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Repeatability Reproducibility CV %

SD Limit SD Limit

Cup Volume (mm3) 0.0065 0.0181 0.0102 0.0287 7.8%

Table 136: Repeatability and Reproducibility of Optic Nerve Head Algorithms (Normal Subjects)

C.2.3.3 Vessel Profusion Performance

Repeatability Reproducibility CV%

SD Limit SD Limit

Normal Subjects

Average Cup–to–Disc Ratio 0.0136 0.0380 0.0242 0.0679 5.4%

Vertical Cup–to–Disc Ratio 0.0243 0.0681 0.0302 0.0846 7.1%

Disc Area (mm2) 0.0538 0.1506 0.0942 0.2637 5.4%

Rim Area (mm2) 0.0420 0.1177 0.0619 0.1733 4.7%

Cup Volume (mm3) 0.0065 0.0181 0.0102 0.0287 7.8%

Glaucoma Subjects

Average Cup–to–Disc Ratio 0.0136 0.0380 0.0242 0.0679 5.4%

Vertical Cup–to–Disc Ratio 0.0243 0.0681 0.0302 0.0846 7.1%

Disc Area (mm2) 0.0538 0.1506 0.0942 0.2637 5.4%

Rim Area (mm2) 0.0420 0.1177 0.0619 0.1733 4.7%

Cup Volume (mm3) 0.0065 0.0181 0.0102 0.0287 7.8%

Table 137: Repeatability and Reproducibility of Optic Nerve Head Algorithms

Repeatability Visit-to-Visit CV %

SD Limit SD Limit

Average Cup–to–Disc Ratio 0.009 0.025 0.009 0.025 1.2%

Vertical Cup–to–Disc Ratio 0.014 0.039 0.015 0.042 1.9%

Disc Area (mm2) 0.084 0.233 0.084 0.233 4.4%

Rim Area (mm2) 0.045 0.125 0.045 0.125 6.6%

Cup Volume (mm3) 0.032 0.089 0.063 0.175 11.7%

Observations:
Repeatability and Reproducibility for disc area measurement is highest and cup volume measurement is lowest.
Coefficient of Variation for cup volume measurement is highest and rim area is lowest.

Table 138: Repeatability and Reproducibility of Optic Nerve Head Algorithms (Glaucoma Subjects)

General observations:

• The optic nerve head algorithm might show increased variability
in certain anatomical variants.

• For tilted discs and discs with large clusters of blood vessels,
shadowing of the underlying RPE and Bruch's membrane may
render the disc edge difficult to identify.

Ambiguity in cup marker placement may increase variability for:

– small, crowded discs with shallow cups

– discs with large clusters of blood vessels

• Cups with excavation or embryonic tissue remnants may have
variable cup volume measurements.

C.2.3.3.1 Subjects: Glaucoma Same Visit

This study included four sites.
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Subject Demographics Subject Pathology

• Subjects: 94

• Age range: 43 to 89

• Mean age: 66.9

• Mild Glaucoma: 45 subjects

• Moderate Glaucoma: 20 subjects

• Severe Glaucoma: 19 subjects

Table 139: Glaucoma Same Visit Study Subjects

C.2.3.3.2 Method: Operator Variability

CIRRUS™ HD-OCT 5000 Scans Operator

A B C D

• Subjects: 63
Three operators acquired scans using the same
CIRRUS™ HD-OCT instrument.

ONH Cube 3 3 3 3

C.2.3.3.3 Subjects: Glaucoma Follow-Up Visit

Demographics Inclusion Criteria Exclusion Criteria

• Number of Subjects: 84

• Age Range: 43-89

• Mean age: 66.9

• Males or females 18 years of age or
older.

• Able and willing to make the required
study visits.

• Able and willing to give consent and
follow study instructions.

• Glaucoma diagnosis.

Mild (45) Mild Glaucoma Normal Eyes

Moderate (20) Moderate Glaucoma

Severe (19) Severe Glaucoma

C.2.3.3.4 Method: Follow-up Visit

Glaucoma: Follow-up Visit Variation

A clinical study was conducted to determine the intra–visit and
inter–visit repeatability of CIRRUS™ HD-OCT optic nerve head para-
meters. [11]

Subject Demographics Subject Pathology

• Subjects: 55

• Age range: 46 to 87

• Mean age: 70.7 ± 11.1

• Mild Glaucoma: 26 subjects

• Moderate Glaucoma: 11 subjects

• Severe Glaucoma: 18 subjects

Table 140: Glaucoma Follow-up Visit Study Subjects

CIRRUS™ HD-OCT 5000 Visits Scans Instrument 1

At each visit, one operator acquired scans using the
same CIRRUS™ HD-OCT instrument.

Visit 1 ONH Cube 3

Visit 2 3

Visit 3 3

Visit 4 3
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C.2.3.3.5 Measurement Performance Results

Repeatability Visit-to-Visit CV %

SD Limit SD Limit

Average Cup–to–Disc Ratio 0.009 0.025 0.009 0.025 1.2%

Vertical Cup–to–Disc Ratio 0.014 0.039 0.015 0.042 1.9%

Disc Area (mm2) 0.084 0.233 0.084 0.233 4.4%

Rim Area (mm2) 0.045 0.125 0.045 0.125 6.6%

Cup Volume (mm3) 0.032 0.089 0.063 0.175 11.7%

Observations:
Repeatability and Reproducibility for disc area measurement is highest and cup volume measurement is lowest.
Coefficient of Variation for cup volume measurement is highest and rim area is lowest.

Table 141: Repeatability and Reproducibility of Optic Nerve Head Algorithms (Glaucoma Subjects)

C.2.3.4 General Observations

• The optic nerve head algorithm might show increased variability
in certain anatomical variants.

• For tilted discs and discs with large clusters of blood vessels,
shadowing of the underlying RPE and Bruch's membrane may
render the disc edge difficult to identify.

Ambiguity in cup marker placement may increase variability for:

– small, crowded discs with shallow cups

– discs with large clusters of blood vessels

• Cups with excavation or embryonic tissue remnants may have
variable cup volume measurements.

C.3 Anterior Segment Algorithms
CIRRUS™ HD-OCTanterior segment algorithm results appear in the
scan analyses shown below.

Measurement Parameters Analyses

Anterior Chamber [} 184] Measurement performance of operator
variability and instrument variability for
normal eyes, corneal pathology:

• Central Corneal Thickness

• Angle to Angle Distance

• Anterior Chamber Depth

Anterior Chamber Analysis [} 342]

HD Angle Scans [} 194] Measurement performance of angles (nasal
and temporal):

• Angle Opening Distance (AOD) 500 and
750

• Trabecular Iris Space Area (TISA) 500
and 750

• Scleral Spur Angle (SSA)

• Anterior Chamber Angle (ACA)

HD Angle [} 349]

Wide Angle to Angle Scans
[} 197]

Wide Angle-to-Angle [} 361]
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Measurement Parameters Analyses

Pachymetry [} 204] Measurement performance of pachymetry
algorithms for normal corneas, corneal
pathology, and post-LASIK:

• Center

• Inner Nasal

• Inner Superior

• Inner Inferior

• Inner Temporal

• Outer Nasal

• Outer Superior

• Outer Inferior

• Outer Temporal

• Epithelial Thickness Measurement (ETM)

Pachymetry [} 356]

Table 142: Anterior Segment Algorithm Parameters

C.3.1 Terms and Acronyms
The following definitions apply to all results tables in this appendix.

All statistics are estimated from two-way random-effect ANOVA
model with random effects operator/device, eye and interaction
between operator/device and eye.

Term Explanation

CV Coefficient of variation = SD ÷ Mean.

Mean Intercept of the ANOVA model

Repeatability CV% (Repeatability SD)/Intercept x 100%.

Repeatability Limit 2.8 x Repeatability SD (per ISO 5725-1 and ISO 5725-6).

Repeatability SD Square root of the residual variance.

Reproducibility CV% (Reproducibility SD)/Intercept x 100%.

Reproducibility SD Square root of the sum of the operator/device variance, the interaction variance and
the residual variance.

Reproducibility Limit 2.8 x Reproducibility SD (per ISO 5725-1 and ISO 5725-6).

SD Standard Deviation

Table 143: Measurement Performance Results Tables

Term Explanation

95% CI Confidence Interval for mean difference is based on t-distribution.

95% LOA Limit of Agreement

ACD of Visante adjusted by CCT (i.e. ACD = original ACD - CCT/1000).

Difference CIRRUS - Visante.

LOA Limit of Agreement calculated as: mean +/- 1.96 * SD where “mean” is the mean
of the differences between Algorithm and Manual results and SD is the standard
deviation.

p-value based on paired t-test.

Table 144: Comparison Results Tables
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C.3.2 Anterior Chamber Measurements
A non-significant risk clinical study was conducted to:

• Determine the repeatability and reproducibility of the CIRRUS™
HD-OCT in measuring:

– Central Corneal Thickness

– Angle to Angle Distance

– Anterior Chamber Depth

• Compare the corresponding measurements of CIRRUS™ HD-
OCT and Visante OCT.

Operator Variability Study

Mean Repeatability Reproducibility

SD Limit CV% SD Limit CV%

Group 1: Normal Cornea

CCT 549.5 9.749 27.297 1.774 11.897 33.311 2.165

Angle to Angle 12.030 0.171 0.479 1.4231 0.300 0.840 2.494

ACD 2.858 0.034 0.096 1.199 0.046 0.128 1.60

Group 2: Cornea Pathology (keratoconus)

CCT 532.1 12.061 33.772 2.267 18.951 53.061 3.561

Angle to Angle 12.363 0.175 0.491 1.418 0.247 0.693 2.002

ACD 3.060 0.040 0.113 1.321 0.061 0.171 1.991

Table 145: Repeatability and Reproducibility of CIRRUS™ HD-OCT Anterior Chamber Measurements

Instrument Variability Study

N CIRRUS Visante Difference 95% CI p-value 95% LOA

Mean SD

Group 1: Normal Cornea

CCT 46 551.5 
(33.9)

537.8 
(33.8)

13.7 
(16.7)

8.7, 
18.6

<.001 -19.8, 
47.1

Angle to Angle 46 12.004 
(0.538)

11.638 
(0.480)

0.365 
(0.371)

0.255, 
0.476

<.001 -0.376, 
1.107

ACD 46 2.860
(0.448)

2.948 
(0.459)

-0.088 
(0.064)

-0.107, -
0.069

<.001 -0.215, 
0.039 ̀

Group 2: Cornea Pathology (keratoconus)

CCT 36 538.2 
(53.4)

511.4 
(55.0)

26.8
(26.9)

17.7, 
35.9

<.001 -27.0, 
80.7

Angle to Angle 36 12.293 
(0.473)

11.939 
(0.467)

0.353 
(0.382)

0.224, 
0.482

<.001 -0.411, 
1.117

ACD 33 3.049
(0.306)

3.144 
(0.320)

-0.095 
(0.089)

-0.126, 
-0.063

<.001 -0.272, 
0.083

Table 146: Mean Difference Between CIRRUS™ HD-OCT and Visante OCT
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C.3.2.1 Subjects

Demographics Inclusion Criteria Exclusion Criteria

• Number of Subjects: 137

• Age Range: 25-69

• Blindness, low vision or severely
diseased eyes,

• Prior surgery or a procedure involving
or affecting the cornea in the study
eye.

• Corneal pathology, either inflam-
matory or non-inflammatory, in the
study eye.

Group 1: Normal (46) Normal Corneas

Group 2: Corneal Pathology (36) Diagnosed with keratoconus • Normal corneas in the study eye.

• Prior LASIK surgery in the study eye.

C.3.2.2 Method

CIRRUS™ HD-OCT 4000 Scans Operator

A B C

Each operator used a different instrument; same eye.
Operators acquired and measured structures using angle
tools.

HD Angle (Nasal) 3 3 3

HD Angle (Temporal) 3 3 3

CIRRUS™ HD-OCT 5000 Scans Operator

A B C

Each operator used a different instrument; same eye.
Operators acquired and measured structures using angle
tools.

HD Angle (Nasal) 3 3 3

HD Angle (Temporal) 3 3 3

Visante Compare Scans Operator

• One operator used one Visante OCT instrument.

• The first qualified Visante OCT image was compared to
the first qualified CIRRUS 6000 image.

HD Angle (Nasal) 3

HD Angle (Temporal) 3

CIRRUS™ HD-OCT 5000 Scans Operator

A B C

This study included 28 subjects.
A single operator acquired three scans using three different
CIRRUS™ HD-OCT instruments (9 scans total).
Each operator used a different instrument; same eye.
Operators acquired and measured structures using angle
tools.

HD Angle (Nasal) 3 3 3
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Operator Variability

CIRRUS™ HD-OCT 5000 Scans Operator

A B C

This study included 22 subjects.
Three different operators performed three scans of each
subject with three different CIRRUS™ HD-OCT instruments (9
scans total).
Each operator used a different instrument; same eye.
Operators acquired and measured structures using angle
tools.

HD Angle (Nasal) 3 3 3

C.3.2.3 Measurement Performance Results

Mean Repeatability Reproducibility

SD Limit CV% SD Limit CV%

Nasal

TISA 500 0.151 0.025 0.071 16.801 0.030 0.083 19.614

TISA 750 0.263 0.028 0.080 10.827 0.037 0.103 14.053

AOD 500 0.439 0.075 0.209 17.012 0.081 0.226 18.365

AOD 750 0.570 0.055 0.153 9.598 0.084 0.236 14.783

SSA 37.696 3.774 10.569 10.013 4.552 12.746 12.076

AC Angle 36.165 3.427 9.595 9.475 4.861 13.612 13.442

Temporal

TISA 500 0.150 0.027 0.076 18.169 0.032 0.090 21.368

TISA 750 0.275 0.041 0.115 14.946 0.045 0.126 16.353

AOD 500 0.445 0.080 0.223 17.893 0.090 0.252 20.243

AOD 750 0.586 0.076 0.213 12.972 0.085 0.237 14.434

SSA 37.846 4.442 12.438 11.737 5.024 14.068 13.276

AC Angle 35.951 3.725 10.430 10.361 5.184 14.514 14.418

Table 147: Repeatability and Reproducibility of CIRRUS™ HD-OCT Wide Angle to Angle Measurements
(Glaucoma)

C.3.2.4 Comparison Results

CIRRUS Visante Difference 95 % CI p value 95% LOA

Mean SD Mean SD Mean SD Mean SD Mean SD

Nasal

36.054 18.137 38.831 18.272 -2.777 5.665 -5.065 -0.488 0.019 -14.107 8.554

Temporal

35.255 18.767 38.573 18.385 -3.318 6.493 -5.940 -0.695 0.015 -16.304 9.669

Table 148: Mean Wide Angle to Angle Difference Between CIRRUS™ HD-OCT and Visante OCT
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C.3.3 Anterior Chamber Measurements: Glaucoma

C.3.3.1 Measurement Performance

C.3.3.1.1 Subjects

Demographics Inclusion Criteria Exclusion Criteria

• Number of Subjects: 137

• Age Range: 25-69

History of leukemia, AIDS, uncontrolled
systemic hypertension, dementia or
multiple sclerosis.

Group 1: Normal Cornea Normal Corneas • Blindness, low vision or severely
diseased eyes,

• Prior surgery or a procedure involving
or affecting the cornea in the study
eye.

• Corneal pathology, either inflam-
matory or non-inflammatory, in the
study eye.

Group 2: Corneal Pathology Anterior segment pathology diagnosis,
including:

• keratoconus

• pellucid marginal degeneration

• corneal scarring

• corneal degeneration

• corneal dystrophy

• corneal changes secondary to disease
or surgery

• Could not fixate long enough to
acquire images.

• Normal corneas in the study eye.

• Prior LASIK surgery in the study eye.

C.3.3.1.2 Method

CIRRUS™ HD-OCT 4000 Scans Operator

A B C

Each operator used a different instrument; same eye.
Operators acquired and measured structures using angle
tools.

HD Angle (Nasal) 3 3 3

HD Angle (Temporal) 3 3 3

CIRRUS™ HD-OCT 5000 Scans Operator

A B C

Each operator used a different instrument; same eye.
Operators acquired and measured structures using angle
tools.

HD Angle (Nasal) 3 3 3

HD Angle (Temporal) 3 3 3

Visante Compare Scans Operator

• One operator used one Visante OCT instrument.

• The first qualified Visante OCT image was compared to
the first qualified CIRRUS 6000 image.

HD Angle (Nasal) 3

HD Angle (Temporal) 3
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CIRRUS™ HD-OCT 5000 Scans Operator

A B C

This study included 28 subjects.
A single operator acquired three scans using three different
CIRRUS™ HD-OCT instruments (9 scans total).
Each operator used a different instrument; same eye.
Operators acquired and measured structures using angle
tools.

HD Angle (Nasal) 3 3 3

Operator Variability

CIRRUS™ HD-OCT 5000 Scans Operator

A B C

This study included 22 subjects.
Three different operators performed three scans of each
subject with three different CIRRUS™ HD-OCT instruments (9
scans total).
Each operator used a different instrument; same eye.
Operators acquired and measured structures using angle
tools.

HD Angle (Nasal) 3 3 3

C.3.3.1.3 Measurement Accuracy Results

Repeatability Reproducibility Operator
Variability

Instrument
Variability

Overall

SD (µm) Limits (µm) SD (µm) Limits (µm)

4.08 11.42 4.23 11.84 544.25 532.25 538.25

Random error variability for Operator Variability was larger than Instrument Variability, so Operator Variability variance
components were used to estimate the random measurement variability and the repeatability standard deviation.

Table 149: Repeatability and Reproducibility of the CIRRUS™ HD-OCT Central Corneal Thickness Algorithm

C.3.3.2 Comparison

C.3.3.2.1 Subjects

Demographics Inclusion Criteria Exclusion Criteria

• Number of Subjects: 27

• Age Range: 43-77

• Mean Age: 62

• Diagnosed with glaucoma.

– Severity mild to severe.

– Within the angle configu-
ration range Grade II to Grade
IV[12]

• Able to make study visits.

• Provided consent.

• Followed study instructions.

• Could not fixate long enough to
acquire images.

• Active infection of the anterior
segment of the eye.

[12] Shaffer: Primary glaucomas. Gonioscopy, ophthalmoscopy and perimetry. Trans Am Acad Ophthalmol Otolaryngol. 1960 Mar-
Apr;64:112-27.
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C.3.3.2.2 Method

CIRRUS™ HD-OCT 4000 Scans Operator

A B C

Each operator used a different instrument; same eye.
Operators acquired and measured structures using angle
tools.

HD Angle (Nasal) 3 3 3

HD Angle (Temporal) 3 3 3

CIRRUS™ HD-OCT 5000 Scans Operator

A B C

Each operator used a different instrument; same eye.
Operators acquired and measured structures using angle
tools.

HD Angle (Nasal) 3 3 3

HD Angle (Temporal) 3 3 3

Visante Compare Scans Operator

• One operator used one Visante OCT instrument.

• The first qualified Visante OCT image was compared to
the first qualified CIRRUS 6000 image.

HD Angle (Nasal) 3

HD Angle (Temporal) 3

CIRRUS™ HD-OCT 5000 Scans Operator

A B C

This study included 28 subjects.
A single operator acquired three scans using three different
CIRRUS™ HD-OCT instruments (9 scans total).
Each operator used a different instrument; same eye.
Operators acquired and measured structures using angle
tools.

HD Angle (Nasal) 3 3 3

Operator Variability

CIRRUS™ HD-OCT 5000 Scans Operator

A B C

This study included 22 subjects.
Three different operators performed three scans of each
subject with three different CIRRUS™ HD-OCT instruments (9
scans total).
Each operator used a different instrument; same eye.
Operators acquired and measured structures using angle
tools.

HD Angle (Nasal) 3 3 3

C.3.3.2.3 Central Corneal Thickness Measurement Accuracy
(Comparison)

This study determined the difference in Central Corneal Thickness
(CCT) measurements between the of the CIRRUS™ HD-OCT and
Ultrasound Pachymetry.

This study included 50 subjects.

A single operator acquired scans using CIRRUS™ HD-OCT and an
Ultrasound Pachymetry instrument.



Instructions for Use C Algorithm Performance Studies
CIRRUS™ HD-OCT C.3 Anterior Segment Algorithms

2660021174149 Rev. D 2019-10 509 / 542

Mean Difference SD (µm) 95% CI of the Difference

Lower Upper

CIRRUS™ HD-OCT -9.06 5.63 -10.66 -7.46

Table 150: Mean Central Corneal Thickness Difference Between CIRRUS™ HD-OCT

The negative difference means that the CIRRUS CCT measurement
is thinner than the ultrasound CCT measurement. OCT instruments
generally measure pachymetry thinner than ultrasound pachymetry.

The Visante User Manual reports an average measurement
difference of 15.1 micrometers. Literature reports differences
between OCT and ultrasound pachymetry range from 11.64 to
49.4 micrometers. [13] [14] [15]

C.3.3.2.4 Axial Dimension Accuracy

Benchtop studies determine the repeatability and reproducibility
performance of CIRRUS™ HD-OCT scans.

Measurement Performance
(µm)

Repeatability Reproducibility Average
(µm)SD (µm) Limit (µm) SD (µm) Limit (µm)

Axial Distance 6.2 2.6 7.1 2.7 7.6 1165.6

Table 151: Performance of Axial Dimensions in Basic Image Geometry

C.3.4 HD Angle Measurements
A non-significant risk clinical study was conducted to:

• Determine the repeatability and reproducibility of the CIRRUS™
HD-OCT in measuring:

– Angle Opening Distance (AOD)

– Trabecular Iris Space Area (TISA)

– Scleral Spur Angle (SSA)

– Anterior Chamber Angle (ACA)

• Compare the corresponding measurements of CIRRUS™ HD-
OCT .

[13] Weisbrod, Stetson, Wieland, Bressler, Schmidt–Erfurth, Knighton, Gregori:Comparison of Hand–Drawn ILM and RPE Segmentation to
the Retinal Segmentation Algorithm of the CIRRUS HD-OCT, ARVO 2008, poster 4240.

[14] Chang, Durbin, Weiland, Schmidt–Erfurth, Gregori, Bressler: Repeatability of retinal thickness measurements using CIRRUS HD-OCT
Spectral Domain Technology, ARVO 2008, poster 4253.

[15] Geitzenauer, Kiss, Durbin, Abunto, Wieland, Bressler, Gregori, Schmidt–Erfurth: Comparing Retinal Thickness Measurements From
CIRRUS Spectral–Domain and Stratus Time–Domain OCT, ARVO 2008, poster 930.

[16] Shaffer: Primary glaucomas. Gonioscopy, ophthalmoscopy and perimetry. Trans Am Acad Ophthalmol Otolaryngol. 1960 Mar-
Apr;64:112-27.
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C.3.4.1 Subjects

Demographics Inclusion Criteria Exclusion Criteria

• Number of Subjects: 27

• Age Range: 43-77

• Mean Age: 62

• Diagnosed with glaucoma.

– Severity mild to severe.

– Within the angle configu-
ration range Grade II to Grade
IV[16]

• Able to make study visits.

• Provided consent.

• Followed study instructions.

• Could not fixate long enough to
acquire images.

• Active infection of the anterior
segment of the eye.

C.3.4.2 Method

CIRRUS™ HD-OCT Scans Operator

A B C

Each operator used a different instrument; same eye.
Operators acquired and measured structures using angle
tools.

HD Angle (Nasal) 3 3 3

HD Angle (Temporal) 3 3 3

Visante Compare Scans Operator

• One operator used one Visante OCT instrument.

• The first qualified Visante OCT image was compared to
the first qualified CIRRUS 6000 image.

HD Angle (Nasal) 3

HD Angle (Temporal) 3

C.3.4.3 Measurement Performance Results

Parameter Mean Repeatability Reproducibility

SD Limit CV% SD Limit CV%

Nasal

TISA 500 0.158 0.017 0.048 10.764 0.022 0.061 13.786

TISA 750 0.281 0.023 0.065 8.305 0.034 0.095 12.085

AOD 500 0.461 0.053 0.148 11.496 0.066 0.185 14.332

AOD 750 0.621 0.054 0.151 8.699 0.075 0.211 12.162

SSA 39.186 2.772 7.762 7.074 3.638 10.188 9.285

AC Angle 38.282 2.517 7.048 6.575 3.433 9.612 8.968

Temporal

TISA 500 0.161 0.020 0.057 12.685 0.026 0.072 16.033

TISA 750 0.270 0.028 0.078 10.319 0.032 0.090 11.950

AOD 500 0.475 0.064 0.179 13.415 0.075 0.209 15.699

AOD 750 0.576 0.062 0.173 10.750 0.072 0.202 12.534

SSA 38.440 3.478 9.738 9.048 4.197 11.751 10.918

AC Angle 37.209 2.868 8.031 7.708 3.630 10.164 9.756

Table 152: Repeatability and Reproducibility of CIRRUS™ HD-OCT HD Angle Measurements
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C.3.4.4 Comparison Results

CIRRUS Visante Difference 95 % CI p value 95% LOA

Mean SD Mean SD Mean SD Mean SD Mean SD

Nasal

37.677 17.408 39.974 19.074 -2.297 8.411 -5.625 1.030 0.168 -19.119 14.525

Temporal

37.141 19.649 36.767 18.295 0.374 5.934 -1.974 2.722 0.746 -11.495 12.243

Table 153: Mean HD Angle Difference Between CIRRUS™ HD-OCT and Visante OCT

C.3.5 Wide Angle-to-Angle Measurements
A non-significant risk clinical study was conducted to:

• Determine the repeatability and reproducibility of the CIRRUS™
HD-OCT in measuring:

– Anterior Chamber Angle (ACA)

– Trabecular Iris Space Area (TISA)

– Angle Opening Distance (AOD)

– Scleral Spur Angle (SSA)

• Compare the corresponding measurements of CIRRUS™ HD-
OCT and Visante OCT.

C.3.5.1 Subjects

Demographics Inclusion Criteria Exclusion Criteria

• Number of Subjects: 26

• Age Range: 43-77

• Mean Age: 62

• Diagnosed with glaucoma.

– Severity mild to severe.

– Within the angle configu-
ration range Grade II to Grade
IV[17]

• Able to make study visits.

• Provided consent.

• Followed study instructions.

• Could not fixate long enough to
acquire images.

• Active infection of the anterior
segment of the eye.

C.3.5.2 Method

CIRRUS™ HD-OCT Scans Operator

A B C

Each operator used a different instrument; same eye.
Operators acquired and measured structures using angle
tools.

Wide Angle to Angle 3 3 3

Wide Angle to Angle 3 3 3

[17] Shaffer: Primary glaucomas. Gonioscopy, ophthalmoscopy and perimetry. Trans Am Acad Ophthalmol Otolaryngol. 1960 Mar-
Apr;64:112-27.
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Visante Compare Scans Operator

• One operator used one Visante OCT instrument.

• The first qualified Visante OCT image was compared to
the first qualified CIRRUS 6000 image.

Wide Angle to Angle 3

Wide Angle to Angle 3

C.3.5.3 Measurement Performance Results

Mean Repeatability Reproducibility

SD Limit CV% SD Limit CV%

Nasal

TISA 500 0.151 0.025 0.071 16.801 0.030 0.083 19.614

TISA 750 0.263 0.028 0.080 10.827 0.037 0.103 14.053

AOD 500 0.439 0.075 0.209 17.012 0.081 0.226 18.365

AOD 750 0.570 0.055 0.153 9.598 0.084 0.236 14.783

SSA 37.696 3.774 10.569 10.013 4.552 12.746 12.076

AC Angle 36.165 3.427 9.595 9.475 4.861 13.612 13.442

Temporal

TISA 500 0.150 0.027 0.076 18.169 0.032 0.090 21.368

TISA 750 0.275 0.041 0.115 14.946 0.045 0.126 16.353

AOD 500 0.445 0.080 0.223 17.893 0.090 0.252 20.243

AOD 750 0.586 0.076 0.213 12.972 0.085 0.237 14.434

SSA 37.846 4.442 12.438 11.737 5.024 14.068 13.276

AC Angle 35.951 3.725 10.430 10.361 5.184 14.514 14.418

Table 154: Repeatability and Reproducibility of CIRRUS™ HD-OCT Wide Angle to Angle Measurements
(Glaucoma)

C.3.5.4 Comparison Results

CIRRUS Visante Difference 95 % CI p value 95% LOA

Mean SD Mean SD Mean SD Mean SD Mean SD

Nasal

36.054 18.137 38.831 18.272 -2.777 5.665 -5.065 -0.488 0.019 -14.107 8.554

Temporal

35.255 18.767 38.573 18.385 -3.318 6.493 -5.940 -0.695 0.015 -16.304 9.669

Table 155: Mean Wide Angle to Angle Difference Between CIRRUS™ HD-OCT and Visante OCT

C.3.6 Pachymetry Algorithm Accuracy
A non-significant risk clinical study was conducted to:

• Determine the repeatability and reproducibility of the CIRRUS™
HD-OCT in measuring:

• Compare the corresponding measurements of CIRRUS™ HD-
OCT and Visante OCT.

Data Collection and Analysis

The data were acquired and analyzed by:
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• 1 operator and 1 Visante OCT

• 3 operators and 3 CIRRUS 6000

• 3 operators and 3 CIRRUS 6000

The first qualified Visante OCT scan was used for comparison with
the first qualified CIRRUS 6000 and CIRRUS 6000 scan from any of
the three devices.

The operators who acquired the images also reviewed them. For
the study measurement, operators used software tools (Angle tool;
TISA tool) to identify structure measurements.

Instrument Group Pachymetry Enhanced High
Resolution Cornea

CIRRUS™ HD-OCT Normal Corneas -

Cornea Pathology -

Post-LASIK -

Visante OCT Normal Corneas -

Cornea Pathology -

Post-LASIK

Table 156: Pachymetry and Anterior Chamber Data Collected

C.3.6.1 Pachymetry Measurement Performance

Mean Repeatability Reproducibility

SD Limit CV% SD Limit CV%

Group 1: Normal Corneal

Center 528.3 1.197 3.350 0.226 1.628 4.557 0.308

Inner Nasal 552.8 2.674 7.486 0.484 3.218 9.011 0.582

Inner Superior 557.9 3.399 9.518 0.609 4.261 11.930 0.764

Inner Inferior 541.9 2.714 7.598 0.501 3.306 9.257 0.610

Inner Temporal 532.5 1.870 5.237 0.351 2.085 5.837 0.392

Outer Nasal 588.9 4.061 11.370 0.690 4.739 13.268 0.805

Outer Superior 599.7 4.786 13.402 0.798 6.897 19.312 1.150

Outer Inferior 572.4 3.511 9.830 0.613 5.326 14.912 0.930

Outer Temporal 554.8 3.170 8.875 0.571 3.430 9.603 0.618

Group 2: Corneal Pathology

Center 521.0 2.739 7.670 0.526 2.788 7.807 0.535

Inner Nasal 553.4 3.928 11.000 0.710 4.394 12.303 0.794

Inner Superior 558.3 4.346 12.169 0.779 4.884 13.677 0.875

Inner Inferior 534.0 3.115 8.723 0.583 4.325 12.109 0.810

Inner Temporal 527.9 2.867 8.027 0.543 3.837 10.742 0.727

Outer Nasal 594.3 4.496 12.589 0.756 5.298 14.835 0.891

Outer Superior 606.5 5.534 15.495 0.912 6.185 17.319 1.020

Outer Inferior 572.5 4.233 11.851 0.739 8.945 25.046 1.563

Outer Temporal 556.2 3.821 10.699 0.687 4.792 13.418 0.862

Group 3: Post-LASIK

Center 465.1 1.784 4.994 0.383 2.068 5.791 0.445

Inner Nasal 514.8 6.912 19.355 1.343 6.912 19.355 1.343

Inner Superior 508.8 4.785 13.398 0.940 5.749 16.098 1.130
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Mean Repeatability Reproducibility

SD Limit CV% SD Limit CV%

Inner Inferior 500.8 4.557 12.759 0.910 5.919 16.572 1.182

Inner Temporal 481.8 4.657 13.040 0.967 4.657 13.040 0.967

Outer Nasal 583.7 9.104 25.492 1.560 9.197 25.752 1.576

Outer Superior 580.2 6.972 19.522 1.202 8.915 24.963 1.537

Outer Inferior 560.4 5.560 15.568 0.992 9.557 26.760 1.705

Outer Temporal 530.0 7.294 20.424 1.376 7.382 20.670 1.393

Table 157: Repeatability and Reproducibility of CIRRUS™ HD-OCT Pachymetry Measurements

C.3.6.1.1 Subjects

# Ages Inclusion Criteria Exclusion Criteria

Normal Cornea
48

25-69 • Males or females 18 years of age or
older.

• Able and willing to make the required
study visits.

• Able and willing to give consent and
follow study instructions.

• No history of:

– leukemia

– AIDS

– uncontrolled systemic hyper-
tension

– dementia

– multiple sclerosis

• Subject unable to fixate well enough
to acquire the images.

• Active infection of the anterior
segment.

• Blindness, low vision or severely
diseased eyes,

• Prior surgery or a procedure involving
or affecting the cornea in the study
eye.

• Corneal pathology, either inflam-
matory or non-inflammatory, in the
study eye.

Corneal
Pathology

49

Anterior segment pathology diagnosis,
including:

• keratoconus

• pellucid marginal degeneration

• corneal scarring

• corneal degeneration

• corneal dystrophy

• corneal changes secondary to disease
or surgery

• Could not fixate long enough to
acquire images.

• Normal corneas in the study eye.

• Prior LASIK surgery in the study eye.

Table 158: Pachymetry Algorithm Study Subjects



Instructions for Use C Algorithm Performance Studies
CIRRUS™ HD-OCT C.3 Anterior Segment Algorithms

2660021174149 Rev. D 2019-10 515 / 542

C.3.6.2 ETM Measurement Performance

A non-significant risk clinical study was conducted:

• To determine the repeatability and reproducibility of the
CIRRUS™ HD-OCT in measuring epithelial thickness.

• Comparing calculated measurements to manual measurements.

This analysis used a subset of data collected in the Anterior
Chamber Measurements [} 503]
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C.3.6.2.1 Subjects

# Ages Inclusing Criteria Exclusion Criteria

Normal Cornea
48

25-69 • Males or females 18 years of age or
older.

• Able and willing to make the required
study visits.

• Able and willing to give consent and
follow study instructions.

• No history of:

– leukemia

– AIDS

– uncontrolled systemic hyper-
tension

– dementia

– multiple sclerosis

• Subject unable to fixate well enough
to acquire the images.

• Active infection of the anterior
segment.

• Blindness, low vision or severely
diseased eyes,

• Prior surgery or a procedure involving
or affecting the cornea in the study
eye.

• Corneal pathology, either inflam-
matory or non-inflammatory, in the
study eye.

Corneal
Pathology

49

Anterior segment pathology diagnosis,
including:

• keratoconus

• pellucid marginal degeneration

• corneal scarring

• corneal degeneration

• corneal dystrophy

• corneal changes secondary to disease
or surgery

• Could not fixate long enough to
acquire images.

• Normal corneas in the study eye.

• Prior LASIK surgery in the study eye.

Table 159: Pachymetry Algorithm Study Subjects

C.3.6.2.2 Results (Group 1)

Sector 101 102 103 104 105 106 107 108 109 110 111

1 15 15 15 15 15 15 15 15 15 15 15

2 15 15 15 15 15 15 15 15 15 15 15

3 15 15 15 15 15 15 15 15 15 15 15

4 15 15 15 15 15 15 15 15 15 15 15

5 15 15 15 15 15 15 15 15 15 15 15

6 15 15 15 15 15 15 15 15 15 15 15

7 15 15 15 15 15 15 15 15 15 15 15

8 15 15 15 15 15 15 15 15 15 15 15

9 15 15 15 15 15 15 15 15 15 15 15

10 15 15 15 15 15 15 15 12 15 15 15

11 15 15 15 15 15 15 15 12 12 10 15

12 15 15 15 15 15 15 15 14 15 15 10

13 15 15 15 15 15 15 15 15 15 15 15

14 15 15 15 15 15 15 15 15 15 15 15

15 15 15 15 15 15 15 15 15 15 15 15

16 15 15 15 15 15 15 15 15 15 15 15

17 15 15 15 15 15 15 15 15 15 15 15

18 15 10 15 15 15 15 15 0 10 12 15

19 5 5 10 1 15 15 15 1 10 0 12
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Sector 101 102 103 104 105 106 107 108 109 110 111

20 5 5 10 8 12 15 15 0 12 2 12

21 5 5 10 12 15 15 15 10 15 11 12

22 15 6 15 10 15 15 15 2 12 15 15

23 15 10 15 15 15 15 15 10 12 15 15

24 10 10 10 2 15 15 15 5 12 10 5

25 10 10 15 7 15 15 15 4 15 15 15

Table 160: ETM Measurements for Group 1



C Algorithm Performance Studies Instructions for Use
CIRRUS™ HD-OCTC.3 Anterior Segment Algorithms

518 / 542 2660021174149 Rev. D 2019-10

C.3.6.2.3 Results (Group 2)

Sector 201 202 203 204 206 207 208 209 210 211 212 213

1 15 15 15 15 15 15 15 15 15 15 15 15

2 15 15 15 15 15 15 15 15 15 15 15 15

3 15 15 15 15 15 15 15 15 15 15 15 15

4 15 15 15 15 15 15 15 15 15 15 15 15

5 15 15 15 15 15 15 15 15 15 15 15 15

6 15 15 15 15 15 15 15 15 15 15 15 15

7 15 15 15 15 15 15 15 15 15 15 15 15

8 15 15 15 15 15 15 15 15 15 15 15 15

9 15 15 15 15 15 15 15 15 15 15 15 15

10 15 15 15 8 15 15 15 15 15 15 15 15

11 15 6 15 5 15 15 15 15 15 11 15 15

12 10 10 10 7 15 15 15 15 15 15 15 15

13 6 15 15 13 10 15 15 15 15 13 15 15

14 15 13 15 15 15 15 15 15 15 15 15 15

15 15 15 15 15 15 15 15 15 15 15 15 15

16 15 15 15 15 15 15 15 15 15 15 15 15

17 15 15 15 15 15 15 15 15 15 15 15 15

18 7 10 10 7 10 7 15 15 15 15 15 15

19 10 0 5 5 10 10 5 10 10 8 13 15

20 3 3 2 5 5 11 12 5 3 10 10 15

21 4 4 10 6 5 12 9 5 15 5 10 15

22 15 10 13 11 10 15 15 5 15 1 15 15

23 10 15 15 15 10 15 15 4 15 15 15 15

24 12 0 15 14 15 15 15 8 15 4 15 15

25 14 4 15 13 15 15 15 10 15 9 15 15

Table 161: ETM Measurements for Group 2
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C.3.6.2.4 Comparison Results: Deming Regression Analysis (Group 1)

Sector Intercept (SE) µm Int [95% CI] µm Slope (SE) Slope [95% CI]

1 4.69 (4.25) [-3.65, 13.02] 0.88 (0.08) [0.71, 1.04]

2 -9.71 (3.47) [-16.52, -2.90] 1.16 (0.07) [1.02, 1.29]

3 -3.13 (2.95) [-8.91, 2.65] 1.02 (0.06) [0.91, 1.13]

4 -11.09 (4.48) [-19.87, -2.31] 1.18 (0.09) [1.01, 1.35]

5 -5.11 (3.33) [-11.64, 1.42] 1.05 (0.06) [0.93, 1.18]

6 2.65 (3.00) [-3.23, 8.54] 0.90 (0.06) [0.79, 1.02]

7 0.18 (3.23) [-6.15, 6.51] 0.96 (0.06) [0.84, 1.09]

8 3.79 (3.35) [-2.78, 10.35] 0.89 (0.07) [0.76, 1.02]

9 -1.51 (3.04) [-7.47, 4.45] 0.98 (0.06) [0.87, 1.10]

10 1.34 (3.77) [-6.06, 8.73] 0.92 (0.08) [0.77, 1.08]

11 -27.06 (5.06) [-36.98, -17.13} 1.47 (0.10) [1.27, 1.66]

12 -12.70 (4.37) [-21.26, -4.14] 1.19 (0.08) [1.03, 1.36]

13 -11.56 (4.80) [-20.96, -2.15] 1.17 (0.09) [0.99, 1.36]

14 -6.34 (3.56) [-13.31, 0.64] 1.08 (0.07) [0.94, 1.22]

15 3.42 (3.57) [-3.57, 10.41] 0.87 (0.07) [0.73, 1.02]

16 -3.43 (2.88) [-9.08, 2.22] 1.02 (0.06) [0.91, 1.14]

17 -2.52 (3.10) [-8.60, 3.55] 1.00 (0.06) [0.88, 1.12]

18 -12.47 (3.22) [-18.79, -6.15] 1.22 (0.07) [1.09, 1.35]

19 3.18 (4.83) [-6.30, 12.65] 0.90 (0.10) [0.71, 1.09]

20 -5.80 (4.60) [-14.82, 3.22] 1.07 (0.09) [0.89, 1.25]

21 -10.72 (7.16) [-24.75, 3.31] 1.17 (0.14) [0.88, 1.45]

22 -1.92 (2.59) [-6.99, 3.15] 1.00 (0.05) [0.90, 1.10]

23 -6.47 (3.10) [-12.55, -0.39] 1.07 (0.07) [0.95, 1.20]

24 -5.77 (2.51) [-10.70, -0.85] 1.06 (0.06) [0.95, 1.17]

25 -4.91 (3.25) [-11.27, 1.45] 1.07 (0.07) [0.94, 1.20]

All -5.92 (0.61) [-7.11, -4.73] 1.07 (0.01) [1.05, 1.10]

Table 162: Deming Regression Analysis Stratified by Sector (Group 1)
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C.3.6.2.5 Comparison Results: Deming Regression Analysis (Group 2)

Sector Intercept (SE) µm Int [95% CI] µm Slope (SE) Slope [95% CI]

1 -2.46 (1.98) [-6.35, 1.43] 1.03 (0.04) [0.95, 1.10]

2 1.09 (1.16) [-1.18, 3.35] 0.94 (0.02) [0.90, 0.99]

3 -2.87 (1.45) [-5.70, -0.03] 1.01 (0.03) [0.95, 1.06]

4 -1.52 (1.28) [-4.02, 0.99] 0.99 (0.02) [0.94, 1.04]

5 -2.91 (1.21) [-5.28, -0.55] 1.01 (0.02) [0.97, 1.06]

6 -2.26 (1.71) [-5.61, 1.10] 1.00 (0.03) [0.94, 1.07]

7 -0.27 (1.03) [-2.30, 1.76] 0.96 (0.02) [0.92, 1.00]

8 -16.11 (3.49) [-22.95, -9.26] 1.30 (0.07) [1.16, 1.43]

9 -7.65 (2.67) [-12.89, -2.41] 1.12 (0.05) [1.02, 1.23]

10 -6.39 (1.53) [-9.38, -3.40] 1.07 (0.03) [1.01, 1.13]

11 -4.73 (1.60) [-7.86, -1.60] 1.05 (0.03) [0.98, 1.11]

12 -1.75 (2.00) [-5.68, 2.18] 0.98 (0.04) [0.90, 1.06]

13 1.11 (1.12) [-1.08, 3.31] 0.93 (0.02) [0.88, 0.97]

14 -8.46 (1.92) [-12.21, -4.70] 1.11 (0.04) [1.04, 1.18]

15 -0.60 (1.10) [-2.75, 1.55] 0.96 (0.02) [0.92, 1.00]

16 -9.25 (2.99) [-15.10, -3.39] 1.14 (0.06) [1.02, 1.26]

17 -8.33 (2.67) [-13.57, -3.09] 1.12 (0.05) [1.02, 1.22]

18 4.44 (1.43) [1.65, 7.24] 0.86 (0.03) [0.81, 0.92]

19 -2.91 (3.80) [-10.37, 4.54] 1.02 (0.08) [0.87, 1.17]

20 -1.25 (3.07) [-7.27, 4.77] 0.98 (0.06) [0.86, 1.11]

21 -1.05 (2.20 [-5.37, 3.26] 1.00 (0.05) [0.91, 1.09]

22 -2.11 (2.38) [-6.76, 2.55] 1.00 (0.05) [0.90, 1.09]

23 3.59 (1.32) [1.00, 6.18] 0.87 (0.03) [0.81, 0.93]

24 -0.27 (1.86) [-3.91, 3.37] 0.96 (0.04) [0.88, 1.04]

25 1.91 (1.65) [-1.32, 5.14] 0.92 (0.03) [0.85, 0.99]

All -2.54 (0.36) [-3.25, -1.83] 1.01 (0.01) [0.99, 1.02]

Table 163: Deming Regression Analysis Stratified by Sector (Group 2)

C.3.6.2.6 Comparison Results: Deming Regression Analysis (Combined)

Group Intercept (SE) µm Int [95% CI] µm Slope (SE) Slope [95% CI]

Normal -5.92 (0.61) [-7.11, -4.73] 1.07 (0.01) [1.05, 1.10]

Pathology -2.54 (0.36) [-3.25, -1.83] 1.01 (0.01) [0.99, 1.02]

All -3.25 (0.30) [-3.83, -2.66] 1.02 (0.01) [1.01, 1.03]

Table 164: Deming Regression Analysis Stratified Combined (Group 1 & Group 2)
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C.3.6.2.7 Comparison Results: Bland Altman (Group 1)

Sector Mean Difference Difference LOA (Lower) LOA (Upper)

Mean SD Min Max Estimate SE 95% CI Estimate SE 95% CI

1 -1.59 1.77 -7.4, 2.8 - -5.05 0.24, -5.5, -4.6 1.88 0.24, 1.4, 2.3

2 -1.83 1.62 -5.9 2.2 -5.00 0.22 -5.4 -4.6 1.33 0.22 0.9 1.8

3 -1.94 1.71 -6.5 1.9 -5.29 0.23 -5.7 -4.8 1.41 0.23 1.0 1.9

4 -1.70 1.94 -7.3 2.3 -5.50 0.26 -6.0 -5.0 2.09 0.26 1.6 2.6

5 -2.49 1.79 -7.1 1.4 -6.00 0.24 -6.5 -5.5 1.03 0.24 0.6 1.5

6 -2.45 1.81 -7.7 2.0 -6.00 0.24 -6.5 -5.5 1.11 0.24 0.6 1.6

7 -1.64 1.75 -6.3 3.1 -5.07 0.23 -5.5 -4.6 1.79 0.23 1.3 2.3

8 -1.80 1.81 -6.3 1.8 -5.34 0.24 -5.8 -4.9 1.75 0.24 1.3 2.2

9 -2.29 1.80 -7.8 1.8 -5.81 0.24 -6.3 -5.3 1.23 0.24 0.8 1.7

10 -2.38 2.28 -9.8 2.7 -6.86 0.31 -7.5 -6.3 2.09 0.31 1.5 2.7

11 -3.10 2.80 -15.7 3.8 -8.58 0.39 -9.3 -7.8 2.38 0.39 1.6 3.1

12 -2.73 2.59 -10.1 4.0 -7.80 0.35 -8.5 -7.1 2.34 0.35 1.7 3.0

13 -2.70 2.53 -12.3 4.2 -7.66 0.34 -8.3 -7.0 2.25 0.34 1.6 2.9

14 -2.52 2.54 -7.9 3.0 -7.50 0.34 -8.2 -6.8 2.46 0.34 1.8 3.1

15 -2.70 2.33 -8.8 2.6 -7.26 0.31 -7.9 -6.6 1.86 0.31 1.2 2.5

16 -2.26 1.92 -8.3 1.4 -6.02 0.26 -6.5 -5.5 1.50 0.26 1.0 2.0

17 -2.53 2.34 -9.4 5.8 -7.12 0.31 -7.7 -6.5 2.06 0.31 1.4 2.7

18 -2.10 2.29 -8.3 4.6 -6.58 0.33 -7.2 -5.9 2.39 0.33 1.7 3.1

19 -1.87 2.01 -6.1 3.5 -5.82 0.37 -6.5 -5.1 2.08 0.37 1.3 2.8

20 -2.31 2.59 -9.0 4.0 -7.38 0.45 -8.3 -6.5 2.77 0.45 1.9 3.7

21 -2.55 2.84 -13.6 5.9 -8.12 0.44 -9.0 -7.3 3.02 0.44 2.2 3.9

22 -1.91 2.28 -8.2 3.8 -6.38 0.34 -7.0 -5.7 2.56 0.34 1.9 3.2

23 -2.93 2.22 -10.0 3.9 -7.27 0.31 -7.9 -6.7 1.41 0.31 0.8 2.0

24 -3.04 2.20 -9.3 2.7 -7.34 0.34 -8.0 -6.7 1.26 0.34 0.6 1.9

25 -1.67 2.36 -7.6 4.5 -6.30 0.35 -7.0 -5.6 2.96 0.35 2.3 3.6

All -2.28 2.21 -15.7 5.9 -6.62 0.06 -6.7 -6.5 2.06 0.06 1.9 2.2

Table 165: Bland Altman Limits of Agreement by Sector (Group 1)
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C.3.6.2.8 Comparison Results: Bland Altman (Group 2)

Sector Mean Difference Difference LOA (Lower) LOA (Upper)

Mean SD Min Max Estimate SE 95% CI Estimate SE 95% CI

1 -1.17 2.98 -7.8 14.7 -7.00 0.38 -7.8 -6.3 4.67 0.38 3.9 5.4

2 -1.86 2.15 -6.9 11.6 -6.08 0.27 -6.6 -5.5 2.36 0.27 1.8 2.9

3 -2.48 2.23 -8.1 5.2 -6.84 0.28 -7.4 -6.3 1.89 0.28 1.3 2.4

4 -1.93 1.96 -8.2 2.0 -5.77 0.25 -6.3 -5.3 1.90 0.25 1.4 2.4

5 -2.24 1.83 -7.5 2.9 -5.83 0.23 -6.3 -5.4 1.34 0.23 0.9 1.8

6 -2.04 2.21 -7.1 6.4 -6.37 0.28 -6.9 -5.8 2.30 0.28 1.7 2.9

7 -2.46 1.78 -6.9 2.5 -5.94 0.23 -6.4 -5.5 1.03 0.23 0.6 1.5

8 -1.22 3.55 -6.4 17.1 -8.19 0.45 -9.1 -7.3 5.75 0.45 4.9 6.6

9 -1.50 3.40 -6.9 14.7 0.43 -9.0 -7.3 5.16 0.43 4.3 -8.16 6.0

10 -2.94 2.36 -9.4 3.6 -7.58 0.31 -8.2 -7.0 1.69 0.31 1.1 2.3

11 -2.42 2.38 -9.1 6.7 -7.08 0.32 -7.7 -6.4 2.24 0.32 1.6 2.9

12 -2.72 2.61 -9.2 8.2 -7.84 0.36 -8.6 -7.1 2.40 0.36 1.7 3.1

13 -2.65 2.01 -7.8 1.8 -6.59 0.27 -7.1 -6.1 1.30 0.27 0.8 1.8

14 -2.92 2.68 -11.1 7.2 -8.17 0.34 -8.8 -7.5 2.34 0.34 1.7 3.0

15 -2.50 2.20 -8.7 3.3 -6.81 0.28 -7.4 -6.3 1.81 0.28 1.3 2.4

16 -2.65 3.76 -8.9 14.0 -10.02 0.48 -11.0 -9.1 4.72 0.48 3.8 5.7

17 -2.35 3.59 -15.5 14.7 -9.39 0.46 -10.3 -8.5 4.69 0.46 3.8 5.6

18 -2.09 2.72 -16.7 4.1 -7.42 0.40 -8.2 -6.6 3.24 0.40 2.4 4.0

19 -2.00 3.86 -18.0 5.7 -9.56 0.66 -10.9 -8.3 5.56 0.66 4.3 6.9

20 -2.01 3.45 -15.5 7.0 -8.77 0.65 -10.1 -7.5 4.74 0.65 3.5 6.0

21 -1.10 2.74 -7.0 5.5 -6.47 0.47 -7.4 -5.5 4.27 0.47 3.3 5.2

22 -2.26 3.68 -14.1 8.3 -9.48 0.53 -10.5 -8.4 4.96 0.53 3.9 6.0

23 -2.19 2.35 -7.4 4.2 -6.80 0.32 -7.4 -6.2 2.41 0.32 1.8 3.0

24 -2.24 2.38 -8.3 8.4 -6.91 0.34 -7.6 -6.2 2.44 0.34 1.8 3.1

25 -1.74 2.61 -9.6 4.3 -6.87 0.36 -7.6 -6.2 3.38 0.36 2.7 4.1

All -2.17 2.77 -18.0 17.1 -7.60 0.07 -7.7 -7.4 3.26 0.07 3.1 3.4

Table 166: Bland Altman Limits of Agreement by Sector (Group 2)

C.3.6.2.9 Comparison Results: Bland Altman (Combined)

Sector Mean Difference Difference LOA (Lower) LOA (Upper)

Mean SD Min Max Estimate SE 95% CI Estimate SE 95% CI

All -2.22 2.52 -18.0 17.1 -7.15 0.05 -7.2 -7.1 2.71 0.05 2.6 2.8

Table 167: Bland Altman Limits of Agreement by Sector (Groups 1 and 2)
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Glossary

AngioPlex Metrix
tools in angiography analysis "Superficial"
preset that allow you to observe and
measure vessel density and capillary
perfusion.

anterior segment
the front third of the eye that includes the
structures in front of the vitreous humour:
the cornea, iris, ciliary body, and lens.

Certificate Serial Number

a unique SERIAL NUMBER used in the
license registration process. CZM includes a
Software Product Certificate with software
that requires license registration.

corneoscleral junction

the margin of the cornea overlapped by the
sclera

CSMT
Central Subfield Measurement Thickness

CV
Coefficient of variation = SD ÷ Mean

DICOM
Digital Imaging and Communications in
Medicine. A standard for data
management, including a file format speci-
fication and a network communication
protocol.

EDI
Enhanced Depth Imaging

EMR
Any electronic medical records system,
including FORUM, whether DICOM-
compatible or not

ERM
Epiretinal membrane - a fibrocellular tissue
found on the inner surface of the retina.

ETDRS grid

macular grid used to measure area and
proximity of macular edema to the macular
center (fovea) and aids in evaluating the
changes in vision in patients with diabetic
retinopathy.
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FastTrac
FastTrac monitors retina movement and
automatically compensates for detected
motion

FAZ

Foveal Avascular Zone - a region within the
fovea devoid of retinal vessels. The FAZ
center is considered the macula center and
the fixation point.

FORUM
A software product for managing,
archiving, and viewing patient data,
images, and reports from computerized
diagnostic instruments or documentation
systems.

ILM
The internal limiting membrane forms the
innermost boundary of the retina between
the retina and the vitreous body, formed by
astrocytes and the end feet of Müller cells.

IOD
Information Object Definitions

IOP
Intraocular Pressure

IPL
Inner Plexiform Layer: an area of the retina
that is made up of a dense reticulum of
fibrils formed by interlaced dendrites of
retinal ganglion cells and cells of the inner
nuclear layer.

iridocorneal angle
the acute angle between the iris and the
cornea at the periphery of the anterior
chamber of the eye.

keratoconus
a progressive eye disease in which the
normally round cornea thins and begins to
bulge into a cone-like shape. This cone
shape deflects light as it enters the eye on
its way to the light-sensitive retina, causing
distorted vision.

NAS
Network Attached Storage: a device for
allowing multiple users remote access to
large amounts of data.

Node ID
an internal alphanumeric identifier unique
to each CZM instrument computer.

OP
Ophthalmic Photography

OPT
Ophthalmic Tomography

OPT IOD
DICOM standard format for archiving and
transferring OCT images as black and white
images

Optic Nerve Head (ONH)

The circular area in the back of the inside of
the eye where the optic nerve connects to
the retina.

Retinal Nerve Fiber Layer
RNFL
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Review Station
A separate networked computer, laptop or
PC (often in the doctor's office) with ZEISS
instrument software installed to access
patient data and images from the
instrument for analysis.

RPC
The radial peripapillary capillaries of the
retina are the most superficial of the
capillary layers. They are limited to the area
around the optic disc in the nerve fiber
layer, especially along the upper and lower
temporal vessels.

RPE
Retinal Pigment Epithelium: the pigmented
cell layer just outside the neurosensory
retina that nourishes retinal visual cells, and
is firmly attached to the underlying choroid
and overlying retinal visual cells.

scleral spurs
a protrusion of the sclera into the anterior
chamber; the origin of the longitudinal
fibres of the ciliary muscle attached
anteriorly to the trabecular meshwork.

SD
Standard deviation

SD-OCT
Special Domain Optical Coherence Tomog-
raphy: a form of non-invasive, low-
coherence interferometry that produces
high-resolution tomograms without
contacting the eye

VMT
Vitreomacular traction - a disorder of the
vitreo-retinal interface.

VRI
Vitreo Retinal Interface - a complex
composite structure connecting the vitreous
cortex and the inner retina.

XML
eXtensible Markup Language is a self-
descriptive markup language designed to
store and transport data
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Index

Numerical
1 Line Scan

About ...........................................  138, 234
200 x 200 Macular Scans

About ...................................................  149
200 x 200 Optic Disc Scans

About ...................................................  153
21 Line Scan

About ...........................................  138, 234
3D Visualization Analysis

About ...................................................  289
5 Line Scan

About ...........................................  138, 234
512 x 128 Macular Scans

About ...................................................  149

A
About ..........................................................  37

Acquiring Scans ....................................  142
Auto Repeat..........................................  216
Cube Scans ...................................  223, 385
FastTrac ................................................  217
Fixation Targets ....................................  212
Image Focus / Position ..........................  214
Patient Categories...................................  87
Protocols ..............................................  145
Scan Patterns ........................................  213
User Roles...............................................  57
XML Export.............................................  93

Acceptance Criteria....................................  228
Sub-RPE ................................................  228

Accessories ................................................  441
Accounts, User

Add New ................................................  71
Delete .....................................................  72
Edit .........................................................  72
Manage ..................................................  70
View .......................................................  71

Acquire
Anterior Chamber Scan.........................  185
HD 1-Line Raster Scan...........................  156
HD 21-Line Raster Scan.........................  156
HD 5-Line Raster Scan...........................  156
HD Angle Scan......................................  194
HD Cornea Scan....................................  201
HD Cross Raster Scan............................  156
HD Radial Raster Scan...........................  156

HD Raster Scans....................................  156
Macular Cube Scans..............................  149
Montage AngioPlex ..............................  171
OCT AngioPlex......................................  163
ONH Angiography ................................  167
Optic DIsc Cube Scans ..........................  153
Pachymetry Scan...................................  205
Wide Angle to Angle Scan ............  197, 362

Acquire Button ............................................  37
Acquire Screen

Overview ..............................................  140
Acquiring Scans, About..............................  142
Add

New Patient ..........................................  126
User Account ..........................................  71

Add a Category ...........................................  88
Add New Patient Tab.................................  128
Adjust Scan Patterns ..................................  157
Adjusting Instrument Height ........................  31
Administrator

Login ......................................................  58
Administrator Login .....................................  58
Advanced RPE Analysis

About ...................................................  258
Select a Different Scan ..........................  367
XML Export.............................................  98

Advanced Search
Overview ..............................................  132

Advanced Visualization
Overview ..............................................  287

Advanced Visualization Analysis
About ...................................................  286

Algorithm Studies ......................................  475
Anterior Chamber .................................  503
Central Corneal Thickness ....  504, 505, 506,

507, 508
Epithelial Thickness ...............................  515
HD Angle Measurements ......................  509
Wide Angle to Angle Measurements.....  511

Align Scans (Registration)...................  248, 315
Angiography.........................................  315
Macular Change ...................................  247

Altitude
Conditions for Use ................................  437

Analysis
Customize List.......................................  119
Edit Images ...........................................  372

Analyst
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Add New ................................................  71
View .......................................................  71

Analyst Profile
Demographic ..........................................  27
Occupational Skills ..................................  27

Analyze
Anterior Chamber .................................  344
Anteriror 5-Line Raster ..........................  365
HD Angle Scan......................................  351
HD Cornea Scan....................................  354
Pachymetry ...........................................  359
Wide Angle to Angle Scan ....................  361

Analyze Button ............................................  37
Angio Montage

Quality Check........................................  176
Angiography

Register License ......................................  61
Registration ..........................................  315
View License Status ................................  69

Angiography Analysis
About ...................................................  309
Overview ..............................................  323
XML Export...........................................  101

Angiography Change Analysis
About ...................................................  327
Overview ..............................................  328
Select a Different Scan ..........................  367

Angiography Cube Scans
About ...................................................  163

Angiography Montage
Acquire Overview..................................  172
Analysis Overview .................................  336

Angiography Scans
About ...................  138, 139, 000, 000, 000

Angiography, OCT
Acquire .................................................  163
Acquire Montage..................................  171
Acquire ONH ........................................  167

AngioPlex Metrix
About ...................................................  309
Algorithm Study....................................  491
FAZ.......................................................  311

AngioPlex Protocol ....................................  146
Angle Scan

Analyze.................................................  351
Annotation

Delete ...................................................  379
Annotations

Adding Calipers.............................  378, 380
Adding Circles.......................................  376

Adding Freeform Shape ........................  377
Adding Text ..........................................  377

ANSI Z80.36-2016 .......................................  15
Anterior Chamber

Acquire Overview..................................  184
Acquire Scan.........................................  185
Algorithm Studies .................................  503
Analysis ................................................  344
Analysis Overview .................................  343
Check Scan Quality ...............................  187
Depth Tool............................................  342
XML Export...........................................  103

Anterior Chamber Cube Scan
Check Quality........................................  190

Anterior Chamber Scan
Acquire, Overview.................................  182

Anterior Segment
Algorithm Study....................................  501

Anterior Segment Analysis
About ...................................................  339

Anterior Segment Scan
5-Line Raster Analysis............................  365
Anterior Chamber Analysis ....................  344
HD Angle Analysis.................................  351
HD Angle, Acquire ................................  194
HD Cornea, Acquire ..............................  201
HD Cornea, Analyze ..............................  354
Pachymetry ...........................................  204
Pachymetry Analysis..............................  359
Pachymetry, Acquire .............................  205
Pachymetry, Check Quality....................  207
Wide Angle to Angle, Acquire.......  197, 362
Wide Angle to Angle, Analyze...............  361

Anterior Segment Scans
About ...........................  140, 180, 235, 339

Anteriror 5-Line Raster...............................  365
Anteror Segment Protocol .........................  146
Aperture ......................................................  32
Archive

Changing ................................................  76
New Setup..............................................  74

Asian Normative Database
Change Instrument Settings ....................  84
Study Details .........................................  467

Atmospheric Pressure
Conditions for Use ................................  437

Audit Log, Export.........................................  36
Auto Repeat ................................................  36

About ...................................................  216
Avascular Layer Preset ...............................  321
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B
Band (MHz) .................................................  22
Bluetooth ....................................................  22
BMP file.......................................................  59
BMP Report ...............................................  237
Brightness

Adjust ...................................................  373
B-Scans

Center and Enhance Manually...............  211
Button

Acquire ...................................................  37
Analyze...................................................  37
Anterior Chamber Depth.......................  342
Done.....................................................  174
Finish ......................................................  37
ID Patient................................................  37
Native ...................................................  108
Native + XML........................................  107
Protocols ................................................  37
Refresh List ...........................................  134
Search ..................................................  128
XML......................................................  108

C
Caliper

Delete ...................................................  379
Calipers, Add to Image ......................  378, 380
Capillary Perfusion Density

About ...................................................  313
Categories ...................................................  36

About .....................................................  87
Adding....................................................  88
Changing ................................................  91
Deleting..................................................  89
Editing ....................................................  88

Caution Symbol ...........................................  11
Cautions

Definition................................................  12
Prohibited Activities ................................  19

CE................................................................  11
Center B-Scans Manually ...........................  211
Center Lines, Live.........................................  36
Central Corneal Thickness

Algorithm Study....  504, 505, 506, 507, 508
Central Region, ETDRS grid ........................  113
Change

Categories ..............................................  91
Change Analysis

Angiography, Overview.........................  328
Macular, Overview................................  249

Change Archives..........................................  76
Change My Password ..................................  36
Check Quality

Anterior Chamber Cube Scan ................  190
Anterior Chamber Scan.........................  187
HD Angle Scan......................................  196
HD Cornea Scan............................  192, 202
Macular Cube Scan ...............................  151
Pachymetry Scan...................................  207
Wide Angle to Angle Scan ....................  199

Chinrest
Controls ................................................  213
Location..................................................  32

Choose Fixation Target Location ................  212
Choriocapillaris Layer Preset.......................  321
Choroid Layer Preset..........................  306, 321
Circle

Delete ...................................................  379
Circles, Add to Image ................................  376
Classification

Optical ....................................................  15
Cleaning

Agents ..................................................  407
Chin cup and forehead rest...................  409
Front window lens ................................  409
Peripherals ............................................  410
Table ....................................................  410

Close
Image Editing Tool ................................  372

Color Image...............................................  375
Color OCT....................................................  36
Comments, Submitting ................................  29
Comparing Scans, Alignment.............  248, 315

Macular Change ...................................  247
Compliance

IEC 61000-4............................................  20
Computer, Instrument .................................  31
Configuration Settings

Instrument Identifeir ...............................  60
Configure

Reports .................................................  112
Connect

DICOM Storage or Records ...................  396
Printer...................................................  402
USB.........................................................  31

Connection
Testing..................................................  397

Copyright, Softwre ....................................  439
Cornea Scan

Acquire .................................................  201
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Analyze.................................................  354
Check Quality........................................  202

Corneal Thickness Map..............................  358
Cross Scan

About ...........................................  138, 234
CSA Certification Symbol .............................  11
CSV Filie ....................................................  245
Cube Scans

About ...........................................  223, 385
Macular Scans.......................................  149
Optic Disc Scans....................................  153

Custom Presets
Creating................................................  314

Customize
Analysis List ..........................................  119
Guided Progression Report....................  116
HD Image Report ..................................  115
Macular Thickness Report .....................  113
ONH OU Report ....................................  115
Scan List ...............................................  118

D
Data Management

Integrity of imported records ................  111
Log Files..................................................  73
Patient Privacy ........................................  89

Data Storage
About .....................................................  40

Database
Normative.............................................  451
Select....................................................  403

Database, Select ..........................................  36
Decorrelation Tails .....................................  230
DECT ...........................................................  22
Delete

Category.................................................  89
Image Editing........................................  379

Delete User..................................................  72
Deviation Map ...................................  273, 284
Device Warranty

Voiding...................................................  19
DICOM

Automatically Search Worklist.................  84
Configure Connections .........................  397
Gateway Connection ............................  396

DICOM Archive Records Menu.....................  35
DICOM Export ...........................................  237
DICOM/FORUM ...........................................  40
Diffuse Change Progression .......................  274
Dimensions and Weight.............................  436

Direct Current Symbol..................................  11
Disposal

Batteries ...............................................  449
Electronics ............................................  449
Packing material ...................................  449

Distance, Wireless........................................  22
Diversified Normative Database

Change Instrument Settings ....................  84
Ganglion Cell ........................................  457
Macula .........................................  456, 469
ONH .....................................................  462
RNFL.....................................................  460

Done Button..............................................  174
DRL Slab ....................................................  321

E
EC Rep Symbol ............................................  11
EDI

About ...................................................  156
Edit

Auto Repeat............................................  36
Categories ..............................................  88
Change My Password .............................  36
Delete .....................................................  72
Export Audit Log File...............................  36
Institution Name .....................................  36
Layers, Angiography Presets..................  314
Layers, Macular Thickness .....................  245
User Account ..........................................  72

Edit Images
Add Circles............................................  376
Add Freeform Shape .............................  377
Adding Calipers.............................  378, 380
Adding Text ..........................................  377
Adjust Brightness ..................................  373
Adjust Transparency..............................  375
Full-screen Image..................................  373
Hide / Show Toolbar .............................  372
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